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Controls and displays

Keys
Keys on the screen

Function

Select screen layout

Toggle the display between
machine operating mode, program-
ming mode, and a third desktop

of 0§

Soft keys for selecting functions on
screen

]

<

[ > } [ A } Switch the soft-key rows

Machine operating modes

A

ey Function

Manual operation

Electronic handwheel

Positioning with Manual Data Input

Program Run, Single Block

Y| & (= el B

Program Run, Full Sequence

Programming modes

Key Function

Programming

Test Run

Y| lo]

Controls and displays

Entering and editing coordinate
axes and numbers

Key Function

- Select the coordinate axes or enter
them in the NC program

n n Numbers

Decimal separator / Reverse
algebraic sign

N E

Polar coordinate entry /
Incremental values

Q parameter programming /
Q parameter status

Capture actual position

2 B8

Skip dialog questions, delete words

23]
20

Confirm entry and resume dialog

EN

5

END Conclude the NC block, end your
input

CE Clear entries or error message

EL Abort dialog, delete program
section

Tool functions

Key Function

To0L Define tool data in the NC program

DEF

TooL Call tool data
CALL
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Managing NC programs and files,
control functions

Key

PGM
MGT

Function

Select or delete NC programs or
files, external data transfer

Cycles, subprograms and
program section repeats

Key Function

Define and call cycles
DEF CALL

PGM
CALL

Define program call, select datum
and point tables

Select MOD functions

HELP

Display help text for NC error
messages, call TNCguide

Display all current error messages

CALC

Show calculator

SPEC
FCT

| [ ) & & & (=

Show special functions

Navigation keys

A~
®
<

]

Function

Position the cursor

GOTO

m}

Go directly to NC blocks, cycles,
and parameter functions

HOME

Navigate to the beginning of a
program or table

N

o

Navigate to the end of the program

or table row

PG UP

Navigate up one page

PG DN

Navigate down one page

Select the next tab in forms

W B @G EE RS

|

Up/down one dialog box or button

8 e Enter and call subprograms and
program section repeats

Potentiometer for feed rate
and spindle speed

Feed rate Spindle speed

100

0

WiOBm 5ni%hwin
WWF % s%
0 o o

HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018



Contents

4 HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018



Contents

Contents

T Fundamentals...........oii 21
P2 | A (=Y o X 33
3 Fundamentals..........oooiiiiiii i ———————— 45
L o Y o1 SRR 97
LT T 1 o PR 129
LT L= a1 Vo R 14 Lo I T T3 1 4 181
7 Special FUNCHIONS.........cooo i 227
£ O |1/ (0 1 B {1 T o o 231
9 HEROS fUNCLIONS........ceiiiiiiiiiciie s n e n e nn e 253
10 Tables and OVEIrVIEWS.........ccoiiiiiiiiii s annn e 321

HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018



Contents

6 HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018



Contents

1.1 ADBOUL thiS MANUAL...........e e ree e eresa s e e ressasss s reesssasss s tessasssssseeesnnsssssseennnnnnn 22
1.2 Control model, software and fEAtUIES...........coiiiiieeiiiiiiiii e resas e eersssss e reesssssssseesssnsssnnns 24
SOTEWWAIE OPTIONS .ttt ee ittt e et e et e e e et e e e e e et e e 25
NEW FUNCHIONS 77T8AX06B.... ..o 27
NEW TUNCHIONS 77 T8AX07 ... 29

HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018 7



Contents

B 1 - QO (- T3 33
D N 0 1Y o 34
2.2 Switching on the MAcChiNe..........c.ooccciiiiiiiiiie i s s sssnn e e e s s ssnr e e s s e s snnneessennneeesnnnns 35

Acknowledging the power interruption and moving to the reference points.........ccccccovvviiiiieiiiiieeene, 35

2.3 Graphically testing the WOIKPIECE..........ccoiiiiiiiiiiiciiiee et s e sne e s nne e e e e nnnees 36
Selecting the Test RUN OPEerating MOGE. .. .....iiiiuiiiiiiiiiii e 36
Selecting the 100l 1aDIE... ..o 36
SEleCtING the NC PIOGIAM .. .eiiii e e e e e et e e aaa e 37
Selecting the screen layout and the VIEW..........oooiiiiiiiiieee e, 37
STAMTING ThE TEST TUN...eiii it 38

2.4  Setting UP tOOIS........ceeiiiiiiiie it e s e n e e e R r e e e nr e e e nnr e e e e nne s 39
Selecting the Manual Operation MOGE. ... .....uiiiiiiiiiii e 39
Preparing and mMeasUring T0O0IS. ... . uuiuiiiiii ettt 39
Editing the TOOL.T 100! 1ADIE........iiiiiiiii e 40
Editing the TOOL_PTCH pocket table.........coiiiiiiiiiiiiii e 41

p 2 11 oY 5 1 o =T T =T | P 42
Selecting the Correct OPErating MOE..........iiiiiiiiiiii e 42
Clamping the WOTKDIECE. ..., 42
Presetting with a 3-D touch probe (option NnUMbBbEr 17) . ... 43

2.6 Machining the WOrKPI€CE............cooiiiiiiiiiiiie e s e san e nr e e s enns 44
Selecting the Program run, single block or Program run, full sequence operating mode..................... 44
Selecting the NC PrOGIraM. ... .. e 44
STArtiNG @N NC PIrOGIrAM .. .ueiiiiiice ettt 44
HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018



Contents

3 FUNAamentals..........oooiiiiiii 45
R I I o 7= I\ (O 1 P 46
HEIDENHAIN KIBITEXT. . .eeeiiiiiiii ettt e e e e e 46
(OfoTaaloT= 141 o111 USROS PP UTRTR 46

Data security and data ProtECTION. ... .o i ettt 47

3.2 \Visual display unit and operating panel............cooooiii e 49
DISPIAY SCIEEN ... e 49
SettiNg the SCrEEN [AYOUL.........oo i 49
CONTIOI PANEL..cii e 50
SCIEEN KEYPAU. ... oo 50

R O |V o Yo [T o T o =Y - o) o R 52
Manual Operation and El. HaNAWNEE........ooo e 52
Positioning with Manual Data INDUL..........ooiiii e 52

P O G AMIMING . e e 52

=TS S 2 0T T OO 53
Program Run, Full Sequence and Program Run, Single BIOCK..............ccccoiiiiiiiiee 53

K - 11 C 3o [Ty o PSP 54
GENETAl STAUS ISPIAY . ..eiiiiiiiiie et 54
Additional STatUS iSPIAYS......coii i, 55

£ N 1 (=0 1 = 11T T 1= 0 4 Lo o 60
1= TP U USRS RRPPPPPPRR 60
Displaying externally generated files on the CONtrol...........ooooiiiiiii e 62

D[ g=Tor (ol 1= T PSRRI 62

P AN S 62
Calling the file MANAGET ... i, 63
AdAitional TUNCHIONS. ..o e e 64
Selecting drives, direCtories and fllES...... ... 65
Choosing one of the last files SEIECTEd.......ooiiiiiiiii e 67

USB deViCES ON the CONTION....iiiiiiii it e e e e 68

Data transfer to or from an external data Carmier..........ooooiiiiiiiiiii e 69

The CONTIOL IN @ NETWOTK ..o ittt e e e e e e 70

DAt DACKUD . .. oo 72
Importing a file from an iTNC B30.......oooiiiii e 72
Additional tools for management of external file types.........oooiiiiiii 73

3.6 Error messages and help SYStem...........oiiiiiiiiiiiiiiiciirire e e e e e s e e snnn e e e e e e e e e aennnnnn 82
e oY gl o =TT oT=To [T TSR 82
TNCguide contexXt-senSitiVe NEID SYSTEM . ..ciuiiiiii e 87

R 27 2 | [ O3 {170 Yo F= T3 o U= 1 i 1 93
Position encoders and referenCe Marks............uvviiiiii i 93

HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018



10

3.8

Contents

Accessories: HEIDENHAIN 3-D touch probes and electronic handwheels.............ccccceveeieeeericnnees 94
3D TOUCKN PIrODES . . e 94
HR eleCtronic NANAWREEIS. ... ... 95

HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018



Contents

g N o o I ¥ T 98
TOOI NUMDET, 100! NMAMIE. ... ettt ettt e e e e e e e e e 98
TOOI IBNGTN Lo e 98
[ eleT I - To [0 I T = TP U USRI 98
Tool table fUNAAMEBNTAIS. ... 99
Entering tool data into the table... ... 103
IMPOtING 100l 1ADIES. . ..o i e 108
Overwriting tool data from an external PC...........cooiiiiiiiiiii e 109
Pocket table fOr t00] CRANGET. ... ... i 110
f [elel e aT=T oo = TSRS PPPPPRPURRR 113
TOOI USAGE T8t 114
N o Yo I 43 =T = e 1= 4 U= 3 117
B . 1ttt et e et e e 117
Calling OOl MANAGEMENT. ... ettt et e et e e 118
Editing t00l MaNAgEMIEBNT. ......ooi i 119
4.3 Tool carrier MANAGEMENT..........cciieiiiccreereeeiire e s s ssnr e e s e sssne e e s s sssnre e e s s s ssne e e s s s snnaeeseesnnneesssnnnneeesannnnes 123
U oo F=T 0 aT=] o) 2= | - T USRS 123
SaVviNg 100l CarTEr 18MIPIATES. .. ..o e 123
Assigning input parameters t0 100l CAITIEIS. ... .. i i it 124
Allocating parameterized 00l CATIBIS. ... ... i i 127

HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018 1



Contents

LT - 1 o PN 129
5.1 Switch-on, SWItCh-0ff............ooo e e e an e e 130
Y1 (e o o TSP SO P PSP SUPPURTURUPPN 130
Traversing refEreNCE POINTS.......iiiiii e 132
SN0 e 133

5.2 Moving the Maching @XES..........coiiiiiiiiiiiiiii e e e e e e s s sn e e e e e e e e s e e s s e nnmnnneeeeeees 134
o) (T O SO U PP TSRO SPPPP 134
Moving the axis with the axis direCtION KEYS.........uvviiiiiiiii e 134
Incremental JOg POSITIONING. .....ci ittt 135
Traverse with the HR 510 electronic handwheel...........cccoiiiii e, 136
Moving with the electronic display handwheels.............. 137

5.3 Spindle speed S, feed rate F and miscellaneous function IM..................cueuiiiiiiiiiiieeeeeeeeens 148
JAY o] o] [To=) 1] o FH ST UPPUTTRRST 148
ENTEriNg ValUES ... .o e 148
Changing the spindle speed and feed rate...........coouuiiiiiiiiiii e 149

Feed rate Mt F IV A K ettt e e 149

5.4 Preset Manage@mENt......... ... it e e e e e e e e e e e e nn e e e e e e e eesaa e e nnnnnnaeeeeees 151
o) (T ST PP U PP TN U PO UPPPP 151
Saving pPresets iN the table. .. ... 151
Protecting presets from DEING OVEIWITTEN . ......oouiiiiiiii e, 155
ACTIVAING @ PIESEE ..o 157

5.5 Presetting without a 3-D touch probe............cooo e 158
AT £ T USROS SPPPP 158

P O DAIATION . . e 158
Presetting With an €nd Ml . ... e 159

Using touch probe functions with mechanical probes or measuring dials..............ccccooeviiii. 160

5.6 Using a 3-D touch probe (OPtion 17)......c.ccccciiiiiiiiiiiiiiciiee e e s ann e s 161
OVBTVIBW ... et e ettt e oottt e et e e e ettt e e e e et e e e ettt e e e e e e e 161
Suppressing touch Probe MONITOIING. .....oouiii i 163
FuNctions in tOUCh ProbE CYCIES........coo i 163
Selecting the ProbiNG CYCIE.......coiiiiiii e 165
Recording measured values from the touch probe CyCles. ... 166
Writing measured values from the touch probe cycles to a datum table..........cc..ccoovviiiiiiiiiiece, 166
Writing measured values from the touch probe cycles to the preset table.................ccoooo 167

5.7 Calibrating 3-D touch probes (OPtion 17)........c.cccceiiiieieiiniiiieseseesssee s ssr e s s sne e sne s s sne e s sneesssnnennnns 168
[ a i oo [Ule3 4o ] o PSP EUSRRR 168
Calibrating the effective 18NGth..... ... 169
Calibrating the effective radius and compensating center misalignment...............cccccoeeveiiiiiiinnenee. 170
Displaying calibration VaAIUES. ...........ooiiiiiiii e 173

12

HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018



Contents

5.8

Presetting with a 3-D touch probe (option NUMDbEr 17)........c.ccccvieieriiierccse e 174
OVEBIVIBW ...ttt e ettt e e e e e e et e e et e e e ettt e e e et e e e 174
PreSETING ON @NY @XIS. . .iiiiiiiiiiiie et 174
(O] (ol [ ol= g Y (= A= R o (=T 1= PR 175
SettiNg @ CENTET lINE @S PrESET. ..o it 178
Measuring workpieces with @ 3-D toUCh Probe..........coooiiiii e 179

HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018 13



Contents

6 Testing and FUNNING........coiiiiiiir e s s e e e e s s n e nnnnn e e e s 181
0 O €1 T o 182
AR I CATION. . 182

VIEWW OPTIONS oo 183

oo SRR SPPPPPRRI 184

VWV e 185
Rotating, zooming and MOVING @ GraphiC.......coooiiiiiiiiii e 186
Speed Of the SETHING TEST TUNS.....ii it 187
Repeating graphic SIMUIBTION..... ... 188
Shifting the SECTIONal PIANE.......oiii e 188

6.2 Showing the workpiece blank in the working space............cccccoiiiiiiiiiiic e e 189
FaY o] o] o= 1] o RPN 189

L |/ 1= L= T T 190
AR CATION. .. 190

6.4 Optional program-run iNtEITUPLION..........ccviiiiiiirier e e s eessree e e sssser e e e asssseeesaessnneeesassnneenasasnnnensanan 191
ADPIICATION. .. 191

6.5  SKipping NC DIOCKS...........uiiiiiiiiiiieicecie e e e e e e e s e e e s nnnr e e e e e e eeeaesa e snnnnnnnnnneeneesannn 192
Test Run and Program RUN .. ... 192
Positioning W/ Manual Data INDUL........ooiiiiiie e 193

L T =3 T TP 194
ADPIICATION. ..o 194

TEST TUN EXECUTION ... ettt ettt e ettt e e et e e e 195
Executing a Test Run up to a certain NC BIOCK. ........coiiiiiiiiii e 196
(€10 ] O I V] aTox 1o ] s PP PSPPI 197
DisSplay Of NC PrOGramMIS. .....co ittt 198

L0 I S o o |- 110 TR0 (V1 PP 199
JAY o] o] [To=1 1] o FH ST UPPUTPURST 199
o a T aTe =T a I N (G o] (oTe [ =1 o VOO RRR 200
STrUCTUNING NC PIrOGIAMIS. ..ot 201
Checking and changing Q ParamEterS...........eei i 202
Interrupting, stopping or aborting MaChiNING...........ooiiiiiiiiii e 204
Moving the machine axes during an INTEITURTION. ... ...uueuieicee e 207
Resuming program run after an intermuptioN.........cooiiiiiiiii e 208
Retraction after @ pOWer INTEITUDTION. ... ..o 209

Any entry into the NC program: BIOCK SCaN.........cooiiiiiiiiiiii e 212
RetUINING 10 the CONTOUT. ... e 217

6.8 Functions for program diSPlay..........cccceeiuiiieiiriiiiiiierieeseree s e sere e s s e s s nne e e s s e s e e nnn e e e nne s 218
OVBIVIBW.....eee ettt 218

14 HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018



Contents

6.9

6.10

6.11

6.12

Positioning w/ Manual Data Input operating mode............ccccoveeiiiiiieciiiieneseeee e 219
Positioning with manual data input (MDI).........ccoooi e 220
Saving NC programs from SIMDI. ... ..o 222
Entering miscellaneous functions IVI..............coooiiiiiiiiiiicicciere e e e e s 223
FUNGAMIENTAIS. ..o et et e e e e 223
Miscellaneous functions for program run inspection, spindle and coolant.................ccccouuueee. 224
OVBIVIBW ...ttt e oo e e e oo e e e e oot e e e e a e e e ettt e e e et e e e eee e 224
Miscellaneous functions for coordinate @ntries..........cccccccceeeriicciieniessire e s ssnre e s eennnes 225
Programming machine-referenced coordinates: MOT/MO2............ccoiiiiiiiiiiiiiie e 225

HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018 15



Contents

71 DefiNiNg @ COUNTEN.......ccoiiieiieei e eeeeeere e e seene e e e e essnr e e s s ssnre e e s ssssne e e e s e s amneeeseesnneeesensnnneeesennnneesennnnnes 228
PN o] ollTor: ) 110 o OO O PP SPPPRTRUPPP 228
Define FUNCTION COUNT .....ooi ettt 229

16 HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018



Contents

= O |1/ (0 1 B {1 T o o 231
< 20 N (Y 01 B {1 oY o 232
Selecting MOD fUNCHIONS. ..o, 232
Changing the SETINGS. ..o 232
EXItING MOD fUNCHIONS. .. oo 232
Overview of MOD FUNCLIONS. .....ooiiiiii e 233

8.2 Display software NUMDErS.............c..iiiiiieiiie e nr e e e e e e s sas s e e s ssnnnnneeeeeneesanennnnnn 234
PN o] o] o= 1] o AU 234

8.3 Entering the code NUMDET.......... .. nnnne e 234
AR CATION. .. 234
Functions provided to the machine tool builder by the code number dialog..............cccooeviiiiin. 235

8.4 Loading the machine configuration...........ccccccoii it e e e e e e eeean 236
PN o] o] o= 1] o RPN 236

8.5 Selecting the PoSition diSPIaY.......ccccoiiiiiiiiiiiiiie e e e snr e s e ssnr e e e e nmnr e e e e enanes 237
AL CATION. ..o 237

8.6 Setting the UNIt Of MEASUIE...........ooeiiiiiiiiei et e e e s essnr e e e e esne e e s e e s annneeseesnneeesennnes 239
ADPIICATION. ..o 239

=0 €1 T o] 4T (oY= T e 240
8.8  Setting the COUNTET ... e e s e e an e s s mn e e e s e nnnne s 241
8.9 Changing the machine Settings............ccuviiiiiiiiiii e 242
SeleCting the KINEMATICS......veiiiiiiie e 242
ENTEriNG traVEISE lIMITS. .. ettt e e e e e e e e 243
Generating @ tool USAGE TIlE........ooiiiiiiii e 244
Permitting or restricting @XTErNal @CCESS. ... .ttt ittt 245

8.10 Configuring the HR 550FS radio handwheel..............c.cccooriiiiiiiiiieee e 248
FAY o] o] [To= 1] o FHUU RSOOSR PPUPPPPPRPRN 248
Assigning the handwheel to a specific handwheel holder............cooviiiiiii 248
Setting the transSmMISSION ChANNEL..........ooiiiiiii e 249
Selecting the tranSMUTEr POWET ... e 249
STATISTICAl TATa. .. o e 250

8.11 Changing the System SEttings.........ccccciiiiiiiiiiiiccicieir s s e re e e e s s s e e s s sssnn s e e e e e e eeessanennnsnnnns 251
SET the SYSIEM TIMIB. . oo 251

8.12 Displaying operating times.........oooiiiiiiiiiiiiii e 251
AR I CATION. . 251

HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018 17



Contents

9 HEROS fUNCHIONS....... ittt s e e s s nn e e e s s nn e e s s s nnnn e e e s e mnnennan 253
L= Tt SO 41T T [T o 4 T = T =) S 254
OVEIVIEW OF TASKDAI ... et ettt e e 255
PO S AN . . e 258
REMNOTE SEIVICE .. ittt e e e e 259

P N e 261
SELINUX SECUNITY SOTtWATE.....oo i, 263

State Reporting Interface (OPtioN T37). ... . i 264

LY T OSSP P PRSP PP PR PUPPPN 267
BaCKUD @NA TESTOIE. ... 270

L= 0 (- 7 | | 273
FAY o] o] o= 1] o RSP RRR 273

9.3 Setting Up data iINtErfaces.........cccieeciiiiiieiiiiei i e e s e e s ssr e e e s s sne e e s eessnne e e e e s nne e e e e e nnneenaan 276
Serial Interfaces 0N the TNC 128, .. i 276

JAY o] o] [To=) 1] o FH ST UPPUTTRRST 276
Setting the RS-232 INtEITACE. ........oeeieiee e 276

Set BAUD RATE (baud rate NO. T0B70T) . ..ueieiei e 276

Set protocol (ProtoCol NO. TOBT02)........e e, 277

Set data bits (dataBits NO. T0BT703)......uiiiiiiiiiiie e 277
Check parity (parity NO. TOB704).......oo oo 277

Set stop bits (StOPBItS NO. TOB705)......cii it 277

Set handshake (flowControl NO. TOB70B8).........coiiuiiiiiiiiiii e 278

File system for file operation (fileSystem nNo. T06707)........ccoiiiiiiiiiiiiiieeee e 278

Block check character (bccAvoidCtriChar No. T06708)......cccoiiriiieiiiiiii e 278
Condition of RTS line (rtSLow NO. TOB709)........omiieeee oo 278
Define behavior after receipt of ETX (noEotAfterEtx no. 106710).........ccoiiiiiiiiiiiieeeee e 279
Settings for the transmission of data using PC software TNCServer..........cccccccccvveeiiiiiiiiieee 279
Setting the operating mode of the external device (fileSystem)...........ooooi 279
Software for data tranS el ... 280

L= I = 1Y 0 1= AT = - V- 282
L) (el [Vexuo] PSSP P TUPPPPRRTUPPPPS 282
CONNECHION POSSIDIITIES. ..ottt 282
General NETWOTK SEHINGS. ... ..eiiiieee e 283
DeVvice-SPECIfic NETWOTK SETINGS. .. .uiiiiiiiiiiie ettt 289

9.5 SELINUX SeCUrity SOftWAIE........cccoiiiiiiiiie e s e s e e e e e e s e e s mnnnnn e e e e e enasnannn 291
(2 I I U L T=Y g Yo 3 1 4T3 i 1 o) o 292
Configuring the User adminiSTratioN..............iiiiiiiii e 293

LOCal LDAP dat@base. ... .. i 295

LDAP ON TEMOTE COMPULET . ...uuiiiiiee ettt 296
Connection 10 @ WINAOWS GOMIN......cuuiiiiiiiiiii ettt e et e et e e e eaeeeas 297
Creating fUMNET USEBIS. .. o it 300
18 HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018



Contents

9.7

A CCESS TGN o e e 303
HEIDENHAIN fUNCIION USEIS. ..ottt 304
DEfINItION OF TOIES ... ittt e e 305
RIS e e 309
DNC connection with user authentiCation..............oiiiiiiiiiii e 310
Login 10 USEr @adminiStratioN.......iiiiieiiii e 314
SWILChING OF 10GGING OUL USEIS....uuiiiiiieieee e 315
Screensaver With [0CKOUT..... ..., 316
[ (@AY o ] Yot (o] 2SR 317
(U =T o) =TT RSO 318
Dialog for requesting additional HghtS.. ... 319
Changing the HEROS conversational [anguage............cccceeriiriimieiiisieieesssseee e s s sseee s s ssneee s s sssnnes 320

HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018 19



Contents

10.1 Machine-specific USer PArameEters............cccceiiiieiiiieriiciere e e e e s sse e e e s s snne e e sssnne e e e s e snnneeeeesnnnneenans 322
FAY o] o] o= 1 1] o OO PPUPPPRRSRR 322
LISt Of USEI PAramMIEIET ... oo 325
10.2 Pin layout and cables for data interfaces.............cccccoiiiiiiieiiiccciee e 336
RS-232-C/V.24 interface for HEIDENHAIN deVICES........viiiiiiiiiiiieiie e 336
NON-HEIDENHAIN GEVICES. ....oiiiiiiiiiiiiiiceie et 338
Ethernet interface RJAD SOCKET.......iii i 338
0 T S ¢ Yo T oY 1 339
USEI FUNCHIONS . .. ettt e e ettt e e e ettt e e e ettt e e e st a e e 341
A GBS S OIS . e 343

20 HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018






1.1 About this manual

Safety precautions

Comply with all safety precautions indicated in this document and
in your machine tool builder's documentation!

Precautionary statements warn of hazards in handling software
and devices and provide information on their prevention. They are
classified by hazard severity and divided into the following groups:

A DANGER

Danger indicates hazards for persons. If you do not follow the
avoidance instructions, the hazard will result in death or severe
injury.

Warning indicates hazards for persons. If you do not follow the
avoidance instructions, the hazard could result in death or
serious injury.

A CAUTION

Caution indicates hazards for persons. If you do not follow the
avoidance instructions, the hazard could result in minor or
moderate injury.

Notice indicates danger to material or data. If you do not follow
the avoidance instructions, the hazard could result in things
other than personal injury, such as property damage.

Sequence of information in precautionary statements

All precautionary statements comprise the following four sections:
= Signal word indicating the hazard severity

® Type and source of hazard

® Consequences of ignoring the hazard, e.g.: "There is danger of
collision during subsequent machining operations"

® Escape — Hazard prevention measures

Fundamentals | About this manual
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Fundamentals | About this manual

Informational notes

Observe the informational notes provided in these instructions to
ensure reliable and efficient operation of the software.

In these instructions, you will find the following informational
notes:

o The information symbol indicates a tip.
A tip provides additional or supplementary information.

@ This symbol prompts you to follow the safety
precautions of your machine tool builder. This symbol
also indicates machine-dependent functions. Possible
hazards for the operator and the machine are described
in the machine manual.

@ The book symbol represents a cross reference to
external documentation, e.g. the documentation of your
machine tool builder or other supplier.

Have you found any errors or would you like to suggest
changes?

We are continuously striving to improve our documentation for you.

Please help us by sending your suggestions to the following e-mail
address:

tnc-userdoc@heidenhain.de
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Fundamentals | Control model, software and features

1.2 Control model, software and features

This manual describes functions for setting up the machine as well
as for testing and running your NC programs. These functions are
provided by controls as of the following NC software numbers.

Control model NC software number
TNC 128 771841-07
TNC 128 Programmming Station 771845-07

The machine manufacturer adapts the usable features of the
control to his machine by the setting machine parameters. Some of
the functions described in this manual may therefore not be among
the features provided by the control on your machine tool.

Control functions that may not be available on your machine
include:

® Probing functions for the 3-D touch probe

In order to find out about the actual features of your machine,
please contact the machine manufacturer.

Many machine manufacturers, as well as HEIDENHAIN, offer
programming courses for the HEIDENHAIN controls. Participation
in one of these courses is recommended to familiarize yourself
thoroughly with the control's functions.
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Software options
The TNC 128 features various software options that can be enabled by your machine tool builder. Each option is to

be enabled separately and contains the following respective functions:
Additional Axis (option 0 and option 1)

Additional axis Additional control loops 1 and 2

Touch Probe Functions (option 17)

Touch probe functions Touch probe cycles:
B Presetting in the Manual operation mode
= Tools can be measured automatically

HEIDENHAIN DNC (option 18)

Communication with external PC applications over COM component

State Reporting Interface — SRI (option 137)

HTTP accesses to the control status = Reading out the times of status changes
= Reading out the active NC programs
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Feature Content Level (upgrade functions)

Along with software options, significant further improvements of
the control software are managed via the Feature Content Level
upgrade functions. If you install a software update on your control
you do not automatically have the functions available as covered by
the FCL.

o All' upgrade functions are available to you without
surcharge when you receive a new machine.

Upgrade functions are identified in the manual as FCL n. The n
signifies the serial number of the development status.

You can purchase a code number in order to permanently enable
the FCL functions. For more information, contact your machine tool
builder or HEIDENHAIN.

Intended place of operation

The control complies with the limits for a Class A device in
accordance with the specifications in EN 55022, and is intended for
use primarily in industrially-zoned areas.

Legal information

This product uses open-source software. Further information is
available on the control as follows:

» Press the MOD key

» Select Code-number entry

» LICENSE INFO soft key
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New functions 77184x-06

® New FUNCTION COUNT function for controlling a counter.
® |t is possible to comment out NC blocks.

= \When multiple instances of the CAD viewer are open, they are
shown somewhat smaller on the third desktop.

® With FN 16: F-PRINT, it is possible to enter references to Q
parameters or QS parameters as the source and target.

= The FN 18 functions have been expanded.

= You can also open the tool-carrier files in the file management,
see "Tool carrier management’, Page 123

= \With the ADAPT NC PGM / TABLE function, you can also import
and modify freely definable tables, see "Importing tool tables",
Page 108

B The machine tool builder can define update rules that make it
possible, for example, to automatically remove umlauts from
tables and NC programs when importing a table, see "Importing
tool tables", Page 108

® A quick search for the tool name is possible in the tool table,
see "Entering tool data into the table", Page 103

B The machine tool builder can disable the setting of presets in
individual axes, see "Saving presets in the table", Page 151,
see "Presetting with a 3-D touch probe (option number 17)",
Page 174

® Line 0 of the preset table can also be edited manually, see
"Saving presets in the table", Page 151

B The nodes in all tree structures can be expanded and collapsed
by double-clicking them.

® New icon in the status display for mirrored machining, see
"General status display", Page 54

B Graphic settings in the Test Run operating mode are
permanently stored.

® |n the Test Run operating mode, you can now choose between
various ranges of traverse, see "Application’, Page 189

= With the TCH PROBE MONITOR OFF soft key you can suppress
touch-probe monitoring for 30 seconds, see "Suppressing touch
probe monitoring", Page 163

m |f the function for orienting the touch probe to the programmed
probe direction is active, the number of spindle revolutions
is limited when the guard door is open. In some cases, the
direction of spindle rotation will change so that positioning will
not always follow the shortest path.

B New machine parameter iconPrioList (no. 100813) for defining
the order of icons in the status display, see "Machine-specific
user parameters", Page 322

® The machine parameter clearPathAtBlk (no. 124203) enables
you to specify whether the tool paths will be cleared with a
new BLK FORM in the Test Run operating mode, see "Machine-
specific user parameters", Page 322
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Modified functions 77184x-06

® |f you use locked tools, the control displays a warning in the
Programming operating mode.

® The TRANS DATUM AXIS NC syntax can also be used within a
contour in the SL cycle.

® Holes and threads are shown in light blue in the programming
graphics.

B The sort order and the column widths are retained in the tool
selection window when the control is switched off.

® |f a file to be deleted does not exist, FILE DELETE no longer
generates an error message.

® |f a subprogram called with CALL PGM ends with M2 or M30,
the control issues a warning. The control automatically clears
the warning as soon as you select another NC program.

® The time needed to paste a large amount of data into an
NC program was considerably reduced.

® \When you double-click a selection field of the table editor with
the mouse or press the ENT key, a pop-up window opens.

® |f you use locked tools, the control displays a warning in the
Test Run operating mode, see "Test run*, Page 194

= The control provides a positioning logic for returning to the
contour, see "Returning to the contour", Page 217

®  The positioning logic for returning to the contour with a
replacement tool has changed, see "Tool change", Page 113

® |f the control finds a stored interruption point on restart, you can
resume the machining operation from that point, see "Any entry
into the NC program: Block scan", Page 212

® The tool is shown in red in the graphics while it is in contact
with the workpiece, and blue during air cuts, see "Tool",
Page 184

® The positions of the sectional planes are no longer reset when
a program or a new blank form is selected, see "Shifting the
sectional plane", Page 188

m Spindle speeds can be entered with decimal places also in
the Manual operation mode. The control displays the decimal
places when the spindle speed is < 1000, see "Entering values',
Page 148

B The control displays an error message in the header until it is
cleared or replaced by a higher-priority error, see "Display of
errors", Page 82

® To connect a USB stick you no longer have to press a soft
key, see "Connecting and removing USB storage devices",
Page 64

B The speed of setting the jog increment, spindle speed and feed
rate was adjusted for electronic handwheels.
B The control automatically recognizes whether a table is to be

imported or the table format is to be adapted, see "Importing
tool tables", Page 108

= \When configuration subfiles are modified, the control no longer
aborts the test run, but only displays a warning.

B You can neither set nor modify a preset without having
referenced the axes, see "Traversing reference points’,
Page 132
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The control issues a warning if the handwheel potentiometers
are still active when the handwheel is deactivated, see "Moving
with the electronic display handwheels", Page 137

When using the HR 550 or HR 550FS handwheel, a warning is
issued if the battery voltage is too low, see "Moving with the
electronic display handwheels", Page 137

The machine tool builder can define whether the R-OFFS offset
will be taken into account for a tool with CUT 0, see "Tool data
for automatic tool measurement”, Page 105

The machine tool builder can change the simulated tool change
position, see "Test run", Page 194

In the machine parameter decimalCharakter (no. 100805) you
can define whether a period or a comma will be used as the
decimal separator, see "Machine-specific user parameters”,
Page 322

New and modified cycle functions 77184x-06

The parameters Q215, Q385, Q369 and Q386 were added to
Cycles 256 RECTANGULAR STUD .

Changes of details in Cycle 233: Monitors the tooth length
(LCUTS) during finishing, increases the area by Q357 in the
milling direction when roughing with milling strategies 0 to 3
(provided that no limit has been set in the milling direction).

The technologically outdated Cycles 1, 2, 3, 4, 5, 17,212, 213,
214, 215, 210, 211, 230, and 231 grouped under OLD CYCLES
can no longer be inserted using the editor. These cycles can still
be executed and edited, however.

The tool touch probe cycles, such as Cycles 480, 481 and 482,
can be hidden.

New SERIAL column in the touch probe table.

New functions 77184x-07

It is now possible to work with cutting data tables.

In Test Run operating mode, a counter defined in the NC
program is simulated.

An NC program you called can be edited when it has been
completely executed in the calling NC program.

With TOOL DEF, you can use QS parameters for entering the
data.

You can now use QS parameters to read from and write to
freely definable tables.

The FN16 function was expanded to include the * input
character that can be used to write comment lines.

New output format for the FN16 function %RS that you can use
to output texts without formatting.

The FN 18 functions have been expanded.

The new user administration enables you to create and
administrate users with different access rights, see "User
administration”, Page 292

With the new HOST COMPUTER MODE function, you can turn

command over to an external host computer, see "Permitting or
restricting external access", Page 245
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= With the State Reporting Interface (SRI), HEIDENHAIN
provides a simple and reliable interface for acquiring the
operating states of your machine, see "State Reporting Interface
(option 137)", Page 264

B The screen layout soft keys were adapted, see "Modes of
operation®, Page 52

® The control checks all NC programs for completeness before
machining. If you attempt to start an incomplete NC program,
the control aborts with an error message, see "Data transfer to
or from an external data carrier", Page 69.

® |n the Positioning w/ Manual Data Input operating mode, you
can now skip NC blocks, see "Skipping NC blocks", Page 192

B The appearance of the Optional program run stop has
changed, see "Optional program-run interruption”, Page 191

B You can use the key between PGM MGT and ERR to toggle
between screens.

®m The control supports USB devices with the exFAT file system,
see "USB devices on the control”, Page 68

m |f the feed rate is less than 10, the control also shows one of
the decimal place that have been entered, see "Entering values”,
Page 148

B |n Test Run operating mode, the machine tool builder can define
whether the tool table or the expanded tool management is
opened.

® The machine tool builder defines which file types you will
be able to import when using the ADAPT NC PGM / TABLE
function, see "Importing a file from an iTNC 530", Page 72

® New machine parameter CfgProgramCheck (no. 129800) for
defining settings for the tool usage files, see "List of user
parameter", Page 325

Modified functions 77184x-07

® The cutting data calculator has been improved.

B The control does not run a tool change macro if neither a tool
name nor a tool number is programmed in the tool call, but the
same tool axis as in the previous TOOL CALL block.

® \When using SQL UPDATE and SQL INSERT, the control checks
the length of the table columns to be written to.

= \When using the FN16 function, M_CLOSE and M_TRUNCATE
have the same effect as far as output to the screen is
concerned.

® |n the Test Run operating mode, the GOTO key now has the
same effect as in the other operating modes, see "GOTO
function”, Page 197

® The ACTIVATE PRESET soft key also updates the values of a line
activated in the preset management, see "Activating a preset’,
Page 157

B From the third desktop you can switch to any operating mode
using the operating mode keys.

® The additional status display in the Test Run operating mode
was adapted to match that of the Manual operation mode, see
"Additional status displays", Page 55
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B The control allows updating of the web browser, see "Additional
tools for management of external file types", Page 73

B The screensaver glideshow was removed.

= The machine tool builder can specify which M functions to allow
in the Manual Operation mode, see "Application", Page 148

= The machine tool builder can define the default values for the L=
OFFS and R-OFFS columns in the tool table, see "Entering tool
data into the table", Page 103

New and modified cycle functions 77184x-07
® The REACTION column was added to the touch probe table.
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First steps | Overview

2.1 Overview

This chapter is intended to help you quickly learn to handle the
most important procedures on the control. For more information on
the respective topic, see the section referred to in the text.

The following topics are included in this chapter:

Switching on the machine
Graphically testing the workpiece
Setting up tools

Workpiece setup

Machining the workpiece

@ The following topics are covered in the Conversational

Programming User's Manual:
®  Switching on the machine
B Programming the workpiece

34
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First steps | Switching on the machine

2.2 Switching on the machine

Acknowledging the power interruption and moving to
the reference points

ADANGER

Caution: Danger for the operator!

MODE: NOML

Machines and machine components always present mechanical a0
hazards. Electric, magnetic or electromagnetic fields are

particularly hazardous for persons with cardiac pacemakers or
implants. The hazard starts when the machine is powered up!

i
. D o 2
» Read and follow the machine manual w B—( |
» Read and follow the safety precautions and safety symbols el B [ i
> Use the safety devices " H . ‘ | | | H o
Eoz) e

@ Refer to your machine manual.

Switching on the machine and traversing the reference
points can vary depending on the machine tool.

» Switch on the power supply for control and machine

> The control starts the operating system. This process may
take several minutes.

> The control will then display the "Power interrupted" message
in the screen header.

» Press the CE key
> The control compiles the PLC program.
» Switch on the machine control voltage
@ > The control checks operation of the emergency

stop circuit and goes into Reference Run mode.

= Cross the reference point manually in the

Tl ; ) :
prescribed sequence: For each axis press the
START key. If you have absolute linear and angle
encoders on your machine there is no need for a
reference run

> The control is now ready for operation in the
Manual operation mode.

v

Further information on this topic

®  Approaching reference points
Further information: "Switch-on", Page 130

®  QOperating modes
Further information: "Programming", Page 52

HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018 35



2.3

Graphically testing the workpiece

Selecting the Test Run operating mode

You can test NC programs in the Test Run operating mode:

» Press the operating mode key

> The control switches to the Test Run operating
mode.

Further information on this topic

Operating modes of the control
Further information: "Modes of operation’, Page 52

Testing NC programs
Further information: "Test run", Page 194

Selecting the tool table

If

you have not yet activated a tool table in Test Run mode, then

you must carry out this step.

» Press the PGM MGT key
> The control opens the file manager.
SELECT » Press the SELECT TYPE soft key
TvPE > The control shows a soft-key menu for selection
of the file type to be displayed.
» Press the DEFAULT soft key
> The control shows all saved files in the right-hand
window.
» Move the cursor to the left onto the directories
» Move the cursor to the TNC:\table directory
» Move the cursor to the right onto the files
» Move the cursor onto the TOOL.T (active tool
table) file, confirm with the ENT key: TOOL.T is
assigned the status S and is therefore active for
Test Run
» Press the END key: Exit the file manager

Further information on this topic

3

Tool management

Further information: "Entering tool data into the table",
Page 103

Testing NC programs

Further information: "Test run", Page 194

6

First steps | Graphically testing the workpiece
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Selecting the NC program

> Press the PGM MGT key
> The control opens the file manager.
Lrst > Press the LAST FILES soft key
[555 > The control opens a pop-up window with the

most recently selected files.

» Use the arrow keys to select the NC program
that you want to test. Load with the ENT key

Selecting the screen layout and the view
» Press the Screen layout key

> The control displays all available alternatives in
the soft-key row.

PROGRAN » Press the PROGRAM + MACHINE soft key

-

MACHINE > In the left half of the screen the control shows
the NC program; in the right half it shows the
workpiece blank.

The control provides the following views:

Soft keys Function
vIEw Plan view
(=
vIEL Projection in three planes
OB
VIEW 3-D view
=

Further information on this topic

B Graphic functions

Further information: "Graphics *, Page 182
B Performing a test run

Further information: "Test run", Page 194
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Starting the test run

RESET
+
STRART

STOP

START

4
>
>

VvV V.V Vv

Press the RESET + START soft key
The control resets the previously active tool data

The control simulates the active NC program up
to a programmed interruption or to the program
end

While the simulation is running, you can use the
soft keys to change views

Press the STOP soft key

The control interrupts the test run

Press the START soft key

The control resumes the test run after a break

Further information on this topic
B Performing a test run

Further information: "Test run", Page 194
®  Graphic functions

Further information: "Graphics ", Page 182

B Adjusting the simulation speed
Further information: "Speed of the setting test runs’,

Page 187
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2.4 Setting up tools

Selecting the Manual operation mode

Tools are set up in the Manual operation mode: [@vanuar oporation
> Press the operating mode key
> The control switches to the Manual operation
\ +0.000
mode. +500..000

Further information on this topic
®m  Operating modes of the control

Further information: "Modes of operation”, Page 52 e m——r I el
100% S-OVR “ @I
100% F-OVR LIMIT 1
T i - I8 el o

Preparing and measuring tools

» Clamp the required tools in their tool holders

» When measuring with an external tool presetter: Measure the
tools, note down the length and radius, or transfer them directly
to the machine through a transfer program

» When measuring on the machine: Insert the tool

HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018 39



Editing the TOOL.T tool table

In the TOOL.T tool table (permanently stored under TNC:\table\),
you can save tool data such as length and radius, as well as further
tool-specific information that the control needs in order to execute
a wide variety of functions.

To enter tool data in the tool table TOOL.T, proceed as follows:

TOOL »
TABLE

Y >

EDIT >

OFF >

»

>

Display the tool table
The control shows the tool table.
Edit the tool table: Set the EDIT soft key to ON

With the upward or downward arrow keys you
can select the tool number that you want to edit

With the rightward or leftward arrow keys you
can select the tool data that you want to edit

To exit the tool table, press the END key

Further information on this topic
®m  QOperating modes of the control
Further information: "Modes of operation’, Page 52

= Working with the tool table
Further information: "Entering tool data into the table",

Page 103
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Editing the TOOL_PTCH pocket table

@ Refer to your machine manual.

The function of the pocket table depends on the
machine.

In the pocket table TOOL_PTCH (permanently saved under
TNC:\table\) you specify which tools your tool magazine contains.

To enter data in the pocket table TOOL_PTCH, proceed as follows:

TOOL
TABLE

g i

POCKET
TABLE

vV vV VvV VY VY

>

Display the tool table

The control shows the tool table.

Display the pocket table

The control shows the pocket table.

Edit the pocket table: Set the EDIT soft key to ON

With the upward or downward arrow keys you
can select the pocket number that you want to
edit

With the rightward or leftward arrow keys you
can select the data that you want to edit

To leave the pocket table, press the END key

Further information on this topic

m QOperating modes of the control

Further information: "Modes of operation’, Page 52
® Working with the pocket table

Further information: "Pocket table for tool changer”,

Page 110

Fncket table editing o] B)Programming | <
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2.5 Workpiece setup

Selecting the correct operating mode

Workpieces are set up in the Manual operation or Electronic
handwheel operating mode

> Press the operating mode key

> The control switches to the Manual operation
mode.

Further information on this topic

® The Manual operation operating mode
Further information: "Moving the machine axes", Page 134

Clamping the workpiece

Mount the workpiece with a fixture on the machine table so that it
is fixed with its edges parallel to the machine axes.
Further information on this topic
B Presetting with a 3-D touch probe
Further information: "Presetting with a 3-D touch probe (option
number 17)", Page 174

® Presetting without 3-D touch probe
Further information: "Presetting without a 3-D touch probe’,
Page 158

First steps | Workpiece setup
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Presetting with a 3-D touch probe
(option number 17)
» Insert a 3-D touch probe: In the Positioning w/ Manual Data

Input mode, run a TOOL CALL block containing the tool axis
and then return to the Manual operation mode

ToucH » Press the TOUCH PROBE soft key
i > The control displays the available functions in the
soft-key row.
ProsING_ » Select the function for setting a preset, e.g.
e press the PROBING POS soft key

> Use the axis direction keys to position the touch
probe near the first touch point on the first
workpiece edge

Select the probing direction via soft key
» Press the NC start key

> The touch probe moves in the defined direction
until it contacts the workpiece and then
automatically returns to its starting point.

> The control then displays the coordinates of the
measured position.

> The touch probe moves in the defined direction
until it contacts the workpiece and then
automatically returns to its starting point.

> The touch probe moves in the defined direction
until it contacts the workpiece and then
automatically returns to its starting point.

> The touch probe moves in the defined direction
until it contacts the workpiece and then
automatically returns to its starting point.

SET » Set to 0: Press the SET PRESET soft key

PRESET

SURCEREeSe » Press the END soft key to close the menu

» Repeat this procedure for all axes, in which you want to set a
preset

Further information on this topic

E Presetting
Further information: "Presetting with a 3-D touch probe (option
number 17)", Page 174
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2.6 Machining the workpiece

Selecting the Program run, single block or Program
run, full sequence operating mode

You can run NC programs either in the Program run, single block
or the Program run, full sequence operating mode:

> Press the operating mode key

> The control switches to the Program run, single
block operating mode and runs the NC program
block by block.

» You have to confirm each NC block with the
NC start key

J) » Press the Program run, full sequence key

> The control switches to the Program run,
full sequence operating mode and runs the
NC program after NC start up to a program
interruption or to the end of the program.

Further information on this topic

®m  Operating modes of the control
Further information: "Modes of operation’, Page 52

= Running NC programs
Further information: "Program run", Page 199

Selecting the NC program

> Press the PGM MGT key

> The control opens the file manager.
Lrst » Press the LAST FILES soft key
>

FILES
The control opens a pop-up window with the
most recently selected files.

» |f required, use the arrow keys to select the
NC program you want to run. Load with the ENT
key

Starting an NC program

> Press the NC start key

il
Ll > The control runs the active NC program.

Further information on this topic

® Running NC programs
Further information: "Program run", Page 199

First steps | Machining the workpiece
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3.1 TheTNC 128

The TNC 128 is a workshop-oriented straight-cut control that
enables you to program conventional machining operations right at
the machine in the easy-to-use Klartext conversational language.

It is designed for milling, drilling and boring machines with up to 3
axes. You can also change the angular position of the spindle under
program control.

Keyboard and screen layout are clearly arranged in such a way that
the functions are fast and easy to use.

HEIDENHAIN Klartext

HEIDENHAIN Klartext, the dialog-guided programming language
for workshops, is an especially easy method of writing programs.
Programming graphics illustrate the individual machining steps for
programming the contour. Workpiece machining can be graphically
simulated either during a test run or during a program run.

You can also enter and test one NC program while another
NC program is machining a workpiece.

Further information: User's Manuals for Conversational
Programming

Compatibility
NC programs created on the HEIDENHAIN TNC 124 straight-
cut control may not always run on the TNC 128. If the NC blocks

contain invalid elements, the control will mark these as ERROR
blocks or with error messages when the file is opened.

Fundamentals | The TNC 128
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Data security and data protection

The availability of data as well as their guaranteed confidentiality,
integrity, and authenticity are decisive for your company's
success. HEIDENHAIN therefore places the utmost importance
on the protection of relevant data against loss, manipulation, and
unauthorized publication.

To ensure that your data is protected actively on the control,
HEIDENHAIN offers integrated, state-of-the-art software solutions.

Your control supports the following software solutions:

m SELinux

Further information: "SELinux security software", Page 263
® Firewall

Further information: "Firewall", Page 273
= Sandbox

Further information: "Sandbox tab", Page 288

B |ntegrated browser
Further information: "Displaying Internet files", Page 76

B Management of external access
Further information: "Permitting or restricting external access',
Page 245

= Monitoring of TCP and UDP ports
Further information: "Portscan", Page 258

= Remote diagnosis
Further information: "Remote Service", Page 259

B User administration
Further information: "User administration”, Page 292

These solutions protect the control effectively, but cannot replace
company-specific IT security and an integrated overall strategy.

In addition to the solutions provided, HEIDENHAIN recommends
implementing a company-specific security strategy. This way you
ensure effective protection of your data and information, even after
they have been exported from the control.

To ensure data security also in the future, HEIDENHAIN
recommends informing yourself regularly about product updates
and updating the software to the current version.

ADANGER

Caution: Danger for the operator!

Manipulated data records or software can lead to an unexpected
behavior of the machine. Malicious software (viruses, Trojans,
malware, worms) can cause changes to data records and
software.

> Check any removable memory media for malicious software
before using them

> Start the internal web browser only from within the sandbox
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Virus scanners

HEIDENHAIN found that virus scanners can negatively affect the
behavior of the NC control.

Possible negative effects are feed rate drops or system crashes,

for example. Such negative effects are unacceptable in numerical
controls for machine tools. HEIDENHAIN therefore does not offer a
virus scanner for the control and does not recommend using a virus
scanner.

The control provides the following alternatives:
SELinux

Firewall

Sandbox

Locking from external access

= Monitoring of TCP and UDP ports

If properly configured, these options ensure extremely effective
protection for the data of the control.

If you insist on using a virus scanner, you must operate the control
in a protected network (with a gateway and a virus scanner). The
subsequent installation of a virus scanner is not possible.
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Fundamentals | Visual display unit and operating panel

3.2 Visual display unit and operating panel

Display screen

The control is shipped with a 12.71-inch screen. .
@ giman
1 Header 9 " B i1t
. . =~ ioaa
When the control is on, the screen displays the selected l 4 I B ST
operating modes in the header: The machine operating mode __x0.000 - };=:
at left and the programming mode at right. The currently | = - axma
active mode is displayed in the larger field of the header, 5
where the dialog prompts and messages also appear. -
2 Soft keys & i)
In the footer the control indicates additional functions in a 4r - wet) @ see ¢ ssee
soft-key row. You can select these functions by pressing the - e 8 Ree el
. . . . . V 2 %
(o BEEOOEEE
keys immediately belovy them. The thin bars immediately ), R .‘
above the soft-key row indicate the number of soft-key rows . C\ A lealialmm] - 1 (Al )

that can be called with the keys to the right and left that are ®
used to switch the soft keys. The bar representing the active
soft-key row is blue

Soft-key selection keys
Keys for switching the soft keys
Setting the screen layout

Key for switchover between machine operating modes,
programming modes, and a third desktop

Soft-key selection keys for machine tool builders
Keys for switching the soft keys for machine tool builders

o 0~ W

0 N

9 USB connection

Setting the screen layout

You select the screen layout yourself. In the Programming
operating mode, for example, you can have the control show the
NC program blocks in the left window while the right window
displays programming graphics. You could also display the
program structure in the right window instead, or display only
the NC program blocks in one large window. The available screen
windows depend on the selected operating mode.

Setting the screen layout:

@ > Press the screen layout key: The soft-key row
shows the available layout options
Further information: "Modes of operation’,
Page 52

PROGRAN > Select the desired screen layout with a soft key

-
GRAPHICS
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Fundamentals | Visual display unit and operating panel

Control panel
The TNC 128 is delivered with an integrated operating panel. ° °

1 Machine operating panel
More information: Machine manual '
File management
Calculator
MOD function
HELP function o Lol bed

™| [ B By By N p
Show error messages 4 J 3 [ 2

2

L L TR —rTT
o xpm)
| ox v a2

[ | u [ | [ | u [ |
e [l

Toggle between the operating modes

3 Programming modes
4 Machine operating modes
5 Initiating programming dialogs “
6 Navigation keys and GOTO jump command
7 Numerical input, axis selection and programming of position-
ing blocks
The functions of the individual keys are described on the inside
front cover.
@ Refer to your machine manual.
Some machine tool builders do not use the standard
HEIDENHAIN operating panel.
External keys, e.g. NC START or NC STOP, are described
in your machine manual.
Screen keypad
You can enter letters and special characters with the screen keypad EJvenie spesation | B@zo07amins T
or (if available) with an alphabetic keyboard connected to the USB sac -
port. e e |
e iy} IR 1} 7+ 1 ]
= EEE e
File name 4 i . a-03-201 1
= HEE I
e —
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Entering text with the screen keypad
Proceed as follows to use the screen keypad:
» Press the GOTO key if you want to enter letters,

€.g. a program name or directory name, using
the screen keypad.

> The control opens a window in which the
numeric keypad of the control is displayed with
the corresponding letters assigned.
n » Press the numerical key until the cursor is on the
desired letter
» Wait until the control transfers the selected
character before you enter the next character

» Use the OK soft key to load the text into the
open dialog field

Ok

Use the abc/ABC soft key to select upper or lower case. If your
machine manufacturer has defined additional special characters,
you can call them with the SPECIAL CHARACTERS soft key and
insert them. Use the BACKSPACE soft key to delete individual
characters.
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3.3 Modes of operation

Manual Operation and El. Handwheel

The Manual operation mode is required for setting up the machine
tool. In this mode of operation, you can position the machine axes
manually or by increments and set the presets.

The Electronic handwheel operating mode supports manual
traverse of machine axes with the HR electronic handwheel.

Soft keys for the screen layout (select as described above)

Soft key Window
Positions
POSITION
POSITION Left: positions, right: status display
5TF|+TLI5
POSITION Left: positions, right: workpiece
UORK;IECE

Positioning with Manual Data Input

This mode of operation is used for programming simple traversing
movements, such as for face milling or pre-positioning.

Soft keys for selecting the screen layout

Soft key Window
NC program
PROGRAN Left: NC program, right: status display
PROGRAN Left: NC program, right: workpiece
Programming

In this mode of operation you create NC programs. The various
cycles and the Q parameter functions help you with programming
and add necessary information. If desired, you can have the
programming graphics show the programmed paths of traverse.

Soft keys for selecting the screen layout

Fundamentals | Modes of operation

[@vanual operation [w_umi:;;smgﬁﬁfnh -
E <vﬂ)j
r
|
Position isplay NODE: NOUL cverview [PGR LA OYC A P05, TO0L 7Y TAANS GPARA -
[ ™
+0. 00¢ 3 =]
Y +0.000 z [
oLTA eo.000 oR-TAD 40,0000 e
obn re.00 oR-pn 0.0000 = 4
e s
» () |
s
@ T B o
s 0 F_Omm/min P G
e active ron L.\ Toha
100% S-OVR
- | iii ON
100% F-OVR  LIMIT 1 =
w TOUCH |  PRESET It TooL
M H s | F | reoee | wanaceuent | h ThBLe
dz | & TeW
Fns)tmning w/ Manual Data Input Waﬁﬂﬁﬁﬁh A%
i St
overvier| RO L6L EYC M POS TobL TY TRAYS PARA
EYTn w EY [u
v vew \ %
1 T00L GALL 7 Z 52300 . )
2 xeis0 Ao rwr wa Thoe wwece
5 o pon swox me . <0.0000 " <0.0000 s [
oims ve0me ontan 0.0 -
oLpa  vo.008 oRpt 0.0080
;‘ T
. e
» @ =l 4
p— Active #ot: THG:\nc_sroghSedi.h o
[x ] 0 |@® ¥
_ on
+0.000
+500.000 | PP @
fiode: oML %o o B I~
F_Omm/min Ovz 100% M 519 =
= —_—
contoun [ PRoGRAM- |
PROGAAM PROGRAN |
| | <romr | [ | | wme | Eno
DEFAULTS || uagumninG FUNGTIONS e
[[BJvanual operation JaPrcgramlng = A
: - 5L
ING: \ne_prog._T-Walteplatte holdex_plate.n
1
v
1
e e e
START neser
o | st | smee | .
H START

Soft key Window
NC program
PROGRAM Left: NC program, right: program structure
SE;TS
PROGRAN Left: NC program, right: programming graphics
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Test Run

In the Test Run operating mode, the control checks NC

programs and program sections for errors, such as geometrical
incompatibilities, missing or incorrect data within the NC program
or violations of the working space. This simulation is supported
graphically in different display modes.

Soft keys for selecting the screen layout

Soft key Window
i NC program
PRoGRAN Left: NC program, right: status display
ProvRan Left: NC program, right: workpiece
o Workpiece

Program Run, Full Sequence and Program Run, Single
Block

In the Program Run Full Sequence operating mode, the control
runs an NC program continuously to its end or to a manual

or programmed stop. You can resume program run after an
interruption.

In the Program Run Single Block operating mode, you execute
each NC block separately by pressing the NC start key. With point
pattern cycles and CYCL CALL PAT, the control stops after each
point.

Soft keys for selecting the screen layout

Soft key Window
- NC program
PRoGRAn Left: NC program, right: structure
PRoGR Left: NC program, right: status display
PRocsn Left: NC program, right: workpiece
o Workpiece

0 B rest Run

5 GYGL DEF 263 SLOT
Q215240 MAGH]
az18sv30
a218-+10
0201210
Qs7aser
a367-+0
az0ze+5
207241000 :Fi
az08=+1
385242000 | FINISHING
338240
az200-+2
0203240
2045450
assie+t
a3s2::0

PLHGNG
0 AATE

Xe0 RO FUAX NED
) 2600 00:09:57 [T —
e —
(®)
©

G START RESET
START SINGLE

OPTIONS

START

Frog!am run, full sequence
™

™
BLK FORM 0.1 Z X-80 Y-30 2-20
BLK FORM 0.2 X+50 Y50 240
TOOL CALL "MILL_DS_ROUGH" 2 85000
s ows

5 CYCL DEF 253 SLOT MILLING
216540 MAGHINING

C |

OPERATION

Q218430 (8 STH

a219++10 H

a201=-10

ad7asr1 o1AEGTION

036740 1SLOT POST 3
o ron i sioos [
x T 0 oo} = 5

BEE]  on

+0.000 | —
+500.000! &

01 NOWL o To Bso BEl on
. S

sLock scan || T00L

TABLE

o
omm/min ovx 1008 u 89

BEGIN H Eno ‘ PAGE ‘ PAGE

t

Yiu
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3.4 Status displays

General status display

The general status display in the lower part of the screen informs
you of the current state of the machine.

It is displayed automatically in the following operating modes:

® Program run, single block

® Program run, full sequence

B Positioning w/ Manual Data Input

o If the GRAPHICS screen layout is selected the status
display is not shown.

In the Manual operation and Electronic handwheel operating
modes, the status display appears in the large window.

Information in the status display
Icon Meaning

ACTL Position display mode, e.g. actual or nominal

Machine axes; the control displays auxiliary axes
in lowercase letters. The sequence and quantity
of displayed axes is determined by the machine
tool builder. Refer to your machine manual for
more information

coordinates of the current position
Y|Z

FSM The displayed feed rate in inches corresponds to
one tenth of the effective value. Spindle speed S,
feed rate F and active M functions

+ Axis is clamped

@ Axis can be moved with the handwheel

Axes are mirrored and moved

No NC program selected, NC program reselect-
i ed, NC program aborted via internal stop, or
NC program terminated

In this condition the control has no modally effec-
tive program information (i.e. the contextual
reference), so that all handling is possible, e.g.
cursor movements or modification of Q parame-
ters.

NC program started, execution runs

=

For safety reasons, the control permits no
handling in this condition

Fundamentals | Status displays

Bdrrogram run, full sequence onc BYProgramming A
; w
THG: \nc_prog\BHE_ML11)\Klaztext\i13_128.h Ovarview PGH LOL CYC W POS TOOL TT TRANS OPARA
EXTERTTNS u
= | g
s
-
Ll
T
e
=Ag |
i g
stovs |
© 0 s L
— S OFE]  ov
Y -39.000
2 | -5.000 ‘ ;.L“nnﬁ @
do: no @ i B B o
r—tr o 1 -
s | se | oo [ svarws o T
oveRvIEw pos sTATUS 0 PaRAM, |
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Icon Meaning

NC program stopped, e.g. in Program run, full
sequence operating mode after pressing the
NC stop key

For safety reasons, the control permits no
handling in this condition

o

NC program interrupted, e.g. in Positioning w/
Manual Data Input operating mode, following
the errorfree execution of an NC block

In this condition the control permits various
handling, e.g. cursor movements or the modifi-
cation of Q parameters. With this handling the
control may lose the modally effective program
information (i.e. the contextual reference). Loss
of this contextual reference may cause undesired
tool positions!

Further information: "Positioning w/ Manual
Data Input operating mode", Page 219 and
"Program-controlled interruptions”, Page 205

NC program aborted or terminated

Pulsing spindle speed function is active

The order of icons can be changed with the optional
machine parameter iconPrioList (no. 100813). Only the
icon for control-in-operation (STIB) is always visible and
cannot be configured.

X
S %
AVAY
i

Additional status displays

The additional status displays contain detailed information on the
program run. They can be called in all operating modes. Exception:
the Programming operating mode. In the Test Run operating
mode, only a limited status display is available.

To switch on the additional status display

» Call the soft key row for screen layout
PROGRAM » Select the layout option for the additional status
STI:TLIS dISplay

> In the right half of the screen, the control shows
the Overview status form.
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To select an additional status display

@ » Toggle through the soft key rows until the
STATUS soft keys appear

T » Either select the additional status display directly

Pos. with the soft key, e.g. positions and coordinates;
or

= > use the switch-over soft keys to select the

desired view

Select the status displays described below as follows:
m directly with the corresponding soft key

B via the switchover soft keys

B or by using the next tab key

@ Please note that some of the status information
described below is not available unless the associated
software option is enabled on your control.

Overview

The Overview status form is displayed by the control following
switch-on if you selected the screen layout PROGRAM + STATUS (or
POSITION + STATUS). The overview form contains a summary of
the most important status information, which you can also find on
the various detail forms.

Soft key Meaning
sTATUS Position display

Tool information

Active M functions

Active coordinate transformations

Active subprogram

Active program section repeat

NC program called with PGM CALL

Current machining time

Name and path of the active main program

General program information (PGM tab)

Soft key Meaning

No direct Name and path of the active main program
selection

possible

Actual/nominal value counter

Dwell time counter

Current machining time

Called NC programs

Fundamentals | Status displays

EJrrogram run, full sequence ove B Programming
TNG: \nc_prog\BMB_ML11\Klartext\113_128.n | dverview, PGH LDL CYE H P05 TOOL TF TRAHS d0ARA
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asississ " 2
S 7 s | d
asszeio  n T4 muon v B
V50 R0 Pn g <an.o000 " wa.000 CONE|
b G50 RYEHAX DL PG 0. 0000 DR-PGH. +0.0000 L
s xe0 Ao FuAx wes
100374 = 0 (EN— o =
a0 R0 A o 4.0
N e 3 ~ ey
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X430 RO FUAX W09 S—
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Lol pem CALL @) oa:08:06
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s ¥e30 RO FuAX ron 2. |
N X+0 RO FMAX NSS s =
10 as7s « 0 o :
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Program section repeats and subprograms (LBL tab)

Soft key Meaning

No direct
selection
possible

Active program section repeats with block
number, label number, and number of
programmed repeats/repeats yet to be run

Active subprograms with block number in which
the subprogram was called and the label number
that was called

Information on standard cycles (CYC tab)

Soft key Meaning

No direct
selection
possible

Active fixed cycle

Active miscellaneous functions M (M tab)

Soft key Meaning

No direct
selection
possible

List of the active M functions with fixed meaning

List of the active M functions that are adapted by
your machine manufacturer

Positions and coordinates (POS tab)

Soft key Meaning

T Type of position display, e.g. actual position

POS.

BPrngxaln run, full sequence

TNG: \ne_prog\BHB_ML11\Klartext\113_128.h

2113 128.0

02042450 :2ND SET-UP GLEARANGE
assie GLIMB O UP-GUT
Q382=40  PLUNGE POSITION

v-30 RO_FMAX

Y430 RO FMAX
X+0 AD FMAX N9S

Ovarview PGH LBL [CYC  PUS TOOL TT TRANS OPARA
Gl sprogramt
Bl no.  LBL no./Mane

Rapetitions
Bl no. LB na./Mame ree

V'] -39.000/
-5.000

Mode: NOML o T B s s000
@ omm/min lovr 100% ulis

sTATUS STATUS TooL STATUS OF

oveRVIEW PoS STATUS o PARAM.

BPrngxaln run, full sequence

TNC: \nc_pcog\BHB ML11\Klastext\113_128.h
2118 1280

5

q

1
12
13
14

02042450
assie
a3sz=+0

ZND SET.UP GLEARANGE
GLIMB O UP-GUT
iPLUNGE POSITION
v-30 RO_FMAX

Y430 RO FMAX
X+0 AD FMAX N9S

s
10 0374 = 0

Y40 RO FMAX
X-30 RO FMAX M3
Y40 RO FMAX

X+30 RO FMAX M35

15 CALL LBL "safa"

Ovarvies PG LBL CYC W $OS TOOL TF TRANS 0PARA
o] 253 morensmaesen

R e

V'] -39.000/
-5.000

oge: NouL @0 T B's 5000
@ ormumin oz 1008 u Bro

STATUS STATUS TooL STATUS OF =

ovenview ros sTATUS a PARAM B

BPrngxaln run, full sequence

TNC: \nc_pcog\BHB ML11\Klastext\113_128.h

5

q

2118 1280
02042450 (2ND SET-UP CLEARANGE
ass1ae GLIMB OR UP-CUT
asszaro PLUNGE POSITION

v-30 RO_FMAX

Y430 RO FMAX
X+0 AD FMAX N9S

s
10 0374 = 0

Ovarview PCH LBL CYC W POS TOOL TT TRANS QPARA

oo
1 veo R Puax
12 x-30 Ro FuAX Mes .
13 Y40 RO FMAX "6
14 X+30 RO FMAX M3 "
15 oAl oL “eater A
.
R
(] +0.000
V] -39.000|
-5.000
Woge: NoUL %o e B so0
@ omimin ove 1008 ullis
STATUS. STATUS. TooL. STATUS OF =
ovemzen | ros i s =

[EPxngxam run, full sequence

THG: \nc_pcog\BHB ML11\KlactextVi13 128.n |

2118 1280
02042450 (2ND SET-UP CLEARANGE
ass1ae GLIMB OR UP-CUT
asszaro PLUNGE FOSITION

Y-30 RO FMAX

Y430 RO FMAX
X+0 AD FMAX N9S

15 CALL LBL "safe"

Ovarview PCH LBL CYC W Pos TOOL TT TRANS QPARA
S| mewow x sa.een
39,000

7 -asseen

Basic transformations
X +0.0000
Y s0.0000
z e0.0000

R e

v | -39.000
-5.000

Mode: NOWL @o T B s soo0
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STATUS. STATUS. TooL STATUS OF

OVERVIEW pos STATUS Q PARAM.
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Information on tools (TOOL tab)

Soft key Meaning

0oL Display of active tool:
STATLS = T: Tool number and tool name
® RT. Number and name of a replacement tool

Tool axis

Tool length and tool radii

Oversizes (delta values) from the tool table (TAB)
and the TOOL CALL (PGM)

Tool life, maximum tool life (TIME 1) and
maximum tool life for TOOL CALL (TIME 2)

Display of programmed tool and replacement
tool

Tool measurement (TT tab)

The control displays this tab only if the function is active
on your machine.

®

Soft key Meaning
No direct Active tool
selection

possible

Measured values from tool measurement

Coordinate transformations (TRANS tab)

Soft key Meaning

No direct Name of the active datum table
selection

possible

Active datum number (#), comment from the
active line of the active datum number (DOC)
from Cycle 7

Active datum shift (Cycle 7); the control displays
an active datum shift in up to 3 (b) axes

Mirrored axes (Cycle 8)

Active scaling factor/factors (Cycle 11 / 26); the
control displays an active scaling factor in up to 6
axes

Scaling datum

Further information: Conversational Programming User's Manual
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EXTERETN
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Displaying Q parameters (QPARA tab)

Soft key

STATUS OF
Q PARAM.

Meaning

Display the current values of the defined
Q parameters

Display the character strings of the defined string
parameters

Press the Q PARAMETER LIST soft key. The control
opens a pop-up window. For each parameter type (Q,
QL, QR, QS), define the parameter numbers you wish to
check. Separate single Q parameters with a comma, and
connect sequential Q parameters with a hyphen, e.g.
1,3,200-208. The input range per parameter type is 132
characters.

The display in the QPARA tab always contains eight
decimal places. The result of Q1 = COS 89.999 is
shown by the control as 0.00001745, for example.
Very large and very small values are displayed by
the control in exponential notation. The result of

Q1 = COS 89.999 * 0.001 is shown by the control as
+1.74532925e-08, whereby e-08 corresponds to the
factor of 108,

Prngzam run, full sequence

o @Programming

nnnnnn
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3.5 File management

Files

Files in the control Type
NC programs

in HEIDENHAIN format H
Tables for

Tools T
Tool changers .TCH
Datums .D
Points PNT
Presets PR
Touch probes TP
Backup files .BAK
Dependent data (e.g. structure items) .DEP
Freely definable tables .TAB
Texts as

ASCII files A
Text files TIXT
HTML files, e.qg. result logs of touch probe HTML
cycles

Help files .CHM

When you write an NC program on the control, you must first enter
a program name. The control saves the NC program to the internal
memory as a file with the same name. The control can also save
texts and tables as files.

The control provides a special file management window in which
you can easily find and manage your files. Here you can call, copy,
rename and erase files.

With the control, you can manage and save files up to a total size
of 2 GB.

o Depending on the setting, the control generates backup
files with the extension *.bak after editing and saving of
NC programs. This reduces the available memory space.

Fundamentals | File management
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File names

When you store NC programs, tables and texts as files, the control
adds an extension to the file name, separated by a point. This
extension indicates the file type.

File name File type

PROG20 H

File names, drive names and directory names on the control

must comply with the following standard: The Open Group Base
Specifications Issue 6 IEEE Std 1003.1, 2004 Edition (POSIX
Standard).

The following characters are permitted:
ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefg
hijklmnopgrstuvwxyz0123456789_-

The following characters have special meanings:

Character Meaning

The last period (dot) in a file name is the
extension separator

\and/ Directory separators

Separates the drive name from the directory

Do not use any other characters. This helps to prevent file transfer
problems, etc. Table names must start with a letter.

o The maximum permitted path length is 255 characters.
The path length consists of the drive characters,
the directory name and the file name, including the
extension.

Further information: "Paths", Page 62
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Displaying externally generated files on the control

The control features several additional tools which you can use to
display the files shown in the table below. Some of the files can
also be edited.

File types Type
PDF files pdf
Excel tables xIs
csv
Internet files html
Text files txt
ini
Graphics files bmp
gif
jpg
png

Further information: "Additional tools for management of external
file types", Page 73

Directories

To ensure that you can easily find your NC programs and files, we
recommend that you organize your internal memory into directories
(folders). You can divide a directory into further directories, which
are called subdirectories. With the -/+ key or ENT you can show or
hide the subdirectories.

Paths

A path indicates the drive and all directories and subdirectories
under which a file is saved. The individual names are separated by a
backslash \.

o The maximum permitted path length is 255 characters.
The path length consists of the drive characters,
the directory name and the file name, including the
extension.

Example EH=]TNC:\

The directory AUFTR1 was created on the TNC drive. Then, in the
AUFTR1 directory, the directory NCPROG was created and the AUFTR1
NC program PROQ.H was copied into it. The NC program now has I:l NCPROG
the following path:

TNC:\AUFTR1\NCPROG\PROG1.H 1 wzTaB

The chart at right illustrates an example of a directory display with
different paths.

KAR25T
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Calling the file manager

PGM
MGT

> Press the PGM MGT key

> The control displays the file management
window (see figure for default setting. If the
control displays a different screen layout, press
the WINDOW soft key).

The narrow window on the left shows the available drives and
directories. Drives designate devices with which data are stored
or transferred. A drive is the internal memory of the control.
Other drives are the interfaces (RS232, Ethernet) to which you
can connect a PC for example. A directory is always identified by
a folder symbol to the left and the directory name to the right.
Subdirectories are shown to the right of and below their parent
directories. If there are subdirectories, you can show or hide them
using the -/+ key.

If the directory tree is longer than the screen, navigate using the
scroll bar or a connected mouse.

The wide window on the right shows you all files that are stored
in the selected directory. Each file is shown with additional
information, illustrated in the table below.

Display Meaning

File name File name and file type

Bytes File size in bytes

Status File properties:

E File is selected in the Programming operat-
ing mode

S File is selected in the Test Run operating
mode

M The file is selected in a Program Run
operating mode

+ File has non-displayed dependent files with

the extension DEP e.g. with use of the tool
usage test

File is protected against erasing and editing

File is protected against erasing and
editing, because it is being run

Date

Date that the file was last edited

Time

Time that the file was last edited

To display the dependent files, set the machine
parameter dependentFiles (no. 122101) to MANUAL.

PAGE

Mamlal operation 1@!{

PAGE

Togramming
Programmin 9

12 file(s) 19.32 68

SELECT
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Additional functions

Protecting a file and canceling file protection
» Place the cursor on the file you want to protect

MORE
FUNCTIONS

PROTECT

B

UNPROTECT

iaf”

» Select the additional functions:
Press the MORE FUNCTIONS soft key

» Activate file protection:
Press the PROTECT soft key

> The file is tagged with the "protected" symbol.

» Cancel file protection:
Press the UNPROTECT soft key

Selecting the editor
» Place the cursor on the file you want to open

MORE
FUNCTIONS

SELECT
EDITOR

» Select the additional functions:
Press the MORE FUNCTIONS soft key

» Select the editor:
Press the SELECT EDITOR soft key

» Mark the desired editor

TEXT EDITOR for text files, e.g. .A or .TXT
PROGRAM EDITOR for NC programs .H and .l
TABLE EDITOR for tables, e.g. .TAB or .T
BPM EDITOR for pallet tables .P

» Press the OK soft key

Connecting and removing USB storage devices

The control automatically detects connected USB devices with a
supported file system.

To remove a USB device, proceed as follows:

MORE
FUNCTIONS

r

» Move the cursor to the left-hand window
» Press the MORE FUNCTIONS soft key
» Remove the USB device

Further information: "USB devices on the control", Page 68
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Selecting drives, directories and files
» To call the file manager, press the PGM MGT key.

Navigate with a connected mouse or use the arrow keys or the soft
keys to move the cursor to the desired position on the screen:

» Moves the cursor from the left to the right
window, and vice versa

» Moves the cursor up and down within a window
PRGE » Moves the cursor one page up or down within a
window

PAGE

Step 1: Select drive

» Move the highlight to the desired drive in the left window

SELECT » Select a drive: Press the SELECT soft key, or
CT
enT > Press the ENT key
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Step 2: Select a directory

» Move the highlight to the desired directory in the left-hand
window—the right-hand window automatically shows all files
stored in the highlighted directory

Step 3: Select a file

SELECT

TYPE

SHOUW

=

SHOW ALL

[

DISPLAY
FILTER

SELECT

ENT

» Press the SELECT TYPE soft key

» Press the soft key for the desired file type, or

» Display all files: Press the SHOW ALL soft key, or

» Use wildcards, e.g. 4*.h: Show all files of type .h
starting with a 4

» Move the highlight to the desired file in the right window

» Press the SELECT soft key, or

» Press the ENT key

> The control opens the selected file in the
operating mode from which you called the file
manager.

If you enter the first letter of the file you are looking for
in the file manager, the cursor automatically jJumps to
the first NC program with the same letter.

66
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Choosing one of the last files selected

» To call the file manager, press the PGM MGT key.
Last » Display the last ten files selected: Press the

FILES

LAST FILES soft key

Press the arrow keys to move the cursor to the file you wish to
select:

» Moves the cursor up and down within a window

OK

» Select the file: Press the OK soft key, or

EnT > Press the ENT key

Manua!. operation rPlogramlng !’f, Sl’“

TEPEYY
5 01:47:42
5 0858012
5 01:47:42
5 01:47:42

oK DELETE CANCEL

CopY.
ok | oLeTE CANCEL | FiE0 |

0 The COPY FIELD soft key allows you to copy the path of
a marked file. You can reuse the copied path later, e.g.
when calling a program with the PGM CALL key.
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USB devices on the control

o Use the USB port only for file transfer and backup.
Before editing or running an NC program, save it to the
hard disk of the control. This helps to avoid duplicate
data maintenance and prevents potential problems
resulting from data transfer during program run.

Backing up data from or loading onto the control is especially easy
with USB devices. The control supports the following USB block
devices:

= Floppy disk drives with FAT/VFAT file system

® Memory sticks with the FAT/VFAT or exFAT file system

= Hard disks with the FAT/VFAT file system

= CD-ROM drives with the Joliet (ISO 9660) file system

The control automatically detects these types of USB devices
when connected. The control does not support USB devices with
other file systems (such as NTFS). The control displays the USB:
TNC does not support device error message when such a device
is connected.

0 If an error message is displayed when connecting a USB
data medium, check the setting in the SELinux security
software.

Further information: "SELinux security software",
Page 263

If the control displays the USB: TNC does not support
device error message when using a USB hub, ignore
and acknowledge the message with the CE key.

If the control repeatedly fails to correctly detect a USB
device with the FAT/VFAT or exFAT file system, connect
another device to check the port. If this resolves the
problem, use the properly working device.

Working with USB devices

@ Refer to your machine manual.

Your machine tool builder can assign permanent names
for USB devices.

The USB devices appear as separate drives in the directory tree, so
you can use the file management functions described in the earlier
chapters.

If a larger file is transferred to a USB device in the file manager,
the control displays a dialog Write access on USB device until
file transfer is completed. The dialog is closed with the HIDE soft
key and file transfer is continued in the background. The control
displays a warning until file transfer is completed.

68 HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018



Fundamentals | File management

Removing USB devices
» To remove a USB device, proceed as follows:

HoRE » Move the cursor to the left-hand window
FLNCTEONS » Press the MORE FUNCTIONS soft key

7

» Remove the USB device

Data transfer to or from an external data carrier

o Before you can transfer data to an external data o = {“
medium, you must set up the data interface. Co 3 BB VR3804V LT O 87 Gl
Further information: "Setting up data interfaces",
Page 276
» Press the PGM MGT key
WINDOW > Press the WINDOW soft key to select the screen
layout for file transfer SRR
» Use the arrow keys to move the cursor to the file
you want to transfer
> The control moves the cursor up and down

within a window.

> The control moves the cursor from the right to
the left window, and vice versa.

If you wish to copy from the control to the external data medium,
move the cursor in the left window to the file to be transferred.

If you wish to copy from the external data medium to the control,
move the cursor in the right window to the file to be transferred.

T » Press the SHOW TREE soft key to select another
TREE drive or directory
» Use the arrow keys to select the desired
directory
o » Press the SHOW FILES soft key
TIES Use the arrow keys to select the desired file
Cory > Press the COPY soft key
oo
ENT » Confirm with the ENT key

> A status window appears on the control,
informing about the copying progress.

WINDOU » Alternative: Press the WINDOW soft key

> The control displays the standard file manager
window again.
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Preventing incomplete NC programs

The control checks all NC programs for completeness before
machining. The control displays a warning if the END PGM NC block
is missing.

When you start the incomplete NC program in Program run, single
block or Program run, full sequence operating mode, the control
aborts with an error message.

Proceed as follows to edit the NC program:
» Select the NC program in Programming operating mode

> The control opens the NC program and automatically adds the
END PGM NC block.

» Check the NC program, and complete it if necessary
sAvE > Press the SAVE AS soft key

i > The control saves the NC program with the END
PGM NC block that has been added.

The control in a network

o Protect your data and your control by running your o [
machines in a secure network. i

o Use the Ethernet card to connect the control to the
network.

Further information: "Ethernet interface ", Page 282 = = = =

The control logs any error messages that occur during
network operation.

If the control is connected to a network, the left directory window % e i i
displays additional drives. All the functions described above
(selecting a drive, copying files, etc.) also apply to network drives,
provided that you have been granted the corresponding rights.

o The control can also run NC programs directly from a
network drive. The external drive does not provide write
protection, however. This may lead to problems caused
by data transfer or by a change to the NC program
during machining.
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Connecting and disconnecting a network drive
> Press the PGM MGT key

v

Press the NET soft key

NET

v

Press the DEFINE NETWORK CONNECTN. soft
key.

> |In a window the control shows the network
drives available for access.

» Use the soft keys described below to define the

connections for each drive

Soft key Function

Connect Establish the network connection. If the connec-
tion is active, the control marks the Mount
column.

Separate End network connection

Auto Automatically establish network connection
whenever the control is switched on. The control
marks the Auto column if the connection is
established automatically

Add Set up new network connection

Remove Delete existing network connection

Copy Copy network connection

Edit Edit network connection

Clear Delete the status window

HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018

71




Data backup

HEIDENHAIN recommends backing up new NC programs and files
created on the control to a PC at regular intervals.

The free-of-charge TNCremo software from HEIDENHAIN is a
simple and convenient method for backing up data stored on the
control.

You can also backup files directly from the control.
Further information: "Backup and restore", Page 270

You additionally need a data medium on which all machine-
specific data, such as the PLC program, machine parameters,
etc., are stored. Ask your machine manufacturer for assistance, if
necessary.

o Take the time occasionally to delete any unneeded files
so that the control always has enough hard-disk space
for system files (such as the tool table).

Importing a file from an iTNC 530

@ Refer to your machine manual.
The machine tool builder can adapt the
ADAPT NC PGM / TABLE function.

The machine tool builder can define update rules that
make it possible, for example, to automatically remove
umlauts from tables and NC programs.

If you export a file from an iTNC 530 and import it into a TNC 128,

depending on the file type you have to adapt its format and content

before you can use the file.

The machine tool builder defines which file types you will be able
to import when using the ADAPT NC PGM / TABLE function. The
control converts the contents of the imported file to a format valid
for the TNC 128 and saves the changes to the selected file.

Further information: "Importing tool tables", Page 108

Fundamentals | File management
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Additional tools for management of external file types

The additional tools enable you to display or edit various externally
created file types on the control.

File types Description
PDF files (pdf) Page 74
Excel spreadsheets (xlIs, csv) Page 75
Internet files (htm, html) Page 76
ZIP archives (zip) Page 78
Text files (ASCII files, e.g. txt, ini) Page 79
Video files (ogg, oga, ogv, ogx) Page 80
Graphic files (bmp, gif, jpg, png) Page 80

o Files with the extensions pdf, xls, zip, bmp, gif, jpg and
png must be transmitted in binary format from the PC to
the control. Adjust the setting in the TNCremo software,
if required (menu item >Extras > Configuration >
Mode).
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Displaying PDF files

To open PDF files directly on the control, proceed as follows:
: B e el ool g AR s
» Call the file manager: Press the PGM MGT key i
Convenient Machining
Select the dIreCtOI’y |n WhICh the PDF flle |S —The HR 520 Handwheel Increases Operator Comfort

saved I 9
» Move the cursor to the PDF file =
Press the ENT key

> The control opens the PDF file in its own
application using the PDF viewer additional tool.

v

0 With the key combination ALT+TAB, you can always
return to the control's user interface while leaving
the PDF file open. Alternatively, you can also click the
corresponding icon in the task bar to switch back to the
user interface of the control.

o If you position the mouse pointer over a button, a brief
tool tip explaining the function of this button will be
displayed. More information on how to use the PDF
viewer is provided in Help.

Proceed as follows to exit the PDF viewer:

» Use the mouse to select the File menu item
> Select Close

> The control returns to the file manager.

If you are not using a mouse, proceed as follows to close the PDF
viewer:

> » Press the key for switching the soft keys
> The PDF viewer opens the File pull-down menu.
Move the cursor to the Close menu item

H
v

» Press the ENT key
> The control returns to the file manager.
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Displaying and editing Excel files
Proceed as follows to open and edit Excel files with the extension
xls, xlsx or csv directly on the control:

» Call the file manager: Press the PGM MGT key
Select the directory in which the Excel file is
saved

Move the cursor to the Excel file
ENT Press the ENT key

> The control opens the Excel file in its own
application using the Gnumeric additional tool.

v

o With the key combination ALT+TAB, you can always
return to the control's user interface while leaving the
Excel file open. Alternatively, you can also click the
corresponding icon in the task bar to switch back to the
user interface of the control.

o If you position the mouse pointer over a button, a brief
tool tip explaining the function of this button will be
displayed. More information on how to use Gnumeric is
provided in Help.

Proceed as follows to exit Gnumeric:

» Use the mouse to select the File menu item
» Select Close

> The control returns to the file manager.

If you are not using a mouse, proceed as follows to close the
additional Gnumeric tool:

@ » Press the key for switching the soft keys
> The Gnumeric additional tool opens the File pull-
down menu.
» Move the cursor to the Close menu item
Nt » Press the ENT key

> The control returns to the file manager.
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Displaying Internet files

o The network must ensure protection against viruses and
malicious software. The same applies to access to the
Internet or other networks.

The protective measures for this network are the
responsibility of the machine tool builder and the
respective network administrator, for example through a
firewall.

o Configure and use the sandbox on your control. For
safety and security reasons, always open the browser in
the sandbox. =

Further information: "Sandbox tab", Page 288

Proceed as follows to open Internet files with the extension htm
or html directly on the control:

W » Call the file manager: Press the PGM MGT key
> Select the directory in which the Internet file is
saved
» Move the cursor to the Internet file
ENT » Press the ENT key

> The control opens the Internet file in its own
application using the Web Browser additional
tool.

o With the key combination ALT+TAB, you can always
return to the control's user interface while leaving
the browser open. Alternatively, you can also click the
corresponding icon in the task bar to switch back to the
user interface of the control.

o If you position the mouse pointer over a button, a
brief tool tip explaining the function of this button will
be displayed. More information on how to use Web
Browser is available in Help.

When you start the web browser, it checks at regular intervals
whether updates are available.

You can update the web browser only if you deactivate the SELinux
security software during this time and you are connected to the
Internet.

o Reactivate SELinux after running the update.
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Proceed as follows to close the web browser:
» Use the mouse to select the File menu item
» Select Quit

> The control returns to the file manager.

If you are not using a mouse, proceed as follows to close the
web browser:

@ > Press the key for switching the soft keys: The
web browser opens the File pull-down menu

» Move the cursor to the Quit menu item

» Press the ENT key
> The control returns to the file manager.
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Working with ZIP archives
Proceed as follows to open ZIP archives with the extension zip

S e+2d4 533 Q

directly on the control: =

» Call the file manager: Press the PGM MGT key | |
Select the directory in which the archive file is 0
saved

FRsH

» Move the cursor to the archive file
ENT » Press the ENT key

> The control opens the archive file in its own
application using the Xarchiver additional tool.

amizh w0 W W K 0B 084

o With the key combination ALT+TAB, you can always
return to the control's user interface while leaving the
archive file open. Alternatively, you can also click the
corresponding icon in the task bar to switch back to the
user interface of the control.

o If you position the mouse pointer over a button, a
brief tool tip explaining the function of this button will
be displayed. More information on how to use the
Xarchiver function is provided in Help.

To exit Xarchiver, proceed as follows:
» Use the mouse to select the ARCHIVE menu item
> Select Exit
> The control returns to the file manager.
If you are not using a mouse, proceed as follows to close the
Xarchiver:
@ » Press the key for switching the soft keys
> Xarchiver opens the ARCHIVE pull-down menu.
Move the cursor to the Exit menu item

H
v

enT » Press the ENT key
> The control returns to the file manager.
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Displaying or editing text files
Use the internal text editor to open and edit text files (ASCII files,

Textdateioen. txt

e.g. with the extension txt). Proceed as follows:
» Call the file manager: Press the PGM MGT key

Select the drive and the directory in which the
text file is saved

» Move the cursor to the text file
ENT Press the ENT key

> The control opens the text file with the internal
text editor.

v

tool builder
ortained pore precisely
C soves the Fotary axis

0 Alternatively, you can also open the ASCII files using
the Leafpad additional tool. The shortcuts you are
familiar with from Windows, which you can use to edit
texts quickly (CTRL+C, CTRL+V....), are available within
Leafpad.

o With the key combination ALT+TAB, you can always
return to the control's user interface while leaving
the text file open. Alternatively, you can also click the
corresponding icon in the task bar to switch back to the
user interface of the control.

Proceed as follows to open Leafpad:

» Use the mouse to select the Menu HEIDENHAIN icon from the
task bar

» Select the Tools and Leafpad menu items in the pull-down
menu

Proceed as follows to exit Leafpad:

» Use the mouse to select the File menu item
» Select Exit

> The control returns to the file manager.
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Displaying video files

@ This function must be enabled and adapted by the
machine tool builder.

Proceed as follows to open video files with the extension ogg,
oga, ogv or ogx directly on the control:

» Call the file manager: Press the PGM MGT key
» Select the directory in which the video file is
saved

» Move the cursor to the video file
ENT » Press the ENT key

> The control opens the video file in its own
application.

0 The paid-for Fluendo Codec Pack is required for other
formats, such as for MP4 files.

@ Any additional software is installed by your machine tool
builder.

Displaying graphics files
Proceed as follows to open graphics files with the extension
bmp, gif, jpg or png directly on the control:

» Call the file manager: Press the PGM MGT key
» Select the directory in which the graphics file is
saved

» Move the cursor to the graphics file
enT » Press the ENT key

The control opens the graphics file in its own
application using the Ristretto additional tool.

o With the key combination ALT+TAB, you can always
return to the control's user interface while leaving the
graphics file open. Alternatively, you can also click the
corresponding icon in the task bar to switch back to the
user interface of the control.

o More information on how to use Ristretto is provided in
Help.
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Proceed as follows to exit Ristretto:

» Use the mouse to select the File menu item
» Select Exit

> The control returns to the file manager.

If you are not using a mouse, proceed as follows to close the
Ristretto tool:

@ > Press the key for switching the soft keys
Ristretto opens the File pull-down menu.
Move the cursor to the Exit menu item

H
v

» Press the ENT key
> The control returns to the file manager.
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3.6 Error messages and help system

Error messages

Display of errors

The control displays error messages in the following cases, for
example:

® |ncorrect data input

® | ogical errors in the NC program

m Contour elements that are impossible to machine
B |ncorrect use of touch probes

When an error occurs, the control displays it in red type in the
header.

o The control uses different colors for different error
classes:

® red for errors

® yellow for warnings
m green for notes

= blue for information

Long and multi-line error messages are displayed in abbreviated
form. Complete information on all pending errors is shown in the
error window.

The control displays an error message in the header until it is
cleared or replaced by a higherpriority error (higher error class).
Information that appears only briefly is always displayed.

An error message that contains an NC block number was caused
by an error in the indicated NC block or in the preceding NC block.

If a rare processor check error should occur, the control
automatically opens the error window. You cannot correct such an
error. Shut down the system and restart the control.

Opening the error window

» Press the ERR key

> The control opens the error window and displays
all accumulated error messages.

Closing the error window
» Press the END soft key, or

END

— » Press the ERR key
> The control closes the error window.
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Detailed error messages

The control displays possible causes of the error and suggestions
for solving the problem:

» Open the error window

HoRE » Information on the error cause and corrective
INFO action: Position the cursor on the error message
and press the MORE INFO soft key

> The control opens a window with information on
the error cause and corrective action.

> Leave Info: Press the MORE INFO soft key again

Soft key: INTERNAL INFO

The INTERNAL INFO soft key supplies information on the error
message. This information is only required if servicing is needed.

» Open the error window

il » Detailed information about the error message:
INFO Position the cursor on the error message and
press the INTERNAL INFO soft key

> The control opens a window with internal
information about the error.

» Exit the details: Press the INTERNAL INFO soft
key again

Soft key FILTER

The FILTER soft key enables you to filter identical warnings listed
immediately in succession.

» Open the error window

e > Press the MORE FUNCTIONS soft key

iR > Press the FILTER soft key. The control filters the
OFF identical warnings
> Exit the filter: Press the GO BACK soft key

E3Program run ﬁn,ﬁ..'}ntest Tun
™ roct un

Type Text
#® K progr

o

_— Il
PN PR— p—— — p——
— w | sewere | END
. | oo | oy | o e ;
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Clearing errors

Clearing errors outside of the error window

» Clear the errors/messages in the header: Press
the CE key

o In certain situations you cannot use the CE key for
clearing the errors because the key is used for other
functions.

Clearing errors
» Open the error window

» Clear individual error messages: Position the
cursor on the error message and press the
DELETE soft key.

Teiere » Clear all error messages: Press the DELETE ALL
Bl soft key.

DELETE

0 If the cause of the error has not been corrected, the
error message cannot be cleared. In this case, the error
message remains in the window.

Error log

The control stores errors occurred and important events (e.g.
system start) in an error log. The capacity of the error log is limited.
If the log is full, the control uses a second file. If this is also full, the
first error log is deleted and newly written etc. If required, switch
from CURRENT FILE to PREVIOUS FILE to view the history.

» Open the error window.

ik » Press the LOG FILES soft key
Teney » Open the error log file: Press the ERROR LOG
LT soft key

ERmviols » Set the previous error log if required: Press the
FILE PREVIOUS FILE soft key

e » Set the current error log if required: Press the
FILE CURRENT FILE soft key

The oldest entry is at the beginning of the log file, and the most
recent entry is at the end.

84 HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018



Fundamentals | Error messages and help system

Keystroke log

The control stores each key pressed and important events (e.g.
system start) in a keystroke log. The capacity of the keystroke log is
limited. If the keystroke log is full, the control switches to a second
keystroke log. If this is also full, the first keystroke log is deleted
and newly written etc. If required, switch from CURRENT FILE to
PREVIOUS FILE to view the history of the inputs.

Lo » Press the LOG FILES soft key

EvaTRORE » Open the keystroke log file: Press the
Los KEYSTROKE LOG soft key

e » Set the previous keystroke log if required: Press
FILE the PREVIOUS FILE soft key

T » Set the current keystroke log if required: Press
FILE the CURRENT FILE soft key

The control saves each key pressed during operation in a keystroke
log. The oldest entry is at the beginning, and the most recent entry
is at the end of the file.

Overview of the keys and soft keys for viewing the log

Soft key/ Function
Keys
BEEIN Go to beginning of keystroke log
e Go to end of keystroke log
Find text
T Current keystroke log
FILE
PREVIOUS Previous keystroke log

Up/down one line

Return to main menu
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Informational texts

If an operating error occurred, e.g. pressing an impermissible key
or entering a value outside of a validity range, the control displays
an information text in the header to inform you of the operating
error. The control deletes this information text with the next valid
entry.

Saving service files

If necessary, you can save the current status of the control and
make it available to a service technician for evaluation. A group of
service files is saved (error and keystroke logs as well as other files
that contain information about the current status of the machine
and the machining).

If you repeat the SAVE SERVICE FILES function with the same file
name, the previously saved group of service files is overwritten.
Therefore, use another file name when executing the function
another time.

Saving service files
» Open the error window

oo » Press the LOG FILES soft key
SAUE » Press the SAVE SERVICE FILES soft key
L > The control opens a pop-up window in which you
can enter a file name or a complete path for the
service file.
» Save the service files: Press the OK soft key

Calling the TNCguide help system

You can call the control’s help system via soft key. Immediately the
help system shows you the same error explanation that you receive
by pressing the HELP soft key.

@ Refer to your machine manual.

If your machine manufacturer also provides a

help system, the control shows an additional

Machine manufacturer (OEM) soft key with which you
can call this separate help system. There you will find
further, more detailed information on the error message
concerned.
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TNCguide context-sensitive help system
Application

o Before you can use the TNCguide, you need to
download the help files from the HEIDENHAIN home
page.
Further information: "Downloading current help files",
Page 92

The TNCguide context-sensitive help system contains the user
documentation in HTML format. The TNCguide is called with

the HELP key, and the control often immediately displays the
information specific to the condition from which the help was
called (context-sensitive call). Even if you are editing an NC block
and press the HELP key, you are usually brought to the exact place
in the documentation that describes the corresponding function.

| Enp |

o The control tries to start the TNCguide in the language
that you have selected as the conversational language.
If the required language version is not available, the
control automatically opens the English version.

The following user documentation is available in TNCguide:
m Conversational Programming User's Manual (BHBKlartext.chm)

®m User's Manual for Setup, Testing and Running NC Programs
(BHBoperate.chm)

m List of All Error Messages (errors.chm)

In addition, the main.chm "book" file is available, with the contents
of all existing .chm files.

@ As an option, your machine tool builder can embed
machine-specific documentation in the TNCguide.
These documents then appear as a separate book in the
main.chm file.
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Working with TNCguide

Calling TNCguide
There are several ways to start the TNCguide:
» Press the HELP key.

» Click the help symbol at the lower right of the screen
beforehand, then click the appropriate soft keys

» Open a help file (CHM file) via the file management. The control
can open any .chm file, even if it is not saved in the control’s
internal memory

S
®
.

o On the Windows programming station, the TNCguide is
opened in the internally defined standard browser.

PAGE |

DIRECTORY WINDOW.

=17 T&ge& 50 =]

For many soft keys there is a context-sensitive call through which
you can go directly to the description of the soft key's function.
This functionality requires using a mouse. Proceed as follows:

> Select the soft-key row containing the desired soft key

» Click with the mouse on the help symbol that the control
displays just above the soft-key row

> The mouse pointer turns into a question mark.

» Move the question mark to the soft key for which you want an
explanation

> The control opens the TNCguide. If there is no entry point
for the selected soft key, then the control opens the book file
main.chm. You can search for the desired explanation using full
text search or by using the navigation.

Even if you are editing an NC block, context-sensitive help is
available:

» Select any NC block

» Select the desired word
» Press the HELP key.
>

The control opens the Help system and shows the description
of the active function. This does not apply for miscellaneous
functions or cycles from your machine manufacturer.
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Navigating in the TNCguide

It's easiest to use the mouse to navigate in TNCguide. A table of
contents appears on the left side of the screen. By clicking the
rightward pointing triangle you open subordinate sections, and by
clicking the respective entry you open the individual pages. It is
operated in the same manner as the Windows Explorer.

Linked text positions (cross references) are shown underlined and
in blue. Clicking the link opens the associated page.

Of course you can also operate TNCguide through keys and

soft keys. The following table contains an overview of the
corresponding key functions.

Soft key Function

= |f the table of contents at left is active: Select
the entry above it or below it

m |f the text window at right is active: Move the
page downward or upward if texts or graphics
are not shown completely

..

If the table of contents at left is active: Open
up the table of contents

m |f the text window at right is active: No
function

]
|

If the table of contents at left is active: Close
the table of contents

m |f the text window at right is active: No
function

B
|

If the table of contents at left is active: Use
the cursor key to show the selected page
® |f the text window at right is active: If the
cursor is on a link, jump to the linked page

m

z

5
|

If the table of contents at left is active: Switch
the tab between the display of the table of
contents, display of the subject index, and the
full-text search function and switching to the
screen half at right

m |f the text window at right is active: Jump
back to the window at left

)

= |f the table of contents at left is active: Select
the entry above it or below it

® |f the text window at right is active: Jump to

@ |g]

next link
BRCK Select the page last shown
i
FORLARD Page forward if you have used the Select page
= last shown function
pacE Move up by one page
PRGE Move down by one page
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Function

Display or hide table of contents

WINDOW

Switch between full-screen display and reduced
display. With the reduced display you can see
some of the rest of the control window

SWITCH

=8

The focus is switched internally to the control
application so that you can operate the control
when the TNCguide is open. If the full screen
is active, the control reduces the window size
automatically before the change of focus

END

Exit TNCguide

Subject index

The most important subjects in the Manual are listed in the subject
index (Index tab). You can select them directly by mouse or with
the arrow keys.

The left side is active.

POWER INTERRUPTED

COMPILE A PLC PROGRAN
The PLE program of the THE is automaiically
RELAY EXT. DC VOLTAGE MISSING

» Select the Index tab

» Use the arrow keys or the mouse to select the @ "
desired keyword T T,
. a
Alternative: ®
» Enter the first few characters J® I
> The control synchronizes the subject index and - RN E s e |
creates a list in which you can find the subject
more easily.

» Use the ENT key to call the information on the
selected keyword

You can enter the search word only with an alphabetic
keyboard connected via USB.
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Full-text search

On the Find tab, you can search all of TNCguide for a specific
word.

The left side is active.

Select the Find tab

Activate the Find: entry field

Enter the search word

Press the ENT key

The control lists all sources containing the word.

Use the arrow keys to navigate to the desired
source

Press the ENT key to go to the selected source

VvV vVvyvVvyyvVvyy

v

o The full-text search only works for single words.

If you activate the Search only in titles function, the
control searches only through headings and ignores the
body text. To activate the function, use the mouse or
select it and then press the space bar to confirm.

You can enter the search word only with an alphabetic
keyboard connected via USB.
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Downloading current help files

You'll find the help files for your control software on the

HEIDENHAIN homepage:
http://content.heidenhain.de/doku/tnc_guide/html/en/

index.html

Navigate to the suitable help file as follows:

» TNC Controls

» Series, e.g. TNC 100
» Desired NC software number, e.g.TNC 128 (77184x-07)
>

Fundamentals | Error messages and help system

Select the desired language version from the TNCguide online

help table

v

Download the ZIP file
> Extract the ZIP file
» Move the extracted CHM files to the TNC:\tncguide\en

directory or the respective language subdirectory on the control

When using TNCremo to transfer the CHM files to the
control, select the binary mode for files with the .chm

extension.
Language TNC directory
German TNC:\tncguide\de
English TNC:\tncguide\en
Czech TNC:\tncguide\cs
French TNC:\tncguide\fr
ltalian TNC:\tncguide\it
Spanish TNC:\tncguide\es
Portuguese TNC:\tncguide\pt
Swedish TNC:\tncguide\sv
Danish TNC:\tncguide\da
Finnish TNC:\tncguide\fi
Dutch TNC:\tncguide\nl
Polish TNC:\tncguide\pl
Hungarian TNC:\tncguide\hu
Russian TNC:\tncguide\ru
Chinese (simplified) TNC:\tncguide\zh
Chinese (traditional) TNC:\tncguide\zh-tw
Slovenian TNC:\tncguide\sl|
Norwegian TNC:\tncguide\no
Slovak TNC:\tncguide\sk
Korean TNC:\tncguide\kr
Turkish TNC:\tncguide\tr
Romanian TNC:\tncguide\ro
92
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3.7 NC fundamentals

Position encoders and reference marks

The machine axes are equipped with position encoders that
register the positions of the machine table or tool. Linear axes are
usually equipped with linear encoders.

When a machine axis moves, the corresponding position encoder
generates an electrical signal. The control evaluates this signal and
calculates the precise actual position of the machine axis.

If there is a power interruption, the calculated position will no
longer correspond to the actual position of the machine slide.

To recover this assignment, incremental position encoders are
provided with reference marks. When a reference mark is crossed
over, a signal identifying a machine-based reference point is
transmitted to the control. This enables the control to re-establish
the assignment of the displayed position to the current machine
position. For linear encoders with distance-coded reference marks,
the machine axes need to move by no more than 20 mm.

With absolute encoders, an absolute position value is transmitted
to the control immediately upon switch-on. In this way the
assignment of the actual position to the machine slide position is
re-established directly after switch-on.
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3.8 Accessories: HEIDENHAIN 3-D touch
probes and electronic handwheels

3-D touch probes

Applications for HEIDENHAIN 3-D touch probes:
= Quickly and precisely set presets

® Measure the workpiece

B Measure and inspect tools

Touch trigger probes TS 260 and KT 130

The TS 260 and KT 130 touch probes transmit the trigger signals via
a cable.

HEIDENHAIN touch trigger probes feature a wearresistant optical
switch that detects the deflection of the stylus. On deflection, a
trigger signal is generated, which causes the control to store the
current position of the touch probe as the actual value.

L

Tool touch probe TT 160

The TT 160 touch probe is designed for the efficient and precise
measurement and inspection of tool dimensions.

The control offers cycles that enable you to determine the tool
length and radius while the spindle is rotating or stationary. The
tool touch probe features a particularly rugged design and a high
degree of protection, which make it insensitive to coolants and
swarf.

A wear-resistant optical switch generates the trigger signal. With
the TT 160, signal transmission is by cable.
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HR electronic handwheels

Electronic handwheels facilitate manual traversing of the axis
slides. A wide range of traverses per handwheel revolution is
available. The portable HR 510, HR 520 and HR 550FS handwheels
are avaible from HEIDENHAIN in addition to the HR 130 and

HR 150 panel-mounted handwheels.

Further information: "Moving with the electronic display
handwheels", Page 137
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4.1 Tool data

Tool number, tool name

Each tool is identified by a number between 0 and 32767. If you are
working with tool tables, you can also enter a tool name for each
tool. Tool names can have up to 32 characters.

o Permitted special characters: #$ % & ,-_.012345
6789@ABCDEFGHIJKLMNOPQRSTUYV
W XY Z

The control automatically replaces lowercase letters
with corresponding uppercase letters during saving.

Impermissible characters: <blank space> !"" () * + :;
<=>?[/1N{]}~

The tool number 0 is automatically defined as the zero tool with the
length L=0 and the radius R=0. In tool tables, tool TO should also
be defined with L=0 and R=0.

Tool length L

You should always enter the tool length L as an absolute value
based on the tool reference point.

Tool radius R

You can enter the tool radius R directly.

Tools | Tool data

L1

L2

L3
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Tool table fundamentals

You can define and store up to 32 767 tools and their tool data in a
tool table.

You must use tool tables if:

B you wish to use indexed tools such as stepped drills with more
than one length compensation value
Further information: "Indexed tool", Page 100

® |f your machine has an automatic tool changer
= |f you want to work with fixed cycles 25x

NOTICE

Caution: Data may be lost!

Deleting line 0 from the tool table will destroy the structure of
the table. As a result, locked tools might no longer be recognized
as locked and, consequently, the search for a replacement

tool will not work, either. The problem cannot be solved by

reinserting a line 0. The original tool table will be permanently
damaged!

> Restore the tool table
= Add a new line 0 to the defective tool table
= Copy the defective tool table (e.g. toolcopy.t)
® Delete the defective tool table (current tool.t)
= Copy the copied tool table (toolcopy.t) as tool.t
B Delete the copied tool table (toolcopy.t)

» Contact HEIDENHAIN Service (NC helpline)

0 All table names must start with a letter. Please keep this
in mind when creating and managing additional tables.
You can select the table view with the Screen Layout

key. You can choose between a list view and a form
view.
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Indexed tool

Step drills, T-slot milling cutters, side milling cutters and, in general,
all tools that require the input of multiple length and radius data
cannot be fully defined in a single line of the tool table. Each line of
the table permits the definition of one length and one radius.

In order to assign multiple compensation data to a tool (multiple
tool table lines), add an indexed tool number (such as T 5.1) to

an existing tool definition (T 5). Each additional line of the table
thus comprises the original tool number, a period and an index (in
ascending order from 1 to 9). The original tool table line contains
the maximum tool length; the tool lengths in the subsequent table
lines are given in descending order of their distance to the tool
holder point.

Proceed as follows to create an indexed tool number (table line):
i » Open the tool table
EINE » Press the Insert Line soft key

> The control opens the Insert Line pop-up
window

» In the Number of new lines = input field, enter
the number of lines to add

» Enter the original tool number into the Tool
number input field

» Confirm with OK

> The control adds the additional lines to the tool
table

Quick search for the tool name:

If the EDIT soft key is set to OFF, you can search for a tool name.

Proceed as follows:

» Enter the first few characters of the tool name, e.g. M

> The control shows a dialog box with the entered text and jumps
to the first match.

» Enter additional characters to narrow down the search result,
e.g. MILL

» If the control cannot find any more matches for the entered
search string, you can press the last entered character (e.g. L) to
jump between matches, as with the arrow keys.

The quick search can also be used for tool selection in the TOOL
CALL block.

Tools | Tool data
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Displaying only specific tool types (filter setting)

» Press the TABLE FILTER soft key

» Select the desired tool type by soft key

> The control displays only tools of the selected type.
» Cancel the filter: Press the SHOW ALL soft key

@ Refer to your machine manual.

The machine tool builder adapts the features of the filter
function to the requirements of your machine.

Soft key Filter functions of the tool table
T Select the filter function
FILTER
Cancel the filter settings and show all tools
SHOW ALL
T Use the default filter
FILTER
ORILL Show all drills in the tool table
cutTeR Show all cutters in the tool table
THRERDTOOL Show all taps/thread cutters in the tool table
TcH. ProOBE Show all touch probes in the tool table
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Hiding or sorting the tool table columns

You can adapt the layout of the tool table to your needs. Columns
that are not to be displayed can be simply hidden:

» Press the SORT/ HIDE COLUMNS soft key
» Select the appropriate column name with the arrow key

» Press the HIDE COLUMN soft key to remove this column from
the table view

You can also modify the sequence of columns in the table:

» You can also modify the sequence of columns in the table with
the Move before: dialog. The entry highlighted in Displayed
columns: is moved in front of this column

Use a connected mouse or the navigation keys to work in the form.

Proceed as follows:
» Press the navigation keys to go to the input fields

» Use the arrow keys to navigate within an input
field

» Press the GOTO key to open drop-down menus

o The function freeze number of columns enables you
to determine how many columns (0-3) the control will
freeze to the left border of the screen. These columns
will remain visible when you navigate to the right within
the table.

Tools | Tool data
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Entering tool data into the table

Standard tool data

Abbr. Inputs Dialog
T Number by which the tool is called in the NC program -
(e.g. b, indexed: 5.2)
NAME Name by which the tool is called in the NC program (max.  Tool name?
32 characters, all capitals, no spaces)
L Tool length L Tool length?
R Tool radius R Tool radius?
R2 Tool radius R2 for toroid cutters (only for graphical repre- Tool radius 2?
sentation of a machining operation with Ball-nose cutter)
DL Delta value for tool length L Tool length oversize?
DR Delta value for tool radius R Tool radius oversize?
DR2 Delta value for tool radius R2 Tool radius oversize 2?
TL Set tool lock (TL for Tool Locked Tool locked? Yes=ENT/No=NOENT
RT Number of a replacement tool — if available — as replace- Replacement tool?
ment tool (RT: for Replacement Tool)
An empty field or input 0 means no replacement tool has
been defined.
TIME1 Maximum tool life in minutes. This function can vary Maximum tool age?
depending on the individual machine tool. Your machine
manual provides more information
TIME2 Maximum tool life in minutes during a tool call: If the Max. tool age for TOOL CALL?
current tool age reaches or exceeds this value, the control
inserts the replacement tool during the next TOOL CALL
(if the tool axis is specified)
CUR_TIME Current age of the tool in minutes: The control automati- Current tool age?
cally counts the current tool life (CUR_TIME: For CURrent
TIME) A starting value can be entered for used tools
TYPE Tool type: Press the ENT key to edit the field. The GOTO Tool type?
key opens a window in which you can select the tool type.
In the tool management, use the SELECT soft key to open
the pop-up window. You can assign tool types to specify
the display filter settings such that only the selected type
is visible in the table
DOC Comment on tool (max. 32 characters) Tool description
PLC Information on this tool that is to be sent to the PLC PLC status?
LCUTS Tooth length of the tool Tooth length in the tool axis?
TMAT Cutting material of the tool for the cutting data calculator Tool material?
CUTDATA Cutting data table for the cutting data calculator Cutting data table?
NMAX Limit the spindle speed for this tool. The programmed Maximum speed [rpm]

value is monitored (error message) as well as an increase
in the shaft speed via the potentiometer. Function
inactive: Enter -.

Input range: 0 to +999 999 if function not active: enter -
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Abbr. Inputs Dialog

TP_NO Reference to the number of the touch probe in the touch-  Number of the touch probe
probe table

T-ANGLE Point angle of the tool. Point angle

PITCH Thread pitch of the tool. Used by tapping cycles (Cycle Tool thread pitch?

206, Cycle 207 and Cycle 209). A positive algebraic sign
means a right-hand thread.

LAST_USE Date and time that the tool was last inserted via TOOL Date/time of last tool call
CALL
KINEMATIC Use the SELECT soft key to show the tool carrier kinemat-  Tool-carrier kinematics

ics. In the tool management, use the SELECT soft key and
the OK soft key to adopt the file name and the path
Further information: "Allocating parameterized tool carri-
ers', Page 127

OVRTIME Time for exceeding the tool life in minutes Tool life expired
Further information: "Overtime for tool life", Page 113

Function is defined by the machine manufacturer. Refer to
your machine manual.
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Tool data for automatic tool measurement

®

Refer to your machine manual.
The machine tool builder defines whether the R-OFFS
offset will be taken into account for a tool with CUT 0.

Your machine tool builder defines the default value for
the R-OFFS and L-OFFS columns.

Abbr. Inputs Dialog

CUT Number of teeth (99 teeth maximum) Number of teeth?

LTOL Permissible deviation from tool length L for wear detec- Wear tolerance: length?
tion. If the entered value is exceeded, the control locks
the tool (status L). Input range: 0 to 0.9999 mm

RTOL Permissible deviation from tool radius R for wear detec- Wear tolerance: radius?
tion. If the entered value is exceeded, the control locks
the tool (status L). Input range: 0 to 0.9999 mm

R2TOL Permissible deviation from tool radius R2 for wear detec- Wear tolerance: Radius 2?
tion. If the entered value is exceeded, the control locks
the tool (status L). Input range: 0 to 0.9999 mm

DIRECT Cutting direction of the tool for measuring the tool during  Cutting direction? M4=ENT/
rotation M3=NOENT

R-OFFS Tool length measurement: Tool offset between stylus Tool offset: radius?
center and tool center.

L-OFFS Radius measurement: Tool offset between upper surface  Tool offset: length?
of stylus and lower surface of tool in addition to offset-
ToolAxis.

LBREAK Permissible deviation from tool length L for breakage Breakage tolerance: length?
detection. If the entered value is exceeded, the control
locks the tool (status L). Input range: 0 to 3.2767 mm

RBREAK Permissible deviation from tool radius R for breakage Breakage tolerance: radius?
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Editing the tool table

The tool table that is active during execution of the part program is [Broor raote caieng - EYieseren -

designated TOOL.T and must be saved in the TNC:\table directory. -
e
@ ' |

Other tool tables that are to be archived or used for test runs are
given different file names with the extension .T. By default, for . : ;
the Test Run and Programming modes the control also uses the l
TOOL.T tool table. In the Test Run mode, press the TOOL TABLE : ;

soft key to edit it. |

To open the tool table TOOL.T: e 5 F : P
16032 100 1 o on
» Select any machine operating mode — T — -
Tool name? Text width 32 a 3
TooL > Select the tool table: Press the TOOL TABLE soft w0 e e | on | e |
TABLE T I L ' ‘ Bl on TABLE
TY U key
e » Set the EDIT soft key to ON
OFF ON

o If you edit the tool table, the selected tool is locked. If
this tool is required in the NC program being used, the
control shows the message: Tool table locked.

If a new tool is created, the length and radius columns
remain empty until entered manually. An attempt to
insert such a newly created tool will be aborted by the
control and an error message will appear. This means
you cannot insert a tool for which no geometry data are
available yet.

Proceed as follows to use the alphabetic keyboard or a connected
mouse for navigation and editing:

® Arrow keys: move from one cell to the next

m ENT key: jump to the next cell; with selection fields: open the
selection dialog

5 Mouse click on a cell: move to the cell

® Double click on a cell: place the cursor in the cell; with selection
fields: open the selection dialog

Soft key Editing functions of the tool table
BEGIN Select the table start
Eno Select the table end
PAGE Select the previous page in the table
pacE Select the next page in the table

Find the text or number

FIND

pEGTN Go to beginning of line

LINE
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Soft key Editing functions of the tool table
EnD. Go to end of line
coPY Copy active field
FIELD
~ paste Insert copied field
FIELD

Add the entered number of lines (tools) at the
end of the table

e Insert a line with definable tool number
e Delete the current line (tool)

Sort the tools according to the content of a

SORT
column
Select possible entries from a pop-up window
 Reser Reset the value
-coLumMN
EpIT Place the cursor in the current cell
FIELD
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Importing tool tables

@ Refer to your machine manual.
The machine tool builder can adapt the
ADAPT NC PGM / TABLE function.
The machine tool builder can define update rules that
make it possible, for example, to automatically remove
umlauts from tables and NC programs.

If you export a tool table from an iTNC 530 and import it into a

TNC 128, you have to adapt its format and content before you

can use the tool table. On the TNC 128, you can adapt the tool
table conveniently with the ADAPT NC PGM / TABLE function. The
control converts the contents of the imported tool table to a format
valid for the TNC 128 and saves the changes to the selected file.

Proceed as follows:
» Save the tool table of the iTNC 530 to the TNC:\table

directory
» Select the Programming operating mode
» Press the PGM MGT key
» Move the cursor to the tool table you want to
import
— » Press the MORE FUNCTIONS soft key
ADRPT » Press the ADAPT NC PGM / TABLE soft key
TEELE > The control asks you whether you want to
overwrite the selected tool table.
» Press the CANCEL soft key
» Alternative: Press the OK soft key to overwrite
» Open the converted table and check its contents
> New columns in the tool table are highlighted

green.
» Press the REMOVE UPDATE INFO soft key
> The green columns are displayed in white again.

o The following characters are permitted in the Name
column of the tool table: #$ % & ,-.0123456789
@QABCDEFGHIJKLMNOPQRSTUVWXYZ

During the import, a comma is converted to a period.
The control overwrites the active tool table when
importing an external table with the same name. To
prevent data loss, back up the original tool table before
you start the import!

When iTNC 530 tool tables are imported, all defined tool
types are transferred as well. Tool types not present are
imported as type Undefined. Check the tool table after
the import.
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Overwriting tool data from an external PC

Application

The TNCremo software provides an especially convenient way to
use an external PC to overwrite tool data.

Further information: "Software for data transfer’, Page 280

This application case occurs if you wish to determine tool data on
an external tool presetter and then transfer this to the control.

Requirements

In addition to option 18 HEIDENHAIN DNC, TNCremo (version 3.1
or higher) is required with TNCremoPlus functions.

Procedure

Copy the TOOL.T tool table to the control, for example to TST.T
Start the TNCremo data transfer software on the PC

Connect to the control

Transfer the copied tool table TST.T to the PC

Use any text editor to reduce TST.T to the lines and columns
to be changed (see figure). Make sure that the header is not
changed and the data is always flush in the column. The tool
number (column T) need not be consecutive

vV v vy

» In TNCremo, select the menu item <Extras> and <TNCcmd>:
This starts TNCcmd

» To transfer the TST.T file to the control, enter the following
command and confirm with the return key (see figure):
put tst.t tool.t /m

o During transfer, only the tool data defined in the subfile
(e.g. TSTT) is overwritten. All other tool data of the table
TOOL.T remains unchanged.

The procedure for copying tool tables using the file
manager is described in the file management.

Further information: Conversational Programming
User's Manual

BEGIN TST LT MM
T NAME L R

1 4+12.5 40

3 +23.15 4+3.5

[END]

| TNC640(340594) - TNCcmd ‘ﬂ‘i—hj

TNCemdPlus - WIN32 Command Line Client for HEIDENHAIN Controls -

Connecting with TNC640(340594) (192.168.56.101)

established with TNC640, NC Software 340595 07 Deu

g\> put tst.t tool.t /m.

Uersion: 5.92 |
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Pocket table for tool changer

@ Refer to your machine manual. [Pocket tanie eastans @m
The machine tool builder adapts the features of the o e e A S
pocket table to the requirements of your machine.

You need a pocket table for automatic tool changing. You manage ﬂ

the assignment of your tool changer in the pocket table. The pocket

table is in the TNC:\table directory. The machine manufacturer can e

amend the name, path and content of the pocket table. If you wish, L

you can select different views using the soft keys in the TABLE B I o

FILTER menu. e L I
(AT o] = 1l =]

Editing a pocket table in a Program Run operating mode

= » Select the tool table: Press the TOOL TABLE soft
THW key
ooKET » Press the POCKET TABLE soft key
TABLE
orr » If required, set the EDIT soft key to ON
ON
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Selecting a pocket table in Programming mode
Proceed as follows to select the pocket table in the Programming

operating mode:

» To call the file manager, press the PGM MGT key.
» Press the SHOW ALL soft key

vy

Select a file or enter a new file name
Confirm your entry with the ENT key or the

SELECT soft key

Abbr. Inputs Dialog
P Pocket number of the tool in the tool magazine -
T Tool number Tool number?
RSV Pocket reservation for box magazines Pocket reserv.: Yes =
ENT / No = NOENT
ST Special tool (ST); If your special tool blocks pockets in front of Special tool?
and behind its actual pocket, these additional pockets need to
be locked in column L (status L).
F The tool is always returned to the same pocket in the tool Fixed pocket? Yes =
magazine ENT / No = NO ENT
L Locked pocket (L: for Locked) Pocket locked Yes =
ENT / No = NO ENT
DOC Display of the comment to the tool from TOOL.T -
PLC Information on this tool pocket that is to be sent to the PLC PLC status?
P1...P5 Function is defined by the machine tool builder. The machine Value?
tool documentation provides further information
PTYP Tool type. Function is defined by the machine tool builder. The Tool type for pocket

machine tool documentation provides further information

table?

LOCKED_ABOVE

Box magazine: Lock the pocket above

Lock the pocket
above?

LOCKED_BELOW

Box magazine: Lock the pocket below

Lock the pocket
below?

LOCKED_LEFT

Box magazine: Lock the pocket at left

Lock the pocket at
left?

LOCKED_RIGHT

Box magazine: Lock the pocket at right
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Soft key

BEGIN

Editing functions for pocket tables

Select the table start

END

Select the table end

PRGE

Select the previous page in the table

PRGE

Select the next page in the table

RESET
POCKET
TABLE

Reset pocket table

Depends on optional machine parameter
enableReset (n0.106102)

RESET
COLUMN

Reset tool number T column

Depends on optional machine parameter
showResetColumnT (no. 125303)

Go to beginning of line

Go to end of line

Simulate a tool change

SELECT

Select a tool from the tool table: The control

shows the contents of the tool table. Use the
arrow keys to select a tool, press OK to transfer it

to the pocket table

RESET
COLUMN

Reset the value

EDIT
CURRENT
FIELD

Place the cursor in the current cell

SORT

Sort the view

Refer to your machine manual.
The machine manufacturer defines the features,

properties and designations of the various display filters.
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Tool change

Automatic tool change

@ Refer to your machine manual.

The tool change function can vary depending on the
individual machine tool.

If your machine tool has automatic tool changing capability, the
program run is not interrupted. When the control reaches a tool call
with TOOL CALL, it replaces the inserted tool by another from the
tool magazine.

Overtime for tool life

@ This function must be enabled and adapted by the
machine tool builder.

The tool condition at the end of planned tool life depends on e.g.
the tool type, machining method and workpiece material. In the

OVRTIME column of the tool table, enter the time in minutes for
which the tool is permitted to be used beyond the tool life.

The machine manufacturer specifies whether this column is
enabled and how it is used during tool search.
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Tool usage test

Requirements

@ Refer to your machine manual.

The tool usage test function must be enabled by your
machine tool builder.

To conduct a tool usage test, you must activate Create tool usage
files in the MOD menu.

Further information: "Generating a tool usage file", Page 244

Generating a tool usage file

Depending on the setting in the MOD menu, you have the
following options for generating the tool usage file:

m Completely simulate the NC program in the Test Run operating
mode

B Completely run the NC program in the Program Run, Full
Sequence/Single Block operating modes

B |n the Test Run operating mode, press the
GENERATE TOOL USAGE FILE soft key (also possible without
simulation)
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The tool usage file generated is in the same directory as the NC
program. It contains the following information:

Column

TOKEN

Meaning

B TOOL: Tool usage time per tool call. The
entries are listed in chronological order.

B TTOTAL: Total usage time of a tool

B STOTAL: Call of a subprogram. The
entries are listed in chronological order.

® TIMETOTAL: The total machining time
of the NC program is entered in the
WTIME column. In the PATH column
the control saves the path name of
the corresponding NC program. The
TIME column shows the sum of all TIME
entries (feed time without rapid traverse
movements). The control sets all other
columns to O

B TOOLFILE: In the PATH column, the
control saves the path name of the tool
table with which you conducted the test
run. This enables the control during the
actual tool usage test to detect whether
you performed the test run with TOOL.T

TNR

Tool number (-1: Tool not inserted yet)

IDX

Tool index

NAME

Tool name from the tool table

TIME

Tool usage time in seconds (feed time
without rapid traverse movements)

WTIME

Tool-usage time in seconds (total usage
time between tool changes)

RAD

Tool radius R + Oversize of tool radius DR
from the tool table. (in mm)

BLOCK

Block number in which the TOOL CALL
block was programmed

PATH

B TOKEN = TOOL: Path name of the active
main program or subprogram

5 TOKEN = STOTAL: Path name of the
subprogram

Tool number with tool index

OVRMAX

Maximum feed rate override that occurred
during machining. The control enters the
value 100 (%) during the test run

OVRMIN

Minimum feed rate override that occurred
during machining. The control enters the
value -1 during the test run

NAMEPROG

® (O: The tool number is programmed
® 1: The tool name is programmed
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The control saves the tool usage times in a separate file with the
extension pgmname.H.T.DEP. This file is not visible unless the
machine parameter dependentFiles (no. 122101) is set to MANUAL

Using a tool usage test

Before starting a program in the Program Run, Full Sequence/
Single Block operating modes, you can check whether the tools
being used in the selected NC program are available and have
sufficient remaining tool life. The control then compares the actual
tool-life values in the tool table with the nominal values from the

tool usage file.

TOOL
USAGE

TOOL. 4
USAGE
TEST

Ok

Press the TOOL USAGE soft key

Press the TOOL USAGE TEST soft key

> The control opens the Tool usage test pop-up
window indicating the result of the usage test.

Press the OK soft key

> The control closes the pop-up window.

Alternative: Press the ENT key

You can query the tool usage test with the FN 18 ID975 NR1

function.
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e
ove B programming Y

THG: \nc_prog\demo )\ EX15.H

jpeaase /M
b BEGIN P EXIS MM __ ] @E%g
i BLK FORM 0.1 Z X-90 Y-60 Z-10 i
2 BLK FORM 0.2 X+390 Y+60 2+0 s M

3 TOOL CALL 7 Z S1500 ]
4 Z+100 RO FMAX M3
5

CYCL DEF 200 DRI/1a01 usage test TN
Q200=+2 ¥

SET
Q201=-15  ;DEP ok

Q206=+150 FEE R ;I

0% Y([Nm] 14:20
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HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018



Tools | Tool management

4.2 Tool management

Basics

@ Refer to your machine manual. [@esoanceators mansgemnt @_H ’

Tools [pockets

Tool management is a machine-dependent function,
which may be partly or completely deactivated.

The machine tool builder defines the exact range of
functions.

PTYP  TL POCKE MAGAZIN Tool life
. -

~ REMAL

_RouGH
MILL_D4_ROUGH

MILL_D6_ROUGH
WILL_D8_RoucH

WILL_D22_ROUGH
MILL_D24_ROUGH 0
MILL_D26_ROUGH o
MILL_D28_ROUGH 0
[ uGH

In tool management, your machine manufacturer can provide a
wide range of functions for tool handling. Examples:

® Display and editing of all tool data from the tool table and the
touch probe table

® Easily readable and adaptable representation of the tool data in
fillable forms

= Any description of the individual tool data in the new table view

Mixed representation of data from the tool table and the pocket
table

Fast sorting of all tool data by mouse
Use of graphic aids, e.g. color coding of tool or magazine status
Copying and pasting of all tool data pertaining to a tool

Graphic depiction of tool type in the table view and in the detail
view for a better overview of the available tool types

WILL_D36_ROUGH
NTII AR RoUAH a

g
Ell sessssvssususssywy s
z

PAGE

t

PAGE

Eno I

4

-

o If you edit a tool in tool management, the selected
tool is locked. If this tool is required in the NC program
being used, the control shows the message: Tool table
locked.
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Calling tool management

®

Refer to your machine manual.

The procedure for calling the tool management may
differ from that described below.

TOOL
TABLE

TUH

[>]

MANAGEMENT |

>
>

Select the tool table: Press the TOOL TABLE soft
key

Scroll through the soft-key row

Press the TOOL MANAGEMENT soft key
The control switches to the new table view.

Tool management view

In the new view, the control presents all tool information in the
following four tabs:

® Tools: Tool-specific information
B pockets: Pocket-specific information
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rﬁExpanded tool management

B wIiLL_vz_Rousk
B WILL D4_ROUGH
B wILL_vs_rousk
B wMILL_be_Rouon
B MILL_D10_ROUGH
B mIiL_ovz_noush
B WILL D1a_ROUGH
B MILL_D16_RouGH
B MILL_D18_ROUGH
10 B MILL_D20_ROUGH
1B wI_oz2_Roven
12 B WILL D24 ROUGH
B mILL_D26_moucH
B wILL_b2e_mouck
B wILL_030_ROUGH
]
n
]
]

1
15
16
17

MILL_D32_ROUGH
MILL_D3a_ROUGH
WILL_D36_ROUGH
NTII AR RoUAH

TL  POCKE  MAGAZIN _Tool life

Not monitore
Not monitored
ot monitorea
Not menitored
Nat monitored
Not monitorea
Not mon1torea
Not monitorea
Not menitored
Not monitorea
Not monitore
Not monitored
Not monitorea
Not monitored
Nat monitorea
Not monitorea
Not monitorea
Not monitorea
Not manitored

=

R REIA!W

PaGE H

FORM FOR
TooL
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Editing tool management

The tool management can be operated by mouse or with the keys [@xpanced too1 management @_m
and soft keys: ]
Soft key Editing functions for tool management = - i g
BEBIN Select the table start seeie onte et st e Jons e ows = e“' Jﬂ
TA -1 ToR 0 TANGLE 48 O TIME2 o d
T Rz 0 T oR2 0 O PITCH -0 @ CUR TIME 0
Acc L T-ANGLE 40 T I ‘
D Select the table end % ors “ . Pl
| L = : ol
T RTOL o & DIRECT
o
PaGE Select the previous page in the table — : :
el Bl 0 I ) e
PRCE Select the next page in the table
T Call the form view of the marked tool.
roet Alternative function: Press the ENT key
Changing tab:

Tools and pockets

Search function: Here you can select the column
to be searched and then the search term either
from a list or by entering it

FIND

o) Import tools
IMPORT
ExPORT Export tools
TOOL
DELETE Delete marked tools
MARKED
TOOLS
APPEND Add several lines at end of table
N LINES
AT END
UPDATE Update table view

Show the programmed tools column (if the
Pockets tab is active)

Define the settings:

® SORT COLUMN active: Click the column
header to sort the content of the column

® SHIFT COLUMN active: The column can be
moved by drag and drop

RESET Reset the manually changed settings (move
SETTINGS . ..
columns) to the original condition
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o You can edit the tool data only in the form view. To
activate the form view, press the FORM FOR TOOL soft
key or the ENT key for the currently highlighted tool.

If you use the tool management without a mouse, then
you can activate and deactivate functions with the -/+
key.

In the tool management, use the GOTO key to search for
the tool number or pocket number.

In addition, you can perform the following functions by mouse:

m Sorting function: You can sort the data in ascending or
descending order (depending on the active setting of the soft
key) by clicking a column of the table head.

®  Arrange columns. You can arrange the columns in any sequence
you want by clicking a column of the table head and then
moving it with the mouse key pressed down. The control does
not save the current column sequence when you exit the tool
management (depending on the active setting of the soft key).

B Show miscellaneous information in the form view: The control
displays tool tips when you leave the mouse pointer on an
active entry field for more than a second and when you have set
the EDIT ON/OFF soft key to ON
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Editing with active form view
If the form view is active, the following functions are available to

you:
Soft key Editing functions, form view
TooL Select the tool data of the previous tool
TooL Select the tool data of the next tool
INDEX Select previous tool index (only active if indexing
— is enabled)
InoEx Select the next tool index (only active if indexing
= is enabled)
Open a pop-up window for selection (only avail-
SELECT . .
able for selection fields)
L Discard all changes made since the form was
CHANGES called
T Add tool index
INDEX
e Delete tool index
INDEX
e Copy the tool data of the selected tool
RECORD
T Insert the copied tool data in the selected tool
DATA REC.
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Deleting marked tool data

Using this function you can simply delete tool data that you no
longer need.

Follow the steps outlined below for deleting:

» In the tool management you use the arrow keys or mouse to
mark the tool data that you wish to delete

» Press the DELETE MARKED TOOLS soft key

> The control shows a pop-up window listing the tool data to be
deleted.

» Press the START soft key to start the deletion procedure
> The control shows a pop-up window with the deletion status.

» Terminate the delete process by pressing the END key or soft
key

NOTICE

Caution: Data may be lost!

The DELETE MARKED TOOLS function permanently deletes the
tool data. The data is not automatically backed up by the control,
e.g. to a recycle bin, before being deleted. The data is irreversibly
deleted by this function.

» Regularly back up important data to external drives

o The tool data of tools still stored in the pocket table
cannot be deleted. The tools must be removed from the
magazine first.
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4.3 Tool carrier management

Fundamentals

You can create and manage tool carriers using the tool carrier
management. The control factors the tool carriers into the
calculations.

On machines with 3 axes, tool carriers for right-angled angle heads
help processing on tool axes X and Y, as the control takes the
dimensions of the angle heads into consideration.

You must carry out the following steps so that the control can
factors the tool carriers into the calculations:

E  Save tool carrier templates

®  Assign input parameters to tool carriers

m  Allocate parameterized tool carriers

Saving tool carrier templates

Many tool carriers only differ from others in terms of their
dimensions, but their geometric shape is identical. So that you
don’t have to design all your tool carriers yourself, HEIDENHAIN
supplies a range of ready-made tool carrier templates. Tool carrier
templates are 3-D models with fixed geometries but changeable
dimensions.

The tool carrier templates must be saved in TNC:\system
\Toolkinematics and have the extension .cft.

o If the tool carrier templates are not available in your
control, please download the data you require from:

http://www.klartext-portal.com/nc-solutions/en

o If you need further tool carrier templates, please contact
your machine manufacturer or third-party vendor.

o The tool carrier templates may consist of several sub-
files. If the sub-files are incomplete, the control will
display an error message.

Do not use incomplete tool carrier templates!
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Assigning input parameters to tool carriers

Before the control can factor the tool carrier into the calculations,
you must give the tool carrier template the actual dimensions.
These parameters are entered in the additional ToolHolderWizard
tool.

Save the parameterized tool carriers with the extension .cfx under
TNC:\system\Toolkinematics.

The additional ToolHolderWizard tool is mainly operated with a
mouse. Using the mouse, you can also set the desired screen
layout by drawing a line between the areas Parameter, Help
graphics and 3-D graphics by holding down the left mouse button.

The following icons are available in the additional
ToolHolderWizard tool:

Tools | Tool carrier management

Icon Function
E’ Close tool
L Open file

Switch between wire frame model and solid
object view

Switch between shaded and transparent view

Display or hide transformation vectors

Display or hide test points

Show or hide measurement points

&
&
L
"B, Show or hide names of collision objects
tH
34

- Return to starting view of the 3-D model
t

o If the tool carrier template does not contain any
transformation vectors, names, test points and
measurement points, the additional ToolHolderWizard
tool does not execute any function when the
corresponding icons are activated.
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Parameterize the tool carrier template in the Manual operation

mode

Proceed as follows to parameterize tool carrier templates and
save these parameters:

"

TOOL. 4
TABLE
EDIT >
OFF
g
>
SELECT
TOOL >
HOLDER
WIZARD

Press the Manual operation key

Press the TOOL TABLE soft key

Press the EDIT soft key

Move the cursor to the KINEMATIC column

Press the SELECT soft key

Press the TOOL HOLDER WIZARD soft key

> The control opens the additional

ToolHolderWizard tool in a pop-up window.
Press the OPEN FILE icon

> The control opens a pop-up window.

Select the desired tool carrier template using the
preview screen

Press the OK button

> The control opens the selected tool carrier

v

(X
v v Vv Y
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template.

The cursor goes to the first parameterizable
value.

Adjust values

Enter the name for the parameterized tool holder
in the Output file area

Press the GENERATE FILE button

If required, reply to the message on the control
Press the CLOSE icon

The control closes the additional tool
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Parameterize the tool carrier template in the Programming
operating mode

Proceed as follows to parameterize tool carrier templates and
save these parameters:

» Press the Programming key
> Press the PGM MGT key

> Select the path TNC:\system\Toolkinematics
> Select the tool carrier template
>

The control opens the additional
ToolHolderWizard tool with the selected tool
carrier template.

> The cursor goes to the first parameterizable
value.

» Adjust values

v

Enter the name for the parameterized tool holder
in the Output file area

Press the GENERATE FILE button

If required, reply to the message on the control
Press the CLOSE icon

The control closes the additional tool

E3
v v v Y
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Allocating parameterized tool carriers

To allow the control to factor a parameterized tool carrier into @ oot tavre caiting
calculations, you must allocate the tool carrier to a tool and call the

T4 TP_NO

tool again. -

o Parameterized tool carriers can consist of several sub-
files. If the sub-files are incomplete, the control will
display an error message.

Only use fully parameterized tool carriers! ==

i ox canceL i
Proceed as follows to allocate a parameterized tool carrier to a asugtrager Kanamarik -
tool: w | o ]
» Operating mode: Press the Manual operation
key
TooL » Press the TOOL TABLE soft key
TABLE
Y
EDIT » Press the EDIT soft key
OFF
» Move the cursor to the KINEMATIC column of the

required tool

» Press the SELECT soft key

> The control opens a pop-up window with
parameterized tool carriers

> Select the desired tool carrier using the preview
screen

> Press the OK soft key

> The control copies the name of the selected tool
carrier to the KINEMATIC column

END » Exit the tool table

SELECT
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Setup | Switch-on, switch-off

5.1 Switch-on, switch-off

Switch-on

A DANGER

Caution: Danger for the operator!

Machines and machine components always present mechanical
hazards. Electric, magnetic or electromagnetic fields are
particularly hazardous for persons with cardiac pacemakers or
implants. The hazard starts when the machine is powered up!
» Read and follow the machine manual

» Read and follow the safety precautions and safety symbols
> Use the safety devices

@ Refer to your machine manual.

Switching on the machine and traversing the reference
points can vary depending on the machine tool.

Switch the machine and the control on as follows:
» Switch on the power supply for the control and the machine

> The control displays the switch-on status in the subsequent
dialogs.

> If booting was successful, the control displays the Power
interrupted dialog

» Press the CE key to clear the message

> The control displays the Compiling PLC
program dialog; the PLC program is compiled
automatically

> The control displays the Switch on external dc
voltage dialog

@ » Switch on the machine control voltage
> The control carries out a self-test.

If the control does not register an error, it displays the Traverse
reference points dialog.

If the control registers an error, it issues an error message.
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Checking the axis positions

@ This section applies only to machine axes with EnDat
encoders.

If the actual axis position after the machine is switched on does
not match the position at switch-off, the control displays a pop-up
window.

» Check the axis position of the affected axis

» If the current axis position matches that proposed in the display,
confirm with YES

NOTICE

Danger of collision!

If they are not paid attention to, deviations between the actual
axis positions and those expected by the control (saved at the
time of switch-off) can lead to undesirable and unforeseeable
movements of the axes. There is risk of collision during
referencing and all subsequent movements.

> Check the axis positions

» Only confirm the pop-up window with YES if the axis
positions match

» Despite confirmation, at first only move the axis carefully

> |f there are discrepancies or you have any doubts, contact
your machine tool builder
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Traversing reference points

If the control performs the self-test successfully, it then displays
the Traverse reference points dialog.

@ Refer to your machine manual.
Switching on the machine and traversing the reference
points can vary depending on the machine tool.
If your machine is equipped with absolute encoders, you
can leave out crossing the reference points.

o If you intend only to edit or graphically simulate
NC programs, you can select the Programming or Test
Run. operating mode immediately after switching on the
control voltage, without needing to reference the axes.

You can neither set a preset nor modify a preset via the
preset table without having referenced the axes. The
control issues the Traverse reference points message.

You can traverse the reference points later. For
this purpose, in Manual operation mode press the
PASS OVER REFERENCE soft key.

Cross the reference points manually in the displayed sequence:

» For each axis press the NC START button, or

> The control is now ready for operation in the
Manual operation mode.

As an alternative you can cross the reference points in any

frl

sequence:

- » Press and hold the axis direction button for each
axis until the reference point has been traversed

- > The control is now ready for operation in the
Manual operation mode.
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Switch-off

@ Refer to your machine manual.
Deactivation is a machine-dependent function.

To prevent data from being lost on switch-off, you need to shut
down the operating system of the control as follows:

» Operating mode: Press the Manual operation
key
SHUT » Press the OFF soft key
DOUWN
sHuT » Confirm with the SHUT DOWN soft key
il » When the control displays the message Now

you can switch off in a pop-up window, you may
switch off the power supply to the control

NOTICE

Caution: Data may be lost!

The control must be shut down so that running processes can be
concluded and data can be saved. Immediate switch-off of the
control by turning off the main switch can lead to data loss not
matter what state the control was in!

» Always shut down the control

» Only operate the main switch after being prompted on the
screen
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5.2 Moving the machine axes

Note

@ Refer to your machine manual.

Movement of the axes via the axis direction keys can
vary depending on the machine.

Moving the axis with the axis direction keys

» Operating mode: Press the Manual operation
key

» Press the axis direction key and hold it down as
long as you wish the axis to move; or

» To move the axis continuously: Press and hold
the axis direction button and press the NC Start
key

» To stop: Press the NC Stop key

=l

3

You can change the feed rate at which the axes are moved with the
F soft key.

Further information: "Spindle speed S, feed rate F and
miscellaneous function M", Page 148

If a moving task is active on the machine, the control displays the
control in operation symbol.
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Incremental jog positioning

With incremental jog positioning you can move a machine axis by a Z
preset distance.

» Operating mode: Press the Manual operation or
Electronic handwheel key
E > Shift the soft-key row
INCRE- » Select incremental jog positioning: Switch the 8 8
INCREMENT soft key to ON
CONFIRN » Enter the infeed of the linear axes and confirm -
oL with the CONFIRM VALUE soft key k 5 s X
Nt > Alternatively, confirm with the ENT key
» Confirm with the OK soft key
> The increment is active.
INGRE- » Deactivate incremental jog positioning: Switch
B the INCREMENT soft key to OFF

6 If you are in the Jog increment menu, you can switch
off incremental jog positioning with the SWITCH OFF
soft key.

The input range for the infeed is from 0.001 mm to
10 mm.
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Traverse with the HR 510 electronic handwheel
The portable HR 510 handwheel is equipped with two permissive
buttons. The permissive buttons are located above the star grip.

You can only move the machine axes when a permissive button is
depressed (machine-dependent function).

The HR 510 handwheel features the following operating elements:
1 EMERGENCY STOP button

Handwheel

Permissive buttons

Axis address keys

Keys for defining the feed rate (slow, medium, fast; the feed
rates are set by the machine tool builder)

Direction in which the control moves the selected axis
Machine functions (set by the machine manufacturer)

T A WDN

N o

Traversing axes
Red LEDs show the active functions, such as the selected axis

> Select the Electronic handwheel operating
mode

» Press and hold a permissive button

» Select the axis

» Select the feed rate

Move the active axis in the positive direction

» Move the active axis in the negative direction

- - I
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Moving with the electronic display handwheels

A DANGER

Caution: Danger for the operator!

Unsecured connections, defective cables, and improper use are
always sources of electrical dangers. The hazard starts when the
machine is powered up!

» Devices should be connected or removed only by authorized
service technicians

» Only switch on the machine via a connected handwheel or a
secured connection

The control supports traversing with the following new electronic
handwheels:

® HR 520: Handwheel with display, data transfer via cable
® HR 550FS: Handwheel with display, data transfer via radio

@ Your machine tool builder can make additional functions
of the HR bxx handwheels available.

The portable HR 520 and HR 550FS handwheels feature a display
on which the control shows information. In addition, you can

use the handwheel soft keys for important setup functions, e.g.
presetting or entering and running M functions.

As soon as you have activated the handwheel with the handwheel
activation key, the operating panel is locked. The control shows this
status in a pop-up window on the screen.
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EMERGENCY STOP key
Handwheel display for status and for selecting functions
Soft Keys

Axis keys; can be exchanged by the machine manufacturer
depending on the axis configuration

Permissive button

A WN =

Arrow keys for defining handwheel sensitivity
Handwheel activation key

Key for traverse direction of the selected axis

Rapid traverse superimposing for the axis direction key

10 Spindle switch-on (machine-dependent function, key can be
exchanged by the machine manufacturer)

11 Generate NC block key (machine-dependent function, key can
be exchanged by the machine manufacturer)

12 Spindle switch-off (machine-dependent function, key can be
exchanged by the machine manufacturer)

13 CTRL key for special functions (machine-dependent function,
key can be exchanged by the machine manufacturer)

14 NC START key (machine-dependent function, key can be
exchanged by the machine manufacturer)

15 NC STOP key (machine-dependent function, key can be
exchanged by the machine manufacturer)

16 Handwheel
17 Spindle speed potentiometer
18 Feed rate potentiometer

19 Cable connection, not available with the HR 550FS wireless
handwheel

© 00N O O

Setup | Moving the machine axes

17

w

o oOh

14
15

16

18
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Handwheel display

1 Only with wireless handwheel HR 550FS: Shows whether 1—

the handwheel is in the docking station or whether wireless 3— —2

operation is active 4—-o 5 6
2 Only with wireless handwheel HR 550FS: Shows the signal o 8 9 ?

strength, 6 bars = maximum signal strength

3 Only with wireless handwheel HR 550FS: Shows the charge
status of the rechargeable battery, 6 bars = fully charged A bar 12—
moves from the left to the right during recharging

4 ACTL: Type of position display

5 Y+129.9788: Position of the selected axis

6 *: STIB (control in operation); program run has been started or
axis is in motion

7 SO0:: Current spindle speed

8 FO: Feed rate at which the selected axis is moving

9 E: Error message
If an error message appears on the control, the handwheel
display shows the message ERROR for three seconds. Then the

letter E is shown in the display as long as the error is pending on
the control.

10 RES 5.0: Active handwheel resolution. Path traversed by the
selected axis with a handwheel revolution

11 STEP ON or OFF: Incremental jog active or inactive. If the
function is active, the control additionally displays the current
traversing step

12 Soft-key row: Selection of various functions, described in the
following sections
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Special features of the wireless handwheel HR 550FS

ADANGER

Caution: Danger for the operator!
Wireless handwheels, due to their rechargeable batteries and
the influence of other wireless devices, are more susceptible

requirements for and information about safe operation leads

maintenance work.

» Check the radio connection of the handwheel for possible
overlapping with other wireless devices

control can run a functional test when it is restarted

» |f more than one wireless handwheel is being used in
a workshop, then ensure an unambiguous assignment

as with color-coded stickers)

> If more than one wireless handwheel is being used in
a workshop, then ensure an unambiguous assignment

as with a functional test)

to interference than cable-bound connections are. Ignoring the

to endangerment of the user, for example during installation or

> Switch off the wireless handwheel and the handwheel holder
after an operating time of 120 hours at the latest so that the

between the handwheels and the handwheel holders (such

between the handwheels and the respective machine (such

0 Due to various potential sources of interference,
a wireless connection is not as reliable as a cable

other wireless devices. If this is the case, then such

for all industrial radio systems.

handwheel holder intended for this. This way you can

for use thanks to the contact strip on the rear side of

stop circuit.

If an error (interruption of the radio connection, poor
reception quality, defective handwheel component)
occurs, the handwheel always reacts with an
emergency stop.

connection. Before a wireless handwheel can be used,
it must be checked whether there is an overlapping with

overlapping must be eliminated. This inspection for the
presence of radio frequencies or channels is obligatory

If you do not use the HR 550FS, always place it into the
ensure that the handwheel batteries are always ready

the radio handwheel and the recharge control, and that
there is a direct contact connection for the emergency

Setup | Moving the machine axes
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The HR 550FS wireless handwheel features a rechargeable battery.
The battery starts charging when you put the handwheel in the
holder.

You can operate the HR 550FS with the battery for up to 8 hours
before it must be recharged again. If not in use, it is recommended
to put the handwheel in the handwheel holder.

As soon as the handwheel is in its holder, it switches internally

to cable operation. This means you can still use it even if the
handwheel is fully discharged. The functions are the same as with
wireless operation.

o When the handwheel is completely discharged, it takes
about 3 hours until it is fully recharged in the handwheel
holder.

Clean the contacts 1 in the handwheel holder and of the
handwheel regularly to ensure their proper functioning.

The transmission range is amply dimensioned. If you should
nevertheless happen to come near the edge of the transmission
area, which is possible with very large machines, the HR 550FS
warns you in time with a plainly noticeable vibration alarm. If this
happens you must reduce the distance to the handwheel holder in
which the radio receiver is integrated.

NOTICE

Caution: Danger to the tool and workpiece!

The wireless handwheel triggers an emergency stop reaction
if the radio transmission is interrupted, the battery is fully
empty, or if there is a defect. Emergency stop reactions during
machining can cause damage to the tool or workpiece.

» Place the handwheel in the handwheel holder when it is not
in use

» Keep the distance between the handwheel and the
handwheel holder small (pay attention to the vibration alarm)

> Test the handwheel before machining
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If the control has triggered an emergency stop you must reactivate
the handwheel. Proceed as follows:

» Press the MOD key to select the MOD function
» Select Machine settings

ser op » Select the configuration menu for
WIRELESS

HANDUHEEL the radio handwheel: Press the
SET UP WIRELESS HANDWHEEL soft key

» Click the Start handwheel button to reactivate
the radio handwheel

» To save the configuration and exit the
configuration menu, press END

The MOD operating mode includes a function for commissioning
and configuring the handwheel.

Further information: "Configuring the HR 550 FS radio
handwheel", Page 248

Selecting the axis to be moved

You can activate the principal axes X, Y, Z and three other axes
defined by the machine manufacturer directly through the axis
keys. Your machine tool builder can also place the virtual axis VT
directly on one of the free axis keys. If the virtual axis VT is not on
one of the axis keys, proceed as follows:

> Press the handwheel soft key F1 (AX)

> The control shows all active axes on the handwheel display. The
currently active axis flashes.

> Select the desired axis with the F1 (->) or F2 soft keys (<-) and
confirm with the F3 (OK) handwheel soft key

Setting the handwheel sensitivity

The handwheel sensitivity determines which path an axis takes per
revolution of the handwheel. The sensitivity levels are pre-defined
and are selectable with the handwheel arrow keys (only when
incremental jog is not active).

Selectable sensitivity levels:
0.001/0.002/0.005/0.01/0.02/0.05/0.1/0.2/0.5/1 [mm/revolution or
degrees/revolution]

Selectable sensitivity levels:
0.00005/0.001/0.002/0.004/0.01/0.02/0.03 [in mm/revolution or
degrees/revolution]

Setup | Moving the machine axes
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Moving the axes

» To activate the handwheel, press the handwheel
button on the HR 5xx

> Now you can operate the control only via the
HR 5xx. The control displays a pop-up window
with this information on the screen

» Select the desired operating mode with the OPM
soft key if necessary

» If required, press and hold the permissive button

» Use the handwheel to select the axis to be
moved. Select the additional axes with the soft
keys as required

» Move the active axis in the positive direction; or

Move the active axis in the negative direction

v

» To deactivate the handwheel, press the
handwheel key on the HR 5xx

> Now you can operate the control via the
operating panel again.
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Potentiometer settings

ADANGER

Caution: Danger for the operator!

Activating the handwheel does not automatically activate the
potentiometers of the handwheel; rather the potentiometers

on the operating panel of the control remain active. After an

NC start on the handwheel, the control immediately begins
with machining or with axis positioning, even though the
potentiometers on the handwheel are set to 0 %. There is a risk
of death to anybody inside the working space!

> Before using the handwheel, set the potentiometers of the
operating panel to 0 %

» When using the handwheel, always also activate the
potentiometers of the handwheel

The potentiometers of the machine operating panel continue to be

active after you have activated the handwheel. If you want to use

the potentiometers on the handwheel, proceed as follows:

> Press the CTRL and handwheel keys on the HR 5xx at the
same time

> The control shows the soft-key menu for selecting the
potentiometers in the handwheel's display.

» Press the HW soft key to activate the handwheel
potentiometers

If you have activated the potentiometers on the handwheel, you

must reactivate the potentiometers of the machine operating panel

before deselecting the handwheel. Proceed as follows:

> Press the CTRL and handwheel keys on the HR 5xx at the
same time

> The control shows the soft-key menu for selecting the
potentiometers in the handwheel's display.

> Press the KBD soft key to activate the potentiometers of the
machine operating panel

The control issues a warning if the handwheel potentiometers are
still active after the handwheel has been deactivated.

Setup | Moving the machine axes
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Incremental jog positioning

With incremental jog positioning the control moves the currently
active handwheel axis by a preset increment defined by you:

» Press the F2 (STEP) handwheel soft key

» To activate incremental jog positioning: Press handwheel soft
key 3 (ON)

» Select the desired jog increment by pressing the F1 or F2 key.
The smallest possible increment is 0.0001 mm (0.00001 inches).
The largest possible increment is 10 mm (0.3937 inches).

» Confirm the selected jog increment with soft key 4 (OK)

» With the + or - handwheel key, move the active handwheel axis
in the corresponding direction

o If you press and hold the F1 or F2 key, each time it
reaches a decimal value 0 the control increases the
counting increment by a factor of 10.

By also pressing the CTRL key, you can increase the
counting increment by a factor of 100 when pressing F1
or F2.

Inputting miscellaneous functions M
» Press handwheel soft key F3 (MSF)
» Press handwheel soft key F1 (M)

» Select the desired M function number by pressing the F1 or F2
key

» Execute the M miscellaneous function with the NC Start key

Inputting spindle speed S

» Press handwheel soft key F3 (MSF)

Press handwheel soft key F2 (S)

Select the desired speed by pressing the F1 or F2 key
Activate the new speed S with the NC Start key

v vy

o If you press and hold the F1 or F2 key, each time it
reaches a decimal value 0 the control increases the
counting increment by a factor of 10.

By also pressing the CTRL key, you can increase the
counting increment by a factor of 100 when pressing F1
or F2.
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Entering the feed rate F

» Press handwheel soft key F3 (MSF)

Press handwheel soft key F3 (F)

Select the desired feed rate by pressing the F1 or F2 key
Load the new feed rate F with the F3 (OK) handwheel soft key

v vy

o If you press and hold the F1 or F2 key, each time it
reaches a decimal value 0 the control increases the
counting increment by a factor of 10.

By also pressing the CTRL key, you can increase the

counting increment by a factor of 100 when pressing F1
or F2.

Setting a preset

» Press handwheel soft key F3 (MSF)

» Press the handwheel soft key F4 (PRS)

» If required, select the axis in which the preset is to be set

» Zero the axis with the handwheel soft key F3 (OK) or with F1
and F2 set the desired value and then confirm with F3 (OK).

By also pressing the CTRL key, you can increase the counting
increment to 10

Changing operating modes
With the F4 (OPM) handwheel soft key you can use the handwheel
to switch the mode of operation if that the current status of the
control allows a mode change.
» Press the handwheel soft key F4 (OPM)
» Select the desired operating mode by handwheel soft key
= MAN: Manual operation

MDI: Positioning w/ Manual Data Input

SGL: Program run, single block

RUN: Program run, full sequence

Generating a complete traversing block

@ Your machine tool builder can assign any function to the
Generate NC block handwheel key.

» Select Positioning w/ Manual Data Input operating mode

If required, use the arrow keys on the alphabetic keyboard to
select the NC block after which the new positioning block is to
be inserted

» Activate the handwheel
» Press the Generate NC block key on the handwheel

> The control inserts a complete traversing block containing all
axis positions selected through the MOD function.
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Functions in the Program Run Operating Modes

You can use the following functions in the Program Run modes of
operation:

= The NC Start key (NC Start handwheel key)

B The NC Stop key (NC Stop handwheel key)

m After the NC Stop key has been pressed: Internal stop
(handwheel soft keys MOP and then Stop)

m After the NC STOP key has been pressed: Traverse manual axes
(handwheel soft keys MOP and then MAN)

® Return to the contour after axes were manually traversed during
a program interruption (handwheel soft keys MOP and then
REPO). Operate using handwheel soft keys just as you would
with the screen soft keys.
Further information: "Returning to the contour", Page 217
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5.3 Spindle speed S, feed rate F and
miscellaneous function M

Application

In the Manual operation and Electronic handwheel operating
modes, you can enter the spindle speed S, feed rate F and the
miscellaneous functions M with soft keys.

Further information: "Enter a miscellaneous function M",
Page 223

@ Refer to your machine manual.
The machine tool builder defines which miscellaneous
functions are available on the machine and which are
allowed in the Manual operation mode.

Entering values

Spindle speed S, miscellaneous function M
Proceed as follows to enter the spindle speed:
> Press the S soft key

> The control shows the Spindle speed S = dialog
in a pop-up window.

» Enter 1000 (spindle speed)
- > Press the NC start key to load the value

S

The spindle speed with the entered speedS is started with a
miscellaneous function M. Input a miscellaneous function M in the
same way.

The control shows the current spindle speed in the status display.
If the spindle speed is less than 1000, the control also shows a
decimal place that has been entered.
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Feed rate F
Proceed as follows to enter the feed rate:
Press the F soft key

v

F

The control opens a pop-up window.

>
» Enter a feed rate
Nt » Confirm with the ENT key

The following is valid for feed rate F:

® |f you enter F=0, then the feed rate that the machine tool
builder has defined as minimum feed rate is effective

= |f the feed rate entered exceeds the maximum value that has
been defined by the machine tool builder, then the value defined
by the machine tool builder is effective

B Fis not lost during a power interruption
® The control displays the feed rate.
The control shows the current feed rate in the status display.

m |f the feed rate is less than 10, the control also shows one of
the decimal place that have been entered.

= The control displays two decimal places if the feed rate is less
than 1.

Changing the spindle speed and feed rate

With the potentiometers you can vary the spindle speed S and feed
rate F from 0 % to 150 % of the set value.

(.: '--\\“ @ | | “Em |
The feed rate potentiometer only lowers the programmed feed A&

rate, not the feed rate calculated by the control. @ @

@ The override for spindle speed is only functional on A%,

machines with infinitely variable spindle drive. 5{@\\1

Feed rate limit F MAX

@ Refer to your machine manual.
The feed-rate limit depends on the machine.

The F MAX soft key enables you to reduce the feed rate speed for
all operating modes. The reduction applies to all rapid traverse and
feed rate movements. The value you enter remains active after
switch-off or switch-on.

The F MAX soft key is available in the following operating modes:
® Program run, single block

® Program run, full sequence

E Positioning w/ Manual Data Input
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Procedure
To activate the feed rate limit F MAX, proceed as follows:

» Operating mode: Press the
Positioning w/ Manual Data Input key

> Press the F MAX soft key

» Enter the desired maximum feed rate
> Press the OK soft key
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5.4 Preset management

Note
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The preset table can contain any number of rows (presets). To
optimize the file size and the processing speed, only use as many
rows as you need to manage your presets.

For safety reasons, new rows can be inserted only at the end of
the preset table.

Saving presets in the table

@ Refer to your machine manual.

The machine tool builder can disable presetting in
individual axes.

The machine tool builder can define a different path for
the preset table.

The preset table has the name PRESET.PR, and is saved in the
TNC:\table\ directory by default.

PRESET.PR is editable in the Manual operation and
Electronic handwheel operating modes only after you have
pressed the CHANGE PRESET soft key. You can open the

PRESET.PR preset table in the Programming operating mode but
not edit it.

There are several methods for saving presets in the preset table:
= Manual input

B Using the touch probe cycles in the Manual operation and
Electronic handwheel operating modes

o Operating notes:

= |n row O the control always saves the preset that
you most recently set manually via the axis keys or
via soft key. If the preset set manually is active, the
control displays the text PR MAN(O) in the status
display.
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Copying the preset table

Copying the preset table into another directory (for data backup)
is permitted. Write-protected lines are also write-protected in the
copied tables.

Do not change the number of lines in the copied tables! If you want
to reactivate the table, this may lead to problems.

To activate the preset table copied to another directory you have to
copy it back.

If you select a new preset table, you need to reactivate the preset.

Manually saving the presets in the preset table
Proceed as follows in order to save presets in the preset table:
» Select the Manual operation mode

X+ Move the tool slowly until it touches (scratches)
the workpiece surface, or position the measuring
dial correspondingly

LINEIRENE
v

PRESET » Press the PRESET MANAGEMENT soft key

MANAGEMENT

> The control opens the preset table and positions
the cursor in the line of the active preset.

TS » Press the CHANGE PRESET soft key

PRESET
>

The control displays all available input options in
the soft-key row.

» Select the line in the preset table that you want
to change (the line number is the preset number)

If needed, select the column in the preset table
that you want to change

-
v

CORRECT » Use the soft keys to select one of the available
THE

PRESET input OptionS
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Input options

Soft key Function
Directly transfer the actual position of the tool
"%“ (the measuring dial) as the new preset: This

function only saves the preset in the axis in
which the cursor is currently positioned

e Assign any value to the actual position of the tool
PRESET . . . .
e (the measuring dial): This function only saves the

preset in the axis in which the cursor is currently

positioned. Enter the desired value in the pop-up

window
CoRRECT Incrementally shift a preset already stored in the
E . . .
preser table: This function only saves the preset in the

axis in which the cursor is currently positioned.
Enter the desired compensation value with
the correct sign in the pop-up window. If inch
display is active: Enter the value in inches, and
the control will internally convert the entered

value to mm
0Tt Directly enter the new preset without calculation
iy of the kinematics (axis-specific). This function

only saves the value in the axis in which the
cursor is currently positioned. Enter the desired
value in the pop-up window. If inch display is
active: Enter the value in inches, and the control
will internally convert the entered value to mm

SAUE Write the currently active preset to a selectable
oreser line in the table: This function saves the preset
in all axes, and then activates the appropriate
line in the table automatically. If inch display is
active: Enter the value in inches, and the control

will internally convert the entered values to mm
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Editing the preset table

Soft key Editing function in table mode

= Select the table start

t

i Select the table end
T Select the previous page in the table
»jnfs Select the next page in the table

e Select the functions for entry of presets

Activate the preset of the selected line of the
preset table

Add several lines at end of table

coPv. Copy the field that is currently highlighted
FIELD
~ paste Insert the copied field
FIELD
[ reser Reset the selected line: The control enters - into
e all columns.
e Insert a line as last line in the table
T Delete the last line in the table
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Protecting presets from being overwritten

You can use the LOCKED column to protect any lines in the preset
table from being overwritten. The write-protected lines are color
highlighted in the preset table.

If you want to overwrite a write-protected line with a manual touch
probe cycle, confirm with OK and enter the password (where
password-protected).

NOTICE

Caution: Data may be lost!

Lines that were locked with the LOCK / UNLOCK PASSWORD
function can be unlocked only with the selected password.
Forgotten passwords cannot be reset. This means that locked
lines would be locked permanently. The preset table would thus
no longer be fully usable.

> Prefer the alternative function LOCK / UNLOCK
» Note down your passwords

Proceed as follows to protect a preset from being overwritten:

cHeNGE > Press the CHANGE PRESET soft key
PRESET

> Select the LOCKED column
o1t » Press the EDIT CURRENT FIELD soft key

CURRENT
FIELD

Protection for a preset without using a password:

Lock # » Press the LOCK / UNLOCK soft key
HnEoeK > The control writes an L in the LOCKED column.

Use a password to protect a preset:

Lock / > Press the LOCK / UNLOCK PASSWORD soft key

» Enter the password in the pop-up window

» Confirm with the OK soft key or with the ENT
key:

> The control writes ### in the LOCKED column.

OK
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Canceling write-protection

To edit a line you have previously write-protected, proceed as
follows:

e » Press the CHANGE PRESET soft key

» Select the LOCKED column

EpIT. » Press the EDIT CURRENT FIELD soft key
FIELD

Preset protected without a password:

ook~ » Press the LOCK / UNLOCK soft key
prock > The control cancels the write-protection.

Preset protected with a password:

j ook - > Press the LOCK / UNLOCK PASSWORD soft key

» Enter the password in the pop-up window
» Confirm with the OK soft key or with the ENT key
> The control cancels the write-protection.
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Activating a preset

Activate the preset in the Manual operation mode

NOTICE

Caution: Significant property damage!

Undefined fields in the preset table behave differently from
fields defined with the value O: Fields defined with the value O
overwrite the previous value when activated, whereas with
undefined fields the previous value is kept.

» Before activating a preset, check whether all columns contain
values.

o Operating notes:

= When activating a preset from the preset table, the
control resets any active datum shift, mirroring, or
scaling factor.

» Select the Manual operation mode
peeser » Press the PRESET MANAGEMENT soft key
RNHEE EN
» Select the preset number that you want to
activate
» Or, with the GOTO key, select the preset number

that you want to activate

» Confirm with the ENT key

AcTI- » Press the ACTIVATE PRESET soft key

URTE
PRESET

» Confirm activation of the preset
> The control sets the display.
> Exit the preset table

EXECUTE

Activating a preset in an NC program

Use Cycle 247 in order to activate presets from the preset table
during program run. In Cycle 247 you define the number of the
preset to be activated.

Further information: Conversational Programming User's Manual
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5.5 Presetting without a 3-D touch probe

Note

When presetting, you set the control display to the coordinates of a
known workpiece position.

o All manual probe functions are available with a 3-D touch
probe.

Further information: "Presetting with a 3-D touch probe
(option number 17)", Page 174

@ Refer to your machine manual.

The machine tool builder can disable presetting in
individual axes.

Preparation

» Clamp and align the workpiece
» Insert the zero tool with known radius into the spindle
» Ensure that the control is showing the actual positions
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Presetting with an end mill

» Select Manual operation mode
» Move the tool slowly until it touches (scratches)

the workpiece surface

)

Setting a preset in an axis:

» Select the axis

> The control opens the PRESETTING Z= dialog
window

o » Alternative: Press the SET PRESET soft key
Select the axis via soft key

n » Zero tool in spindle axis: Set the display to a
known workpiece position (here, 0) or enter
- the thickness d of the shim. In the tool axis:
ENT . .
Consider the tool radius

Repeat the process for the remaining axes.

If the tool in the tool axis has already been set, set the display of
the tool axis to the length L of the tool or enter the sum Z=L+d.

o Operating notes:

® The control automatically saves the preset set with
the axis keys in row 0 of the preset table.
= |f the machine tool builder has locked an axis, then

you cannot set a preset in that axis. The soft key for
that axis is then not visible.
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Using touch probe functions with mechanical probes
or measuring dials

If you do not have an electronic 3-D touch probe on your machine,
you can also use all the previously described manual touch probe
functions (exception: calibration function) with mechanical probes
or by simply touching the workpiece with the tool.

Further information: "Using a 3-D touch probe (option 17)",
Page 161

In place of the electronic signal generated automatically by a 3-D
touch probe during probing, you can manually initiate the trigger
signal for capturing the probing position by pressing a key.

Proceed as follows:

PROBING » Select any touch probe function by soft key

POS

i » Move the mechanical probe to the first position
to be captured by the control.

» To capture the position: Press the
'+' Actual-position-capture soft key

> The control saves the current position.

» Move the mechanical probe to the next position
to be captured by the control.

» To capture the position: Press the
+ Actual-position-capture soft key

> The control saves the current position.

» |f required, move to additional positions and
capture as described previously

» Preset: In the menu window, enter the
coordinates of the new preset, confirm with the
SET PRESET soft key, or write the values to a
table
Further information: "Writing measured values
from the touch probe cycles to a datum table’,
Page 166
Further information: "Writing measured values
from the touch probe cycles to the preset table",
Page 167

» Terminate the probing function: Press the END
key

o If you try to set a preset in a locked axis, the control will
issue either a warning or an error message, depending
on what the machine tool builder has defined.
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5.6 Using a 3-D touch probe (option 17)

Overview

The following touch probe cycles are available in the Manual
operation mode:

@ Refer to your machine manual.
The control must be specially prepared by the machine
tool builder for the use of a 3-D touch probe.
The touch probe cycles are available only with option
number 17. If you are using a HEIDENHAIN touch probe,
this option is available automatically.

o HEIDENHAIN only gives warranty for the function of the
probing cycles if HEIDENHAIN touch probes are used.

Soft key Function Page
CALTBRATE Calibrating the 3-D Touch 168
i Probe
PROBING Setting the preset on any 174
= axis
PROBING Setting a circle center as 175
\ a preset
PROBING Setting the centerline as 178
= preset
TCH PROBE Touch probe system data
TABLE
management
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Traverse movements with a handwheel with display

With a handwheel with display, it is possible to transfer control to
the handwheel during a manual touch probe cycle.

Proceed as follows:

Start the manual touch probe cycle

Position the touch probe at a position near the first touch point
Probe the first touch point

Activate the handwheel on the handwheel

The control shows the Handwheel active pop-up window.
Position the touch probe at a position near the second touch
point

Deactivate the handwheel on the handwheel

The control closes the pop-up window.

Probe the second touch point

If necessary, set the preset

End the probing function

vV VvV VvyvVvyVvVvyy

vV vVvyyVvy

o If the handwheel is active, you cannot start the touch
probe cycles.
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Suppressing touch probe monitoring

Suppress touch probe monitoring

If the stylus is deflected, the control issues an error message as
soon as you want to move a machine axis.

You must deactivate touch-probe monitoring in the Manual
operation mode in order to use a positioning block to retract a
touch probe after it has been deflected.

You can deactivate touch-probe monitoring for 30 seconds with the
TCH PROBE MONITOR OFF soft key.

The control issues the error
messageThe touch probe monitor is deactivated for 30 seconds.
The error message automatically clears itself after 30 seconds.

0 If the touch probe receives a stable signal within the
30 seconds, such as "Touch probe not deflected," then
touch-probe monitoring reactivates itself automatically
and the error message is cleared.

NOTICE

Danger of collision!

The TCH PROBE MONITOR OFF soft key suppresses the
corresponding error message if the stylus is deflected. The
control does not perform an automatic collision check with the
stylus. Because of this behavior, you must check whether the
touch probe can retract safely. There is a risk of collision if you
choose the wrong direction for retraction.

> Carefully move the axes in the Manual operation mode

Functions in touch probe cycles

Soft keys that are used to select the probing direction or a probing
routine are displayed in the manual touch probe cycles. The soft
keys displayed vary depending on the respective cycle:

Soft key Function
. Select the probing direction
+
_%_ Capture the actual position

Probe hole (inside circle) automatically

Probe stud (outside circle) automatically
(€],
ProBING Probe a model circle (center point of several
[ Jee elements)
Select a paraxial probing direction for probing of
@ holes, studs and model circles
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Automatic probing routine for holes, studs and model circles

NOTICE

Danger of collision!

The control does not perform an automatic collision check with
the stylus. During automatic probing procedures the control
positions the touch probe to the probing positions automatically.
There is a risk of collision if pre-positioning was not correct or if
obstacles have been ignored.

» Program a suitable pre-position
> Use safety clearances to take obstacles into account

If you use a probing routine for automatic probing of a hole, stud,
or a pattern circle, the control opens a form with the required entry
fields.

Input fields in the Measure stud and Measure hole forms

Input field Function

Stud diameter? or Hole Diameter of probe contact (optional for
diameter holes)

Safety clearance? Distance to the probe contact in the
plane

Incr. clearance height? Positioning of touch probe in spindle
axis direction (starting from the current
position)

Automatic probing routine:

» Pre-position touch probe

PROBTNG » Select the probing function: Press the
PROBING CC soft key

» Hole should be probed automatically: Press the

HOLE soft key
- > Select paraxial probing direction

» Start probing function: Press the NC start key

> The control carries out all pre-positioning and
probing processes automatically.

The control approaches the position at the feed rate FMAX defined
in the touch probe table. The defined probing feed rate F is used for
the actual probing operation.

Setup | Using a 3-D touch probe (option 17)
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Operating and programming notes:

m Before starting an automatic probing routine, you
need to preposition the touch probe near the first
touch point. Offset the touch probe by approximately
the safety clearance opposite to the probing
direction. The safety clearance is derived from the
sum of the values in the touch-probe table and in the
entry form.

® For inside circles with large diameters, the control
can also position the touch probe on a circular
arc at the feed rate FMAX. This requires that you
enter a safety clearance for prepositioning and the
hole diameter in the input form. Position the touch
probe inside the hole at a position that is offset by
approximately the safety clearance from the wall.
Take the starting angle of the first probing process
into account in pre-positioning; for example, at a
starting angle of 0° the control will first probe in the
positive direction of the reference axis.

Selecting the probing cycle

> Select the Manual operation or Electronic handwheel mode of

operation

TOUCH
PROBE

Az

PROBING

POS
e

» Select the probing functions: Press the
TOUCH PROBE soft key

» Select the touch probe cycle by pressing the
appropriate soft key, for example PROBING POS

> The control displays the associated menu.

Operating notes:

= When you select a manual probing function, the
control opens a form displaying all data required.
The content of the forms varies depending on the
respective function.

®E You can also enter values in some of the fields. Use
the arrow keys to switch to the desired input field.
You can position the cursor only in fields that can be
edited. Fields that cannot be edited are dimmed.
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Recording measured values from the touch probe
cycles

@ Refer to your machine manual.

The control must be specially prepared by the machine
tool builder for use of this function.

After executing the respective touch-probe cycle, the control writes
the measured values to the TCHPRMAN.html file.

If you have not defined a path in the machine parameter
FN16DefaultPath (no. 102202), the control will store the
TCHPRMAN.html file in the TNC:\ main directory.

o Operating notes:
= |f you run several touch probes cycles in a row, the
control stores the measured values below each
other.

Writing measured values from the touch probe cycles
to a datum table

o If you want to save measured values in the workpiece
coordinate system, use the ENTER IN DATUM TABLE
function. If you want to save measured values
in the basic coordinate system, use the
ENTRY IN PRESET TABLE function.

Further information: "Writing measured values from
the touch probe cycles to the preset table", Page 167

With the ENTER IN DATUM TABLE soft key, the control can write
the values measured during any touch probe cycle to a datum
table:

» Select any probe function

» Enter the desired coordinates for the datum in the designated
input boxes (depends on the touch probe cycle being run)

» Enter the datum number in the Number in table? input field
» Press the ENTER IN DATUM TABLE soft key

> The control saves the datum in the indicated datum table under
the entered number.
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Writing measured values from the touch probe cycles
to the preset table

o If you want to save measured values in the basic [ epecation - Epsosnamming &
cooro!mate system, use the ENTRY IN PRESET TABLE R . R
function. If you want to save measured values .
in the workpiece coordinate system, use the Cd |
ENTER IN DATUM TABLE function. I.bﬁ_
Further information: "Writing measured values from —
the touch probe cycles to a datum table", Page 166 - I
—7.87‘3v ‘. J.i'
With the ENTRY IN PRESET TABLE soft key, the control can write | & BEAT] I (e
the values measured during any touch probe cycle to the preset AL e
table. The measured values are then stored referenced to the Vi ' .

machine coordinate system (REF coordinates). The preset table has
the name PRESET.PR, and is saved in the TNC:\table\ directory.

» Select any probe function

» Enter the desired coordinates for the preset in the designated
input boxes (depends on the touch probe cycle being run)
Enter the preset number in the Number in table? input field
Press the ENTRY IN PRESET TABLE soft key

The control opens the Overwrite active preset? menu.

Press the OVERWRITE PRESET soft key

The control saves the preset in the preset table under the
entered number.

B Preset number does not exist: The control does not save the
line until the CREATE LINE soft key has been pressed (Create
line in table?)

B Preset number is protected: Press the
ENTRY IN LOCKED LINE soft key to overwrite the active
preset

B Preset number is password-protected: Press the
ENTRY IN LOCKED LINE soft key and enter the password to
overwrite the active preset

vV v v v Y

o The control displays a note if a table row cannot be
written to because of disabling. The probing function
itself is not interrupted.
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5.7 Calibrating 3-D touch probes (option 17)

Introduction

In order to precisely specify the actual trigger point of a 3-D touch
probe, you must first calibrate the touch probe, otherwise the
control cannot provide precise measuring results.

o Operating notes:
®  Always calibrate the touch probe again in the
following cases:
= |nitial configuration
Broken stylus
Stylus exchange
Change in the probe feed rate

Irregularities caused, for example, when the
machine heats up

. Change of active tool axis

® \When you press the OK soft key after calibration,
the calibration values are applied to the active
touch probe. The updated tool data then become
immediately effective, there is no need to retrieve
the tool again.

During calibration, the control finds the effective length of the
stylus and the effective radius of the ball tip. To calibrate the 3-D
touch probe, clamp a ring gauge or a stud of known height and
known radius to the machine table.

The control provides calibration cycles for calibrating the length and

the radius:
ToucH » Press the TOUCH PROBE soft key
Pil%E

CALTBRATE » Display the calibration cycles: Press
i CALIBRATE TS

» Select the calibration cycle

Calibration cycles

Soft key Function Page
Calibrating the length 169
0y
Measure the radius and the center 170
offset using a calibration ring
Measure the radius and the center 170
% offset using a stud or a calibration pin
Measure the radius and the center 170
:O:: A offset using a calibration sphere
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Calibrating the effective length

o HEIDENHAIN only gives warranty for the function of the
probing cycles if HEIDENHAIN touch probes are used.

@ The effective length of the touch probe is always
referenced to the tool reference point. The tool
reference point is often on the spindle nose (and face of
the spindle). The machine manufacturer may also place
the tool reference point at a different point.

» Set the preset in the spindle axis such that for the machine
tool table Z=0.

» Select the calibration function for the touch
szizg probe length: Press the CAL. Press L

> The control displays the current calibration data.

» Datum for length?: Enter the height of the ring
gauge in the menu window

» Move the touch probe to a position just above
the ring gauge

» To change the traverse direction (if necessary),
press a soft key or an arrow key

» Probe surface: Press NC Start key
» Check results

» Press the OK soft key for the values to take
effect

» Press the CANCEL soft key to terminate the
calibrating function.

> The control logs the calibration process in the
TCHPRMAN.html file.
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Calibrating the effective radius and compensating
center misalighment

o HEIDENHAIN only gives warranty for the function of the
probing cycles if HEIDENHAIN touch probes are used.

When calibrating the ball-tip radius, the control executes an
automatic probing routine. In the first run the control finds the
midpoint of the calibration ring or stud (approximate measurement)
and positions the touch probe in the center. Then, in the actual
calibration process (fine measurement), the radius of the ball tip

is ascertained. If the touch probe allows probing from opposite
orientations, the center offset is determined during another cycle.

The property of whether or how your touch probe can be oriented
is predefined for HEIDENHAIN touch probes. Other touch probes
are configured by the machine tool builder.

o The center offset can be determined only with a suitable
touch probe.

If you want to calibrate using the outside of an object,
you need to preposition the touch probe above the
center of the calibration sphere or calibration pin.
Ensure that the touch points can be approached without
collision.

The calibration routine varies depending on how your touch probe
can be oriented:

® No orientation possible, or orientation in only one direction: The
control executes one approximate and one fine measurement,
and then ascertains the effective ball tip radius (column R in
tool.t).

= QOrientation possible in two directions (e.g. HEIDENHAIN touch
probes with cable): The control executes one approximate
and one fine measurement, rotates the touch probe by 180°,
and then executes another probing routine. The center offset
(CAL_OF in tchprobe.tp) is determined in addition to the radius
by probing from opposite orientations.

= Any orientation possible (e.g. HEIDENHAIN touch probes with
infrared transmission): The control executes one approximate
and one fine measurement, rotates the touch probe by 180°,
and then executes another probing routine. The center offset
(CAL_OF in tchprobe.tp) is determined in addition to the radius
by probing from opposite orientations.
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Calibration using a calibration ring
Proceed as follows for manual calibration using a calibration ring:

» In the Manual operation mode, position the ball
tip inside the bore of the ring gauge

e » Select the calibration function: Press the CAL. R

e soft key

The control displays the current calibration data.

Enter the diameter of the ring gauge

Probe: Press the NC Start key

The 3-D touch probe probes all required touch

points in an automatic probing routine and

calculates the effective ball-tip radius. If probing

from opposite orientations is possible, the

control calculates the center offset.

» Check results

» Press the OK soft key for the values to take
effect

> Press the END soft key to terminate the
calibrating function.

> The control logs the calibration process in the
TCHPRMAN.html file.

VvV v.v .V

@ Refer to your machine manual.
In order to be able to determine ball-tip center
misalignment, the control needs to be specially
prepared by the machine manufacturer.
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Calibration with a stud or calibration pin

Proceed as follows for manual calibration with a stud or calibration

pin:

» In the Manual operation mode, position the ball
tip above the center of the calibration pin

» Select the calibration function: Press the CAL. R

E% soft key

Enter the outside diameter of the stud

Enter the safety clearance

Probe: Press the NC Start key

The 3-D touch probe probes all required touch
points in an automatic probing routine and
calculates the effective ball-tip radius. If probing
from opposite orientations is possible, the
control calculates the center offset.

» Check results

» Press the OK soft key for the values to take
effect

> Press the END soft key to terminate the
calibrating function.

> The control logs the calibration process in the
TCHPRMAN.html file.

v v vy

@ Refer to your machine manual.

In order to be able to determine ball-tip center
misalignment, the control needs to be specially
prepared by the machine manufacturer.
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Calibration using a calibration sphere
Proceed as follows for manual calibration using a calibration
sphere:
» In the Manual operation mode, position the ball
tip above the center of the calibration sphere

» Select the calibration function: Press the CAL. R
soft key

Enter the outside diameter of the ball
Enter the safety clearance
Select Length measurement, if applicable

e

If necessary, input the reference for the length
Probe: Press the NC Start key

The 3-D touch probe probes all required touch
points in an automatic probing routine and
calculates the effective ball-tip radius. If probing
from opposite orientations is possible, the
control calculates the center offset.

Check results

Press the OK soft key for the values to take
effect

» Press the END soft key to terminate the
calibrating function

> The control logs the calibration process in the
TCHPRMAN.html file.

vV v v v VvV Vv

Refer to your machine manual.

In order to be able to determine ball-tip center
misalignment, the control needs to be specially
prepared by the machine manufacturer.

®

Displaying calibration values

The control saves the effective length and effective radius of the
touch probe in the tool table. The control saves the touch probe
center offset to the touch probe table in the columns CAL_OF1
(principal axis) and CAL_OF2 (minor axis). You can display the
values on the screen by pressing the TCH PROBE TABLE soft key.

During calibration, the control automatically creates the

TCHPRMAN.html log file to which the calibration values are saved.

Ensure that the tool number of the tool table and
the touch-probe number of the touch-probe table are
correct.
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5.8 Presetting with a 3-D touch probe
(option number 17)

Overview

@ Refer to your machine manual.
The machine tool builder can disable presetting in
individual axes.
If you try to set a preset in a locked axis, the control will

issue either a warning or an error message, depending
on what the machine tool builder has defined.

o HEIDENHAIN only gives warranty for the function of the
probing cycles if HEIDENHAIN touch probes are used.

The following soft-key functions are available for setting a preset on
an aligned workpiece:

Soft key Function Page
PROBING Setting a preset in any axis 174
POS
PROBING Setting a circle center as preset 175
%}) cc
PROBING Setting the center line as preset 178
CL

o With an active datum shift the determined value is with
respect to the current preset (possibly a manual preset
from the Manual operation mode). The datum shift is
taken into account in the position display.

Presetting on any axis

PROBING » Select the probing function: Press the

POS

= POSITION PROBING soft key

» Move the touch probe to a position near the
touch point

» Select the axis and probing direction, e.g. Probe
in direction Z-

Probe: Press the NC Start key
» Preset: Enter the nominal coordinate

» Load with the SET PRESET soft key
Further information: "Writing measured values
from the touch probe cycles to a datum table",
Page 166
Further information: "Writing measured values
from the touch probe cycles to the preset table",
Page 167

» Terminate the probing function: Press the END
soft key
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Circle center as preset

With this function, you can set the preset at the center of bore
holes, circular pockets, cylinders, studs, circular islands, etc.

Inside circle:

The control probes the inside wall of a circle in all four coordinate Y
axis directions.

For incomplete circles (circular arcs) you can choose the
appropriate probing direction.

» Position the touch probe approximately in the
center of the circle

 PROBING » Select the probing function: Press the
Gy = PROBING CC soft key
> Select the soft key for the desired probing
direction

» Probe: Press the NC Start key. The touch
probe probes the inside wall of the circle in the
selected direction. Repeat this process. After
the third probing process, you can have the
control calculate the center (four touch points are
recommended)

» Terminate the probing procedure and switch to
the evaluation menu: Press the EVALUATE soft
key

» Preset: Enter both coordinates of the center of
the circle in the menu window

» Load with the SET PRESET soft key
Further information: "Writing measured values
from the touch probe cycles to a datum table",
Page 166
Further information: "Writing measured values
from the touch probe cycles to the preset table",
Page 167

» Terminate the probing function: Press the END
soft key

o The control needs at least three touch points to
calculate outside or inside circles, e.g. with circle
segments. More precise results are obtained with four
touch points. If possible, always pre-position the touch
probe to the center.
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Outside circle:

Setup | Presetting with a 3-D touch probe (option number 17)

Position the touch probe at a position near the
first touch point outside of the circle

Select the probing function: Press the
PROBING CC soft key

Select the soft key for the desired probing
direction

Probe: Press the NC Start key. The touch

probe probes the inside wall of the circle in the
selected direction. Repeat this process. After
the third probing process, you can have the
control calculate the center (four touch points are
recommended)

Terminate the probing procedure and switch to
the evaluation menu: Press the EVALUATE soft
key

Preset: Enter the coordinates of the preset

Load with the SET PRESET soft key

Further information: "Writing measured values
from the touch probe cycles to a datum table",
Page 166

Further information: "Writing measured values
from the touch probe cycles to the preset table",
Page 167

Terminate the probing function: Press the END
soft key

Once the probing routine is completed, the control displays the
current coordinates of the circle center and the circle radius.
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Setting the preset using multiple holes or circular studs

The manual probing function Probing of circular pattern is part of
the Cir probing function. Individual circles can be measured with
paraxial probing operations.

A second soft-key row provides the PROBING CC (probing of
circular pattern) soft key for using multiple holes or circular studs
to set the preset. You can set the intersection of three or more
elements as preset.

Setting the preset in the intersection of multiple holes or
circular studs:

» Pre-position touch probe
Select the Probing CC probing function

PROBING » Select the probing function: Press the
S PROBING CC soft key
PROBING » Press the PROBING CC (probing of circular

= pattern) soft key

Probe a circular stud

» Circular stud should be probed automatically:
E@j% Press Stud soft key
_— » Enter or select using soft key
@
o » Start probing function: Press the NC start key

Probe the hole.

» Hole should be probed automatically: Press the
Hole soft key

i » Enter or select using soft key

\f\)
1

—+
e

» Start probing function: Press the NC start key

—
=

» Repeat the probing procedure for the remaining
elements

» Terminate the probing procedure and switch to
the evaluation menu: Press the EVALUATE soft
key

» Preset: Enter both coordinates of the center of
the circle in the menu window

» Load with the SET PRESET soft key
Further information: "Writing measured values
from the touch probe cycles to a datum table",
Page 166
Further information: "Writing measured values
from the touch probe cycles to the preset table",
Page 167

» Terminate the probing function: Press the END
soft key
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Setting a center line as preset

» Select the probing function: Press the Y
PROBING CL soft key

» Position the touch probe at a position near the
first touch point

» Select the probing direction by soft key
» Probe: Press the NC Start key

» Position the touch probe at a position near the
second touch point

» Probe: Press the NC Start key

> Preset: Enter the coordinates of the preset in
the menu window, confirm with the SET PRESET H X
soft key, or write the value to a table
Further information: "Writing measured values
from the touch probe cycles to a datum table",
Page 166
Further information: "Writing measured values
from the touch probe cycles to the preset table",
Page 167

» Terminate the probing function: Press the END
soft key

0 If you desire, then after the second touch point you can
change the position of the centerline in the evaluation
menu, and thus the axis for setting the preset. Use the
soft keys to choose between principal axis, secondary
axis, and tool axis. This way you can determine the
positions once, and then store them in the principal axis
as well as in the secondary axis.
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Measuring workpieces with a 3-D touch probe

You can also use the touch probe in the Manual operation and
Electronic handwheel operating modes to perform simple
measurements on the workpiece.

With a 3-D touch probe you can determine:
® Position coordinates, and from them,
® Dimensions on the workpiece

Finding the coordinates of a position on an aligned workpiece

= » Select the probing function: Press the

| = PROBING POS soft key

» Move the touch probe to a position near the
touch point

» Select the probing direction and the axis
to which the coordinates relate: Use the
corresponding soft keys to select

» Start the probing process: Press the NC Start
key

The control shows the coordinates of the touch point as preset.
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Measuring workpiece dimensions

PROBING » Select the probing function: Press the ‘HHH >
B PROBING POS soft key z

» Position the touch probe at a position near the q

first touch point A
» Select the probing direction by soft key
» Probe: Press the NC Start key

> If you need the current preset later, write down
the value that appears in the display

» Preset: Enter 0.
» Cancel the dialog: Press the END key

» Select the probing function again: Press the
PROBING POS soft key

» Position the touch probe at a position near the
second touch point B

> Select the probe direction with the soft keys:
Same axis but from the opposite direction

» Probe: Press the NC Start key

s T
|

\ 4

The Measured value display shows the distance between the two
points on the coordinate axis.

To return to the values that were active before the length
measurement:

Select the probing function: Press the PROBING POS soft key
» Probe the first touch point again

» Set the preset to the value that you wrote down previously

» Cancel the dialog: Press the END key

v
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6.1 Graphics

Application

The control graphically simulates a machining operation in the
following operating modes:

= Manual operation

Program run, single block

Program run, full sequence

Test Run

Positioning w/ Manual Data Input

0 In Positioning w/ Manual Data Input operating mode,
the workpiece blank that is currently active in the
Program Run, Full Sequence/Single Block operating
mode is shown.

The graphic depicts the workpiece as if it were being machined
with tool.

For active tool tables, the control also takes the entries in the
columns L, LCUTS, T-ANGLE and R2 into consideration.

The control will not show a graphic if

® no NC program is selected

B the wrong screen layout is selected

® the current NC program has no valid workpiece blank definition
|

with blank form definition with a subprogram, the BLK FORM
block was not yet run

Testing and running | Graphics
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VIEW OPTIONS
Proceed as follows to access the VIEW OPTIONS:

» Select the desired operating mode
ot » Press the VIEW OPTIONS soft key

OPTIONS

The available soft keys depend on the following settings:
® The selected view.
You can select the view with the VIEW soft key.

B The selected model quality.
You can select the model quality in the Graphic settings MOD
function.

The control provides the following VIEW OPTIONS:

Soft keys Function
UORKPTECE | Show the workpiece
[ 4 X

Show the tool
Further information: "Tool", Page 184

Show the tool paths
Further information: "Tool", Page 184

Select the view

Further information: "View", Page 185

RESET Reset the tool paths
ToOoL
PATHS
ReseT Reset the workpiece blank
rFomn
BLANK Show the workpiece blank frame
FRAME
oFF  [on]
UORKPIECE Highlight the workpiece edges on 3-D model

EDGES
ofFF [oN]

E Show the block numbers of the tool paths
BLOCK NO.
oFf  [on]
HARK Show the end points of the tool paths
END POINT
oFF  [on]|
UORKPIECE Show the workpiece in color
IN COLOR
OFF
S Remove the chips

CHIPS

Workpiece remainders (chips) after the milling
process are removed.

RESET Reset the tool paths
ToOL
PATHS
{@?JQQ Rotate and zoom the workpiece
iy Further information: "Rotating, zooming and

moving a graphic", Page 186
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Soft keys Function
= Shift the sectional plane in the projection in three
@ﬂl . planes

Further information: "Shifting the sectional
plane’, Page 188

6 Operating notes:
= With the machine parameter clearPathAtBlk
(no. 124203), you specify whether the tool paths are
cleared in the Test Run operating mode with a new
BLK FORM.

= |f points were output incorrectly by the
postprocessor, machining marks may occur on the
workpiece. To recognize these unwanted machining
marks in time (prior to machining), you can test
externally created NC programs for corresponding
irregularities by displaying the tool paths.

®m The control saves the state of the soft keys in non-
volatile memory.

Tool

Displaying the tool

If the L and LCUT columns are defined in the tool table, the tool is
graphically displayed.

Further information: "Entering tool data into the table", Page 103
The control displays the tool in various colors:

= Turquoise: Tool length

® Red: Length of cutting edge and tool is engaged

® Blue: Length of cutting edge and tool is retracted
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Showing the tool paths

The control displays the following types of movement: [ 5 G

Soft keys Function

TooL PaTHS Movements at rapid traverse and at the

E programmed feed rate

TooL PATHS Movements at the programmed feed rate

'

TOOL PATHS No movements

o> =

WORKPIEGE |

EfX‘@I'X

neser || meser
TooL BLK
PATHS FoRM

TooL PATHS

R

| EIUI]

o If you move at rapid traverse inside a workpiece, both
the movement and the workpiece is shown in red at the
respective location.

| workpzeee | TooL | nssew RESET
|l 24T 7 ¢

TooL 'pms

S

view

s EIEII]

View

The control provides the following views:

Soft keys Function

uIEW Plan view
=

uzEw Projection in three planes
OEw

uzEu 3-D view
(5l v o

‘@ " ‘!@# )=

Projection in three planes

The simulation shows three sectional planes and a 3-D model,
similar to a technical drawing.

ud o800 00:05:56 T MAX

RESET

@;ﬂ\ B

=

H 1% ’.‘@"}TX“ ”Ellv
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3-D view
The high-resolution 3-D view enables you to display the surface of T oo B
the machined workpiece in greater detail. Using a simulated light
source, the control creates realistic light and shadow conditions.

oA

START
SINGLE

=T | [P

RESET
START +
sTART

Rotating, zooming and moving a graphic
Proceed as follows to rotate a graphic, for example:

P ?J » Select functions for rotating and zooming
= “ > The control displays the following soft keys.
Soft keys Function

e = Rotate in 5° steps about the verti-
=7 = cal axis

‘ Tilt in 5° steps about the horizon-
=7 [ X tal axis
.+@Q Enlarge the graphic stepwise

Reduce the graphic stepwise

1@ Reset the graphic to its original

size and angle

Move the graphic upward or
‘ downward

Move the graphic to the left or

- = right
11 Reset the graphic to its original
@*\ position and angle

186 HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018



Testing and running | Graphics

You can also use the mouse to change the graphic display. The
following functions are available:

» In order to rotate the model shown in three dimensions, hold
down the right mouse button and move the mouse. If you
simultaneously press the shift key, you can only rotate the
model horizontally or vertically

» To shift the model shown: Hold the center mouse button or
mouse wheel down and move the mouse. If you simultaneously
press the shift key, you can only shift the model horizontally or
vertically

» To zoom in on a certain area: Mark a zoom area by holding the
left mouse button down.

> After you release the left mouse button, the control zooms in on
the defined area.

» To rapidly magnify or reduce any area: Rotate the mouse wheel
backwards or forwards

» To return to the standard display: Press the shift key and
simultaneously double-click with the right mouse key. The
rotation angle is maintained if you only double-click with the
right mouse key

Speed of the setting test runs

o The most recently set speed stays active until a power
interruption. After the control is switched on the speed
is set to FMAX.

After you have started a program, the control displays the following
soft keys with which you can set the simulation speed:

Soft key Functions
Test program with the speed that will be
@\ used when actually running the program
(programmed feed rates will be taken into
account)
@ Increase the simulation speed incrementally
= Decrease the simulation speed incrementally
(@)
" Test run at the maximum possible speed
@ (default setting)

You can also set the simulation speed before you start a program:

> Select the function for setting the simulation
speed

> Select the desired function by soft key, e.qg.
incrementally increasing the simulation speed

DR
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Repeating graphic simulation

A part program can be graphically simulated as often as desired. To
do so you can reset the graphic to the workpiece blank.

Soft key Function
RESET Display the unmachined workpiece blank in the
Fon Program run, single block and Program run,
full sequence operating modes
RESET THE Display the unmachined workpiece blank in the
VOLUME R
MODEL Test Run operating mode

Shifting the sectional plane

The default setting of the sectional plane is selected so that it lies
in the working plane in the center of the workpiece blank and in the
tool axis on the top surface of the workpiece blank.

Proceed as follows to move the sectional plane:
> Press the soft key for

%E
@ﬂl shifting the sectional plane

> The control displays the following soft keys:

Soft keys Function
E'__ % Shift the vertical sectional plane
L0 L0 to the right or left
— — Shift the vertical sectional plane
| (I forward or backward
— T— Shift the horizontal sectional
L] LI plane upwards or downwards

The position of the sectional planes is visible during shifting. The
shift remains active, even if you activate a new workpiece blank.

Resetting sectional planes

The shifted sectional plane also remains active for a new workpiece
blank. The sectional plan is automatically reset when the control is
restarted.

Proceed as follows to move the sectional plane to the default
position:

=TI > Press the soft key for
O resetting the sectional planes soft key
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6.2 Showing the workpiece blank in the
working space

Application

In Test Run operating mode, you can graphically check the position
of the workpiece blank and the preset in the working space of the

machine. The graphic shows the preset that has been set in the NC oo
program using Cycle 247 If you have not defined a preset in the NC -
program, then the graphic shows the active preset on the machine. 40,00

(_g@ operation |EBJTest Run

Traverse range

You can activate working space monitoring in Test Run operating
mode: Press the BLANK IN WORK SPACE soft key. You can activate
or deactivate the function using the SW limit monitoring soft key.

A transparent cuboid represents the workpiece blank. Its
dimensions are shown in the BLK FORM table. The control takes
over the dimensions from the workpiece blank definition of the
selected NC program.

For a test run it normally does not matter where the workpiece
blank is located within the working space. If you activate working
space monitoring, you must graphically shift the workpiece blank
so that it lies within the working space. Use the soft keys shown in

the table.
You can also activate the current preset for the Test Run operating
mode.
Soft keys Function
Shift workpiece blank in positive/
- =& negative X direction
Shift workpiece blank in positive/
o & 7@ negative Y direction
f ’ Shift workpiece blank in positive/
@ @ negative Z direction
g Show workpiece blank refer-
enced to the set preset
ACTIVE Display the current traverse range
TRAVERSE
RANGES
seLEGT The control shows the traverse
TRAVERSE . .
RANGE ranges configured by the machine
tool builder that can be selected
as required.
T Switch monitoring function on or
monitoring Off
HACHINE Display machine reference point
REF POINT
OFF

o For blank in work space, the control depicts the BLK
FORM only schematically.

= \With BLK FORM CYLINDER, a cuboid is depicted as
the workpiece blank
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6.3 Measuring

Application

In Test Run operating mode, you can use the MEASURING soft key
to show the coordinates.

» Set the MEASURING soft key to ON

» Position the mouse pointer on the respective
position

> The control shows an approximated value for the
corresponding coordinates.

o The MEASURING soft key is available in the following
views:

= Plan view
® 3-D view
Further information: "View", Page 185
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6.4 Optional program-run interruption

Application

@ Refer to your machine manual.

The behavior of this function varies depending on the
respective machine.

The control optionally interrupts program run at NC blocks in which
an M1 has been programmed. If you use M1 in the Program run
operating mode, the control does not switch off the spindle or the
coolant.

» Set the MO1 soft key to OFF

> The control does not interrupt the Program run
or Test Run at NC blocks that contain an M1.

» Set the MO1 soft key to ON

> The control interrupts the Program run or Test
Run at NC blocks with M1.
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6.5 Skipping NC blocks

You can have NC blocks skipped in the following operating modes:
® Test Run

® Program run, full sequence

® Program run, single block

® Positioning w/ Manual Data Input

o Operating notes:
= This function does not work for TOOL DEF blocks.

m  After a power interruption the control returns to the
most recently selected setting.

B The setting of the HIDE soft key is only effective in
the respective operating mode.

Test Run and Program Run

Application

In Test Run or Program Run, Full Sequence/Single Block
operating mode, the control can skip over NC blocks that you have
prefaced with a slash (/):

HIDE

» Set the HIDE soft key to ON

> The control skips the NC blocks.
>
>

Set the HIDE soft key to OFF
The control runs or tests the NC blocks.

HIDE

ON

Procedure
You can optionally hide NC blocks.

Proceed as follows to hide NC blocks in the Programming operat-
ing mode:

» Select the desired NC block
> Press the INSERT soft key
REMOVE > The control inserts a slash (/).

Proceed as follows to show NC blocks in the Programming
operating mode again:

» Select the hidden NC block
o » Press the REMOVE soft key
> The control removes the slash (/).

Testing and running | Skipping NC blocks
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Positioning w/ Manual Data Input

Application

o In order to skip NC blocks in the Positioning w/ Manual
Data Input operating mode, you need an alphabetic
keyboard.

In Positioning w/ Manual Data Input operating mode, you can
have the control skip NC blocks that have been marked corre-

spondingly:

e » Set the HIDE soft key to ON

] g > The control skips the NC blocks.
o, » Set the HIDE soft key to OFF
el > The control runs the NC blocks.
Procedure

Proceed as follows to hide NC blocks in the Positioning w/
Manual Data Input operating mode:

» Select the desired NC block

» Press the / key on the alphabetic keyboard
> The control inserts a slash (/).

Proceed as follows to show NC blocks again in the Positioning w/
Manual Data Input operating mode:

» Select the hidden NC block

> Press the Backspace key
> The control removes the slash (/).
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6.6 Testrun

Application

In the Test Run operating mode, you can simulate NC programs
and program sections in order to reduce programming errors during
program run. The control checks the programs for the following:

Geometrical incompatibilities

Missing data

Impossible jumps

Violation of the machine's working space
Using disabled tools

The following functions are also available:
Blockwise test run

Interruption of test at any NC block
Skip NC blocks

Functions for graphic simulation
Measure machining time

Additional status display

Keep the following in mind when performing a test run

With cuboid workpiece blanks, the control starts a test run after a
tool call at the following position:

B |n the working plane in the center of the defined BLK FORM

® |n the tool axis, 1T mm above the MAX point defined in the BLK
FORM

NOTICE

Danger of collision!

In the Test Run operating mode, the control does not take all
axis movements of the machine into consideration (e.g., PLC
positioning movements as well as movements from tool-change
macros and M functions). This can cause a test performed
without errors to later deviate from the machining operation.
Danger of collision during machining!

> Test the NC program at the later machining position (BLANK
IN WORK SPACE)

> Program a safe intermediate position after the tool change
and before prepositioning

> Carefully test the NC program in the Program run, single
block operating mode

@ Refer to your machine manual.
Your machine tool builder can also define a tool-change
macro for the Test Run operating mode. This macro will
simulate the exact behavior of the machine.
In doing so, the machine tool builder often changes the
simulated tool change position.

Testing and running | Test run
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Test run execution

o For the test run, you must activate a tool table (status
S). Select a tool table via the file manager in the Test
Run operating mode.

You can select any preset table (status S) for the test run.

After RESET + START, line 0 of the temporarily loaded preset table
automatically displays the currently active preset from Preset.PR
(execution). Line 0 is selected when starting the test run until you
define another preset in the NC program. All presets from lines >
0 are read by the control from the selected preset table of the test
run.

With the BLANK IN WORK SPACE function, you can activate
workspace monitoring for the test run.

Further information: "Showing the workpiece blank in the working
space ", Page 189

» Operating mode: Press the Test Run key
P » Call the file manager with the PGM MGT key and

select the file you wish to test

The control then displays the following soft keys:

Soft key Functions
RESET Reset the blank form, reset the previous tool
staRT data and test the entire NC program

Test the entire NC program
START

START Test each NC block individually
SINGLE
=L
g;;m Executes the Test Run until NC block N
=

Stop test run (this soft key only appears if you

sTor have started the test run)

You can interrupt and continue the test run at any time, even within
fixed cycles. In order to continue the test, the following actions
must not be performed:

® Selecting another NC block with the arrow keys or the GOTO
key

= Making changes to the NC program
® Selecting another NC program
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Executing a Test Run up to a certain NC block

With the STOP AT function the control executes a Test Run up to
the NC block with block number N.

Proceed as follows to stop the Test Run at any NC block:
» Press the STOP AT soft key

» Stop at: N = Enter the block number at which
the simulation should stop

» Enter the Program name of the NC program
containing the NC block with the selected block
number

> The control shows the name of the selected
NC program.

» If the simulation is to be stopped in an
NC program that has been called using PGM
CALL, then enter this name

> Repetitions = If N is located in a program-section
repeat, enter the number of repeats that you
want to run.
Default 1: The control stops before N is
simulated

Q36840 ALLOWANGE FOR SIDE e T TN
RESET [——
EUEC START B —
sTART || oo

Possibilities in stopped condition

If you interrupt the Test Run with the STOP AT function, you have
the following possibilities in this stopped condition:

E Enable or disable NC block skip

= Optional program stop enable or disable

= Modify graphics resolution and model

= Modify the NC program in the Programming operating mode

If you modify the NC program in the Programming operating mode,

the simulation behaves as follows:

B Modification before the interruption point: The simulation
restarts at the beginning

®  Modification after the interruption point: Positioning at the
interruption point is possible with GOTO
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GOTO function
Using the GOTO key

Jumping with the GOTO key

Use the GOTO key to jump to a specific location in the NC program,
regardless of the active operating mode.

Proceed as follows:

» Press the GOTO key

> The control opens a pop-up window.
» Enter a number
>

Select the jump statement by soft key, e.g.
move down the number of lines entered

N LINES

The control provides the following options:

Soft key Function
N LInes Move up the number of lines entered
N LINES Move down the number of lines entered
5010 Jump to the block number entered
INE
NlLJNEER

0 Use the GOTO function only during programming and
testing of NC programs. Use the block scan function
during program run.
Further information: "Any entry into the NC program:
Block scan", Page 212

Quick selection with the GOTO key

With the GOTO key, you can open the Smart Select window that
makes it easy for you to select special functions or cycles.

Proceed as follows to select special functions:

» Press the SPEC FCT key
» Press the GOTO key

> The control displays a pop-up window showing a
structural view of the special functions

» Select the desired function

Further information: User's Manual Conversational Programming

Opening the selection window with the GOTO key

When the control provides a selection menu, you can use the
GOTO key to open the selection window. This allows you to view
the available entries.
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Display of NC programs
Syntax highlighting

The control displays syntax elements with various colors according uma...m =)
to their meaning. Color-highlighting makes the NC programs easier e "
to read and clearer. e T b

1_BLK FORM CYLINDER 2 R30 L8D DIST+2

ANY COMMEN

| 9 |

—

Color highlighting of syntax elements : :m ] ‘:I
T ] :]

-

-

Use Color

J &

Standard color Black

Display of comments Green =¥ =

Display of numerical values Blue = == 3 | I 5 J—‘
Display of the block number Violet - ‘ - | = " - “ H |
Display of FMAX Orange

Display of the feed rate Brown

Scrollbar

Screen content can be shifted with the mouse using the scroll
bar at the right edge of the program window. In addition, the size
and position of the scrollbar indicates program length and cursor
position.
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6.7 Program run

Application

In the Program run, full sequence operating mode, the control
executes an NC program continuously to its end or up to a program
stop.

In the Program run, single block operating mode, the control
executes each NC block individually after pressing the NC Start key.
With point pattern cycles and CYCL CALL PAT the control stops
after each point.

You can use the following control functions in the Program run,
single block and Program run, full sequence operating modes:

Interrupt program run

Start the program run from a certain NC block
Skip NC blocks

Edit the tool table TOOL.T

Checking and changing Q parameters
Superimpose handwheel positioning
Functions for graphic simulation

Additional status display

BPrngtaln run, full sequence

1teplatte_holder plate.

PR

HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018 199




Testing and running | Program run

Running an NC program

Preparation

1 Clamp the workpiece to the machine table.
2 Set the preset

3 Select the pallet files (status M)

4 Select the NC program (status M)

o Operating notes:

= You can change the feed rate and spindle speed
using the potentiometers.

B You can reduce the feed rate using the FMAX soft
key. This reduction affects all rapid traverse and
feed movements, even after the control has been
restarted.

Program Run, Full Sequence
» Start the NC program with the NC start key

Program Run, Single Block

» Start each NC block of the NC program individually with the
NC start key
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Structuring NC programs

Definition and applications

- Tapping
B8 END PGM _STEMPEL STANP M

The control enables you to comment NC programs in structuring [Eieniai sresation | @ -ozarmino @m
blocks. Structuring blocks are texts with up to 252 characters and el s v srane. v

are used as comments or headlines for the subsequent program e C]
lines. T D

With the aid of appropriate structuring blocks, you can organize
long and complex NC programs in a clear and comprehensible
manner.

This function is particularly convenient if you want to change the
NC program later. Structuring blocks can be inserted into the
NC program at any point.

Structure blocks can also be displayed in a separate window, and “ o
be edited or added to, as desired. Use the appropriate screen
layout for this.

The control manages the inserted structure items in a separate
file (extension: .SEC.DEP). This speeds navigation in the program
structure window.

The PROGRAM + SECTS screen layout can be selected in the
following operating modes:

® Program run, single block
® Program run, full sequence
® Programming

LI

e e

Displaying the program structure window / Changing the active

window
PROGRAM » Display structure window: For this screen layout
sects press the PROGRAM + SECTS soft key

» Change the active window: Press the
CHANGE WINDOW soft key

Selecting blocks in the program structure window

If you are scrolling through the program structure window block

by block, the control at the same time automatically moves the
corresponding NC blocks in the program window. This way you can
quickly skip large program sections.
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Checking and changing Q parameters

Procedure

You can check Q parameters in all operating modes, and also edit
them.

TNG:ne_pro= + ¥ sevesmsoses worae ceoen [
5 T-haitep @ Poxameter list
I P YT N

» |If you are in a program run, interrupt it if required (e.g. by o o e i o

pressing the NC stop key and the INTERNAL STOP soft key) or sl s mioms £3 om —
stop the test run e X |
. » To call the Q parameter functions, press the e e =

Q INFO soft key or the Q key S T e
> The control lists all of the parameters and their IR S— \:]
corresponding current values. . P e C]
» Use the arrow keys or the GOTO key to select =17 U T ” T J o ‘ mesar | wor [ ]

FIELD VALE @ on o8

the desired parameter.

If you would like to change the value, press the
EDIT CURRENT FIELD soft key. Enter a new value
and confirm with the ENT key

To leave the value unchanged, press the
PRESENT VALUE soft key or close the dialog with
the END key

rﬁPrngram run, full sequence

'
2
s - 2_ssann
on-Tas
© parameter list
[« w3 ! oR-po1
5 CYCL DEF 253 SLOT MILL

Q218540 [MACHINING Q S0

az18=430

st eng | —————— P

stot wioi @

iDEPTH | oR

10000

TNG: \ne_prog.\_T noldar_plate.h | overview [PGH LOL CYE W P05 TOOL TF TRANS OPARA
B holder_plate.h (4| Eewonc, X 800
1 ¥ <0.000
™ 2 <0000
BLK FORM 0.1 Z X-80 Y-30 2.20 T4 WILL DB _RouGH
BLK FORM 0.2 X450 Ye50 240 L +a0. 0080 R
TOOL GALL “MILL_DB_RoUGH

+0.0008
<0.0000

|

isLeT DIAE
:sLoT posy 98

e
e Comen ]

ww
© o0:00:00

Bplatte_holder_plate.n

All of the parameters with displayed comments are used )

. . +0.000
by the control within cycles or as transfer parameters. +460.000
(Mode: NOML | o T Bso

If you want to check or edit local, global or string
parameters, press the SHOW PARAMETERS Q QL QR QS
soft key. The control then displays the specific
parameter type. The functions previously described also
apply.

o |

£

w | onen
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You can have Q parameters also displayed in the additional status
display in all operating modes (except Programming mode).

» |If you are in a program run, interrupt it if required
(e.g. by pressing the NC stop key and the INTERNAL STOP soft
key), or stop the test run

@ » Call the soft key row for screen layout
PROGRAN » Select the layout option for the additional status
‘_E‘FI;_US dlsplay

> In the right half of the screen, the control shows
the Overview status form.

e > Press the STATUS OF Q PARAM. soft key

Q PARAM.

o » Press the Q PARAMETER LIST soft key
PARAMETER
LsT > The control opens a pop-up window.

» For each parameter type (Q, QL, QR, QS), define
the parameter numbers you wish to control.
Separate single Q parameters with a comma,
and connect sequential Q parameters with a
hyphen, e.g. 1,3,200-208. The input range per
parameter type is 132 characters

o The display in the QPARA tab always contains eight
decimal places. The result of Q1 = COS 89.999 is

shown by the control as 0.00001745, for example.
Very large or very small values are displayed by
the control in exponential notation. The result of
Q1 = COS 89.999 * 0.001 is shown by the control as
+1.74532925e-08, whereby e-08 corresponds to the
factor of 108,
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Interrupting, stopping or aborting machining
There are several ways to stop a program run:

B |nterrupt the program run with e.g. the miscellaneous function
MO

= |nterrupt the program run e.g. with the miscellaneous function
MO

B Stop the program run, e.g. with the NC stop key in connection
with the INTERNAL STOP soft key

B Terminate the program run e.g. with the miscellaneous
functions M2 or M30

The control shows the current status of the program run in the
status display.

Further information: "General status display”’, Page 54

In contrast to a stopped run, an interrupted, aborted (terminated)

program run enables certain actions by the user, including the

following:

® Select operating mode

® Check Q parameters and change these if necessary using the
Q INFO function

®  Change setting for the optional programmed interruption with
M1

®  Change setting for the programmed skipping of NC blocks with
/

o During major errors, the control automatically aborts
the program run (e.g., during a cycle call with stationary
spindle).

Testing and running | Program run
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Program-controlled interruptions

You can set interruptions directly in the NC program. The control
interrupts the program run in the NC Block containing one of the
following inputs:

B Programmed stop MO
® Conditional stop M1

NOTICE

Danger of collision!

Certain manual interactions cause the control to lose program
information affecting the mode and thereby to lose the so-called
contextual reference. After the loss of the contextual reference,
unexpected and undesired movements can occur. There is a
danger of collision during subsequent machining operations!
» Do not perform the following interactions:

®  Cursor movement to another NC block

® The jump command GOTO to another NC block

® Editing an NC block

B Modifying Q parameter values with the Q INFO soft key

= Switching the operating modes

> Restore the contextual reference via repetition of the required
NC blocks

@ Refer to your machine manual.

The miscellaneous function M6é may also lead to
a suspension of the program run. The machine
manufacturer sets the functional scope of the
miscellaneous functions.
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Manual program interruption

While an NC program is being executed in the Program run, full
sequence operating mode, select the Program run, single block
operating mode. The control interrupts the machining process at

the end of the current machining step.

Aborting program run

—

ol

STOP

206

4
>
>

Press the NC Stop key
The control does not finish the current NC block.

The control shows the icon for stopped status in
the status display.

Actions such as a change of operating mode are
not possible.

The program can be resumed with the NC start
key.

Press the INTERNAL STOP soft key

The control briefly shows the icon for program
cancellation in the status display.

The control shows the icon for the exited inactive
status in the status display.

Actions such as a change of operating mode are
available again.

Testing and running | Program run
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Moving the machine axes during an interruption

You can move the machine axes during an interruption in the same
way as in the Manual Operation mode.

Modifying the preset during an interruption

If you modify the active preset during an interruption, resuming the
program run is only possible with GOTO or mid-program startup at
the interruption point.

Example: Retracting the spindle after tool breakage
» Interrupt machining

» Enable the axis direction keys: Press the MANUAL TRAVERSE
soft key

» Move the machine axes with the axis direction keys

@ Refer to your machine manual.

On some machines you may have to press the NC start
key after the MANUAL TRAVERSE soft key to enable the
axis direction keys.
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Resuming program run after an interruption

The control saves the following data during a program interruption:
® The last tool that was called

® Current coordinate transformations (e.g., datum shift, mirroring)
® The coordinates of the circle center that was last defined

The control uses the stored data for returning the tool to
the contour after manual machine axis positioning during an
interruption (RESTORE POSITION soft key).

o Operating notes:

B The saved data remains active until it is reset (e.g.,
by selecting a program).

= |f you interrupt an NC program using the
INTERNAL STOP soft key, you have to start
machining at the start of the program or by using the
BLOCK SCAN function.

® For program interruptions within program-section
repeats or subprograms, you have to use the
BLOCK SCAN function for re-entering at the point of
interruption.

= With machining cycles, mid-program startup is
always executed at the start of the cycle. If you
interrupt a program run during a machining cycle, the
control repeats machining steps already carried out
after a block scan.

Resuming the program run with the NC Start key

You can resume program run by pressing the NC start key if the
NC program was stopped in one of the following ways:

B Press the NC Stop key
B Programmed interruption

Resuming program run after an error

With an erasable error message:

» Remove the cause of the error

» Clear the error message from the screen: Press the CE key

> Restart the program, or resume program run where it was
interrupted

Testing and running | Program run

208 HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018



Testing and running | Program run

Retraction after a power interruption

@ Refer to your machine manual.

Your machine tool builder configures and enables the
Retract operating mode.

With the Retraction mode of operation you can disengage the tool
from the workpiece after an interruption in power.

If you activated a feed rate limit before a power failure, this
is still active. You can deactivate the feed-rate limit using the
CANCEL THE FEED RATE LIMITATION soft key.

The Retraction mode of operation is selectable in the following
conditions:

® Power interrupted

= No control voltage for the relay

= Traverse reference points

The Retraction operating mode offers the following modes of

traverse:

Mode Function

Machine axes Movement of all axes in the machine coordi-
nate system

Thread Movements of the tool axis in the active

coordinate system with compensating
movement of the spindle

Effective parameters: Thread pitch and direc-
tion of rotation

The control selects the mode of traverse and the associated
parameters automatically. If the traverse mode or the parameters
have not been correctly preselected, you are unable to reset them
manually.

NOTICE

Caution: Danger to the tool and workpiece!

A power failure during the machining operation can cause
uncontrolled “coasting” or braking of the axes. In addition, if

the tool was in effect prior to the power failure, then the axes
cannot be referenced after the control has been restarted.

For non-referenced axes, the control takes over the last saved
axis values as the current position, which can deviate from the
actual position. Thus, subsequent traverse movements do not
correspond to the movements prior to the power failure. If the
tool is still in effect during the traverse movements, then the tool
and the workpiece can sustain damage through tension!

» Use a low feed rate

> Please keep in mind that the traverse range monitoring is not
available for non-referenced axes
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Example

The power failed while a thread cutting cycle was being performed.
You have to retract the tap:

» Switch on the power supply for control and machine

> The control starts the operating system. This process may take
several minutes.

> The control will then display the Power interrupted message in
the screen header.

pEmT— » Activate the Retraction mode: Press the
OFF RETRACT soft key
> The control displays the message Retraction
selected

Confirm the power interruption: Press the CE key
> The control compiles the PLC program.

H
v

C

@ » Switch on the machine control voltage

> The control checks the functioning of the
EMERGENCY STOP circuit. If there is at least
one non-referenced axis, you will have to
compare the displayed position values with
the actual axis values and confirm that they are
correct. if required, follow the dialog.

» Check the preselected traverse mode: If required, select
THREAD

» Check the preselected thread pitch: if required, enter the thread
pitch

» Check the preselected direction of rotation: if needed, select
the turning direction of the thread
Right-handed thread: the main spindle turns clockwise when
moving into the workpiece, counterclockwise when retracting
from it; left-handed thread: main spindle turns counter-clockwise
when moving into the workpiece and clockwise when retracting
from it

» Activate retraction: Press the RETRACT soft key

RETRACT

» Retraction: Retract the tool with the axis direction keys or the
electronic handwheel
Axis key Z+: Retraction from the workpiece
Axis key Z-: Moving into the workpiece

» Exit retraction: Return to the original soft-key
-
level
o » End the Retraction mode: Press the
RETRACTION END RETRACTION soft key

> The control checks whether the Retraction
mode can be ended. If necessary, follow the
dialog.

210
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» Answer confirmation request: If the tool was not correctly
retracted, press the NO soft key. If the tool was correctly
retracted, press the YES soft key.

> The control hides the Retraction selected dialog.

> Initialize the machine: if required, cross the reference points
> Establish the desired machine condition
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Any entry into the NC program: Block scan

@ Refer to your machine manual.

The BLOCK SCAN function must be enabled and
configured by the machine tool manufacturer.

With the BLOCK SCAN function you can start an NC program at any
desired NC block. The control takes workpiece machining up to this
NC block into account in its calculations.

If the NC program was interrupted under the following conditions,
the control saves the interruption point:

® INTERNAL STOP soft key
B Emergency stop
m Power failure

If, while restarting, the control finds a saved point of interruption,
then it outputs a message. You can then execute mid-program
startup directly at the point of interruption.

You can run the mid-program startup in the following ways:

®  Mid-program startup in the main program, with repetitions if
necessary

= Multi-level mid-program startup in subprograms and touch probe
cycles

®  Mid-program startup in a point table
® Block scan in pallet programs

At the start of the block scan, the control resets all data, as with a
selection of the NC program. During the block scan, you can switch
between Program Run Full Sequence and Program Run Single
Block.

NOTICE

Danger of collision!

The BLOCK SCAN function skips over the programmed touch
probe cycles. As a result, the result parameters contain no
values or, possibly, incorrect values. If the subsequent machining
operation uses these result parameters, then there is a risk of
collision!

» Use the BLOCK SCAN function at multiple levels
Further information: "Procedure for multi-level mid-program
startup", Page 214

Testing and running | Program run

[EPxngxam run, full sequence [m_r]_! ,
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Procedure for simple mid-program startup

o The control only displays the dialogs required by the
process in the pop-up window.

» Press the BLOCK SCAN soft key

> The control shows a pop-up window with the
active main program.

» Start-up at: N =: Enter the number of the
NC block where you wish to enter the NC
program

» Program: Check the name and path of the

NC program containing the NC block, or enter
with the SELECT soft key

» Repetitions: Enter the number of
repetitions which should be taken into
account in the block scan if the NC block
is located within a program section repeat.
Default 1 means first machining

e » Press the ADVANCED soft key if required
OFF
Last_ » if required, press the INSERT LAST NC BLOCK
soft key to select the last saved interruption
E » Press the NC Start key

The control starts the block scan, calculates until
the entered NC block and shows the next dialog.

If you changed the machine status:

@ » Press the NC Start key

> The control restores the machine status, e.g.
TOOL CALL, M functions and shows the next

dialog.
If you changed the axis positions:
@ » Press the NC Start key

> The control approaches the specified positions
in the specified sequence and shows the next
dialog.
Approach axes in individually selected
sequence:
Further information: "Returning to the contour”,
Page 217

@ » Press the NC Start key

The control resumes execution of the NC
program.

Example of simple mid-program startup

After an internal stop, you would like to start in NC block 12 in the
third machining operation of LBL 1.

In the pop-up window enter the following data:
® Start-up at: N =12
® Repetitions 3
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Procedure for multi-level mid-program startup

If you, for example, start in a subprogram that is called several
times by the main program, then use the multi-level block scan. For
this purpose, jump in the main program to the desired subprogram
call. With the CONTINUE BLOCK SCAN function, you can jump
further from this position.

Operating notes:

® The control only displays the dialogs required by the
process in the pop-up window.

® You can also continue the BLOCK SCAN without
restoring the machine status and the axis position
of the first startup point. For this, press the
CONTINUE BLOCK SCAN soft key before confirming
the restoration with the NC-Start key.

RDVANCED

oFF [_on]

LAST
[(= ]
OFF [ On|

Mid-program startup to the first start-up point:

» Press the BLOCK SCAN soft key
» Enter the first NC block where you wish to start
» Press the ADVANCED soft key if required

» |f required, press the INSERT LAST NC BLOCK
soft key in order to select the last saved
interruption

» Press the NC Start key

> The control starts the block scan and calculates
until the entered NC block.

If the control should restore the machine status of the entered

NC block:

» Press the NC Start key

> The control restores the machine status, e.g.
TOOL CALL, M functions.

If the control should restore the axis positions:

» Press the NC Start key

> The control moves in the specified sequence to
the specified positions.

If the control should run the NC block:

=

» Select the Program Run Single Block operating
mode if required

» Press the NC Start key
> The control runs the NC block.

Mid-program startup to the next start-up point:

CONTINUE
BLOCK SCAN

s —

» Press the CONTINUE BLOCK SCAN soft key
» Enter the NC block where you wish to start

If you changed the machine status:

=

» Press the NC Start key

» Press the NC Start key

Testing and running | Program run
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If the control should run the NC block:
» Press the NC Start key

> Repeat these steps if required to jump to the
next start-up point

! > Press the NC Start key

> The control resumes execution of the NC
program.

Example of multi-level mid-program startup

You run a main program with several subprogram calls in the

NC program Sub.h. You work with a touch probe cycle in the main
program. You use the result of the touch probe cycle later for
positioning.

After an internal stop you wish to start up in NC block 8 in the
second call of the subprogram. This subprogram call is in NC block
53 of the main program. The touch probe cycle is in NC block 28 of
the main program, i.e. before the desired start-up point.

» Press the BLOCK SCAN soft key

> In the pop-up window enter the following data:
= Start-up at: N =28
® Repetitions 1

» Select the Program Run Single Block operating
mode if required

Ik » Press the NC start key until the control runs the
touch probe cycle

> The control saves the result.

» Press the CONTINUE BLOCK SCAN soft key

> In the pop-up window enter the following data:
= Start-up at: N =53
= Repetitions 1

13 » Press the NC start key until the control runs the
NC block

> The control jumps into the subprogram Sub.h.
> Press the CONTINUE BLOCK SCAN soft key
> In the pop-up window enter the following data:
= Start-up at: N =8
= Repetitions 1

13 » Press the NC start key until the control runs the
NC block

> The control continues to run the subprogram and
then returns to the main program.
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Block scan in a point table

If you start in a point table called by the main program, use the
ADVANCED soft key.

orF  [on]|

3

Press the BLOCK SCAN soft key

The control shows a pop-up window.
Press the ADVANCED soft key

The control expands the pop-up window.

Point number: Enter the line number of the
point table you start with

Point file: Enter the name and path of the point
table

If required, press the SELECT LAST BLOCK soft
key in order to select the last saved interruption

Press the NC Start key

If you would like to use the block scan function to start in a point
pattern, then proceed just as you would for starting in the point
table. Enter the desired point number in the Point number input
field. The first point in the point pattern has the point number 0.

216
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Returning to the contour
With the RESTORE POSITION function, the control moves the tool [E3Froaram run, full seqvence @_! ’

to the workpiece contour in the following situations: okt et et Tw.m_mwmnmm

oL X 52,719
¥ 30.000

= Return to the contour after the machine axes were moved
during a program interruption that was not performed with the
INTERNAL STOP function.

® Return to the contour with a block scan with
RESTORE POS AT N, for example after an interruption with
INTERNAL STOP

® Depending on the maching, if the position of an axis has

changed after the control loop has been opened during a .
program interruption s

1 amse
T 50 FACEMILL DO
n to contour (NC START) 20,0000

50 B 2000
fovr 1008 u B
ok s

e |

INTERNAL
sTOP

Procedure
Proceed as follows to approach the contour:
— » Press the RESTORE POSITION soft key
FoSTTION » Restore the machine status, if required
Approach the axes in the sequence shown by the control:

» Press the NC Start key

Approach the axes according to individually selected sequence:

seLeeT > Press the SELECT AXIS soft key
o » Press the axis soft key of the first axis
! > Press the NC Start key

> Press the axis soft key of the second axis
! > Press the NC Start key

> Repeat the process for all axes

0 If the tool is located in the tool axis below the starting
point, then the control offers the tool axis as the first
traverse direction.
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6.8 Functions for program display

Overview

In the Program Run Single Block and Program Run Full Sequence
operating modes, the control displays the following soft keys for
displaying the NC program in pages:

Soft key Functions

Go back one screen in the NC program

Go forward one screen in the NC - program

Select start of program

Select end of program
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6.9 Positioning w/ Manual Data Input
operating mode

The Positioning w/ Manual Data Input operating mode is
particularly convenient for simple machining operations or for pre-
positioning the tool. It enables you to write a short NC program in
Klartext conversational programming and execute it immediately.
The NC program is stored in the file $MDI.

You can use the following functions for example:
® Cycles

® Radius compensation

= Program section repetitions

® Q parameters

The additional status display can be activated in the Positioning w/
Manual Data Input operating mode.
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Positioning with manual data input (MDI)
> Select Positioning w/ Manual Data Input
operating mode
» Program the desired available function
o » Press the NC Start key

1
L > The control executes the highlighted NC block.
Further information: "Positioning w/ Manual
Data Input operating mode", Page 219

6 Operating and programming notes:
® The following functions are not available in the
Positioning w/ Manual Data Input operating mode:
® Program call
® PGM CALL
= SEL PGM
® CALL SELECTED PGM
B Programming graphics
B Program-run graphics
® Using the SELECT BLOCK and CUT OUT BLOCK soft
keys etc. you can also conveniently and rapidly reuse
program sections from other NC programs.

Further information: Conversational Programming
User's Manual

= You can control and modify Q parameters with the
soft keys Q PARAMETER LIST and Q INFO.
Further information: "Checking and changing Q
parameters”, Page 202
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Example

A hole with a depth of 20 mm is to be drilled into a single
workpiece. After clamping and aligning the workpiece and setting
the preset, you can program and execute the drilling operation with
a few lines of programming.

First you pre-position the tool above the workpiece with straight-
line blocks and position with a safety clearance of 5 mm above the
hole. Then drill the hole with Cycle 200 DRILLING.

Call the tool: tool axis Z,
spindle speed 2000 rpm
Retract tool (F MAX = rapid traverse)

Move the tool at F MAX to a position above the hole, spindle
on

Move the tool at F MAX to a position above the hole
Define the DRILLING cycle

Set-up clearance of the tool above the hole

Depth of hole (algebraic sign=work direction)

Feed rate for drilling

Depth of each infeed before retraction

Dwell time after every retraction in seconds
Coordinate of the workpiece surface

Set-up clearance of the tool above the hole

Dwell time in seconds at the hole bottom

Depth referenced to the tool tip or the cylindrical part of the
tool

Call the DRILLING cycle
Retract the tool

End of program
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Saving NC programs from $MDI

The $MDI file is intended for short NC programs that are only
needed temporarily. Nevertheless, you can store an NC program, if
necessary, by proceeding as follows:

» Operating mode: Press the Programming key
» To call the file manager, press the PGM MGT key.

» Move the highlight to the SMDI file

» To copy the file: Press the COPY soft key

DESTINATION FILE =

» Enter the name under which you want to save the current
contents of the $MDI file, e.g. Hole

> Press the OK soft key.

; — » Exit the file manager: Press the END soft key
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6.10 Entering miscellaneous functions M

Fundamentals

With the control’s miscellaneous functions—also called M
functions—you can affect:

= the program run, e.g. a program interruption

= the machine functions, such as switching spindle rotation and
coolant supply on and off

® the path behavior of the tool

You can enter up to four M (miscellaneous) functions at the end of
a positioning block or in a separate NC block. The control displays
the following dialog question: Miscellaneous function M ?

You usually enter only the number of the miscellaneous function
in the programming dialog. Some miscellaneous functions can be
programmed with additional parameters. In this case, the dialog is
continued for the parameter input.

In the Manual operation and Electronic handwheel operating
modes, the M functions are entered with the M soft key.

Effectiveness of miscellaneous functions

Please note that some M functions become effective at the start
of a positioning block, and others at the end, regardless of their
position in the NC block.

Miscellaneous functions come into effect in the NC block in which
they are called.

Some miscellaneous functions are effective only in the NC block in
which they are programmed. Unless the miscellaneous function is

only effective blockwise, you must either cancel it in a subsequent

NC block with a separate M function, or it is automatically canceled
by the control at the end of the program.

o If multiple functions were programmed in a single NC
block, the execution sequence is as follows:

® M functions taking effect at the start of the block are
executed before those taking effect at the end of the
block

= |f all M functions are effective at the start or end of
the block, execution takes place in the sequence as
programmed
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6.11 Miscellaneous functions for program run
inspection, spindle and coolant

Overview

@ Refer to your machine manual.

The machine manufacturer can influence the behavior of
the miscellaneous functions described below.

M Effect Effective at block Start End

MO Program STOP [
Spindle STOP

M1 Optional program STOP [

Spindle STOP if necessary
Coolant OFF if necessary (function
defined by the machine tool builder)

M2 STOP program run [
Spindle STOP
Coolant off
Return jump to block 1
Clear status display
Functional scope depends on machine

parameter
resetAt (no. 100901)
M3 Spindle ON clockwise [
M4 Spindle ON counterclockwise [
M5 Spindle STOP [
M6 Tool change [
Spindle STOP
Program STOP
M8 Coolant ON [
M9 Coolant OFF m
M13  Spindle ON clockwise [
Coolant ON
M14  Spindle ON counterclockwise [
Coolant ON
M30 Same as M2 u
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6.12 Miscellaneous functions for coordinate
entries

Programming machine-referenced coordinates: M91/
M92

Scale datum

On the scale, a reference mark indicates the position of the scale
datum.

Machine datum
The machine datum is required for the following tasks:
= Define the axis traverse limits (software limit switches)

B Approach machine-referenced positions (e.g. tool change
positions)

m Set a workpiece preset

The distance in each axis from the scale datum to the machine
datum is defined by the machine manufacturer in a machine
parameter.

Standard behavior
The control references the coordinates to the workpiece datum.

Further information: "Presetting without a 3-D touch probe’,
Page 158

Behavior with M91 — Machine datum

If you want the coordinates in a positioning block to be based on
the machine datum, enter M91 into these NC blocks.

o If you program incremental coordinates in an M91 block,
enter them with respect to the last programmed M91
position. If no M91 position is programmed in the active
NC block, then enter the coordinates with respect to the
current tool position.

The coordinate values on the control screen reference the machine
datum. Switch the display of coordinates in the status display to
REF

Further information: "Status displays", Page 54
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Behavior with M92 - Additional machine reference point

@ Refer to your machine manual.

In addition to the machine datum, the machine tool
builder can also define an additional machine-based
position as a machine reference point.

For each axis, the machine tool builder defines the
distance between the machine reference point and the
machine datum.

If you want the coordinates in positioning blocks to be based on the
machine preset, enter M92 into these NC blocks.

o Radius compensation remains the same in blocks that
are programmed with M91 or M92. The tool length will
not be taken into account.

Effect

M91 and M92 are effective only in the blocks in which M91 and
M92 have been programmed.

M91 and M92 take effect at the start of block.

Workpiece preset
If you want the coordinates to always be referenced to the machine y4 \
datum, you can disable the setting of presets for one or more axes.

If presetting is inhibited for all axes, the control no longer displays

the SET PRESET soft key in the Manual operation mode. Y

The figure shows coordinate systems with the machine and Y
workpiece datum. X

M91/M92 in the Test Run mode

In order to be able to graphically simulate M91/M92 movements,
you need to activate working space monitoring and display the
workpiece blank referenced to the defined preset.

Further information: "Showing the workpiece blank in the working
space ", Page 189
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7.1 Defining a counter

Application

@ Refer to your machine manual.
Your machine manufacturer enables this function.

The FUNCTION COUNT function allows you to control a simple
counter from within the NC program. For example, this function
allows you to count the number of manufactured workpieces.

Proceed as follows for the definition:

» Show the soft key row with special functions
SR » Press the PROGRAM FUNCTIONS soft key
'FUNCTIONS
Tt » Press the FUNCTION COUNT soft key
COLNT

NOTICE

Caution: Data may be lost!

Only one counter can be managed by the control. If you execute
an NC program that resets the counter, any counter progress of
another NC program will be deleted.

> Please check prior to machining whether a counter is active.

» |f necessary, note down the counter value and enter it again
via the MOD menu after execution.

Effect in the Test Run operating mode

You can simulate the counter in the Test Run operating mode. Only
the count you have defined directly in the NC program is effective.
The count in the MOD menu remains unaffected.

Effect in the Program Run Single Block and Program Run Full
Sequence operating modes

The count from the MOD menu is only effective in the Program
Run Single Block and Program Run Full Sequence operating
modes.

The count is retained even after a restart of the control.

Special Functions | Defining a counter
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Define FUNCTION COUNT
The FUNCTION COUNT function provides the following possibilities:

Soft key Meaning

Increase count by 1

Reset counter

Set the nominal count (target value) to the
desired value

Input value: 0-9999
Set the counter to the desired value
Input value: 0-9999

Increment the counter by the desired value
Input value: 0-9999

Repeat the NC program starting from this label if
more parts are to be machined.

Reset the counter value

Enter the target number of parts to be machined
Enter the jump label

Machining

Increment the counter value

Repeat the machining operations if more parts are to be
machined.

m
x
S
3
T
o
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8.1 MOD function

The MOD functions provide additional input possibilities and
displays. In addition, you can enter code numbers to enable access
to protected areas.

Selecting MOD functions
Open the pop-up window with the MOD functions: [Bvanuar oporation @ﬁm

> Press the MOD key T A
> The control opens a pop-up window displaying - : _‘

the available MOD functions. e | i Fo]

Enabled functions

e

52
B

3
sﬂ e=im

e

LICENSE
INFO

DIAGHOSIS CANCEL

PARAMETER

Changing the settings
There are three possibilities for changing a setting, depending on
the function selected:

» Enter a numerical value directly, e.g., when determining the
traverse range limit

» Change the setting by pressing the ENT key
» Change a setting via a selection window

o If there are multiple possible settings available, then you
can show the selection box by pressing the GOTO key.
Select the desired setting with the ENT key. If you do
not wish to change the setting, close the window with
the END key.

Exiting MOD functions

» Exit the MOD functions: Press the CANCEL soft key or the END
key
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Overview of MOD functions

The following functions are available independent of the selected
operating mode:
Code-number entry

® Code number

Display settings

Position displays

Unit of measure (mm/inch) for position display
Program input for MDI
Show time of day

Show the info line

Graphic settings

5 Model type

= Model quality

Counter settings

B Momentary count

® Target value for counter
Machine settings

Kinematics

Traverse limits

Tool-usage file

External access

Set up wireless handwheel
System settings

® Set the system time

® Define the network connection
® Network: IP configuration
Diagnostic functions

= Bus diagnosis

® HEROS information
General information

= \ersion information

B License information

®  Machine times

[iManua! operation

Posi

tion disp]

————

HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018 233




8.2 Display software numbers

Application

The following software numbers are displayed on the control’s
screen after the Software version MOD function has been
selected:

®  Control model: Designation of the control (managed by
HEIDENHAIN)

® NC SW: Number of the NC software (managed by
HEIDENHAIN)

®  NCK: Number of the NC software (managed by
HEIDENHAIN)

® PLC: Number or name of the PLC software (managed by
your machine manufacturer)

In the FCL Information MOD function, the control shows the
following information:

= Development level (FCL=Feature Content Level):
Development level of the software installed on the control
Further information: "Feature Content Level (upgrade
functions)", Page 26

8.3 Entering the code number

Application
The control requires a code number for the following functions:

Function Code number

Select user parameters 123

Configuring an Ethernet card NET123

Enabling special functions for Q parameter 555343
programming

MOD functions | Display software numbers
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Functions provided to the machine tool builder by the
code number dialog

The two soft keys OFFSET ADJUST and UPDATE DATA are shown in
the MOD menu of the control.

The OFFSET ADJUST soft key enables automatic determination and
subsequent saving of an offset voltage required for analog axes.

@ Refer to your machine manual.
This function may only be used by trained personnel!

The UPDATE DATA soft key enables the machine tool builder to
install software updates on the control.

NOTICE

Caution: Possible loss of data!

An incorrect procedure when installing updates can cause a loss
of data.

Do not install any software updates without instructions!
Contact your machine manufacturer.
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8.4 Loading the machine configuration

Application

NOTICE

Caution: Data may be lost!

The RESTORE function irrevocably overwrites the current
machine configuration with the backup files. The control does
not perform an automatic backup before the RESTORE function.
The files are thus permanently gone.

» Perform a backup of the current machine configuration prior
to the RESTORE function

» Use the function only in consultation with the machine tool
builder

Your machine tool builder can provide you a backup with a machine
configuration. After entering the keyword RESTORE, you can load
the backup on your machine or programming station. Proceed as
follows to load the backup:

» Enter the keyword RESTORE in the MOD dialog

> Select the backup file in the control’s file manager
(e.g., BKUP-2013-12-12_.zip)

> The control opens the pop-up window for the backup.
» Press Emergency Stop
> Press the OK soft key to start the backup process
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8.5 Selecting the position display

Application

You can influence the display of the coordinates for the Manual
operation mode as well as for the Program run, full sequence
and Program run, single block operating modes.

The figure on the right shows the different tool positions:

B |nitial position 1
® Target position of the tool

® \Workpiece datum

B Machine datum

You can select the following coordinates for the control’s position

displays:
Display Function
NOML Nominal position: The value currently commanded by the control
0 The NOML and ACTL displays differ solely with regard to following error.
ACTL Actual position; current tool position
@ Refer to your machine manual.
Your machine tool builder defines whether the ACTL and NOML display
deviates from the programmed position by the DL oversize of the tool call.
REF ACTL Reference position; actual position relative to the machine datum
REF NOML Reference position; nominal position relative to the machine datum
LAG Servo lag; difference between nominal and actual positions
ACTDST Distance remaining to the programmed position in the input coordinate system; differ-

ence between actual and target positions
Examples with Cycle 11:

Scaling factor 0.2

> LIX+10

> The ACTDST display shows 10 mm.

> The scaling factor does not have any influence.

v
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Display Function

REFDST Distance remaining to the programmed position in the machine coordinate system;
difference between actual and target positions

Examples with Cycle 11

» Scaling factor 0.2

> LIX+10

> The REFDST display shows 2 mm.

> The scaling factor has an effect on the distance and thus on the display.

M118 Traverse paths that were executed with handwheel superimpositioning function
(M118)

With the Position display 1 MOD function, you can select the
position display in the status display.

With the Position display 2 MOD function, you can select the
position display in the additional status display.
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8.6 Setting the unit of measure

Application

With this MOD function, you can determine whether the control
coordinates are displayed in millimeters or inches.

B Metric system: e.g. X = 15.789 (mm), the value is displayed to 3
decimal places

® |nch system: e.g. X = 0.6216 (inches), value is displayed to 4
decimal places

If you would like to activate the inch display, the control shows the
feed rate in inch/min. In an inch program you must enter the feed
rate larger by a factor of 10.
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8.7 Graphic settings

With the Graphic settings MOD function, you can select the model
type and model quality for the Test Run operating mode.
Proceed as follows to select Graphic settings:

» Select the Graphic settings group in the MOD menu

> Select the model type

» Select the model quality

» Press the APPLY soft key

» Press the OK soft key.

In the Test Run operating mode, the control displays icons of the
active Graphic settings.

You have the following simulation parameters for the control’s Graphic settings:

Model type
Icon Choice Properties Application
- ery true to detall, illing with undercuts,
é 3-D Vi detail Milli ith und
Ea heavy time and processor consump-
tion
] 25D Fast Milling without undercuts
=]
ﬁ No model Very fast Line graphics
Model quality
Icon Choice Properties
EEEE Very high High data transfer rate, exact depiction of tool geometry,
depiction of block end points and block numbers possible
@BDEO High High data transfer rate, exact depiction of tool geometry
@BOO Medium Medium data transfer rate, approximation of tool geometry
@000 Low Low data transfer rate, coarse approximation of tool geometry
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8.8 Setting the counter

With the Counter settings MOD function, you can change the
current count (actual value) and the target value (nominal value).
Proceed as follows to select Counter settings:

» Select the Counter settings group in the MOD menu

» Select the current count

» Select the target value for the counter

> Press the APPLY soft key

> Press the OK soft key

The control immediately takes over the selected value in the status
display

Proceed as follows to change the Counter settings by soft key:

Soft key Meaning

Reset count
RESET

Increase count

Lower count

You can also enter the values directly with a connected mouse.
Further information: "Defining a counter", Page 228
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8.9 Changing the machine settings

Selecting the kinematics

@ Refer to your machine manual.

Your machine tool builder configures and enables the
Kinematics selection function.

NOTICE

Danger of collision!

All stored kinematics can also be selected as active machine
kinematics. By this means, all manual movements and
machining operations are executed using the selected
kinematics. All subsequent axis movements pose a risk of
collision!

> Use the Kinematics selection function only in the Test Run
operating mode

> Use the Kinematics selection function for selecting the
active machine kinematics only as needed

You can use this function to test NC programs whose kinematics
does not match the active machine kinematics. If your machine

tool builder saved different kinematic models in your machine

and enabled them for selection, you can activate one of these
kinematics configurations with the MOD function. When you select
a kinematics model for the test run this does not affect machine
kinematics.

o Ensure that you have selected the correct kinematics
in the Test Run operating mode for checking your
workpiece.
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Entering traverse limits

[ﬁManuaL operation

@ Refer to your machine manual.
Your machine tool builder configures and enables the zs

Traverse limits function. esition dim] . _

Ao Status Lower limit Upper Jimit
< aeoseo] [ a0.0000

.

The Traverse limits MOD function enables you to limit the actually gt | IS
usable traverse path within the maximum range of traverse. This
enables you to define protection zones on each axis in order, B
for example, to protect an indexing head from collision.

To enter traverse limits: E
» In the MOD menu select the Machine settings group s
» Select the Traverse limits menu
> Enter the values of the desired axes as a reference value or load

the momentary position with the actual position capture soft

key
> Press the APPLY soft key
> The control checks the entered values for validity.

> Press the soft key OK

Aty [ emetyan

o2 E
fl®: 5
2= A

i

"
g

PASTE
FIELD

EMPTY
EVERYTHING

CANCEL

v
FIELD

6 Operating notes:

B The protection zone becomes active automatically as
soon as you have set a valid traverse limit in an axis.
The settings are kept even after the control has been
restarted.

®E You can only deactivate the protection
zone by deleting all values or pressing the
EMPTY EVERYTHING soft key.
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Generating a tool usage file

@ Refer to your machine manual.

The tool usage test function must be enabled by your
machine tool builder.

With the Tool-usage file MOD function, you can select whether
the control never, once, or always creates a tool usage file.

Generate a tool usage file:
» In the MOD menu, select the Machine settings group
» Select the Tool-usage file menu

> Select the desired setting for the Program Run, Full Sequence/
Single Block and Test Run operating modes

> Press the APPLY soft key
» Press the OK soft key
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Permitting or restricting external access

[iManua! operation

@ Refer to your machine manual.
The machine tool builder can configure the external sassinge 10 ororancion

Position disp]|

access options.

@ Extornal accass permitted

CompuTa: - 3ECITIC ACCesS Ies: e

@
@ ons [ ne triction
B General information | $SCE1VATed by the mechine manufasturer.

With the External access MOD function, you can grant or restrict
access to the control. Once you have restricted external access,

it is no longer possible to connect to the control and to exchange B g 1
data over a network or over a serial connection (e.g., with the M’_, =
TNCremo software). o &

Proceed as follows to restrict external access:

» In the MOD menu, select the Machine settings group
» Select the External access menu

> Set the EXTERNAL ACCESS ON/OFF soft key to OFF
> Press the OK soft key
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Computer-specific access control

If your machine tool builder has set up computer-specific access
control (machine parameter CfgAccessControl no. 123400), you can
permit access for up to 32 connections authorized by you.

Proceed as follows:

» Select Add to create a new connection
> The control opens an input window for you to enter the

connection data.

Access settings

Host name Host name of the external
computer

Host IP Network address of the exter-
nal computer

Description Additional information (text is
shown in the overview list)

Type:

Ethernet Network connection

Com 1 Serial interface 1

COM 2 Serial interface 2

Access rights:

Inquire For external access, the
control opens a query dialog

Deny Do not permit network access

Permit Permit network access without

If you assign the Inquire access right to a connection, and if access

query

is gained from this address, then the control opens a pop-up
window. You must permit or deny external access in the pop-up

window:

External access Permission

Yes Permit once

Always Permit continuously
Never Deny continuously
No Deny once

In the overview list, an active connection is shown with
a green symbol.

246

[iManual operation

Position disp]|

O Machine settings
K tics.

@ Special
B Diagnostic functions
B General information

5
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Host computer operation

@ Refer to your machine manual.

This function must be enabled and adapted by the
machine tool builder.

With the HOST COMPUTER MODE soft key you transfer the
command to an external host computer in order to transfer data to
the control, for example.

The requirements to be met for starting host computer mode
include the following:

® Dialogs, such as GOTO or Block Scan are closed

® No program run is active

® Handwheel is inactive

Proceed as follows to start the host computer mode:

> In the MOD menu, select the Machine settings group
» Select the External access menu

» Press the HOST COMPUTER MODE soft key

>

The control shows an empty screen with the Host computer is
active pop-up window.

@ Your machine tool builder can specify that the host
computer mode can automatically be activated
externally.

Exit the host computer mode as follows:
» Press the HOST COMPUTER MODE soft key again

HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018 247



MOD functions | Configuring the HR 550FS radio handwheel

8.10 Configuring the HR 550FS radio
handwheel

Application

o This setup dialog is managed by the HEROS operating
system.
After you have changed the conversational language on
your control, you need to restart the control to enable
the new language.

To configure the HR 550FS radio handwheel, use the
SET UP WIRELESS HANDWHEEL soft key. The following functions
are available:

B Assigning the handwheel to a specific handwheel holder
m Setting the transmission channel

®  Analyzing the frequency spectrum for determining the optimum
transmission channel

® Selecting transmitter power
m Statistical information on the transmission quality

0 Any changes or modifications that were not expressly
approved by the party responsible for conformity could
void your authority to operate the device.

This device complies with Part 15 of the FCC Rules
and the RSS standard(s) of Industry Canada for license-
exempt equipment.

Operation is subject to the following conditions:

1 This device must not cause any harmful interference,
and

2 this device must accept any interference received,
including interference that may cause undesired
operation.

Assigning the handwheel to a specific handwheel

holder
» Make sure that the handwheel holder is connected to the Configuration of wireless handvheel
onpemzsm
control hardware.
. . handwheel serial no. 0037478964 - Connect HW Data packets 12023
» Place the wireless handwheel you want to assign to the e , | tospsces o oo
handwheel holder in the handwheel holder canuuis o om0 oo
Transmitter power Full power Set power Max. successi ive lost 0
» Press the MOD key to select the MOD function —
» Select the Machine settings menu wu[ou -
Stop HW End

» Select the configuration menu for the radio handwheel: Press
the SET UP WIRELESS HANDWHEEL soft key

» Click on the Connect HW button

> The control saves serial number of the inserted radio
handwheel and shows it in the configuration window on the
left next to the Connect HW button.

» Save the configuration and close the configuration menu:
Press the END button
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Setting the transmission channel

If the wireless handwheel is started automatically, then the

control tries to select the transmission channel providing the best
transmission signal. Proceed as follows if you want to set the radio
channel yourself:

> Press the MOD key to select the MOD function
» Select the Machine settings menu

» Select the configuration menu for the radio handwheel: Press
the SET UP WIRELESS HANDWHEEL soft key

» Click the Frequency spectrum tab
» Click the Stop HW button

> The control stops the connection to the wireless handwheel and
determines the current frequency spectrum for all 16 available
channels.

» Memorize the number of the channel with the least amount of
radio traffic (smallest bar)

» Click the Start handwheel button to reactivate the radio
handwheel

Click the Properties tab
Click the Select channel button
The controls shows all available channel numbers

Click the number of the channel that the control has found to
have the least amount of radio traffic

To save the configuration and exit the configuration menu, press
the END button

vvVvyy

v

Selecting the transmitter power

Configuration of wireless handwheel =83

o A reduction in transmission power decreases the range
of the wireless handwheel.

> Press the MOD key to select the MOD function
> Select the Machine settings menu

» Select the configuration menu for the radio handwheel: Press
the SET UP WIRELESS HANDWHEEL soft key

> Click the Set power button

> The control displays the three available power settings. Click
on the desired setting.

» To save the configuration and exit the configuration menu,
press the END button

Properes Fiequeney spectum
Configuration Statistics
handwheel serial no. 0037478964 [ ConnecthW|  Data packets 12023
[ oeymRe]
f Lost packets ) 0.00%
Channelinuse 24 CRC ermor 0 0.00%
Transmitter power  Full power Setpower Max. successive lost [0
HWin charger
Staws
HANDWHEEL ONLINE Error code
[ swpuw | | Starthandwheel | e 4
Configuration of wireless handwheel e
Properses Frequency specrum
ch 1l R 13 1 15 16 17 18 19 20 2 2 23 24 2 2
0dBm
50 d&m
100 d8m |
aa (89 |[s9 |[es |[8s |[80 |[we |[s9 |[74 |[9 |[s3 |[s5 |[83 |[m0 |[s9 [0 |[-74
Status
HANDWHEEL OFFLINE Error code
© swpHwW | y [ e
Conf of wireless )
Proeries Fiequency specnm
Configuration Statistics
handwheel serial no. 0037478964 | ConnecthW.|  Data packets 12023
f Lost packets ) 0.00%
Channelinuse 24 CRC ermor ) 0.00%
Transmitter power  Full power [“setpower | Max.success ivelost |0
HWin charger =
Staws
HANDWHEEL ONLINE Error code
- sopHw | | Starthandwheel | e 4
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Statistical data

To display the statistical data, proceed as follows: st of wireless handnes T
» Press the MOD key to select the MOD function CE::::::'"*“'“ e
» Select the Machine settings menu - - e
» Select the configuration menu for the radio handwheel: Press — . B

the SET UP WIRELESS HANDWHEEL soft key - —
> The control displays the configuration menu with the statistical =T R .

data.

Under Statistics, the control displays information about the
transmission quality.

If the reception quality is poor so that a proper and safe stop of the
axes cannot be ensured anymore, an emergency-stop reaction of
the wireless handwheel is triggered.

The displayed value Max. successive lost indicates whether
reception quality is poor. If the control repeatedly displays values
greater than 2 during normal operation of the radio handwheel
within the desired range of use, then there is a high risk of an
undesired disconnection. This can be corrected by increasing the
transmitter power or by changing to another channel with less radio
traffic.

If this occurs, try to improve the transmission quality by selecting
another channel or by increasing the transmitter power.

Further information: "Setting the transmission channel", Page 249
Further information: "Selecting the transmitter power", Page 249
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8.11 Changing the system settings

Set the system time

With the Set the system time MOD function you can set the
time zone, date and time manually or by means of an NTP server
synchronization.

Proceed as follows to set the system time:

> In the MOD menu, select the System settings group
> Press the SET DATE/ TIME soft key

» In the Time zone area, select the desired time zone
>

Press the NTP on soft key in order to select the Set the time
manually entry

Change the date and time as needed

Press the OK soft key

To set the system time with the aid of an NTP server:

In the MOD menu, select the System settings group
Press the SET DATE/ TIME soft key

In the Time zone area, select the desired time zone

Press the NTP off soft key in order to select the Synchronize
the time over NTP server entry

Enter hostnames or the URL of an TNP server
Press the Add soft key
» Press the OK soft key

vy

vV vyYwvy

A 4

8.12 Displaying operating times

Application

The MACHINE TIME MOD function enables you to see various [@vanuar oporation
types of operating times:

g &)
Operating time Meaning ‘
Control on Opgrating time of the control since being @“N
put into service ha j

Machine on Operating time of the machine tool since e = e
being put into service = s

Program run Duration of controlled operation since P = ;
being put into service - “ “ ” H “ " - ]

@ Refer to your machine manual.

The machine tool builder can provide further operating
time displays.
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9.1 Window manager

@ Refer to your machine manual.

The machine tool builder determines the scope of
function and behavior of the window manager.

The control features the Xfce window manager. Xfce is a standard
application for UNIX-based operating systems, and is used to
manage graphical user interfaces. The following functions are
possible with the window manager:

m Display a task bar for switching between various applications
(user interfaces)

= Manage an additional desktop, on which special applications
from your machine manufacturer can run

® Control the focus between NC software applications and those
of the machine manufacturer

B You can change the size and position of pop-up windows. It is
also possible to close, minimize and restore pop-up windows

o The control shows a star in the upper left of the screen
if an application of the window manager or the window
manager itself has caused an error. In this case, switch
to the window manager and correct the problem. If
required, refer to your machine manual.
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Overview of taskbar

In the task bar you can choose different workspaces by mouse [@vanuar oporation @ﬁm
click. ,

The control provides the following workspaces: T T @
= Workspace 1: Active operating mode +0.000

®m \Workspace 2: Active programming mode —+85.854 -

® \Workspace 3: or applications of the machine tool builder

- 1~ <
1
(6)]
o
o
o
dI:F
=]

(optionally available) - —
B Workspace 4: applications of the machine tool builder (optionally e o :
available) ,17 - &
In addition, you can also select other applications from the task bar e R :
> o e [

which you have started in parallel to the control software, e.g. the
TNCguide.

o You can randomly move all open applications to the
right of the green HEIDENHAIN symbol between the
workspaces by pressing and holding the left mouse
button.

Click the green HEIDENHAIN symbol to open a menu in which you
can get information, make settings or start applications.

The following functions are available:

= About HEROS: Open information about the operating system of
the control

® NC Control: Start and stop the control software (for diagnostic
purposes only)

B Web Browser: Start the web browser
® Diagnostic: Diagnostic applications

B GSmartControl: Available only to authorized specialists
HE Logging: Define settings for internal diagnostic files
HE Menu: Available only to authorized specialists
perf2: Check processor load and process load

Portscan: Test active connections
Further information: "Portscan", Page 258

Portscan OEM: Available only to authorized specialists

B RemoteService: Start and stop remote maintenance
Further information: "Remote Service", Page 259

= Terminal: Enter and execute console commands
m Settings: Operating system settings
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Date/Time: Set date and time

Language/Keyboards: Select system dialog language and
keyboard version—the control overwrites the setting of the
system dialog language when starting with the language
setting of the machine parameter CfgDisplayLanguage (no.
101300)

Network: Define network settings

Printer: Configure and manage printer
Further information: "Printer", Page 261

Screensaver: Setting the screensaver

Further information: "Screensaver with lockout",
Page 316

Current User: Show the current user
Further information: "Current User", Page 318
UserAdmin: Configure the user administration

Further information: "Configuring the user administration”,
Page 293

OEM Function Users: Edit the OEM function users

Further information: "HEIDENHAIN function users",

Page 304

SELinux: Define safety software for Linux-based operating
systems

Shares: Connect and manage external network drives

State Reporting Interface (option 137): Activate the SRI and
clear the status data

Further information: "State Reporting Interface (option
137)", Page 264

VNC: Define the setting for external software accessing
the control for e.g. maintenance work (Virtual Network
Computing)

Further information: "VNC', Page 267
WindowManagerConfig: Available only to authorized
specialists

Firewall: Configure the firewall

Further information: "Firewall", Page 273

HePacketManager: Available only to authorized specialists

HePacketManager Custom: Available only to authorized
specialists

® Tools: File applications

256

Document Viewer: Display and print files, e.g. PDF files
File Manager: Available only to authorized specialists
Geeqie: Open, manage, and print graphics

Gnumeric: Open, edit, and print tables

Keypad: Open virtual keyboard

Leafpad: Open and edit text files

NC/PLC Backup: Create backup file
Further information: "Backup and restore", Page 270

NC/PLC Restore: Restore backup file
Further information: "Backup and restore", Page 270

QupZilla: Alternative web browser for touch operation

HEROS functions | Window manager
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Ristretto: Open graphics

Screenshot: Create screenshots
TNCguide: Call up help system

Xarchiver: Extract or compress directories

Applications: Supplementary applications
® Orage Calender: Open calendar

m Real VNC viewer: Define the setting for external software
accessing the control for e.g. maintenance work (Virtual
Network Computing)

® Shutdown: Shut down the control

Further information: "Switching or logging out users",
Page 315

o The applications available under tools can be started
directly by selecting the corresponding file type in the
file management of the control
Further information: "Additional tools for management
of external file types", Page 73
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Portscan

The PortScan function enables the cyclic or manual searching for

all open, incoming TCP and UDP list ports on the system. All ports

found are compared with whitelists. If the control finds a non-listed

port it shows a corresponding pop-up window.

The HeROS Diagnostic menu contains the Portscan and Portscan

OEM applications for this purpose. Portscan OEM is only executable

after entering the machine manufacturer password.

The Portscan function searches for all open, incoming TCP and

UDP ports on the system and compares them to four whitelists

stored in the system:

®  System-internal whitelists /etc/sysconfig/portscan-
whitelist.cfg and /mnt/sys/etc/sysconfig/portscan-
whitelist.cfg

= \Whitelist for ports with machine manufacturerspecific
functions, e.g. for Python and DNC applications: /mnt/plc/etc/
sysconfig/portscan-whitelist.cfg

= Whitelist for ports with customerspecific functions: /mnt/tnc/
etc/sysconfig/portscan-whitelist.cfg

For each entry, the whitelist specifies the type of port (TCP/UDP),

the port number, the providing program, and optional comments.

If the automatic port scan function is active, only ports listed in

the whitelists can be open. Non-listed ports trigger a notification

window.

The result of the scan is saved to a log file (LOG:/portscan/scanlog

and LOG:/portscan/scanlogevil), and if new ports are found that are

not listed in one of the whitelists these are displayed.

Manually starting Portscan
Proceed as follows to manually start the Portscan:

> Taskbar at the bottom edge of the screen
Further information: "Window manager", Page 254

Press the green HEIDENHAIN button to open the JH menu
Select the Diagnostic menu item

Select the Portscan menu item

The control opens the HeRos Portscan pop-up window.
Press the Start key

vV VvV VvyvVvyy

Cyclically starting Portscan
Proceed as follows to automatically start the Portscan cyclically:

» Taskbar at the bottom edge of the screen
Further information: "Window manager", Page 254

Press the green HEIDENHAIN button to open the JH menu
Select the Diagnostic menu item

Select the Portscan menu item

The control opens the HeRos Portscan pop-up window.
Press the Automatic update on key

Set the time interval with the slider

vV v Vv vVvyVvyy

HEROS functions | Window manager
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Remote Service

Together with the Remote Service Setup Tool, the TeleService from
HEIDENHAIN enables encrypted end-to-end connections to be
established between a service computer and the machine tool.

To enable the HEIDENHAIN control to communicate with the
HEIDENHAIN server, the control needs to be connected to the
Internet.

Further information: "General network settings", Page 283

In its basic state the firewall of the control blocks all incoming and
outgoing connections. Therefore, the firewall settings must be
adjusted or the firewall must be deactivated for the duration of the
service session.

Setting up the control

Proceed as follows to deactivate the firewall: Firewall/ssH settings
» Taskbar at the bottom edge of the screen R

B3

Further information: "Window manager", Page 254 E;‘zm.ﬂmm

[ it ICHP cho answer

imerace [0 g

Press the green HEIDENHAIN button to open the JH menu e e 5

Computer Descrption

Select the Settings menu item
Select the Firewall menu item = [P ‘
The control displays the Firewall settings dialog. |

Deactivate the firewall by removing the Active option in the
Firewall tab.

vV VvV VvyvVvyy

v

SMB (CIFS) Senver

SSH server

VNC server

Used for HEIDENHAIN Teleservice:
temoNT.

Press the Apply button to save the settings
Press the OK button B

v

[ ) @ || @ |

> The firewall is disabled.

o Do not forget to activate the firewall again after the end
of the service session.

o Alternative procedure for deactivating the firewall

The remote diagnosis via the TeleService PC software
uses the LSV2 service and this service must therefore
be permitted in the firewall settings.

The following deviations from the firewall default
settings are required:
» Set the method to Permit some for the LSV2 service

» Enter the name of the service computer in the
Computer column

The access security is ensured through the network
settings. The network security is the responsibility of
the machine tool builder or the respective network
administrator.

Automatic installation of a session certificate

With an NC software installation a temporary certificate is
automatically installed on the control. An installation, also in the
form of an update, may only be carried out by a service technician
from the machine tool builder.
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Manual installation of a session certificate

A new certificate must be installed if no valid session certificate e
is installed on the control. Clarify which certificate is needed R P —
with your service employee. He will then provide you with a valid ol .
certificate file if necessary. =

Proceed as follows to install the certificate on the control:

> Taskbar at the bottom edge of the screen
Further information: "Window manager", Page 254 s .

Press the green HEIDENHAIN button to open the JH menu == == =
Select the Settings menu item

Select the Network menu item

The control displays the Network settings dialog.

Select the Internet tab. The settings in the Remote
maintenance field are configured by the machine tool builder.

Press the Add button

Select the file in the selection menu

Press the Open key

The certificate is opened.

Press the OK soft key

It may be necessary to restart the control to load the settings

VvV VvyyvVYyy
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Launching the service session

Proceed as follows to start the service session:

» Open the task bar at the bottom edge of the screen

Press the green HEIDENHAIN button to open the JH menu
Select the Diagnostic menu item

Select the RemoteService menu item

Enter the Session key of the machine tool builder

vV vYvyy
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Printer

The Printer function in the HeROS menu enables you to add and
manage printers.

Displaying the printer settings
Proceed as follows to access the printer settings:

» Open the task bar at the bottom edge of the screen
Further information: "Window manager", Page 254

Press the green HEIDENHAIN button to open the JH menu
Select the Settings menu item

Select the Printer menu item

The control opens the Heros Printer Manager pop-up window.

v v v Yy

The name of the printer is displayed in the input field.

Soft key Meaning

CREATE Creates the printer named in the input field

CHANGE Modifies the properties of the selected printer

COPY Creates the printer named in the input field with the attributes of the selected printer
This can be useful if printing both portrait and landscape formats on the same printer

DELETE Deletes the selected printer

uP Selects the desired printer

DOWN

STATUS Displays status information of the selected printer

PRINT Prints a test page on the selected printer

TEST PAGE
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For each printer, the following attributes can be set:

Setting

Meaning

Name of the printer

The printer name can be changed here.

Connection Here, you can select the connection type
m USB: The USB connection can be assigned here. The name is displayed
automatically.
®m Network: Enter the network name or the IP address of the target printer here. In
addition, specify the port of the network printer here (default: 9100)
= Printer not connected
Timeout Defines the delay to printing after the last change has been made to the file to be

printed in PRINTER:. This can be useful if the file to be printed is populated with data
by using FN functions, e.g. during probing.

Standard printer

Select to define the standard printer in case several printers are available. Is defined
automatically when creating the first printer.

Settings for printing of
text

These settings are applicable when printing text documents:
Paper size

Number of copies

Job name

Font size

Header

Print options (black and white, color, duplex)

Orientation

Portrait, landscape for all printable files

Expert options

Print options:

Available only to authorized specialists

®m Copying of the file to be printed in PRINTER:
The file to be printed is automatically forwarded to the standard
printer and deleted from the directory after the print job has

been executed

® Using the FN 16: F-PRINT function

List of printable files:
= Text files

® Graphic files

m PDF files

o The connected printer must be PostScript-enabled.
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SELinux security software

SELinux is an extension for Linux-based operating systems.
SELinux is an additional security software package based on
Mandatory Access Control (MAC) and protects the system against
the running of unauthorized processes or functions and therefore
protects against viruses and other malware.

MAC means that every action must be explicitly permitted,
otherwise it will not be executed by the control. The software is
intended as protection in addition to the normal access restriction
in Linux. Certain processes and actions can only be executed if the
standard functions and access control of SELinux permit it.

o The SELinux installation of the control has been
prepared to permit running only programs installed with
the HEIDENHAIN NC software. Other programs cannot
be run with the standard installation.

The access control of SELinux under HEROS 5 is regulated as
follows:

B The control executes only applications that are installed with the
HEIDENHAIN NC software

® Files in connection with the security of the software (SELinux
system files, HEROS 5 boot files, etc.) may only be changed by
programs that are selected explicitly

= New files generated by other programs must never be executed

®m USB data carriers cannot be deselected

® There are only two processes that are permitted to execute new
files:

®  Starting a software update: A software update from
HEIDENHAIN can replace or change system files

® Starting the SELinux configuration: The configuration of
SELinux is usually password-protected by your machine
manufacturer; refer here to the relevant machine manual

6 HEIDENHAIN recommends activating SELinux because
it provides additional protection against attacks from
outside.
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Introduction

With production lot sizes becoming ever smaller and products
becoming increasingly customized, systems for production data
acquisition are becoming increasingly important.

The operating resource data—as one of the most important parts
of production data acquisition—describe the states of an operating
resource along the time scale. For machine tools, the idle times
and run times as well as information about pending faults are
recorded. An evaluation per workpiece can also be made when the
active NC programs are additionally taken into account.

One of the most common applications of production data
acquisition is the determination of equipment effectiveness. The
term Overall Equipment Effectiveness (OEE) is a measure of
the value added of equipment. It provides information about the
productivity of equipment as well as its losses at a glance.

With the State Reporting Interface (SRI), HEIDENHAIN offers a
simple and reliable interface for acquiring the operating states of
your machine.

In contrast to other common interfaces, SRl also provides

"historical" operating data. Even if your company network fails for
several hours, your valuable operating data will not be lost.

o A buffer memory that contains 2x 10 000 entries is
available for storing the historical operating states. An
entry corresponds to a status change in this context.

HEROS functions | Window manager
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Configuring the control
Adjusting the firewall settings:

The State Reporting Interface uses TCP Port 19090 to transfer
the acquired operating states.

Accesses to the SRI from the company network (X26 connection)
must be permitted in the firewall settings.

» Allow SRI
Further information: "Firewall", Page 273

o If the SRl is accessed locally via an IPC connected to
the machine network (X116), ethO (X26) can also remain
locked.

Activating the State Reporting Interface:

In the control's factory default setting, the SRl is deactivated.
> Press the DIADUR key to open the HEROS menu

> Select the Settings menu item

> Select the State Reporting Interface menu item

>

Activate the State Reporting Interface in the SRI pop-up
window

)
Start browser on SRI —|
i Firgion e A 1 i

Please also look at firewall settings

[/ angenden | [ 490k | [ @ abbrechen |

1

Further information: "Overview of taskbar", Page 255

To clear all previous operating states, use the
Clear historical data button.
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Acquiring operating states
The State Reporting Interface uses the Hypertext Transfer
Protocol (HTTP) to transfer the operating states.

With the following URLs (Uniform Resource Locator), you can
access the operating states of your control using any web browser.

®  http://<hostname>:19090/sri for accessing all pieces of
information (max. 20 000 entries)

®  http://<hostname>:19090/sri?lineno=<line> for accessing the
most recent pieces of information

Configuring URL:

» Replace the <hostname> by your control's network name
» Replace <line> by the first line to be retrieved

> The control transmits the requested data.

<htm >
<head></ head>
<body>
<pre style="word-wrap: break-word; white-space: pre-wrap;">

State Reporting Interface: 1.0.6
HOST: XXX
HARDWARE: MC64XX 0.1
SOFTWARE: 340590 09
1 ; 2018-07-04 ; 09:52:22 ; TNC:\nc_prog\TS. h ; SUSPEND

; 2018-07-04 ; 09:52:28 ; TNC:\nc_prog\demo\ Start_demo. h ; SUSPEND
; 2018-07-04 ; 09:52:30 ; TNC:\nc_prog\demo\ Start_denmo. h ; OPERATE
; 2018-07-04 ; 09:52:35 ; TNC:\nc_prog\deno\Start_denmo. h ; ALARM

; 2018-07-04 ; 09:52:40 ; TNC:\nc_prog\demo\ Start_demo. h ; SUSPEND

; 2018-07-04 ; 09:53:14 ; TNC: \nc_prog\demo\ Start_demo. h ; SUSPEND
; 2018-07-04 ; 09:53:19 ; TNC:\nc_prog\demo\ Start_denmo. h ; OPERATE
2018-07-04 ; 09:53:24 ; TNC:\nc_prog\deno\ Start_denmo. h ; ALARM

2
3
4
5
6 ; 2018-07-04 ; 09:52:49 ; TNC:\nc_prog\$mdi . h ; SUSPEND
7
8
9
e

</ body>
</ htm >

You will find the operating states in the <body> of the HTML file as
CSV contents (Comma Separated Values).

CSV contents:
= Header
Designation Meaning
State Reporting Inter- Version of the interface.
face: The version number should be taken into account in the evaluation of the data
to ensure downward compatibility in your application.
SOFTWARE: Software of the connected control.
HOST: Full network name of the connected control.
HARDWARE: Hardware of the connected control.
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® QOperating data

Contents Meaning

1 Consecutive number

2

2018-07-04 Date (yyyy-mm-dd)

09:52:22 Time (hh:mm:ss)

TNC:\nc_prog\TS.h Selected or active NC program

States Status:

= OPERATE B Program run is active

= SUSPEND B Program run stopped without error

= ALARM = Program stopped due to an error
VNC

Use the VNC function to configure the behavior of the various VNC

Manual operation
" Manual opexation

clients. This includes, for example, operation via soft keys, mouse |
and the alphabetic keyboard. | [

The control provides the following options: 2 “a.ano = " et
® List of permitted clients (IP address or name) PR

® Password for the connection e

®  Additional server options

® Additional settings for assigning the focus — e e e e
@ Refer to your machine manual. L_ 5; B —

For multiple clients or operating units, the focus e [ o [ | o | | e | oo [ [

assignment procedure depends on the design and the
operating situation of the machine.

This function must be adapted by your machine
manufacturer.
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Opening the VNC settings
Proceed as follows to open the VNC settings:

» Open the task bar at the bottom edge of the screen
Further information: "Window manager", Page 254

Press the green HEIDENHAIN button to open the JH menu
Select the Settings menu item
Select the VNC menu item

v v v Yy

The control opens the VNC Settings pop-up window.
The control provides the following options:
= Add: Add new VNC viewer/client

® Remove: Deletes the selected client. Only possible with
manually entered clients.

®  Edit: Edit the configuration of the selected client

m Update: Updates the display. Required with connection
attempts during which the dialog is open.

VNC settings
Dialog Option Meaning
VNC client settings Computer name: |IP address or computer name
VNC: Connection of the client to the VNC viewer
VNC Focus The client participates in the focus assignment
Type = Manual
Manually entered client
® Denied

This client is not permitted to connect

® Enable TeleService and IPC
Client via TeleService connection

= DHCP
Other computer that obtains an IP address from this
computer
Firewall warning Warnings and information about if the VNC protocol has not
been authorized for all VNC clients due to firewall settings on
the control.

Further information: "Firewall", Page 273.

Global settings Enable TeleService Connection is always permitted
and IPC
Password The client must enter a password for verification. If this option
verification is active, the password must be entered when the connection

is made.
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Dialog Option Meaning

Enabling other VNC Deny Access generally denied to all other VNC clients.

Inquire During connection attempts a corresponding dialog is opened.
Permitted Access is generally granted to all other VNC clients.

VNC Focus Settings Enabling VNC focus Enable focus assignment for this system. Otherwise there is
no central focus assignment. In the default setting, the focus
is actively reassigned by the owner of the focus by clicking the
focus symbol. This means that the owner of the focus must
first release the focus by clicking the focus symbol before any
other client can retrieve the focus.

Enabling In the default setting, the focus is actively reassigned by the

concurrency VNC
focus

owner of the focus by clicking the focus symbol. This means
that the owner of the focus must first release the focus by
clicking the focus symbol before any other client can retrieve
the focus. If concurrency focus is selected, any client can
retrieve the focus at any time without having to wait for the
current owner of the focus to release it.

Timeout
Concurrency VNC
Focus

Time period within which the current owner of the focus
can object to the focus being withdrawn or can prevent the
reassignment of the focus. If a client requests the focus, a
dialog in which the reassignment of focus can be refused
appears on all clients' screens.

Focus symbol

Current status of VNC focus on the respective client: Focus
is owned by other client. Mouse and alphabetic keyboard are
disabled.

e — W]

Current status of VNC focus on respective client: Focus is
owned by current client. Entries can be made.

Current status of VNC focus on the respective client: Request
by the owner of the focus to give the focus to another client.
Mouse and alphabetic keyboard are disabled until the focus is
assigned unambiguously.

If Enable concurrency VNC focus is selected, a pop-up window
appears. This dialog makes it possible to refuse that the focus be
given to the requesting client. If this does not occur, the focus
changes to the requesting client after the set time limit.
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Backup and restore

With the NC/PLC Backup and NC/PLC Restore functions you can
back up and restore individual folders or the complete TNC drive.
You can save the backup files locally, on a network drive, or to USB
storage devices.

The backup program generates a *. tncbck file that can also be
processed by the PC tool TNChackup (part of TNCremo). The
restore program can restore these files as well as those from
existing TNCbackup programs. If a *. tncbck file is selected in
the file manager of the control, the program NC/PLC Restore is
automatically launched.

Backup and restore is subdivided into several steps. Navigate
between these steps with the FORWARD and BACK soft keys.
Specific actions for steps are selectively displayed as soft keys.

Opening NC/PLC Backup or NC/PLC Restore
Proceed as follows to open the functions:

» Open the task bar at the bottom edge of the screen
Further information: "Window manager", Page 254

Press the green HEIDENHAIN button to open the JH menu
Select the Tools menu item

Open the NC/PLC Backup or NC/PLC Restore menu item
The control opens the pop-up window.

v v v Yy
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Backing up data
To backup data from the control, proceed as follows:
» Select NC/PLC Backup
> Select the type
B Back up the TNC partition

® Back up the directory tree: Select the directory for backup in
the file management

® Back up the machine configuration (for machine tool builders
only)

® Complete backup (for machine tool builders only)
® Comment: Freely configurable comment for the backup
> Select the next step with the FORWARD soft key

» Stop the control if required with the STOP NC SOFTWARE soft
key

> Define the exclusion rules

m Use preset rules

= \Write own rules to the table

Select the next step with the FORWARD soft key
The control generates a list of files for backing up.
Check the list. Deselect files if necessary.

Select the next step with the FORWARD soft key
Enter the name of the backup file

Select the storage path

Select the next step with the FORWARD soft key
The control generates the backup file.

Confirm with the OK soft key

The control concludes the backup process and restarts the NC
software.

V V.V V¥V VvV VVVY
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Restoring data

NOTICE

Caution: Data may be lost!

When you restore data (Restore function), any existing data will
be overwritten without a confirmation prompt. Existing data is
not automatically backed up by the control before running the
restore process. Power failures or other problems can interfere
with the data restore process. As a consequence, data may be
irreversibly damaged or deleted.

> Before starting the data restore process, make a backup of
the existing data

To restore the data proceed as follows:

Select NC/PLC Restore

Select the archive to be restored

Select the next step with the FORWARD soft key
The control generates a list of files for restoring.
Check the list. Deselect files if necessary.
Select the next step with the FORWARD soft key

Stop the control if required with the STOP NC SOFTWARE soft
key

Extract the archive

The control restores the files.
Confirm with the OK soft key

The control restarts the NC software.

vV v vV VvYVvy

v v VY
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9.2 Firewall

Application

You can set up a firewall for the primary network interface of the
control. It can be configured so that incoming network traffic is
blocked and/or a message is displayed, depending on the sender
and the service. The firewall cannot be started for the secondary
network interface of the control.

Once the firewall has been activated, a symbol appears at the
lower right in the taskbar. The symbol changes depending on the
safety level that the firewall was activated with, and informs about
the level of the safety settings:

lcon Meaning

Firewall protection does not yet exist
| U W although it has been activated accord-
ing to the configuration. This can happen,
for example, if PC names for which there are

no equivalent IP addresses as yet were used
in the configuration.

@ @ Firewall active with medium security level
Firewall active with high safety level. (All
@ [@ services except for the SSH are blocked)

o Have your network specialist check and, if necessary,
change the standard settings.

Configuring the firewall
Make your firewall settings as follows:

» Use the mouse to open the task bar at the bottom edge of the
screen
Further information: "Window manager", Page 254

» Press the green HEIDENHAIN button to open the JH menu
> Select the Settings menu item
> Select the Firewall menu item.

HEIDENHAIN recommends activating the firewall with the
prepared default settings:

» Select the Active option to enable the firewall

> Press the Set standard values button to activate the default
settings recommended by HEIDENHAIN.

» Confirm the changes with Apply
» Close the dialog with OK.
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Option Meaning
Active Switching the firewall on and off
Interface Selection of the eth0 interface usually corresponds to X26 of the MC main

computer. eth1 corresponds to X116. You can check this in the network
settings on the Interfaces tab. For main computer units with two Ethernet
interfaces, the DHCP server for the machine network is active for the second
(non-primary) interface by default. With this setting the firewall cannot be
activated for eth1 because the firewall and DHCP server mutually exclude
each other.

6 To configure the sandbox, you use the optional interface brsbO.
Further information: "Sandbox tab", Page 288

Report other inhibited packets

Firewall active with high safety level. (All services except for the SSH are
blocked)

Inhibit ICMP echo answer

If this option is set, the control no longer responds to a PING request

Service

This column contains the short names of the services that are configured
with this dialog. For the configuration it is not important here whether the
services themselves have been started

B LDAPS includes the server on which the user data and the user
administration configuration are saved.

B LSV2 includes the functionality for TNCremo and Teleservice, as well as
the HEIDENHAIN DNC interface (ports 19000 to 19010)

® SMB only refers to incoming SMB connections, i.e. if a Windows release is
made on the NC. Outgoing SMB connections (i.e. if a Windows release is
connected to the NC) cannot be prevented.

® SRl refers to the connections that are used in conjunction with the
acquisition of operating states through the State Reporting Interface
option.

® SSH stands for the Secure Shell protocol (port 22). As of HEROS
504, LSV2 can be executed securely via this SSH protocol while user
administration is active.

Further information: "DNC connection with user authentication”,
Page 310

B VNC protocol means access to the screen contents. If this service is
blocked, the screen content can no longer be accessed, not even with the
TeleService programs from HEIDENHAIN (e.g. screenshot). If this service
is blocked, the VNC configuration dialog shows a warning from HEROS
that VNC is disabled in the firewall.

Method

Use Method to configure whether the service is inaccessible for all (Prohib-
it all), accessible for all (Permit all) or only accessible for individuals (Permit
some). If you set Permit some you must also specify the computer (under
Computer) that you wish to grant access to the respective service. If you

do not specify any computer under Computer, the setting Prohibit all will
automatically become active when the configuration is saved.

Log

If Log is activated, a red message is output if a network packet for this
service was blocked. A (blue) message is output if a network packet for this
service was accepted
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Option Meaning

Calculator If the setting Permit some is selected under Method, the relevant computers
can be specified here. The computers can be entered with their IP address-
es or host names separated by commas. If a host name is used, the system
checks upon closing or saving of the dialog whether the host name can be
translated into an IP address. If this is not the case, an error message is
displayed and the dialog does not terminate. If a valid host name is specified,
this host name is translated into an IP address each time the control is start-
ed. If a computer that was entered with its name changes its IP address, you
may have to restart the control or formally change the firewall configuration
to ensure that the control uses the new IP address for a host name in the

firewall.
Advanced options These settings are only intended for your network specialists
Set standard values Resets the settings to the default values recommended by HEIDENHAIN
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9.3 Setting up data interfaces

Serial interfaces on the TNC 128

The TNC 128 automatically uses the LSV2 transmission protocol
for serial data transfer. The LSV2 protocol is prescribed and cannot
be modified apart from setting the baud rate (machine parameter
baudRateLsv2, no. 106606). You can also define another type of
data transfer (interface). The settings described below are therefore
effective only for the respective newly defined interface.

Application
To set up a data interface, press the MOD key. Enter the code [ERFEsSEs s o @%ecrine perenotor programing B
number 123. In the CfgSeriallnterface (no. 106700) machine

parameter, you can enter the following settings:

* BAUD_57600.
BLOCKWISE
7 o1t

: EVEN

= Number of stop bits i1 Stop-Bit

King

e
e :|
—

PAGE

=

PAGE.

}

Setting the RS-232 interface

Open the RS232 folder. The control then displays the following
settings:

Set BAUD RATE
(baud rate no. 106701)

You can set the BAUD RATE (data transfer speed) from 110 to 115
200 baud.

276 HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018



HEROS functions | Setting up data interfaces

Set protocol
(protocol no. 106702)

The data transfer protocol controls the data flow of a serial
transmission (comparable to MP5030 of the iTNC 530).

o Operating notes:

B The BLOCKWISE setting designates a type of data
transfer in which the data is transferred grouped in
blocks.

® The BLOCKWISE setting does not correspond to the
data reception in blocks nor to the simultaneous
execution of older contouring controls in blocks. This
function is no longer available for current controls.

Data transmission protocol Selection
Standard data transmission (transmission STANDARD
line-by-line)

Packet-based data transfer BLOCKWISE
Transmission without protocol (only charac- RAW_DATA

terby-character)

Set data bits
(dataBits no. 106703)

By setting the data bits you define whether a character is
transmitted with 7 or 8 data bits.

Check parity

(parity no. 106704)

The parity bit helps the receiver to detect transmission errors. The
parity bit can be formed in three different ways:

= No parity (NONE): There is no error detection

® Even parity (EVEN): Here there is an error if the receiver finds
that it has received an odd number of set bits

®  Odd parity (ODD): Here there is an error if the receiver finds that
it has received an even number of set bits

Set stop bits
(stopBits no. 106705)
The start bit and one or two stop bits enable the receiver

to synchronize each transmitted character during serial data
transmission.
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Set handshake
(flowControl no. 106706)
By handshaking, two devices control data transfer between them.

A distinction is made between software handshaking and hardware
handshaking.

= No data flow checking (NONE): Handshaking is not active

B Hardware handshaking (RTS_CTS): Transmission stop is active
through RTS

® Software handshaking (XON_XOFF): Transmission stop is active
through DC3 (XOFF)

File system for file operation
(fileSystem no. 106707)
In fileSystem you define the file system for the serial interface.

This machine parameter is not required if you don't need a special
file system.

® EXT. Minimum file system for printers or non-HEIDENHAIN
transmission software. It corresponds to the EXT1 and EXT2
operating modes on older HEIDENHAIN controls.

® FE1: Communication with the TNCserver PC software or an
external floppy disk unit.

Block check character
(bccAvoidCtriChar no. 106708)
With Block Check Character (optional) no control character, you

determine whether the checksum can correspond to a control
character.

®m TRUE: The checksum does not correspond to a control character
®m FALSE: The checksum can correspond to a control character

Condition of RTS line

(rtsLow no. 106709)

With the state of the RTS line (optional), you can define whether
the LOW level is active in idle state.

® TRUE: Level is LOW in idle state

m FALSE: Level is not LOW in idle state
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Define behavior after receipt of ETX
(noEotAfterEtx no. 106710)
With define behavior after reception of ETX (optional) you

determine whether the EOT character is sent after the ETX
character was received.

= TRUE: The EQT character is not sent
u FALSE: The EQT character is sent

Settings for the transmission of data using PC
software TNCserver

Apply the following settings in machine parameter R$232
(no. 106700):

Parameters Selection

Data transfer rate in baud Has to match the setting in
TNCserver

Data transmission protocol BLOCKWISE

Data bits in each transferred 7 bits

character

Type of parity checking EVEN

Number of stop bits 1 stop bit

Specify type of handshake: RTS_CTS

File system for file operations FE1

Setting the operating mode of the external device
(fileSystem)

o The load all programs, load offered program, and load
directory functions are not available in the FE2 and FEX
operating modes.

Icon External device Operating
mode
PC with TNCremo software LSV2
HEIDENHAIN floppy disk units FE1

Non-HEIDENHAIN devices such as FEX
EE!:' printers, scanners, punchers, PC
without TNCremo
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Software for data transfer

For data transfer to or from the control, you should use the
TNCremo software. With TNCremo, data transfer is possible with
all HEIDENHAIN controls via the serial interface or the Ethernet
interface.

o You can download the current version of the TNCremo
software from the HEIDENHAIN homepage.

System requirements for TNCremo:
m PC with 486 processor or higher

® Windows XP Windows Vista, Windows 7 Windows 8 operating
system

= 16 MB RAM
m 5 MB free memory space on your hard disk
= An available serial interface or connection to the TCP/IP network

Installation under Windows

» Start the SETUREXE installation program with the file manager
(Explorer)

» Follow the setup program instructions

Starting TNCremo under Windows

» Click <Start>, <Programs>, <HEIDENHAIN Applications>,
<TNCremo>

When you start TNCremo for the first time, TNCremo automatically

tries to set up a connection with the control.
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Data transfer between the control and TNCremo

Check whether the control is connected to the correct serial port
on your PC or to the network.

Once you have started the TNCremo software, you will see a list of

Datei Ansicht Exvas Hille

040397 11:3406 Frei. e

all files that are stored in the active directory in the upper section o
. . . . . 0208.97 14:51:30 Insgesar ]B
of the main window 1. Using <File>, <Change directory>, you can w1451 O
select any drive or another directory on your PC. —
. lar i atum <] | Pkt
If you want to control data transfer from the PC, establish the my S — e
connection with your PC in the following manner: e o i e
. . . [1203H 2 2340 06,0499 15.35:46 Baudrate [Auto Detect):
> Select <File>, <Setup connection>. TNCremo now receives the Eo = i e s
file and directory structure from the control and displays this in e = Zoineee
[DNEVabinhrg iy A

the lower part of the main window 2

» To transfer a file from the control to the PC, select the file in the
control window per mouse click and move the highlighted file
into the PC window while holding down the mouse button 1

» To transfer a file from the PC to the control, select the file in the
PC window per mouse click and move the highlighted file into
the control window while holding down the mouse button 2

If you want to control data transfer from the control, establish the
connection with your PC in the following manner:

» Select <Extras>, <TNCserver>. TNCremo then starts in server
mode and can receive data from the control or send data to the
control

» You can now call the file management functions on the control
by pressing the PGM MGT key in order to transfer the desired
files
Further information: "Data transfer to or from an external data
carrier", Page 69

o If you have exported a tool table from the control, then
the tool types are converted to tool type numbers.

End TNCremo
Select <File>, <Exit>

0 You can open the context-sensitive help function of the
TNCremo software by pressing the F1 key.
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Introduction

The control is provided with an Ethernet card as a standard feature
so that you can integrate it into your network as a client.

The control transmits data via the Ethernet card using the following

protocols:

= the smb protocol (Server Message Block) for Windows
operating systems, or

® The TCP/IP protocol family (Transmission Control
Protocol/Internet Protocol) and with support from the NFS
(Network File System)

o Protect your data and your control by running your
machines in a secure network.

Connection possibilities

You can connect the Ethernet card in your control to your network
through the RJ45 connection (X26,1000BaseTX, 100BaseTX and
10BaseT), or directly to a PC. The connection is metallically isolated
from the control electronics.

For a 1000Base TX, 100BaseTX, and 10BaseT connection, use a
twisted-pair cable to connect the control to your network.

o The maximum possible cable length depends on the
quality grade of the cable, the sheathing, and the type of
network (1000BaseTX, 100BaseTX, or 10BaseT)

HEROS functions | Ethernet interface

PC osesesEEE0

10BaseT / 100BaseTx / 1000BaseTx
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General network settings

o Have a network specialist configure the control.

Proceed as follows to access the general network settings:

» Press the MOD key

Enter the code number NET123
Press the PGM MGT key

v

20

2]
E
v

v

Press the NET soft key

v

Press the CONFIGURE NETWORK soft key

Computer name tab

o This setup dialog is managed by the HEROS operating s m
system. After you have changed the conversational B
language on your control, you need to restart the control e o a
to enable the language. sdte 5
B& tnoguid imertace: 35|

s
Compuername 56|

[WEROSS - s

T

Setting Meaning ;
Primary interface Name of the Ethernet interface to be s
integrated in your company network. Only e i
active if a second, optional Ethernet inter- R Eed B P
face is available on the control hardware e 4‘,, IS 4 P v | s [ |
Computer name Name displayed for the control in your

company network

Host file Only required for special applications:
Name of a file in which the assignments
of IP addresses to computer names are
defined
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Interfaces tab

Setting

Meaning

Interface list

List of the active Ethernet interfaces.
Select one of the listed interfaces (via
mouse or arrow keys)

B Activate button: Activate the selected
interface (X appears in the Active
column)

B Deactivate button: Deactivate the
selected interface (- appears in the
Active column)

= Configuration button: Open the
configuration menu

Allow IP forwarding

This function must be kept deactivated.
Only activate this function after instruction
by our Service Department for diagnos-
tic purposes. If external access to the
second, optional Ethernet interface is
necessary, this function needs to be
activated.

Proceed as follows to access the configuration menu:
» Press the Configuration button

Setting

Meaning

Status

® Interface active: Connection status of
the selected Ethernet interface

= Name: Name of the interface you are
currently configuring

B Plug connection: Number of the plug
connection of this interface on the logic
unit of the control

Profile

Here you can create or select a profile in
which all settings shown in this window
are stored. HEIDENHAIN provides two
standard profiles:

B DHCP-LAN: Settings for the standard
Ethernet interface; should work in a
standard company network

B MachineNet: Settings for the second,
optional Ethernet interface; for
configuration of the machine network

Press the corresponding buttons to save,

load and delete profiles

IP address

B Automatically procure IP address:
The control is to procure the IP address
from the DHCP server

= Manually set IP address: Manually
define the IP address and subnet
mask. Input: Four numerical
values separated by periods,
€.9.160.1.180.20 and 255.255.0.0
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®0 [ 1me: 1ne_oxogipont.ie.z, - oxe
SCine_prog | Metwerk settings T .

‘Conoecos Conbaurason
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T
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Setting Meaning
Domain Name B Automatically procure DNS: The
Server (DNS) control is to automatically procure the

I[P address of the domain name server

®  Manually configure the DNS: Manually
enter the |IP addresses of the servers
and the domain name

Default gateway = Automatically procure default
gateway: The control is to
automatically procure the default
gateway

= Manually configure the default
gateway: Manually enter the IP
addresses of the default gateway

» Apply the changes with the OK button, or discard them with the
Cancel button

Internet tab
The Internet tab currently has no function.

Ping/Routing tab

Setting Meaning

Ping In the Address: input field, enter the
IP number for which you want to check
the network connection. Input: Four
numerical values separated by periods,
€.9.160.1.180.20. As an alternative,
you can enter the name of the computer
whose connection you want to check

B Press the Start button to begin the
test. The control shows the status
information in the Ping field

B Press the Stop button to conclude the
test

T

55|
55|
55|
55|
55|
55|
55|

Fouy

1w 1ns_progipoun-.u;-. 1.+ oxe

=
B0 ne_prog | Netwazk
ae

settings -
amo | {Computerien lsaces mat 7o ousna |NESUIDIGID DHCP sotvs
st

xxxxx

=] )
s
emiroigie
csonabon  Gateway  Genmask  Flags Memc Rel Use flace
S oS e T
10700 0000 252552400 U 0 0 Oehd

updaw

= e =

=ol

56|
55|
- s
55|
55|

LTI

el
s

55
=m

oll
65
55
55
55

S
55
=5
55
57

B

| [ |
e e e -

| upiig |

- |

%&

Routing For network specialists: Status information
of the operating system for the current
routing

B Press the Update button to refresh the
routing information
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NFS UID/GID tab

On the NFS UID/GID tab, you enter the user and group ﬁihoﬂrmmq
identifications. eamen e o
f————

Setting Meaning oo e, e
Set UID/GID for NFS = User ID: Definition of which user e
shares identification the end user uses to

access files in the network. Ask your

network specialist for the proper value

®  Group ID: Definition of the group
identification with which you access B O =N =S

files in the network. Ask your network D e e 4}.;._“

specialist for the proper value
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DHCP Server tab
Setting Meaning -
. mael IVHC:\MJ:OQ\PGA\'.H *.1;°.0XF
DHCP server ® |P addresses from: Define the IP SG pepres o s asa
. . @83 POM DHCP semings. ;
address as of which the control is Eorae : =
. =~ | eassten ] b
to derive the pool of dynamic IP S e

addresses. The control transfers the
values that appear dimmed from

the static IP address of the defined
Ethernet interface; these values cannot
be edited.

= |P addresses to: Define the IP address
up to which the control is to derive the & alii i | i | i | | el
pool of dynamic IP addresses.

B Lease Time (hours): Time within
which the dynamic IP address is
to remain reserved for a client. If a
client logs on within this time, the
control reassigns the same dynamic IP
address.

1 4]
55/

55|
56|
55|
55|
56|
55

e
e
o
N
—
e

56|

5
55|

® Domain name: Here you can define
a name for the machine network if
required. This is necessary if the same
names are assigned in the machine
network and in the external network,
for example.

= Forward DNS to external: If IP
Forwarding is active (Interfaces tab)
and the option is active, you can
specify that the name resolution for
devices in the machine network can
also be used by the external network.

= Forward DNS from external: If IP
Forwarding is active (Interfaces tab)
and the option is active, you can
specify that the control is to forward
DNS inquiries from devices within the
machine network to the name server
of the external network if the DNS
server of the MC cannot answer the
inquiry.

B Status button: Call an overview of
the devices that are provided with a
dynamic IP address in the machine
network. You can also select settings
for these devices.

= Advanced options button: Additional
settings for the DNS/DHCP server.

= Set stan- dard values button: Set
factory default settings.
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Sandbox tab
On the Sandbox tab, you configure the sandbox feature.

With the sandbox feature, the control enables you to execute
applications in an environment that is isolated from the rest of the
control. By isolating the data accesses, applications that run within
a sandbox container have no access to files outside the virtual
environment. This can be used, for example, to run a browser with
access to the Internet.

o Configure and use the sandbox on your control. For
safety and security reasons, always open the browser in
the sandbox.

Proceed as follows to activate the sandbox:
» Activate the Sandbox option (by selecting it)
> The control activates the default settings for the sandbox.

> When the default settings are active, the control offers you to
start the browser from within the sandbox.

The sandbox can share a network connection (e.g. ethQ) with the
control. You can use the Configure button to configure separate
network settings for the sandbox.

6 You can define firewall settings for the sandbox using
the brsb0 interface.

Further information: "Firewall", Page 273

With the aid of the network settings, this enables you to allow only
the sandbox to access the Internet. The control is only allowed

to access its local Intranet or machine network. In this case, the
browser is only allowed to access the Internet if the browser runs
within the sandbox.

The sandbox is automatically given its own computer name. The
computer name of the control is therefore suffixed with _sandbox.
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Device-specific network settings

o Have a network specialist configure the control.

You can define any number of network settings, but you can
manage only seven at one time.

Proceed as follows to access the device-specific network

settings:

» Press the MOD key
Alternative:

» Press the PGM MGT key

- » Press the NET soft key

> Press the DEFINE NETWORK CONNECTN. soft
key
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To manage the network drives, use the screen buttons. ﬁnnwm’mng
Proceed as follows to add a network drive: e ety o
» Press the Add button e o s
> The control starts the connection wizard, which guides you by T S A I
dialog through the required definitions.
= =5 FRwmd (= (=]
Setting Meaning —

Network drive List of all connected network drives. The
control shows the respective status of the
network connections in the columns:

®  Mount: Network drive connected / not
connected

B Auto: Network drive is to be connected
automatically/manually

Meunt assistant &)

®m Type: Type of network connection. cifs Network Drive - Define Name
and nfs are possible

® Drive: Designation of the drive on the e e ——— e
control = ]

olame D:

= ID: Internal ID that identifies if a mount ———
point has been used for more than one o — p—
connection — — —
= Server: Name of the server —— ‘
® Share: Name of the directory on the
server that the control is to access
® User: User name with which the user
logs on to the network
® Password: Network password
protected or not
= Query password?: Query / do not
query password during connection

® Options: Display additional connection
options

Status log Display of status information and error
messages.
Press the Clear button to delete the
contents of the Status Log window.
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9.5 SELinux security software

SELinux is an extension for Linux-based operating systems.
SELinux is an additional security software package based on
Mandatory Access Control (MAC) and protects the system against
the running of unauthorized processes or functions and therefore
protects against viruses and other malware.

MAC means that every action must be explicitly permitted,
otherwise it will not be executed by the control. The software is
intended as protection in addition to the normal access restriction
in Linux. Certain processes and actions can only be executed if the
standard functions and access control of SELinux permit it.

0 The SELinux installation of the control has been
prepared to permit running only programs installed with
the HEIDENHAIN NC software. Other programs cannot
be run with the standard installation.

The access control of SELinux under HEROS 5 is regulated as
follows:

B The control executes only applications that are installed with the
HEIDENHAIN NC software

® Files in connection with the security of the software (SELinux
system files, HEROS 5 boot files, etc.) may only be changed by
programs that are selected explicitly

® New files generated by other programs must never be executed

® USB data carriers cannot be deselected

® There are only two processes that are permitted to execute new
files:

®  Starting a software update: A software update from
HEIDENHAIN can replace or change system files

m Starting the SELinux configuration: The configuration of
SELinux is usually password-protected by your machine
manufacturer; refer here to the relevant machine manual

o HEIDENHAIN recommends activating SELinux because
it provides additional protection against attacks from
outside.
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9.6 User administration

@ Refer to your machine manual.

Some user administration areas are configured by the
machine tool builder.

If you want to use the user administration feature on
a control without HEIDENHAIN keyboard, you need to
connect an external alphabetic keyboard to the control.

User administration is inactive in the control's factory
default setting. This status is called legacy mode. In
legacy mode, the control's behavior is identical to that of
older software versions without user administration.

It is not mandatory that you use the user administration
feature, but it is essential for the implementation of an IT
security system.

User administration supports you in the following fields
of security, based on the requirements of the IEC 62443
series of standards:

®  Application security

® Network security
® Platform security

User administration enables you to define users with different access
rights.
The following options are available for saving your user data:
B Local LDAP database
® Using the user administration feature on one single control
m Setting up a central LDAP server for more than one control

® Exporting an LDAP server configuration file if the exported
database is to be used by more than one control

Further information: "Local LDAP database", Page 295
= LDAP database on remote computer
= |mporting an LDAP server configuration file

Further information: "LDAP on remote computer”,
Page 296

= Connection to a Windows domain

B |ntegrating the user administration feature on more than
one control

m Using different roles on different controls

Further information: "Connection to a Windows domain’,
Page 297

o Parallel operation of Windows users and users from an
LDAP database is possible.
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Configuring the user administration

User administration is inactive in the control's factory default
setting. This status is called legacy mode.
Further information: ", Page 292
Before user administration can be used, you need to configure it.
Perform the following steps for configuration:
1. Activate the user administration and create the useradmin user
2. Set up a database

= Further information: "Local LDAP database’, Page 295

® Further information: "LDAP on remote computer’,
Page 296

= Further information: "Connection to a Windows domain",
Page 297
3. Create further users

Further information: "Creating further users", Page 300
Proceed as follows to call the user administration:

» Select the HEROS menu icon

» Select the Settings menu item

> Select the UserAdmin menu item

> The control opens the User management window.

1. Proceed as follows to activate the user administration:
» Call the user administration

> Press the User administration active soft key

> The control shows the message Password for user ‘'useradmin’
missing.

User management

Settings [ User management | Password settings \

Global settings
" User administration not active
[

‘= User administration is activ_el ‘

Password for ‘ | Reconnect

¥ Anonymize users in login data useradmin server

6 The function Anonymize users in login data is active
in the factory default setting. As a consequence, the
user name is blacked out in all log data. If your company
permits the filing of personal data on IT systems, you
can deactivate this function.

After user administration has been activated, create the useradmin
function user.

Proceed as follows to create the useradmin user:
» Press Password for useradmin

> The control opens the Password for user useradmin pop-up
window.

» Enter the password for the useradmin user
> Select Set new password

> The message Settings and password for useradmin were
changed appears.
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6 For reasons of security, passwords should comply with

the following criteria:
®  Eight characters minimum
m |etters, numbers and special characters

= Avoid using whole words or a sequence of
characters, e.g. Anna or 123

The useradmin user is comparable to the local administrator of a
Windows system.

The useradmin account provides the following functions:

Creating databases

Assigning the password data

Activating the LDAP database

Exporting LDAP server configuration files

Importing LDAP server configuration files

Emergency access if the user database was destroyed
Retroactive change of the database connection
Deactivating the user administration

0 The useradmin user automatically receives the

HEROS.Admin role. This allows him to manage

users in the user administration, provided that he
knows the LDAP database password. The useradmin
user is a function user who has been predefined by
HEIDENHAIN. You can neither add roles to function
users, nor delete their roles.

Further information: "Definition of roles", Page 305

HEIDENHAIN recommends permitting more than one
person to access an account with the HEROS.Admin
role. This ensures that necessary changes to the user
administration can also be made in the administrator's
absence.

2. Proceed as follows to set up the database:

>

vV VvV v v Vvy

294

Select the database for saving the user data

B | ocal LDAP database

Further information: "Local LDAP database", Page 295

= | DAP on remote computer

Further information: "LDAP on remote computer", Page 296
= Connection to a Windows domain

Further information: "Connection to a Windows domain®,
Page 297

Set up a database

Press the APPLY soft key.

Press the END soft key

The control opens the System reboot required window
Press Yes to restart the system

The control is restarted.

HEROS functions | User administration
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 System reboot required s BB

rebooted in order for it te function correctly.

. You have switched between active user administration and legacy mode. The system must be
' Restart the system now?

‘ Yes H Cancel

Local LDAP database

Before you can use the Local LDAP database function, the [ configure local LDAP database. EIE
fO| IOWIng requ”.ements m USt be met I:s:i:i;érse:vri!“ybaellu:;l- LDAP domain. If you change the domain name, all
® The user administration is active fiemectine ook demar:

The server name s the same as
X - - thenostnameand can only be
Nameict.rhie sever [BEmpcisasisansss | o o etk
I configuration.

= The useradmin user has already been configured

Proceed as follows to set up a local LDAP database: | }:}
» Call the user administration

> Select the LDAP user database function

> The control enables the dimmed area for editing the LDAP user
database.

Select the Local LDAP database function

Select the Configure function

The control opens the Configure local LDAP database window
Enter the name of the LDAP domain

Enter the password

Repeat the password

Press the OK soft key

The control closes the Configure local LDAP database window

\
|
| o

Export
user data

Import
user data

Cancel

V vV vV vV vV vV VY%

o Before you can start editing the user administration, the
control prompts you to enter the password of your local
LDAP database.

Passwords must not be trivial and must be known only
to the administrators.

Further information: "Creating further users’,
Page 300
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LDAP on remote computer

Before you can use the LDAP on remote computer function, the
following requirements must be met:

= The user administration is active

® The useradmin user has been configured

B An LDAP database has been set up in the company network
|

A server configuration file of an existing LDAP database must
be stored on the control or on a PC in the network

The PC with the existing configuration file is running.

®m The PC with the existing configuration file is accessible in the
network

Proceed as follows to provide an LDAP database with a server
configuration file:

» Call the user administration
» Select the LDAP user database function

> The control enables the dimmed area for editing the LDAP user
database.

» Select the Local LDAP database function

> Select the Export server configuration function

> The control opens the Export LDAP configuration file window
>

Enter the name for the server configuration file into the name
field

» Save the file to the desired folder
> The server configuration file was exported successfully

Proceed as follows to use the LDAP on remote computer function: Tnport LoAP. contiguration rile e

o . et On This Computer
» Call the user administration 1 & veme B compita 5:508/125 GBavalabe 1
» Select the LDAP user database function N

> The control enables the dimmed area for editing the LDAP user o

8 sk

database e

™

Select the LDAP on remote computer function

Select the Import server configuration function

The control opens the Import LDAP configuration file window
Select the existing configuration file

Select Open

Press the APPLY soft key.

The configuration file was imported.

vV VvV vV vV V VY
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Connection to a Windows domain

Before you can use the Connection to Windows domain function,
the following requirements must be met:

® The user administration is active

The useradmin function user has already been set up
There is a Windows Active Domain Controller in the network
You have access to the password of the domain controller

You have access to the user interface of the domain controller or
you are supported by an IT administrator

B The domain controller is accessible in the network

Proceed as follows to set up the Connection to Windows domain
function:

» Call the user administration

» Select the Connection to Windows domain function
» Select the Find domain function

> The control recognizes the found domain.

o Use the Configure function to define various settings
of your connection:

® Deactivate the function Map SIDs to Unix UIDs

= You can define a special group of Windows users
to whom you want to restrict the connection to
this control

= You can modify the organizational unit in which the
HERQOS role names are stored

B You can change the prefix in order to manage
users from different workshops, for example.
Each prefix given to a HEROS role name can be
changed, e.g. HEROS hall 1 and HEROS hall 2

B You can change the separator within the HEROS
role name

» Press the APPLY soft key.
> The control opens the Connect to domain window.

With the Organizational unit for computer account
function, you can specify in which of the already existing
organizational units you want to create the access, e.g.

® ou = controls
B cn = computers

The values you enter must match the conditions of the
domain. The terms are not exchangeable.

Enter the user name of the domain controller
Enter the password of the domain controller
The control connects to the Windows domain found.

The control checks whether all of the required roles have been
created in the domain as groups.

vV VvVvVvyy
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If not all of the required roles have been created in the
domain as groups, the control issues a warning.

If the control issues a warning, proceed in one of the
two following ways:

» Press the ADD ROLE DEFINITION soft key
m Select the Add function

You can enter the roles directly into the domain in
this case.

m Select the Export function

You can output the roles externally to a file in .Idif
format in this case.

> All of the required roles have been created in the domain as
groups.

| Cconnection to Windows domain

Domain: KDC:
LDAP ID-mapping: Yes

HEROS role base:

There are the following ways to create groups corresponding to the

different roles:

®  Automatically when entering the Windows domain by specifying
a user with administrator rights

® By importing an import file in .Idif format into the Windows
server

The users need to be added manually by the Windows

administrator to the roles (security groups) on the domain controller.

Two suggestions describing how the groups can be structured by

the Windows administrator are given by HEIDENHAIN below:

® Suggestion 1: The user is a direct or indirect member of the
respective group:

Group
HEROLE.NC.SETTER
¥
A
Setter l
¥ B
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® Suggestion 2: Users from various sectors (workshops) are
members of groups with different prefixes:

HERworkshopl.NC HERworkshop2 NC Group
SETTER SETTER
h 4 ¥
A
sefter_workshopi setter_workshop2 i
B

B is member of A

el
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Creating further users

After configuring the user administration, you can create further
users.

Before you can create further users, you must have configured and
selected an LDAP database.

Proceed as follows to create further users:
» Call the user administration
» Select the User management tab

o The User management tab is only effective for the
following databases:
® Local LDAP database
E LDAP on remote computer
If Connection to Windows domain is used, you

need to configure the users in the Windows
domain.

Further information: "Connection to a Windows
domain", Page 297

» Press the EDIT ON soft key

> The control prompts you to enter the password of your user
database.

This step is only needed if you have restarted your
control after configuring the database.

> After you have entered the password, the control opens the
User management menu.

You can edit the existing users or create new users.
Proceed as follows to create a new user:

» Press the CREATE NEW USER soft key

> The control opens a window for creating a user.
» Enter the user name

» Enter a password for the user

HEROS functions | User administration

S| Usv muragement | paeprerd s |

Changs ieen

-----

DELETE
Rol PASSWORD

s

_

KEYS

The user has to change this password the first time he
logs on.

Further information: "Login to user administration”,
Page 314

» You can optionally also create a user description.
» Press the ADD ROLE soft key

» In the selection window, select the roles corresponding to your
user. Further information: "Definition of roles", Page 305

» Confirm your selection with the ADD soft key
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0 Two additional soft keys are available in the menu:
= ADD REMOTE LOGIN:

Adds Remote.HEROS.Admin in place of
HEROS.Admin, for example.

This role is only enabled for remote logon to the
system.

= ADD LOCAL LOGIN

Adds Local.HEROS.Admin in place of HEROS.Admin,
for example.

This role is only enabled for local logon at the
control's screen.

Further information: "Definition of roles", Page 305

Press the CLOSE soft key

The control closes the window for creating a user.
Press the OK soft key

Press the APPLY soft key.

The changes you made are applied.

Press the END soft key

The control closes the user administration.

VvV vV VVVVY

o If you have not restarted your control after configuring
the database, the control prompts you to restart for the
changes to take effect.

Further information: "Configuring the user
administration", Page 293
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You can optionally also assign images to your users. The default
user icons from HEIDENHAIN are available for this. You can also
load your own images in JPEG or PNG format to the control. Then
you can use these image files as profile images.

Proceed as follows to define profile images:

» Log on the user with HEROS.Admin role, e.g. useradmin
Further information: "Login to user administration”, Page 314
Call the user administration

Select the User management tab

Press the EDIT USER soft key

Press the CHANGE ICON soft key

Select image

Use the CHOOSE ICON soft key to select an image

Press the OK soft key

Press the APPLY soft key.

The changes you made are applied.

V vV vV vV vV vV vV VY

o You can also directly add profile images when creating
the users.
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Access rights

The user administration is based on the Unix rights management.
Access to the control is controlled by means of rights.

User
(for example: Test)
contains several
roles

roles
(for example: NC.Programmer)
contains several rights

rights
(for example: NC.EditNCProgram)
contains several functions

The user administration differentiates between the following terms:
= User
®  Function user pre-defined by HEIDENHAIN

Further information: "HEIDENHAIN function users",
Page 304

B Function user defined by the machine tool builder
m Self-defined users

A user can be pre-defined in the control or he can be defined
by the end user. A user contains all the roles that have been
assigned to him.

6 Your machine tool builder defines function users who
are required for machine maintenance, for example.

Depending on the task assigned, you can use one of
the pre-defined function users or you have to create a
new user.

The access rights of HEIDENHAIN function users are
already pre-defined in the control's factory default
setting.

Further information: "Creating further users’,

Page 300

Roles consist of a combination of rights that cover certain
functions provided by the control.

Roles:

E Operating system roles

E NC operator roles

®  Machine tool builder (PLC) roles

All of these roles are pre-defined in the control.
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You can assign more than one role to a user. If more than one
role is assigned to a user, he will be granted all rights contained
in these roles.

Rights:

= HEROS rights

= NC rights

®m PLC rights (OEM)

Rights consist of a combination of functions that cover a task
area of the control, e.g. editing the tool table.

o Ensure that every user is only assigned the access rights
he needs. The access rights result from the actions a
user performs on and with the control.

HEIDENHAIN function users

HEIDENHAIN function users are pre-defined users that are
automatically created when the user administration is activated.
Function users cannot be edited.

HEIDENHAIN provides four different function users in the control's ; )
factory default setting. & me: "
= oem = = sys

The oem function user is intended for the machine tool builder.
With oem, you can access the PLC partition of the control. (1 user

® Function user defined by the machine tool builder & :
(= A useradmin

@ Refer to your machine manual.

The users defined by the machine tool builder can
differ from those pre-defined by HEIDENHAIN.

The machine tool builder's function users can already
be active in legacy mode and replace code numbers.

By entering code numbers or passwords that replace
code numbers, you can temporarily enable rights of
oem function users.

Further information: "Current User", Page 318

B sys
With the sys function user, you can access the system partition

of the control. This function user is reserved for use by the JH
Service department.

= user

In legacy mode, the user function user is automatically logged
on to the system during control start-up. When the user
administration is active, the user function user has no effect.
The logged-on user of the type user cannot be changed in
legacy mode.

® useradmin

The useradmin function user is automatically created when
the user administration is activated. With useradmin, you can
configure and edit the user administration.
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Definition of roles

HEIDENHAIN combines several rights for individual task areas to
roles. Different pre-defined roles that you can use to assign rights
to your users are available. The tables below describe the individual
rights of the different roles.

o Every user should have at least one role from the
operating system area and at least one role from the
programming area.

You can enable a role either for local login or for remote
login. With local login, the user directly logs on to the
control at the control's screen. A remote login (DNC) is a
connection via SSH.

You can therefore also make the rights of a user
dependent on the access he uses to operate the
control.

If a role is only enabled for local login, Local. is added
to the role name, e.g. Local. HEROS.Admin instead of
HEROS.Admin.

If a role is only enabled for remote login, Remote. is
added to the role name, e.g. Remote.HEROS.Admin
instead of HEROS.Admin.

Further information: "Creating further users’,
Page 300

Advantages of classification in roles:
®  Easier administration for the end user

m Different rights are compatible between different software
versions of the control and different machine manufacturers.

o Various applications require access to certain interfaces.
Where required,the administrator also needs to set up
rights to access the required interfaces as well as rights
to access certain functions and additional programs.
These rights are granted by the operating system roles.

o The following contents can change in the following
software versions of the control:

= HEROS role names
= Unix groups
5 Basic ID number
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Operating system roles:

Role Rights

HEROS role name UNIX group Basic ID number
HEROS.RestrictedUser Role for a user with minimum rights on the operating system.

® HEROS.MountShares B mnt = 332

m HEROS.Printer = |p =9
HEROS.NormalUser Role for a normal user with limited rights on the operating system.

This role grants the rights of the RestrictedUser role, as well as the following

rights:

® HEROS.SetShares ® mntcfg = 331

= HEROS.ControlFunctions ® ctrifct m 337
HEROS.LegacyUser With the legacy user role, the behavior regarding the operating system of the

control is identical to that of older software versions without user administration.
The user administration remains active.

This role grants the rights of the NormalUser role, as well as the following rights:

= HEROS.BackupUsers ® yserbck = 334

® HEROS.PrinterAdmin B [padmin " 16

® HEROS.SWUpdate ® swupdate = 338

m HEROS.SetNetwork ® netadmin = 333

® HEROS.SetTimezone {7 = 330

® HEROS.VMSharedFolders B vboxsf = 1000
HEROS.Admin The configuration of the network and the configuration of the user administration

are some of the rights granted by this role.

This role grants the rights of the LegacyUser role, as well as the following rights:

= HEROS.UserAdmin B yseradmin B 336
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NC operator roles:

Role Rights

HEROS role name UNIX group Basic ID number
NC.Operator This role allows you to run NC programs.

= NC.OPModeProgramRun = NCOpPgmRun = 302
NC.Programmer This role grants the rights of NC programming.

This role grants the rights of the Operator role, as well as the following rights:

® NC.EditNCProgram ® NCEdNCProg ®m 305
= NC.EditPalletTable = NCEdPal = 309
= NC.EditPresetTable ® NCEdPreset = 308
= NC.EditToolTable = NCEdTool = 306
= NC.OPModeMDi = NCOpMDI = 301
= NC.OPModeManual = NCOpManual = 300
NC.Setter This role allows you to edit the pocket table.
This role grants the rights of the Programmer role, as well as the following rights:
® NC.ApproveFsAxis ® NCApproveFsAxis ® 319
= NC.EditPocketTable = NCEdPocket = 307
® NC.SetupDrive ® NCSetupDrv ® 315
m NC.SetupProgramRun m NCSetupPgRun = 303

NC.AutoProductionSetter This role allows you to execute all NC functions, including programming a sched-
uled NC program start.

This role grants the rights of the Setter role, as well as the following rights:
®m NC.ScheduleProgramRun ® NCSchedulePgRun = 304

NC.LegacyUser With the legacy user role, the control's behavior regarding NC programming
is identical to that of older software versions without user administration. The
user administration remains active. The LegacyUser has the same rights as the
AutoProductionSetter.

NC.AdvancedEdit This role allows you to use special functions of the NC and table editors.
® FN 17 and editing the table head
Replacement for code number 555343

= NC.EditNCProgramAdv ® NCEditNCPgmAdv = 327

= NC.EditTableAdv ® NCEditTableAdv = 328
NC.RemoteOperator This role allows NC program start via the DNC interface.

®  NC.RemoteProgramRun = NCRemotePgmRunm® 329
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Machine tool builder (PLC) roles:

Role Rights

HEROS role name UNIX group Basic ID number
PLC.ConfigureUser This roles grants the rights on code number 123.

= NC.ConfigUserAdv = NCConfigUserAdv = 316

® NC.SetupDrive = NCSetupDrv = 315
PLC.ServiceRead This role allows read-only access during servicing.

This role can be used to display various types of diagnostic information
m NC.Data.AccessServiceRead m NCDAServiceRead = 324

o Refer to your machine manual.
The machine tool builder can adapt the PLC roles.

When the machine tool builder (PLC) roles are

adapted by the machine tool builder, the following
contents may change:

= The names of the roles
B The number of roles
m The functionality of the roles
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Rights

The table below lists all of the individual rights.

Rights:

HEROS role name

Description

HEROS.Printer

Data output to network printers

HEROS.PrinterAdmin

Configuration of network printers

NC.OPModeManual

Operation of the machine in the Manual Operation and Electronic handwheel
operating modes

NC.OPModeMDi

Working in the Positioning w/ Manual Data Input operating mode

NC.OPModeProgramRun

Execution of NC programs in the Program Run Full Sequence or Program run,
single block operating mode

NC.SetupProgramRun

Probing in the Manual Operation and Electronic handwheel operating modes

NC.ScheduleProgramRun

Program a scheduled NC program start

NC.EditNCProgram

Editing NC programs

NC.EditToolTable

Editing the tool table

NC.EditPocketTable

Editing the pocket table

NC.EditPresetTable

Editing the preset table

NC.EditPalletTable

Editing pallet tables

NC.SetupDrive

Adjustment of drives by the end user

NC.ApproveFsAxis

Confirming test position of safe axes

NC.EditNCProgramAdv

Additional NC functions, e.g. FN 17

NC.EditTableAdv

Additional table programming functions, e.g. editing the table head

HEROS.SetTimezone

Adjustment of time and date, time zone, and time synchronization via NTP and
HEROS menu

HEROS.SetShares Configuration of network shares mounted by the control
HEROS.MountShares Connecting and disconnecting network shares with the control
HEROS.SetNetwork Configuration of network and relevant settings for data security

HEROS.BackupUsers

Data backup on the control—for all users configured on the control

HEROS.BackupMachine

Backup and restoring data of the entire machine configuration

HEROS.UserAdmin

Configuration of user administration on the control
This includes creating, deleting and configuring local users

HEROS.ControlFunctions

Control function of the operating system

®  Auxiliary functions, such as starting and stopping NC software.
B Telemaintenance

B Advanced diagnostic functions, such as log data

HEROS.SWUpdate

Installation of software updates for the control

HEROS.VMSharedFolders

Access to shared folders of a virtual machine
Only relevant when running a programming station within a virtual machine
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HEROS role name Description

NC.RemoteProgramRun Start of NC program via remote interface, e.g. DNC

NC.ConfigUserAdv Configuration access to the contents that have been enabled through code
number 123

NC.Data.AccessServiceRead  Read-only access to the PLC partition during servicing

DNC connection with user authentication

Introduction

If user administration is active, DNC applications also need to
authenticate a user for the correct rights to be assigned.

To do this, the connection is routed over an SSH tunnel. This
method assigns the remote user to a user set up on the control,
granting the remote user this user's rights.

Besides, the encryption used with the SSH tunnel protects the
communication from attackers.
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Concept of transmission through an SSH tunnel
Prerequisites:
m TCP/IP network
® The remote computer acts as SSH client
= The control acts as SSH server
= Key pair consisting of
= Private key
= Public key

An SSH connection is always set up between an SSH client and an
SSH server.

A key pair is used to protect the connection. This key pair is
generated on the client. The key pair consists of a private key and
a public key. The private key remains with the client. During setup,
the public key is transferred to the server and assigned to a certain
user.

The client tries to connect to the server using the pre-defined
user name. The server can use the public key to verify that the
requester of the connection holds the associated private key. If
yes, the server accepts the SSH connection and assigns it to the
user that has been used for the login. Communication can then be
“tunneled" through this SSH connection.
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Use in DNC tools

The PC tools available from HEIDENHAIN, such as TNCremo with
version v3.3 or higher, provide all functions for setting up, building
up, and managing secure connections through an SSH tunnel.
When the connection is set up, the required key pair is generated
in TNCremo and the public key is transferred to the control.

o Once the connection configurations created in TNCremo
have been set up, they can be shared among all PC
tools for building up a connection.

This also applies to applications that are using the HEIDENHAIN
DNC component from RemoTools SDK for communication. There is
no need to adapt existing customer applications.

o In order to expand the connection configuration using
the associated CreateConnections tool, you need to
update to HEIDENHAIN DNC v1.7.1. A modification of
the application source code is not required.

Proceed as follows to set up a secure connection for the logged-on
user:

Select the HEROS menu item

Select the Settings menu item

Select the Current User menu item

Press the CERTIFICATES AND KEYS soft key

Select the Allow password authentication function
Press the STORE AND RESTART SERVER NOW soft key

Use the TNCremo application to set up the secure connection
(TCP secure).

vV v v v v VY

For detailed information on how to proceed, please refer
to the integrated help system of TNCremo.

> The public key has been stored on the control by TNCremo.

In order to ensure maximum security, the Allow
password authentication function is to be deactivated
after the public key has been stored.

» Deselect the Allow password authentication function
Press the STORE AND RESTART SERVER NOW soft key
> The control has adopted your changes.

o In addition to using the PC tools for setup with
password authentication, you can also import the public
key into the control by using a USB stick or a network
drive. However, this is not described in detail in this
document.

HEROS functions | User administration
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Proceed as follows to delete a key in the control so that a user can
no longer use the secure DNC connection:

Select the HEROS menu item

Select the Settings menu item

Select the Current User menu item

Press the CERTIFICATES AND KEYS soft key
Select the key to be deleted

Press the DELETE SSH KEY soft key

The control deletes the selected key.

vV v vV v v VY

Disabling insecure connections in the firewall

The DNC protocols LSV2 and RPC can be disabled in the firewall to

ensure that the control's IT security is really improved through the

use of SSH tunnels.

This requires that the following parties change to secure

connections:

= Machine tool builders with all additional applications, e.g. pick-
and-place robots

0 If the additional application is connected via machine
network X116, there is no need to switch to an
encrypted connection.

® End users with existing DNC connections

If you have ensured that the connections of all parties are secure,
the DNC protocol can be disabled in the firewall.

Proceed as follows to disable the DNC protocol in the firewall:
» Select the HEROS menu item

Select the Settings menu item

Select the Firewall menu item

Select the Prohibit all method for LSV2

Press the Apply button

The control saves your changes.

Close the window with OK

VvV Vv vVvyvVvyy
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The login dialog appears in the following situations:

® |f user administration is active, the dialog appears immediately
after the control has booted

m  After the User logout function has been executed

B After the Switch user function has been executed

m  After the screen has been locked by the screensaver

The login dialog provides the following options:

®m Users who logged in at least once

m Other user

Proceed as follows to log in a user who is already shown in the
login dialog:

Select the user in the login dialog

The control enlarges the user icon you selected

Enter the user password.

The control uses the selected user to log you in.

To log in a user for the first time, you need to use Other.
Proceed as follows to log in a user for the first time with Other:
Select Other in the login dialog

The control enlarges the user icon you selected

Enter the user name

Enter the user's password

The control recognizes the user.

The control opens a window with the message Password
expired. Change your password now.

Enter your current password

Enter a new password

Repeat the new password

The control uses the new user to log you in.
The user is shown in the login dialog.

vV v Vv Y
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o For reasons of security, passwords should comply with
the following criteria:

®  Eight characters minimum
m | etters, numbers and special characters

= Avoid using whole words or a sequence of
characters, e.g. Anna or 123

Keep in mind that an administrator can define the requirements to
be met by a password. The password requirements include:

B Minimum length

B Minimum number of different types of characters
m Capital letters

Small letters

® Numbers

® Special characters

B Maximum length of character strings, e.g. 54321 = string of five
characters

HEROS functions | User administration

Select the user and enter a password

ENTER USER
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® The number of characters must match the dictionary check

B Minimum number of characters changed compared to previous
password

If the new password does not meet the requirements, an error
message will be issued. This means that you have to enter a
different password.

Switching or logging out users

Use the Switch off HEROS menu item or the icon of the same  switch off and restart =
name at bottom right in the menu bar to open the Switch off and
restart window.

The control provides the following options: (Restart: Restart the system
= Switch-off:

B The control stops and ends all additional programs and
fUnCtionS ()Switch user: Switch to other user

B The system is shut down  CANGEL |
® The control is switched off ' ' '
B Restart:

B The control stops and ends all additional programs and
functions

= The system is restarted
® Log out:
B The control ends all additional programs
B The user is logged out
= The login window appears

@ Switch-off: Shut down and switch off the system

(JlLog out: Log the user out

o To continue, you need to log in a new user and
enter his password.
The NC program continues running under the
previously logged-on user.

® Switch user:
® The login window appears
® The user is not logged out

o You can close the login window with Cancel
without entering a password.

All additional programs and the NC programs
started by the logged-on user continue running.
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Screensaver with lockout

You can use the screensaver to lock the control. NC programs that
have already been started continue running during this period.

o You need to enter a password to unlock the screensaver
again.
Further information: "Login to user administration”,
Page 314

Screensaver Preferences (XScreensaver 5.20, 06-Oct-2012)
Ele Help

Display Modes [Advanced

Spotlight
Mode: | Only One Screen Saver

Attraction

s

Spotlight

Blank After (30 |3| minutes
Cycle After (10 |3 minut
Ccycle After % minutes = —

 Lock Screen After [0 S minutes

Proceed as follows to access the screensaver settings in the
HEROS menu:

» Select the HEROS menu item

> Select the Settings menu item

» Select the Screensaver menu item

The screensaver provides the following options:

B Use the Blank After setting to define after how many minutes
the screensaver should turn on.

®m Use the Lock Screen After setting to activate the lock with
password protection.

® The time value behind Lock screen after defines the delay after
which the lock will take effect after the screensaver has been
turned on. A value of 0 means that the lock becomes effective
immediately after the screensaver has been turned on.

When the lock is active and you use one of the input devices

(e.g. the mouse), the screensaver disappears and the lock screen

appears.

The screen was locked due to inactivity.
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Use Unlock screen or Enter to call the login window again.
Further information: "Login to user administration", Page 314

HOME directory

When user administration is active, a private HOME: directory, to
which you can save your private programs and files, is available to
every user.

The HOME: directory can be viewed by the logged-on user.
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Current User

With Current User, you can view the group rights of the currently
logged-on user in the HEROS menu.

6 In legacy mode, the user function user is automatically
logged on to the system during control start-up. When
user administration is active, the user function user has
no effect.

Further information: "HEIDENHAIN function users",
Page 304

Calling the Current User:

» Select the HEROS menu icon

> Select the Settings menu icon

» Select the Current User menu icon

The user administration allows you to temporarily increase the
current user's rights by adding the rights of a user you selected.

Proceed as follows to temporarily increase a user's rights:
Call Current User

Press the Add rights soft key

Select a user

Enter the selected user's user name

Enter the selected user's password

The control temporarily increases the logged-on user's rights by
adding the rights of the user entered in Add rights.

vV v v vV .Yy

By entering code numbers or passwords that replace
code numbers, you can temporarily enable rights of oem
function users.

Further information: "HEIDENHAIN function users",
Page 304

You have the following options to remove the rights that have
temporarily been added:

®  Enter the code number 0

® | og out the user

® Press the REMOVE ADDED RIGHTS soft key

Proceed as follows to select the REMOVE ADDED RIGHTS soft key:
» Call Current User

» Select the Added rights tab

» Press the REMOVE ADDED RIGHTS soft key

In the Current User menu item, you can change your current
user's password.

Proceed as follows to change your current user's password:
» Call Current User

» Select the Change password tab

» Enter your old password

» Press the VERIFY OLD PASSWORD soft key

HEROS functions | User administration

[Active user

Autoproductionsetter | v smmsen seve

9ase o | addad ropee | Changa paceword

closa.
WINDOW. |

-
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> The control checks whether you have correctly entered your old
password.

> If the control verified that the password is correct, the fields
New password and Repeat password are enabled.

Enter your new password
Repeat your new password
Press the SET NEW PASSWORD soft key

The control compares the requirements defined for passwords
by the administrator to the password you entered.

Further information: "Login to user administration", Page 314
> The message Password was changed successfully appears.

v v vy

Dialog for requesting additional rights
If you do not have the rights required for a specific HEROS menu 2SR ineE e e O K o B
item, the control opens the window for requesting additional rights: sinasdadinens iy e e ner

In this window, the control offers you to temporarily increase your '
rights by adding another user's rights.

In the Users that have this right: field, the control lists all existing
users that have the right to this function.

Required right: Useradmin

Users that have this right:

Enter the user and password:
user: [usera dmin

rs |[-Cont. ]

o If Connection to Windows domain is used, only users e
that were recently logged on are shown in the selection

menu.

To attain the rights of users that are not shown, enter
their user data. The control will then recognize those
users that are contained in the user database.

Proceed as follows to temporarily add another user's rights to your
user's rights:

Select a user that possesses the required right

Enter the user's name

Enter the user's password

Press the SET RIGHT soft key

The control adds the entered user's rights to your rights.
Further information: "Current User", Page 318

v v vvVvy
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9.7 Changing the HEROS conversational
language

The HEROS conversational language is internally based on the NC
conversational language. Therefore, the HEROS menu and the
control cannot permanently be set to two different conversational
languages.

When you change the NC conversational language, the HEROS
conversational language is adapted to the NC conversational
language every time the control is restarted.

6 In order to change the HEROS conversational language,
the Allow NC to change HEROS config files function
must be activated in the SELinux menu.

Further information: "SELinux security software",
Page 263

The following link provides information on how to change the NC
conversational language:

Further information: "List of user parameter", Page 325

You can change the language layout of the keyboard for HEROS
applications.

o The language layout for the control and the
HEIDENHAIN keyboard always remains in English,
even after the language has been changed. Changing
the language layout is therefore only reasonable for
additional keyboards.

Proceed as follows to change the language layout of the keyboard
for HEROS applications:

» Select the HEROS menu icon

> Select Settings

Select Language/Keyboards

The control opens the helocale window.
Select the Keyboards tab

Select the desired keyboard layout
Select Apply

Select OK

Press Apply

The changes are applied.

VvV VvV vV v vV vV VY
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Tables and Overviews | Machine-specific user parameters

10.1 Machine-specific user parameters

Application
The parameter values are entered in the configuration editor.

@ Refer to your machine manual.

The machine tool builder can make additional machine-
specific parameters available as user parameters, so
that you can configure the functions that are available.

The machine parameters are grouped as parameter objects in a
tree structure in the configuration editor. Each parameter object has
a name (e.g. Settings for screen displays) that gives information
about the parameters it contains.

Calling the configuration editor
Proceed as follows:

» Press the MOD key

» |f required, use the arrow keys to navigate to
Code-number entry

» Enter the code number 123
Confirm with the ENT key

> The control displays the list of available
parameters in the tree view.

v
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Depiction of the parameters

The icon at the beginning of each line in the parameter tree shows
additional information about this line. The icons have the following
meanings:

|

Branch exists but is closed

|
Elﬁ Branch is open

|
Empty object, cannot be opened
|
Initialized machine parameter
| occoe .
""" Uninitialized (optional) machine parameter
|

ﬂ Can be read but not edited

[ ]
ﬁ Can neither be read nor edited

The type of the configuration object is identified by its folder
symbol:

|

Key (group name)
|

List

Entity (parameter object)

0 The icons of not yet active parameters and objects
appear dimmed. These can be activated with the
MORE FUNCTIONS and INSERT soft keys.

Changing the parameters
Proceed as follows:

» Find the desired parameter
» Edit the value

\, » Press the END soft key to close the configuration
B editor
o > Press the STORE soft key to save the changes

o The control saves a change list of the last 20 changes
to the configuration data. To undo changes, select the
corresponding line and press the MORE FUNCTIONS and
CANCEL CHANGE soft keys.
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Changing the display of the parameters

If you are in the configuration editor for the user parameters, you
can change the display of the existing parameters. In the default
setting, the parameters are displayed with short, explanatory texts.

Proceed as follows in order to have the actual system names of
the parameters be shown:

@ > Press the Screen layout key

> Press the SHOW SYSTEM NAME soft key

Follow the same procedure to return to the standard display.

Displaying help texts

The HELP key enables you to call a help text for each parameter
object or attribute.

If the help text does not fit on one page (1/2 is then displayed at
the upper right, for example), press the HELP PAGE soft key to
scroll to the second page.

The control displays other information (e.g. unit of measurement,
initial value, selection list) in addition to the help text. If the
selected machine parameter matches a parameter in the previous
control model, the corresponding MP number is displayed.
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List of user parameter

Parameter settings

DisplaySettings
Display sequence and rules for axes
[0] to [B]
Depends on the available axes

Depends on the available axes
Key name of an object in CfgAxis
Key name of the axis to be displayed

Axis designation
Axis designation to be used in place of the key name

Display rule for the axis
ShowAlways
IfKinem
IfKinemaxis
IfNotKinemAXxis
Never

Sequence of the axes shown in the REF display
[0] to [5]
Depends on the available axes

Type of position display in the position window
NOML
ACTL
REF ACTL
REF NOML
LAG
ACTDST
REFDST
M 118

Type of position display in the status display
NOML
ACTL
REF ACTL
REF NOML
LAG
ACTDST
REFDST
M 118

Definition of decimal separator for position display
. point
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Parameter settings
, comma

Feed rate display in Manual Operation mode
at axis key: Display the feed rate only if axis-direction key is pressed
always minimum: Always display the feed rate

Display of spindle position in the position display
during closed loop: Display spindle position only if spindle is in position control loop

during closed loop and M5: Display spindle position if spindle is in position control loop
and with M5

Lock PRESET MANAGEMENT soft key
True: Access to the preset table is locked
False: The preset table can be accessed by soft key

Font size for program display
FONT_APPLICATION_SMALL
FONT_APPLICATION_MEDIUM

Sequence of icons in the display
[0] to [9]
Depends on the activated options

DisplaySettings
Display step for the individual axes
List of all available axes
Display step for position display in mm or degrees
0.1
0.05
0.01
0.005
0.001
0.0005
0.0001

Display step for position display in inches
0.005
0.001
0.0005
0.0001

DisplaySettings
Definition of the unit of measure valid for the display
metric: Use the metric system
inch: Use the inch system
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Parameter settings

DisplaySettings
Format of the NC programs and cycle display
Program entry in HEIDENHAIN Klartext conversational programming language or in DIN/ISO

HEIDENHAIN: Klartext conversational programming language for entering the
program in Positioning with Manual Data Input operating mode

ISO: DIN/ISO for entering the program in Positioning with Manual Data Input operat-
ing mode

DisplaySettings
Definition of the NC and PLC conversational languages
NC conversational language
ENGLISH
GERMAN
CZECH
FRENCH
ITALIAN
SPANISH
PORTUGUESE
SWEDISH
DANISH
FINNISH
DUTCH
POLISH
HUNGARIAN
RUSSIAN
CHINESE
CHINESE_TRAD
SLOVENIAN
KOREAN
NORWEGIAN
ROMANIAN
SLOVAK
TURKISH

PLC conversational language
See NC conversational language

PLC error message language
See NC conversational language

Language for online help
See NC conversational language
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Parameter settings

DisplaySettings
Behavior during control start-up
Acknowledge the "Power interrupted" message

TRUE: Start-up of the control is not continued until the message has been acknowl-
edged

FALSE: The Power interrupted message does not appear

DisplaySettings
Display mode for time of day
Selection of a display mode for the time of day
Analog
Digital
Logo
Analog and logo
Digital and logo
Analog on logo
Digital on logo

DisplaySettings
Link row on/off
Display settings for link row
OFF: Switch off the information line in the operating-mode line.
ON: Switch on the information line in the operating-mode line

DisplaySettings
Settings for 3-D view
Model type of the 3-D view

3-D (compute-intensive): Model depiction for complex machining operations with
undercuts

2.5-D: Model depiction for 3-axis operations
No Model: Model depiction is deactivated

Model quality of 3-D view
very high: High resolution; the block end points can be depicted
high: High resolution
medium: Medium resolution
low: Low resolution

Reset tool paths in new BLK form
ON: With new BLK form in Test Run, the tool paths are reset
OFF: With new BLK form in Test Run, the tool paths are not reset
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Parameter settings

DisplaySettings
Position display settings
Position display

With TOOL CALL DL
As Tool Length: The programmed oversize DL is considered to be the change in tool
length for display of the workpiece-based position
As Workpiece Oversize: The programmed oversize DL is considered to be the
workpiece oversize for display of the workpiece-based position

DisplaySettings
Table editor setting
Behavior when deleting tools from the pocket table
DISABLED: Deletion of tool is not possible
WITH_WARNING: Tool deletion is possible, but must be confirmed
WITHOUT_WARNING: Tool deletion is possible without warning

Behavior when deleting a tool's index entries
ALWAYS_ALLOWED: Deletion of index entries is always possible

TOOL_RULES: The behavior depends on the setting of the parameter "Behavior when
deleting tools from the pocket table"

Show the RESET COLUMN T soft key

TRUE: The soft key is displayed and all tools can be deleted from the tool memory by the
user

FALSE: The soft key is not displayed
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Parameter settings

ProbeSettings
Configuration of the tool calibration
TT140_1
M function for spindle orientation
-1: Spindle orientation directly by NC
0: Function inactive
1 to 999: Number of the M function for spindle orientation

Probing routine
MultiDirections: Probing from multiple directions
SingleDirection: Probing from one direction

Probing direction for tool radius measurement

X_Positive, Y_Positive, X_Negative, Y_Negative, Z_Positive, Z_Negative
(depending on the tool axis)

Distance from lower edge of tool to upper edge of stylus
0.001 to 99.9999 [mm]: Offset of stylus to tool

Rapid traverse in probing cycle
10 to 300 000 [mm/min]: Rapid traverse in probing cycle

Probing feed rate during tool measurement
1 to 3000 [mm/min]: Probing feed rate during tool measurement

Calculation of the probing feed rate

ConstantTolerance: Calculation of the probing feed rate with constant toler-
ance

VariableTolerance: Calculation of the probing feed rate with variable tolerance
ConstantFeed: Constant probing feed rate

Speed determination method
Automatic: Automatically determine speed
MinSpindleSpeed: Use the minimum spindle speed

Max. permissible surface cutting speed at the tooth edge
1 t0129 [m/min]: Permissible surface cutting speed at the circumference of the

milling tool

Maximum permissible speed for tool measurement
0 to 1000 [1/min]: Maximum permissible speed

Maximum permissible measurement error during tool measurement
0.001 to 0.999 [mm]: First maximum permissible measurement error

Maximum permissible measurement error during tool measurement
0.001 to 0.999 [mm]: Second maximum permissible measurement error
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Parameter settings

NC stop during tool check
True: When the breakage tolerance is exceeded, the NC program is stopped
False: The NC program is not stopped

NC stop during tool measurement
True: When the breakage tolerance is exceeded, the NC program is stopped
False: The NC program is not stopped

Change the tool table during tool check and tool measurement
AdaptOnMeasure: The table is changed after tool measurement
AdaptOnBoth: The table is changed after tool check and tool measurement
AdaptNever: The table is not changed after tool check and tool measurement

Configuration of a round stylus
TT140_1
Coordinates of the stylus center
[0]: X coordinate of the stylus center with respect to the machine datum
[1]: Y coordinate of the stylus center with respect to the machine datum
[2]: Z coordinate of the stylus center with respect to the machine datum

Set-up clearance above the stylus for pre-positioning
0.001 to 99 999.9999 [mm]: Set-up clearance in tool-axis direction

Safety zone around the stylus for prepositioning

0.001 to 99 999.9999 [mm]: Set-up clearance in the plane perpendicular to the
tool axis
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Parameter settings

ChannelSettings
CH_NC
Active kinematics
Kinematics to be activated
List of machine kinematics

The kinematics to be activated during control start-up
List of machine kinematics

Specify the behavior of the NC program
Reset the machining time when program starts
True: Machining time is reset
False: Machining time is not reset

PLC signal for the number of the pending fixed cycle
Depends on the machine tool builder

Configuration of the fixed cycles
Overlap factor for pocket milling
0.001 to 1.414: Overlap factor for Cycle 4 POCKET MILLING

Traverse after machining a contour pocket

PosBeforeMachining: Tool moves to the same position as before the cycle was
machined

ToolAxClearanceHeight: Position the tool axis to clearance height

Display the Spindle ? error message if M3/M4 is not active
On: Issue error message
Off: No error message

Display the Enter depth as negative
On: Issue error message
Off: No error message

M function for spindle orientation in fixed cycles
-1: Spindle orientation directly by NC
0: Function inactive
1 to 999: Number of the M function for spindle orientation

Do not show Plunging type is not possible error message
On: Error message is not displayed
Off: Error message is displayed

Behavior of M7 and M8 with Cycles 202 and 204

TRUE: At the end of Cycles 202 and 204, the status of M7 and M8 is restored to
that before the cycle call

FALSE: At the end of Cycles 202 and 204, the status of M7 and M8 is not
restored automatically

332 HEIDENHAIN | TNC 128 | User's Manual for Setup, Testing and Running NC Programs | 10/2018



Tables and Overviews | Machine-specific user parameters

Parameter settings

Do not show the Residual material warning
On: Warning is not displayed
Off: Warning is displayed

Special spindle parameters for threads
Potentiometer for feed rate during thread cutting

SpindlePotentiometer: During thread cutting, the potentiometer is effec-
tive for the spindle-speed override. The potentiometer for the feed-rate
override is disabled

FeedPotentiometer: During thread cutting, the potentiometer is effec-
tive for the feed-rate override. The potentiometer for the spindle-speed
override is not active

Waiting time at reversal point in thread base

—999999999 to 999999999: The spindle stops for this time at the bottom
of the thread before starting again in the opposite direction of rotation

Advanced switching time of spindle

—999999999 to 999999999: The spindle is stopped at this time before
reaching the bottom of the thread

Limitation of spindle speed with Cycles 17, 207 and 18

TRUE: With small thread depths, the spindle speed is limited so that it
runs at constant speed approx. 1/3 of the time

FALSE: No limitation of the spindle speed
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Parameter settings

Settings for the NC editor
Generate backup files
TRUE: Generate backup file after editing NC programs
FALSE: Do not generate backup file after editing NC programs

Behavior of the cursor after deletion of lines
TRUE: Cursor is placed on the preceding line after deletion (behavior of iTNC)
FALSE: Cursor is placed on the following line after deletion

Behavior of the cursor on the first or last line
TRUE: Cursor jumps from end to beginning of program
FALSE: Cursor is not allowed to jump from end to beginning of program

Line break on blocks with more than one line
ALL: Always display all lines
ACT: Only display the lines of the active block completely
NO: Only display all lines when block is edited

Activate help graphics when entering cycle data
TRUE: Always display help graphics during input
FALSE: Only display help graphics when the CYCLE HELP soft key is set to ON. The CYCLE

HELP OFF/ON soft key is displayed in Programming operating mode after pressing the
Screen layout key

Behavior of the soft-key row after entering a cycle
TRUE: The cycle soft-key row remains active after a cycle definition
FALSE: The cycle soft-key row is hidden after a cycle definition

Confirmation request when deleting a block
TRUE: Display confirmation request when deleting an NC block
FALSE: Do not display confirmation request when deleting an NC block

Line number up to which a test of the NC program is to be run.
100 to 50000: Program length for which the geometry is to be checked

DIN/ISO programming: Block number increment
0 to 250: Increments for creation of DIN/ISO blocks in the program

Specify programmable axes
TRUE: Use the specified axis configuration
FALSE: Use the default axis configuration XYZABCUVW

Line number to which identical syntax elements are searched for
500 to 50000: Search for selected elements with up or down arrow keys

Behavior of PARAXMODE function with UVW axes
FALSE: PARAXMODE function enabled
TRUE: PARAXMODE function disabled
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Parameter settings

File management settings
Display of dependent files
MANUAL: Dependent files are displayed
AUTOMATIC: Dependent files are not displayed

Settings for tool-usage files
Create tool-usage file for NC program
NotAutoCreate: Do not create a tool usage list when a program is selected
OnProgSelectionlfNotExist: When a program is selected, create a list if does not yet exist

OnProgSelectionlfNecessary: When a program is selected, create a list if it does not yet
exist or is obsolete

OnProgSelectionAndModify: When a program is selected, create a list if it does not yet
exist or the program is changed

Create a pallet usage file
NotAutoCreate: Do not create a tool usage list when a pallet is selected

OnProgSelectionlfNotExist: When a pallet is selected, a list is created if it does not yet
exist

OnProgSelectionlfNecessary: When a pallet is selected, a list is created if it does not yet
exist or is obsolete

OnProgSelectionAndModify: When a pallet is selected, a list is created if it does not yet
exist, is obsolete or the program is changed

Paths for the end user
These machine parameters are only effective for a Windows programming station

List of drives and/or directories
Drives or directories entered here are shown in the control’s file manager

FN 16 output path for execution
Path for FN 16 output when no path is defined in the NC program

FN 16 output path for the Programming and Test Run operating modes
Path for FN 16 output when no path is defined in the NC program

Serial Interface RS232
Further information: "Setting up data interfaces", Page 276
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10.2 Pin layout and cables for data interfaces

RS-232-C/V.24 interface for HEIDENHAIN devices

o The interface complies with the requirements of
EN 50178 for Low voltage electrical separation.

When using the 25-pin adapter block:

Control Conn. cable 365725-xx Adapter block Conn. cable 274545-xx
310085-01

Male Assign- Female Color Female Male Female Male Color Female
ment

1 Do not 1 1 1 1 1 White/ 1
assign Brown

2 RXD 2 Yellow 3 3 3 3 Yellow 2

3 TXD 3 Green 2 2 2 2 Green 3

4 DTR 4 Brown 20 20 20 20 Brown 8

5 Signal 5 Red 7 7 7 7 Red 7
GND

6 DSR 6 Blue 6 6 6 6 6

7 RTS 7 Gray 4 4 Gray 5

8 CTR 8 Pink 5 Pink 4

9 Do not 9 8 Violet 20
assign

Hsg. External Hsg. External Hsg. Hsg. Hsg. Hsg. External Hsg.
shield shield shield
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When using the 9-pin adapter block:

Control Conn. cable 355484-xx Adapter block Conn. cable 366964-xx
363987-02

Male Assign- Female Color Male Female Male Female Color Female
ment

1 Do not 1 Red 1 1 1 1 Red 1
assign

2 RXD 2 Yellow 2 2 2 2 Yellow 3

3 TXD 3 White 3 3 3 3 White 2

4 DTR 4 Brown 4 4 4 4 Brown 6

5 Signal GND b5 Black 5 5 5 5 Black 5

6 DSR 6 Violet 6 6 6 6 Violet 4

7 RTS 7 Gray 7 7 7 7 Gray 8

8 CTR 8 White/ 8 8 8 8 White/ 7

Green Green

9 Do not 9 Green 9 9 9 9 Green 9
assign

Hsg. External Hsg. External Hsg. Hsg. Hsg. Hsg. External Hsg.
shield shield shield
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Non-HEIDENHAIN devices

The connector layout of a non-HEIDENHAIN device may
substantially differ from that of a HEIDENHAIN device.

It depends on the unit and the type of data transfer. The table
below shows the connector pin layout on the adapter block.

Adapter block 363987-02 Conn. cable 366964-xx

Female Male Female Color Female
1 1 1 Red 1
2 2 2 Yellow 3
3 3 3 White 2
4 4 4 Brown 6
5 5 5 Black 5
6 6 6 Violet 4
7 7 7 Gray 8
8 8 8 White/Green 7
9 9 9 Green 9
Hsg Hsg. Hsg External shield Hsg.
Ethernet interface RJ45 socket

Maximum cable length:

E Unshielded: 100 m

® Shielded: 400 m

Pin Signal Description

1 TX+ Transmit Data

2 TX- Transmit Data

3 REC+ Receive Data

4 Vacant

5 Vacant

6 REC- Receive Data

7 Vacant

8 Vacant
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10.3 Specifications

Explanation of symbols

m Default

o Axis option

1 Advanced Function Set 1

Specifications

Components

Operating panel
Screen with soft keys

Program memory

2GB

Input resolution and display
step

As fine as 0.1 pm for linear axes

Up to 0.0001° for rotary axes

Input range

Maximum 999 999 999 mm or 999 999 999°

Block processing time

6 ms

Axis feedback control

Position loop resolution: Signal period of the position encoder/1024
Cycle time of position controller: 3 ms
Cycle time of speed controller: 200 us

Range of traverse

Maximum 100 m (3937 inches)

Spindle speed

Maximum 100,000 rpm (analog speed command signal)

Error compensation

Linear and nonlinear axis error, backlash, thermal expansion

Static friction

Data interfaces

One each RS-232-C /V.24 max. 115 kilobaud

Expanded data interface with LSV-2 protocol for remote operation of the
control through the data interface with the TNCremo software

Ethernet interface 1000 BaseT
3 x USB (1 x front USB 2.0; 2 x rear USB 3.0)

Ambient temperature
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Input formats and units of control functions

Positions, coordinates, chamfer lengths

—99 999.9999 to +99 999.9999
(5,4: number of digits before and after the decimal point)
(mm]

Tool numbers

010327679 (5, 1)

Tool names

32 characters, enclosed by quotation marks with TOOL
CALL. Permitted special characters: #$ % & ., - _

Detail values for tool compensation

—-99.9999 to +99.9999 (2, 4) [mm]

Spindle speeds

0 t0 99 999.999 (5, 3) [rpm]

Feed rates

0 t0 99,999.999 (5, 3) [mm/min] or [mm/tooth] or [mm/1]

Dwell time in Cycle 9

0 to 3600.000 (4, 3) [s]

Thread pitch in various cycles

-9.9999 to +9.9999 (2, 4) [mm]

Angle for spindle orientation

0 to 360.0000 (3, 4) [°]

Datum numbers in Cycle 7 0to0 2999 (4, 0)

Scaling factor in Cycles 11 and 26 0.000001 to 99.999999 (2, 6)
Miscellaneous functions M 0to0 999 (4, 0)

Q parameter numbers 0to 1999 (4, 0)

Q parameter values —99 999.9999 to +99 999.9999 (9, 6)
Labels (LBL) for program jumps 0 t0 999 (5, 0)

Labels (LBL) for program jumps

Any text string in quotation marks (")

Number of program section repeats REP

1 to 65 534 (5, 0)

Error number for Q parameter function FN 14

0to 1199 (4, 0)
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User functions

User functions

Short description [ Basic version: 3 axes plus closed-loop spindle
| 1. Additional axis for 4 axes plus closed-loop spindle
| 2. Additional axis for 5 axes plus closed-loop spindle

Program entry In HEIDENHAIN conversational format
Position entry L] Nominal positions for straight lines in Cartesian coordinates
[ Incremental or absolute dimensions

L] Display and entry in mm or inches

Tool tables Multiple tool tables with any number of tools

Parallel operation Creating an NC program with graphical support while another NC program is
being run

Cutting data Automatic calculation of spindle speed, cutting speed, feed per tooth and

feed per revolution

Program jumps [ Subprograms
[ Program section repeats

[ Any desired NC program as subprogram

Machining cycles L] Cycles for drilling, and conventional and rigid tapping
[ Roughing and finishing rectangular pockets
[ Cycles for pecking, reaming, boring, and counterboring
[ Roughing and finishing rectangular studs
(] Cycles for clearing level surfaces
] Face milling
m Cartesian and polar point patterns

[ OEM cycles (special cycles developed by the machine manufacturer)
can also be integrated

Coordinate transformation [ Datum shift, mirroring

[ Scaling factor (axis-specific)

Q parameters [ Mathematical functions =, +, —, *, /, roots
Programming with variables - Logical operations (=, #, <, >)
L] Calculating with parentheses

[ sin @, cos @, tan a, arc sin, arc cos, arc tan, an, en, In, log, absolute
value of a number, constant 11, negation, truncation of digits before or
after the decimal point

] Functions for calculation of circles

[ String param.

Programming aids n Calculator
[ Complete list of all current error messages
[ Context-sensitive help function for error messages
[ TNCguide: The integrated help system.

[ Graphic support for the programming of cycles

[ Comment and structure blocks in the NC program
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User functions

Teach-In

Actual positions can be transferred directly to the NC program

Test graphics
Display modes

Graphic simulation before a program run, even while another
NC program is being run

Plan view / projection in 3 planes / 3-D view

Detail enlargement

Programming graphics

In the Programming operating mode, the contours of the NC blocks are
drawn on screen while they are being entered (2-D pencil-trace graph-
ics), even while another NC program is being run

Program-run graphics
Display modes

Graphic simulation of real-time machining in plan view / projection in 3
planes / 3-D view

Machining time

Calculation of machining time in the Test Run operating mode

Display of the current machining time in the Program Run, Single Block
and Program Run, Full Sequence operating modes

Preset management

For saving any presets

Contour, returning to

Block scan in any NC block in the NC program, returning the tool to the
calculated nominal position to continue machining

NC program interruption, contour departure and return

Datum tables

Multiple datum tables for storing workpiece-specific datums

Touch probe cycles

342

Calibrating the touch probe
Presetting, manual

Tools can be measured automatically
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Accessories

Accessories

Electronic handwheels | HR 510: Portable handwheel
n HR 550FS: Portable radio handwheel with display
[ HR 520: Portable handwheel with display
[ HR 420: Portable handwheel with display
(] HR 130: Panel-mounted handwheel

L] HR 150: Up to three panel-mounted handwheels via handwheel adapter
HRA 110

Touch probes m TS 248: 3-D touch trigger probe with cable connection

m TS 260: 3-D touch trigger probe with cable connection
[ TT 160: 3-D touch trigger probe for tool measurement
[ KT 130: Simple touch trigger probe with cable connection
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6.3	Kontur anfahren und verlassen

Übersicht: Bahnformen zum Anfahren  und Verlassen der Kontur

Die Funktionen APPR (engl. approach = Anfahrt) und DEP (engl. departure = Verlassen) werden mit der APPR/DEP-Taste aktiviert. Danach lassen sich folgende Bahnformen über Softkeys wählen:

Funktion

Anfahren

Verlassen

Gerade mit tangentialem Anschluss	

Gerade senkrecht zum Konturpunkt

Kreisbahn mit tangentialem Anschluss

Kreisbahn mit tangentialem Anschluss an die Kontur, An- und Wegfahren zu einem Hilfspunkt außerhalb der Kontur auf tangential anschließendem Geradenstück

Schraubenlinie anfahren und verlassen

Beim Anfahren und Verlassen einer Schraubenlinie (Helix) fährt das Werkzeug in der Verlängerung der Schraubenlinie und schließt so auf einer tangentialen Kreisbahn an die Kontur an. Verwenden Sie dazu die Funktion APPR CT bzw. DEP CT. 

Wichtige Positionen beim An- und Wegfahren

Startpunkt P

S

 

Diese Position programmieren Sie unmittelbar vor dem APPR-Satz.  P

S

 liegt außerhalb der Kontur und wird ohne Radiuskorrektur (R0) angefahren.

Hilfspunkt P

H

 

Das An- und Wegfahren führt bei einigen Bahnformen über einen Hilfspunkt P

H

, den die TNC aus Angaben im APPR- und DEP-Satz errechnet. Die TNC fährt von der aktuellen Position zum Hilfspunkt P

H

 im zuletzt programmierten Vorschub. Wenn Sie im letzten Positioniersatz vor der Anfahrfunktion FMAX (positionieren mit Eilgang) programmiert haben, dann fährt die TNC auch den Hilfspunkt P

H

 im Eilgang an

Erster Konturpunkt P

A

 und letzter Konturpunkt P

E

 

Den ersten Konturpunkt P

A

 programmieren Sie im APPR-Satz, den letzten Konturpunkt P

E

 mit einer beliebigen Bahnfunktion. Enthält der APPR-Satz auch die Z-Koordinate, fährt die TNC das Werkzeug erst in der Bearbeitungsebene auf P

H

 und dort in der Werkzeug-Achse auf die eingegebene Tiefe.

Endpunkt P

N

  

Die Position P

N

 liegt außerhalb der Kontur und ergibt sich aus Ihren Angaben im DEP-Satz. Enthält der DEP-Satz auch die Z-Koordinate, fährt die TNC das Werkzeug erst in der Bearbeitungsebene auf P

H

 und dort in der Werkzeug-Achse auf die eingegebene Höhe.

6.3

  

Kontur anfahren und verlassen

Anfahren auf einer Geraden mit tangentialem Anschluss: APPR LT

Die TNC fährt das Werkzeug auf einer Geraden vom Startpunkt P

S

 auf einen Hilfspunkt P

H

. Von dort aus fährt es den ersten Konturpunkt P

A

 auf einer Geraden tangential an. Der Hilfspunkt PH hat den Abstand LEN zum ersten Konturpunkt P

A

.

Beliebige Bahnfunktion: Startpunkt P

S

 anfahren

Dialog mit Taste APPR/DEP und Softkey APPR LT eröffnen:

Koordinaten des ersten Konturpunkts P

A

LEN: Abstand des Hilfspunkts P

H

 zum ersten Konturpunkt P

A

Radiuskorrektur RR/RL für die Bearbeitung

NC-Beispielsätze

7	L X+40 Y+10 R0 FMAX M3 

	P

S

 ohne Radiuskorrektur anfahren

8	APPR LT X+20 Y+20 Z-10 LEN15 RR F100

	P

A

 mit Radiuskorr. RR, Abstand P

H

 zu P

A

: LEN=15

9	L x+35 Y+35

	Endpunkt erstes Konturelement

10	L ...

	Nächstes Konturelement

Anfahren auf einer Geraden senkrecht zum ersten Konturpunkt: APPR LN 

Die TNC fährt das Werkzeug auf einer Geraden vom Startpunkt PS auf einen Hilfspunkt PH. Von dort aus fährt es den ersten Konturpunkt PA auf einer Geraden senkrecht an. Der Hilfspunkt PH hat den Abstand LEN + Werkzeug-Radius zum ersten Konturpunkt PA. 

Beliebige Bahnfunktion: Startpunkt PS anfahren

Dialog mit Taste APPR/DEP und Softkey APPR LN eröffnen:

Koordinaten des ersten Konturpunkts P

A

Länge: Abstand des Hilfspunkts P

H

. LEN immer positiv eingeben!

Radiuskorrektur RR/RL für die Bearbeitung

NC-Beispielsätze

7	L X+40 Y+10 R0 FMAX M3 

	P

S 

ohne Radiuskorrektur anfahren

8	APPR LN X+10 Y+20 Z-10 LEN15 RR F100 

	P

A

 mit Radiuskorr. RR

9	L X+20 Y+35 	

Endpunkt erstes Konturelement

10	L ... 

	Nächstes Konturelement

Anfahren auf einer Kreisbahn mit tangentialem Anschluss: APPR CT

Die TNC fährt das Werkzeug auf einer Geraden vom Startpunkt PS auf einen Hilfspunkt PH. Von dort fährt es auf einer Kreisbahn, die tangential in das erste Konturelement übergeht, den ersten Konturpunkt PA an. 

Die Kreisbahn von PH nach PA ist festgelegt durch den Radius R und den Mittelpunktswinkel CCA. Der Drehsinn der Kreisbahn ist durch den Verlauf des ersten Konturelements gegeben. 

Beliebige Bahnfunktion: Startpunkt PS anfahren

Dialog mit Taste APPR/DEP und Softkey APPR CT eröffnen:

Koordinaten des ersten Konturpunkts PA

	Radius R der Kreisbahn

Anfahren auf der Seite des Werkstücks, die durch die Radiuskorrektur definiert ist: R positiv eingeben

Von der Werkstück-Seite aus anfahren: 

R negativ eingeben

Mittelpunktswinkel CCA der Kreisbahn

	CCA nur positiv eingeben

Maximaler Eingabewert 360°

Radiuskorrektur RR/RL für die Bearbeitung

NC-Beispielsätze

7 L X+40 Y+10 R0 FMAX M3 	PS ohne Radiuskorrektur anfahren

8 APPR CT X+10 Y+20 Z-10 CCA180 R+10 RR F100 	PA mit Radiuskorr. RR, Radius R=10

9 L X+20 Y+35 	Endpunkt erstes Konturelement

10 L ... 	Nächstes Konturelement

Anfahren auf einer Kreisbahn mit tangentialem Anschluss an die Kontur und Geradenstück: APPR LCT

Die TNC fährt das Werkzeug auf einer Geraden vom Startpunkt PS auf einen Hilfspunkt PH. Von dort aus fährt es auf einer Kreisbahn den ersten Konturpunkt PA an. Der im APPR-Satz programmierte Vorschub ist wirksam für die gesamte Strecke, die die TNC im Anfahrsatz verfährt (Strecke PS – PA).

Wenn Sie im Anfahrsatz alle drei Hauptachs-Koordinaten X, Y und Z programmiert haben, dann fährt die TNC von der vor dem APPR-Satz definierten Position in allen drei Achsen gleichzeitig auf den Hilfspunkt PH und daran anschließend von PH nach PA nur in der Bearbeitungsebene.

Die Kreisbahn schließt sowohl an die Gerade PS – PH als auch an das erste Konturelement tangential an. Damit ist sie durch den Radius R eindeutig festgelegt.

Beliebige Bahnfunktion: Startpunkt PS anfahren

Dialog mit Taste APPR/DEP und Softkey APPR LCT eröffnen:

Koordinaten des ersten Konturpunkts PA

Radius R der Kreisbahn. R positiv angeben

Radiuskorrektur RR/RL für die Bearbeitung

NC-Beispielsätze

7 L X+40 Y+10 R0 FMAX M3 	PS ohne Radiuskorrektur anfahren

8 APPR LCT X+10 Y+20 Z-10 R10 RR F100 	PA mit Radiuskorr. RR, Radius R=10

9 L X+20 Y+35 	Endpunkt erstes Konturelement

10 L ... 	Nächstes Konturelement

Wegfahren auf einer Geraden mit tangentialem Anschluss: DEP LT

Die TNC fährt das Werkzeug auf einer Geraden vom letzten Konturpunkt PE zum Endpunkt PN. Die Gerade liegt in der Verlängerung des letzten Konturelements. PN befindet sich im Abstand LEN von PE.

	Letztes Konturelement mit Endpunkt PE und Radiuskorrektur programmieren

Dialog mit Taste APPR/DEP und Softkey DEP LT eröffnen:

LEN: Abstand des Endpunkts PN vom letzten Konturelement PE eingeben

NC-Beispielsätze

23 L Y+20 RR F100 	Letztes Konturelement: PE mit Radiuskorrektur

24 DEP LT LEN12.5 F100 	Um LEN=12,5 mm wegfahren

25 L Z+100 FMAX M2 	Z freifahren, Rücksprung, Programm-Ende

Wegfahren auf einer Geraden senkrecht zum letzten Konturpunkt: DEP LN

Die TNC fährt das Werkzeug auf einer Geraden vom letzten Konturpunkt PE zum Endpunkt PN. Die Gerade führt senkrecht vom letzten Konturpunkt PE weg. PN befindet sich von PE im Abstand LEN + Werkzeug-Radius.

	Letztes Konturelement mit Endpunkt PE und Radiuskorrektur programmieren

Dialog mit Taste APPR/DEP und Softkey DEP LN eröffnen:

LEN: Abstand des Endpunkts PN eingeben

Wichtig: LEN positiv eingeben!

NC-Beispielsätze

23 L Y+20 RR F100 	Letztes Konturelement: PE mit Radiuskorrektur

24 DEP LN LEN+20 F100  	Um LEN=20 mm senkrecht von Kontur wegfahren

25 L Z+100 FMAX M2 	Z freifahren, Rücksprung, Programm-Ende

Wegfahren auf einer Kreisbahn mit tangentialem Anschluss: DEP CT

Die TNC fährt das Werkzeug auf einer Kreisbahn vom letzten Konturpunkt PE zum Endpunkt PN. Die Kreisbahn schließt tangential an das letzte Konturelement an.

	Letztes Konturelement mit Endpunkt PE und Radiuskorrektur programmieren

Dialog mit Taste APPR/DEP und Softkey DEP CT eröffnen:

Mittelpunktswinkel CCA der Kreisbahn

Radius R der Kreisbahn

Das Werkzeug soll zu der Seite das Werkstück verlassen, die durch die Radiuskorrektur festgelegt ist: R positiv eingeben

Das Werkzeug soll zu der entgegengesetzten Seite das Werkstück verlassen, die durch die Radiuskorrektur festgelegt ist: R negativ eingeben

NC-Beispielsätze

23 L Y+20 RR F100 	Letztes Konturelement: PE mit Radiuskorrektur

24 DEP CT CCA 180 R+8 F100 	Mittelpunktswinkel=180°, 

	Kreisbahn-Radius=8 mm

25 L Z+100 FMAX M2 	Z freifahren, Rücksprung, Programm-Ende

Wegfahren auf einer Kreisbahn mit tangentialem Anschluss an Kontur und Geradenstück: DEP LCT

Die TNC fährt das Werkzeug auf einer Kreisbahn vom letzten Konturpunkt PE auf einen Hilfspunkt PH. Von dort fährt es auf einer Geraden zum Endpunkt PN. Das letzte Konturelement und die Gerade von PH – PN haben mit der Kreisbahn tangentiale Übergänge. Damit ist die Kreisbahn durch den Radius R eindeutig festgelegt.

	Letztes Konturelement mit Endpunkt PE und Radiuskorrektur programmieren

Dialog mit Taste APPR/DEP und Softkey DEP LCT eröffnen:

Koordinaten des Endpunkts PN eingeben

	Radius R der Kreisbahn. R positiv eingeben

NC-Beispielsätze

23 L Y+20 RR F100 	Letztes Konturelement: PE mit Radiuskorrektur

24 DEP LCT X+10 Y+12 R+8 F100 	Koordinaten PN, Kreisbahn-Radius=8 mm

25 L Z+100 FMAX M2 	Z freifahren, Rücksprung, Programm-Ende

	Kontur anfahren und verlassen

Start- und Endpunkt

Das Werkzeug fährt vom Startpunkt aus den ersten Konturpunkt an. Anforderungen an den Startpunkt:

Ohne Radiuskorrektur programmiert

Kollisionsfrei anfahrbar

Nahe am ersten Konturpunkt

Beispiel

Bild rechts oben: Wenn Sie den Startpunkt im dunkelgrauen Bereich festlegen, dann wird die Kontur beim Anfahren des ersten Konturpunkts beschädigt.

Erster Konturpunkt

Für die Werkzeugbewegung auf den ersten Konturpunkt programmieren Sie eine Radiuskorrektur.

Startpunkt in der Spindelachse anfahren

Beim Anfahren des Startpunkts muss das Werkzeug in der Spindelachse auf Arbeitstiefe fahren. Bei Kollisionsgefahr den Startpunkt in der Spindelachse separat anfahren.

NC-Beispielsätze

N30 G00 G40 X+20 Y+30 * 

N40 Z-10 * 

Endpunkt

Voraussetzungen für die Wahl des Endpunkts:

Kollisionsfrei anfahrbar

Nahe am letzten Konturpunkt

Konturbeschädigung ausschließen: Der optimale Endpunkt liegt in der Verlängerung der Werkzeugbahn für die Bearbeitung des letzten Konturelements

Beispiel

Bild rechts oben: Wenn Sie den Endpunkt im dunkelgrauen Bereich festlegen, dann wird die Kontur beim Anfahren des Endpunkts beschädigt.

Endpunkt in der Spindelachse verlassen:

Beim Verlassen des Endpunkts programmieren Sie die Spindelachse separat. Siehe Bild rechts Mitte.

NC-Beispielsätze

N50 G00 G40 X+60 Y+70 * 

N60 Z+250 * 

Gemeinsamer Start- und Endpunkt

Für einen gemeinsamen Start- und Endpunkt programmieren Sie keine Radiuskorrektur.

Konturbeschädigung ausschließen: Der optimale Startpunkt liegt zwischen den Verlängerungen der Werkzeugbahnen für die Bearbeitung des ersten und letzten Konturelements.

Beispiel

Bild rechts oben: Wenn Sie den Endpunkt im schraffierten Bereich festlegen, dann wird die Kontur beim Anfahren des ersten Konturpunktes beschädigt.

Tangential An- und Wegfahren

Mit G26 (Bild rechts Mitte) können Sie an das Werkstück tangential anfahren und mit G27 (Bild rechts unten) vom Werkstück tangential wegfahren. Dadurch vermeiden Sie Freischneidemarkierungen.

Start- und Endpunkt

Start- und Endpunkt liegen nahe am ersten bzw. letzten Konturpunkt außerhalb des Werkstücks und sind ohne Radiuskorrektur zu programmieren.

Anfahren

G26 nach dem Satz eingeben, in dem der erste Konturpunkt programmiert ist: Das ist der erste Satz mit Radiuskorrektur G41/G42

Wegfahren

G27 nach dem Satz eingeben, in dem der letzte Konturpunkt programmiert ist: Das ist der letzte Satz mit Radiuskorrektur G41/G42

	Den Radius für G26 und G27 müssen Sie so wählen, dass die TNC die Kreisbahn zwischen Startpunkt und erstem Konturpunkt sowie letztem Konturpunkt und Endpunkt ausführen kann.

NC-Beispielsätze

n50 g00 g40 g90 x-30 y+50 * 	Startpunkt

n60 g01 g41 x+0 y+50 f350 * 	Erster Konturpunkt

n70 g26 r5 * 	Tangential anfahren mir Radius R = 5 mm

. . .	

konturelemente programmieren	

. . .	Letzter Konturpunkt

n210 g27 r5 * 	Tangential Wegfahren mit Radius R = 5 mm

n220 g00 g40 x-30 y+50 * 	Endpunkt

	Bahnbewegungen - rechtwinklige Koordinaten

Übersicht der Bahnfunktionen

Funktion	Bahnfunktionstaste	Werkzeug-Bewegung	Erforderliche Eingaben	Seite

Gerade L

engl.: Line		Gerade	Koordinaten des Geraden-Endpunkts	Seite 189

Fase: CHF

engl.: CHamFer		Fase zwischen zwei Geraden	Fasenlänge	Seite 190

Kreismittelpunkt CC;

engl.: Circle Center		Keine	Koordinaten des Kreismittelpunkts bzw. Pols	Seite 192

Kreisbogen C

engl.: Circle		Kreisbahn um Kreismittelpunkt CC zum Kreisbogen-Endpunkt	Koordinaten des Kreis-Endpunkts, Drehrichtung	Seite 193

Kreisbogen CR

engl.: Circle by Radius		Kreisbahn mit bestimmten Radius	Koordinaten des Kreis-Endpunkts, Kreisradius, Drehrichtung	Seite 194

Kreisbogen CT

engl.: Circle Tangential		Kreisbahn mit tangentialem Anschluss an vorheriges und nachfolgendes Konturelement	Koordinaten des Kreis-Endpunkts	Seite 196

Ecken-Runden RND

engl.: RouNDing of Corner		Kreisbahn mit tangentialem Anschluss an vorheriges und nachfolgendes Konturelement	Eckenradius R	Seite 191

Freie Kontur-Programmierung FK		Gerade oder Kreisbahn mit beliebigem Anschluss an vorheriges Konturelement	siehe „Bahnbewegungen – Freie Kontur-Programmierung FK”, Seite 209	Seite 212

Bahnfunktionen programmieren

Bahnfunktionen können Sie komfortabel über die grauen Bahnfunktions-Tasten programmieren. Die TNC frägt in weiteren Dialogen nach den erforderlichen Eingaben.

	Falls Sie die DIN/ISO-Funktionen mit einer angeschlossene USB-Tastatur eingeben,  achten Sie darauf, dass die Großschreibung aktiv ist.

Gerade LGerade im Eilgang G00

Gerade mit Vorschub G01 F

Die TNC fährt das Werkzeug auf einer Geraden von seiner aktuellen Position zum Endpunkt der Geraden. Der Startpunkt ist der Endpunkt des vorangegangenen Satzes.

Koordinaten des Endpunkts der Geraden, falls nötig

	Radiuskorrektur RL/RR/R0 G40/G41/G42

	Vorschub F

Zusatz-Funktion M

Eilgangbewegung

Einen Geraden-Satz für eine Eilgangbewegung (G00-Satz) können Sie auch mit der Taste L eröffnen:

Drücken Sie die Taste L zum eröffnen eines Programmsatzes für eine Geradenbewegung

Wechseln Sie mit der Pfeil-Taste nach links in den Eingabebereich für die G-Funktionen

Wählen Sie den Softkey G00 für eine Verfahrbewegung im Eilgang

NC-Beispielsätze

7 L X+10 Y+40 RL F200 M3 

8 L IX+20 IY-15  

9 L X+60 IY-10  

N70 G01 G41 X+10 Y+40 F200 M3 * 

N80 G91 X+20 Y-15  * 

N90 G90 X+60 G91 Y-10 * 

Ist-Position übernehmen

Einen Geraden-Satz (LG01-Satz) können Sie auch mit der Taste „Ist-Position-übernehmen“ generieren:

Fahren Sie das Werkzeug in der Betriebsart Manueller Betrieb auf die Position, die übernommen werden soll

Bildschirm-Anzeige auf Programm-Einspeichern/Editieren wechseln

Programm-Satz wählen, hinter dem der L-Satz eingefügt werden soll

	Taste „Ist-Position-übernehmen“ drücken: Die TNC generiert einen L-Satz mit den Koordinaten der Ist-Position

Fase zwischen zwei Geraden einfügen

Konturecken, die durch den Schnitt zweier Geraden entstehen, können Sie mit einer Fase versehen.

In den Geradensätzen vor und nach dem CHFg24-Satz programmieren Sie jeweils beide Koordinaten der Ebene, in der die Fase ausgeführt wird

Die Radiuskorrektur vor und nach CHFg24-Satz muss gleich sein

Die Fase muss mit dem aktuellen Werkzeug ausführbar sein

Fasen-Abschnitt: Länge der Fase, falls nötig:

Vorschub F (wirkt nur im CHFg24-Satz)

NC-Beispielsätze

7 L X+0 Y+30 RL F300 M3 

8 L X+40 IY+5 

9 CHF 12 F250 

10 L IX+5 Y+0 

N70 G01 G41 X+0 Y+30 F300 M3 * 

N80 X+40 G91 Y+5 * 

N90 G24 R12 F250 * 

N100 G91 X+5 G90 Y+0 * 

	Eine Kontur nicht mit einem CHFg24-Satz beginnen.

Eine Fase wird nur in der Bearbeitungsebene ausgeführt.

Der von der Fase abgeschnittene Eckpunkt wird nicht angefahren.

Ein im CHF-Satz programmierter Vorschub wirkt nur in diesem CHF-Satz. Danach ist wieder der vor dem CHFg24-Satz programmierte Vorschub gültig.

Ecken-Runden RNDG25

Die Funktion RNDg25 rundet Kontur-Ecken ab.

Das Werkzeug fährt auf einer Kreisbahn, die sowohl an das vorhergegangene als auch an das nachfolgende Konturelement tangential anschließt.

Der Rundungskreis muss mit dem aufgerufenen Werkzeug ausführbar sein.

Rundungs-Radius: Radius des Kreisbogens, falls nötig: 

Vorschub F (wirkt nur im RNDg25-Satz)

NC-Beispielsätze

5 L X+10 Y+40 RL F300 M3 

6 L X+40 Y+25 

7 RND R5 F100 

8 L X+10 Y+5 

	Das vorhergehende und nachfolgende Konturelement sollte beide Koordinaten der Ebene enthalten, in der das Ecken-Runden ausgeführt wird. Wenn Sie die Kontur ohne Werkzeug-Radiuskorrektur bearbeiten, dann müssen Sie beide Koordinaten der Bearbeitungsebene programmieren.

Der Eckpunkt wird nicht angefahren.

Ein im RNDg25-Satz programmierter Vorschub wirkt nur in diesem RNDg25-Satz. Danach ist wieder der vor dem RNDg25-Satz programmierte Vorschub gültig.

Ein RND-Satz lässt sich auch zum weichen Anfahren an die Kontur nutzen.

Kreismittelpunkt CCI, J

Den Kreismittelpunkt legen Sie für Kreisbahnen fest, die Sie mit der C-Taste (Kreisbahn C) programmierendie Sie mit den Funktionen G02, G03 oder G05 programmieren. Dazu

geben Sie die rechtwinkligen Koordinaten des Kreismittelpunkts in der Bearbeitungsebene ein oder

übernehmen die zuletzt programmierte Position oder

	übernehmen die Koordinaten mit der Taste „Ist-Positionen-übernehmen“

Kreismittelpunkt programmieren: Taste SPEC FCT drücken.

	Softkey PROGRAMM FUNKTIONEN wählen

	Softkey DIN/ISO wählen

	Softkey I oder J wählen

Koordinaten für den Kreismittelpunkt eingeben oder

Um die zuletzt programmierte Position zu übernehmen: Keine KoordinatenG29 eingeben

NC-Beispielsätze

5 CC X+25 Y+25 

N50 I+25 J+25 * 

oder

10 L X+25 Y+25 

11 CC 

N10 G00 G40 X+25 Y+25 * 

N20 G29 * 

Die Programmzeilen 10 und 11 beziehen sich nicht auf das Bild.

	Gültigkeit

Der Kreismittelpunkt bleibt solange festgelegt, bis Sie einen neuen Kreismittelpunkt programmieren. Einen Kreismittelpunkt können Sie auch für die Zusatzachsen U, V und W festlegen.

Kreismittelpunkt inkremental eingeben

Eine inkremental eingegebene Koordinate für den Kreismittelpunkt bezieht sich immer auf die zuletzt programmierte Werkzeug-Position.

	Mit CC kennzeichnen Sie eine Position als Kreismittelpunkt: Das Werkzeug fährt nicht auf diese Position.

Der Kreismittelpunkt ist gleichzeitig Pol für Polarkoordinaten.

Kreisbahn C um Kreismittelpunkt CC

Legen Sie den Kreismittelpunkt CCI, J fest, bevor Sie die Kreisbahn programmieren. Die zuletzt programmierte Werkzeug-Position vor der Kreisbahn der Startpunkt der Kreisbahn.

Drehsinn

Im Uhrzeigersinn: G02

Im Gegen-Uhrzeigersinn: G03

Ohne Drehrichtungs-Angabe: G05. Die TNC fährt die Kreisbahn mit der zuletzt programmierten Drehrichtung

Werkzeug auf den Startpunkt der Kreisbahn fahren

Koordinaten des Kreismittelpunkts eingeben

Koordinaten des Kreisbogen-Endpunkts eingeben, falls nötig:

Drehsinn DR

Vorschub F

Zusatz-Funktion M

	Die TNC verfährt Kreisbewegungen normalerweise in der aktiven Bearbeitungsebene. Wenn Sie Kreise programmieren, die nicht in der aktiven Bearbeitungseben liegen, z.B. C Z... X... DR+g2 Z... X... bei Werkzeug-Achse Z, und gleichzeitig diese Bewegung rotieren, dann verfährt die TNC einen Raumkreis, also einen Kreis in 3 Achsen.

NC-Beispielsätze

5 CC X+25 Y+25 

6 L X+45 Y+25 RR F200 M3 

7 C X+45 Y+25 DR+ 

N50 I+25 J+25 * 

N60 G01 G42 X+45 Y+25 F200 M3 * 

N70 G03 X+45 Y+25 * 

Vollkreis

Programmieren Sie für den Endpunkt die gleichen Koordinaten wie für den Startpunkt.

	Start- und Endpunkt der Kreisbewegung müssen auf der Kreisbahn liegen.

Eingabe-Toleranz: bis 0.016 mm (über Maschinen-Parameter circleDeviation wählbar).

Kleinstmöglicher Kreis, den die TNC verfahren kann: 0.0016 µm.

Kreisbahn CRG02/G03/G05 mit festgelegtem Radius

Das Werkzeug fährt auf einer Kreisbahn mit dem Radius R.

Drehsinn

Im Uhrzeigersinn: G02

Im Gegen-Uhrzeigersinn: G03

Ohne Drehrichtungs-Angabe: G05. Die TNC fährt die Kreisbahn mit der zuletzt programmierten Drehrichtung

Koordinaten des Kreisbogen-Endpunkts

Radius R

Achtung: Das Vorzeichen legt die Größe des Kreisbogens fest!

Drehsinn DR

Achtung: Das Vorzeichen legt konkave oder konvexe Wölbung fest!

Zusatz-Funktion M

Vorschub F

Vollkreis

Für einen Vollkreis programmieren Sie zwei Kreissätze hintereinander:

Der Endpunkt des ersten Halbkreises ist Startpunkt des zweiten. Endpunkt des zweiten Halbkreises ist Startpunkt des ersten.

Zentriwinkel CCA und Kreisbogen-Radius R

Startpunkt und Endpunkt auf der Kontur lassen sich durch vier verschiedene Kreisbögen mit gleichem Radius miteinander verbinden:

Kleinerer Kreisbogen: CCA<180° 

Radius hat positives Vorzeichen R>0

Größerer Kreisbogen: CCA>180° 

Radius hat negatives Vorzeichen R<0

Über den Drehsinn legen Sie fest, ob der Kreisbogen außen (konvex) oder nach innen (konkav) gewölbt ist:

Konvex: Drehsinn DR–G02 (mit Radiuskorrektur RLG41)

Konkav: Drehsinn DR+G03 (mit Radiuskorrektur RLG41)

NC-Beispielsätze

10 L X+40 Y+40 RL F200 M3 

11 CR X+70 Y+40 R+20 DR- (Bogen 1) 

N100 G01 G41 X+40 Y+40 F200 M3 * 

N110 G02 X+70 Y+40 R+20 * (Bogen 1) 

oder

11 CR X+70 Y+40 R+20 DR+ (Bogen 2) 

N110 G03 X+70 Y+40 R+20 * (Bogen 2) 

oder

11 CR X+70 Y+40 R-20 DR- (Bogen 3) 

N110 G02 X+70 Y+40 R-20 * (Bogen 3) 

oder

11 CR X+70 Y+40 R-20 DR+ (Bogen 4) 

N110 G03 X+70 Y+40 R-20 * (Bogen 4) 

	Der Abstand von Start- und Endpunkt des Kreisdurchmessers darf nicht größer als der Kreisdurchmesser sein.

Der maximale Radius beträgt 99,9999 m.

Winkelachsen A, B und C werden unterstützt.

Kreisbahn CTG06 mit tangentialem Anschluss

Das Werkzeug fährt auf einem Kreisbogen, der tangential an das zuvor programmierte Konturelement anschließt.

Ein Übergang ist „tangential“, wenn am Schnittpunkt der Konturelemente kein Knick- oder Eckpunkt entsteht, die Konturelemente also stetig ineinander übergehen.

Das Konturelement, an das der Kreisbogen tangential anschließt, programmieren Sie direkt vor dem CTG06-Satz. Dazu sind mindestens zwei Positionier-Sätze erforderlich

Koordinaten des Kreisbogen-Endpunkts, falls nötig:

	Vorschub F

Zusatz-Funktion M

NC-Beispielsätze

7 L X+0 Y+25 RL F300 M3 

8 L X+25 Y+30 

9 CT X+45 Y+20 

10 L Y+0 

N70 G01 G41 X+0 Y+25 F300 M3 * 

N80 X+25 Y+30 * 

N90 G06 X+45 Y+20 * 

G01 Y+0 * 

	Der CTG06-Satz und das zuvor programmierte Konturelement sollten beide Koordinaten der Ebene enthalten, in der der Kreisbogen ausgeführt wird!

Beispiel: Geradenbewegung und Fasen kartesisch

	

0 BEGIN PGM LINEAR MM 	

1 BLK FORM 0.1 Z X+0 Y+0 Z-20 	Rohteil-Definition für grafische Simulation der Bearbeitung

2 BLK FORM 0.2 X+100 Y+100 Z+0 	

3 TOOL CALL 1 Z S4000 	Werkzeug-Aufruf mit Spindelachse und Spindeldrehzahl

4 L Z+250 R0 FMAX 	Werkzeug freifahren in der Spindelachse mit Eilgang FMAX

5 L X-10 Y-10 R0 FMAX 	Werkzeug vorpositionieren

6 L Z-5 R0 F1000 M3 	Auf Bearbeitungstiefe fahren mit Vorschub F = 1000 mm/min

7 APPR LT X+5 y+5 LEN10 RL F300 	Kontur an Punkt 1 anfahren auf einer Geraden mit 

	tangentialem Anschluss

8 L Y+95 	Punkt 2 anfahren

9 L X+95 	Punkt 3: erste Gerade für Ecke 3

10 CHF 10 	Fase mit Länge 10 mm programmieren

11 L Y+5 	Punkt 4: zweite Gerade für Ecke 3, erste Gerade für Ecke 4

12 CHF 20 	Fase mit Länge 20 mm programmieren

13 L X+5 	Letzten Konturpunkt 1 anfahren, zweite Gerade für Ecke 4

14 DEP LT LEN10 F1000 	Kontur verlassen auf einer Geraden mit tangentialem Anschluss

15 L Z+250 R0 FMAX M2 	Werkzeug freifahren, Programm-Ende

16 END PGM LINEAR MM 	

%linear g71 * 	

n10 g30 g17 x+0 y+0 z-20 * 	Rohteil-Definition für grafische Simulation der Bearbeitung

n20 g31 g90 x+100 y+100 z+0 * 	

n30 t1 g17 s4000 * 	Werkzeug-Aufruf mit Spindelachse und Spindeldrehzahl

n40 g00 g40 g90 z+250 * 	Werkzeug freifahren in der Spindelachse mit Eilgang

n50 x-10 y-10 * 	Werkzeug vorpositionieren

n60 g01 z-5 f1000 m3 * 	Auf Bearbeitungstiefe fahren mit Vorschub F = 1000 mm/min

n70 g01 g41 x+5 y+5 f300 * 	Kontur an Punkt 1 anfahren, Radiuskorrektur G41 aktivieren 

n80 g26 r5 f150 * 	Tangentiales Anfahren

n90 y+95 * 	Punkt 2 anfahren

n100 x+95 * 	Punkt 3: erste Gerade für Ecke 3

n110 g24 r10 * 	Fase mit Länge 10 mm programmieren

n120 y+5 * 	Punkt 4: zweite Gerade für Ecke 3, erste Gerade für Ecke 4

n130 g24 r20 * 	Fase mit Länge 20 mm programmieren

n140 x+5 * 	Letzten Konturpunkt 1 anfahren, zweite Gerade für Ecke 4

n150 g27 r5 f500 * 	Tangentiales Wegfahren

n160 g40 x-20 y-20 f1000 * 	Freifahren in der Bearbeitungsebene, Radiuskorrektur aufheben

n170 g00 z+250 m2 * 	Werkzeug freifahren, Programm-Ende

n99999999 %linear g71 * 	

Beispiel: Kreisbewegung kartesisch

	

0 BEGIN PGM CIRCULAR MM 	

1 BLK FORM 0.1 Z X+0 Y+0 Z-20 	Rohteil-Definition für grafische Simulation der Bearbeitung

2 BLK FORM 0.2 X+100 Y+100 Z+0 	

3 TOOL CALL 1 Z s4000 	Werkzeug-Aufruf mit Spindelachse und Spindeldrehzahl

4 L Z+250 R0 FMAX 	Werkzeug freifahren in der Spindelachse mit Eilgang FMAX

5 L X-10 Y-10 R0 FMAX 	Werkzeug vorpositionieren

6 L Z-5 R0 F1000 M3 	Auf Bearbeitungstiefe fahren mit Vorschub F = 1000 mm/min

7 APPR LCT X+5 Y+5 R5 RL F300 	Kontur an Punkt 1 anfahren auf einer Kreisbahn mit 

	tangentialem Anschluss

8 L X+5 Y+85 	Punkt 2: erste Gerade für Ecke 2

9 RND R10 F150 	Radius mit R = 10 mm einfügen, Vorschub: 150 mm/min

10 L X+30 Y+85 	Punkt 3 anfahren: Startpunkt des Kreises mit CR

11 CR X+70 Y+95 R+30 DR- 	Punkt 4 anfahren: Endpunkt des Kreises mit CR, Radius 30 mm

12 L X+95 	Punkt 5 anfahren

13 L X+95 Y+40 	Punkt 6 anfahren

14 CT X+40 Y+5 	Punkt 7 anfahren: Endpunkt des Kreises, Kreisbogen mit tangentia-

	lem Anschluss an Punkt 6, TNC berechnet den Radius selbst

15 L X+5 	Letzten Konturpunkt 1 anfahren

16 DEP LCT X-20 Y-20 R5 F1000 	Kontur verlassen auf einer Kreisbahn mit tangentialem Anschluss

17 L Z+250 R0 FMAX M2 	Werkzeug freifahren, Programm-Ende

18 END PGM CIRCULAR MM 	

%circular g71 * 	

n10 g30 g17 x+0 y+0 z-20 * 	Rohteil-Definition für grafische Simulation der Bearbeitung

n20 g31 g90 x+100 y+100 z+0 * 	

n30 t1 g17 s4000 * 	Werkzeug-Aufruf mit Spindelachse und Spindeldrehzahl

n40 g00 g40 g90 z+250 * 	Werkzeug freifahren in der Spindelachse mit Eilgang

n50 x-10 y-10 * 	Werkzeug vorpositionieren

n60 g01 z-5 f1000 m3 * 	Auf Bearbeitungstiefe fahren mit Vorschub F = 1000 mm/min

n70 g01 g41 x+5 y+5 f300 * 	Kontur an Punkt 1 anfahren, Radiuskorrektur G41 aktivieren 

n80 g26 r5 f150 * 	Tangentiales Anfahren

n90 y+85 * 	Punkt 2: erste Gerade für Ecke 2

n100 g25 r10 * 	Radius mit R = 10 mm einfügen, Vorschub: 150 mm/min

n110 x+30 * 	Punkt 3 anfahren: Startpunkt des Kreises

n120 g02 x+70 y+95 r+30 * 	Punkt 4 anfahren: Endpunkt des Kreises mit G02, Radius 30 mm

n130 g01 x+95 * 	Punkt 5 anfahren

n140 y+40 * 	Punkt 6 anfahren

n150 g06 x+40 y+5 * 	Punkt 7 anfahren: Endpunkt des Kreises, Kreisbogen mit tangentia-

	lem Anschluss an Punkt 6, TNC berechnet den Radius selbst

n160 g01 x+5 * 	Letzten Konturpunkt 1 anfahren

n170 g27 r5 f500 * 	Kontur verlassen auf einer Kreisbahn mit tangentialem Anschluss

n180 g40 x-20 y-20 f1000 * 	Freifahren in der Bearbeitungsebene, Radiuskorrektur aufheben

n190 g00 z+250 m2 * 	Werkzeug freifahren in der Werkzeug-Achse, Programm-Ende

n99999999 %circular g71 * 	

Beispiel: Vollkreis kartesisch

	

0 BEGIN PGM C-CC MM 	

1 BLK FORM 0.1 Z X+0 Y+0 Z-20 	Rohteil-Definition

2 BLK FORM 0.2 X+100 Y+100 Z+0 	

3 TOOL CALL 1 Z S3150 	Werkzeug-Aufruf

4 CC X+50 Y+50 	Kreismittelpunkt definieren

5 L Z+250 R0 FMAX 	Werkzeug freifahren

6 L X-40 Y+50 R0 FMAX 	Werkzeug vorpositionieren

7 L Z-5 R0 F1000 M3 	Auf Bearbeitungstiefe fahren

8 APPR LCT X+0 Y+50 R5 RL F300 	Kreisstartpunkt anfahren auf einer Kreisbahn mit tangentialem

	Anschluss

9 C X+0 DR- 	Kreisendpunkt (=Kreisstartpunkt) anfahren

10 DEP LCT X-40 Y+50 R5 F1000 	Kontur verlassen auf einer Kreisbahn mit tangentialem

	Anschluss

11 L Z+250 R0 FMAX M2 	Werkzeug freifahren, Programm-Ende

12 END PGM C-CC MM 	

%c-cc g71 * 	

n10 g30 g17 x+0 y+0 z-20 * 	Rohteil-Definition

n20 g31 g90 x+100 y+100 z+0 * 	

n30 t1 g17 s3150 * 	Werkzeug-Aufruf

n40 g00 g40 g90 z+250 * 	Werkzeug freifahren

n50 i+50 j+50 * 	Kreismittelpunkt definieren

n60 x-40 y+50 * 	Werkzeug vorpositionieren

n70 g01 z-5 f1000 m3 * 	Auf Bearbeitungstiefe fahren

n80 g41 x+0 y+50 f300 * 	Kreisstartpunkt anfahren, Radiuskorrektur G41

n90 g26 r5 f150 * 	Tangentiales Anfahren

n100 g02 x+0 * 	Kreisendpunkt (=Kreisstartpunkt) anfahren

n110 g27 r5 f500 * 	Tangentiales Wegfahren

n120 g01 g40 x-40 y-50 f1000 * 	Freifahren in der Bearbeitungsebene, Radiuskorrektur aufheben

n130 g00 z+250 m2 * 	Werkzeug freifahren in der Werkzeug-Achse, Programm-Ende

n99999999 %c-cc g71 * 	

Bahnbewegungen – Polarkoordinaten

Übersicht

Mit Polarkoordinaten legen Sie eine Position über einen Winkel PAH und einen Abstand PRR zu einem zuvor definierten Pol CCI, J fest.

Polarkoordinaten setzen Sie vorteilhaft ein bei:

Positionen auf Kreisbögen

Werkstück-Zeichnungen mit Winkelangaben, z.B. bei Lochkreisen

Übersicht der Bahnfunktion mit Polarkoordinaten

Funktion	Bahnfunktionstaste	Werkzeug-Bewegung	Erforderliche Eingaben	Seite

Gerade LPG10, G11	 + 	Gerade	Polarradius, Polarwinkel des Geraden-Endpunkts	Seite 202

Kreisbogen CPG12, G13	 + 	Kreisbahn um Kreismittelpunkt/ Pol zum Kreisbogen-Endpunkt	Polarwinkel des Kreisendpunkts, Drehrichtung	Seite 203

Kreisbogen G15	 + 	Kreisbahn entsprechend aktiver Drehrichtung	Polarwinkel des Kreisendpunkts	Seite 212

Kreisbogen CTPG16	 + 	Kreisbahn mit tangentialem Anschluss an vorheriges Konturelement	Polarradius, Polarwinkel des Kreisendpunkts	Seite 204

Schraubenlinie (Helix)	 + 	Überlagerung einer Kreisbahn mit einer Geraden	Polarradius, Polarwinkel des Kreisendpunkts, Koordinate des Endpunkts in der Werkzeugachse	Seite 205

Polarkoordinaten-Ursprung: Pol CCI, J

Den Pol CC können Sie an beliebigen Stellen im Bearbeitungs-Programm festlegen, bevor Sie Positionen durch Polarkoordinaten angeben. Gehen Sie beim Festlegen des Pols vor, wie beim Programmieren des Kreismittelpunkts.

Pol programmieren: Taste SPEC FCT drücken.

	Softkey PROGRAMM FUNKTIONEN wählen

	Softkey DIN/ISO wählen

	Softkey I oder J wählen

	Koordinaten: Rechtwinklige Koordinaten für den Pol eingeben oder um die zuletzt programmierte Position zu übernehmen: G29 eingeben. Den Pol festlegen, bevor Sie Polarkoordinaten programmieren. Pol nur in rechtwinkligen Koordinaten programmieren. Der Pol ist solange wirksam, bis Sie einen neuen Pol festlegen.

	Koordinaten: Rechtwinklige Koordinaten für den Pol eingeben oder um die zuletzt programmierte Position zu übernehmen: Keine Koordinaten eingeben. Den Pol festlegen, bevor Sie Polarkoordinaten programmieren. Pol nur in rechtwinkligen Koordinaten programmieren. Der Pol ist solange wirksam, bis Sie einen neuen Pol festlegen.

NC-Beispielsätze

12 CC X+45 Y+25 

N120 I+45 j+45 * 

Gerade LPim Eilgang G10

Gerade mit Vorschub G11 F

Das Werkzeug fährt auf einer Geraden von seiner aktuellen Position zum Endpunkt der Geraden. Der Startpunkt ist der Endpunkt des vorangegangenen Satzes.

Polarkoordinaten-Radius PRR: Abstand des Geraden-Endpunkts zum Pol CC eingeben

Polarkoordinaten-Winkel PAH: Winkelposition des Geraden-Endpunkts zwischen –360° und +360°

Das Vorzeichen von PAH ist durch die Winkel-Bezugsachse festgelegt:

Winkel von der Winkel-Bezugsachse zu PRR gegen den Uhrzeigersinn: PAH>0

Winkel von der Winkel-Bezugsachse zu PRR im Uhrzeigersinn: PAH<0

NC-Beispielsätze

12 CC X+45 Y+25 

13 LP PR+30 PA+0 RR F300 M3 

14 LP PA+60 

15 LP IPA+60 

16 LP PA+180 

N120 I+45 J+45 * 

N130 G11 G42 R+30 h+0 F300 M3 * 

N140 H+60 * 

N150 G91 H+60 * 

N160 G90 H+180 * 

Kreisbahn CPG12/G13/G15 um Pol CCI, J

Der Polarkoordinaten-Radius PRR ist gleichzeitig Radius des Kreisbogens. PRR ist durch den Abstand des Startpunkts zum Pol CCI, J festgelegt. Die zuletzt programmierte Werkzeug-Position vor der Kreisbahn ist der Startpunkt der Kreisbahn.

Drehsinn

Im Uhrzeigersinn: G12

Im Gegen-Uhrzeigersinn: G13

Ohne Drehrichtungs-Angabe: G15. Die TNC fährt die Kreisbahn mit der zuletzt programmierten Drehrichtung

Polarkoordinaten-Winkel PAH: Winkelposition des Kreisbahn-Endpunkts zwischen –99999,9999° und +99999,9999°

Drehsinn DR

NC-Beispielsätze

18 CC X+25 Y+25 

19 LP PR+20 PA+0 RR F250 M3 

20 CP PA+180 DR+ 

N180 I+25 J+25 * 

N190 G11 G42 R+20 h+0 F250 M3 * 

N200 G13 H+180 * 

	Bei inkrementalen Koordinaten gleiches Vorzeichen für DR und PA eingeben.	

Kreisbahn CTPG16 mit tangentialem Anschluss

Das Werkzeug fährt auf einer Kreisbahn, die tangential an ein vorangegangenes Konturelement anschließt.

Polarkoordinaten-Radius PRR: Abstand des Kreisbahn-Endpunkts zum Pol CCI, J

Polarkoordinaten-Winkel PAH: Winkelposition des Kreisbahn-Endpunkts

NC-Beispielsätze

12 CC X+40 Y+35 

13 L X+0 Y+35 RL F250 M3 

14 LP PR+25 PA+120 

15 CTP PR+30 PA+30 

16 L Y+0 

N120 I+40 J+35 * 

N130 G01 G42 X+0 Y+35 F250 M3 * 

N140 G11 R+25 H+120 * 

N150 G16 R+30 H+30 * 

N160 G01 Y+0 * 

	Der Pol ist nicht Mittelpunkt des Konturkreises!

Schraubenlinie (Helix)

Eine Schraubenlinie entsteht aus der Überlagerung einer Kreisbewegung und einer Geradenbewegung senkrecht dazu. Die Kreisbahn programmieren Sie in einer Hauptebene.

Die Bahnbewegungen für die Schraubenlinie können Sie nur in Polarkoordinaten programmieren.

Einsatz

Innen- und Außengewinde mit größeren Durchmessern

Schmiernuten

Berechnung der Schraubenlinie

Zum Programmieren benötigen Sie die inkrementale Angabe des Gesamtwinkels, den das Werkzeug auf der Schraubenlinie fährt und die Gesamthöhe der Schraubenlinie.

Für die Berechnung in Fräsrichtung von unten nach oben gilt:

Anzahl Gänge n	Gewindegänge + Gangüberlauf am 

Gewinde-Anfang und -ende

Gesamthöhe h	Steigung P x Anzahl der Gänge n

Inkrementaler Gesamtwinkel IPAh	Anzahl der Gänge x 360° + Winkel für 

Gewinde-Anfang + Winkel für Gangüberlauf

Anfangskoordinate Z	Steigung P x (Gewindegänge + Gangüberlauf am Gewinde-Anfang)

Form der Schraubenlinie

Die Tabelle zeigt die Beziehung zwischen Arbeitsrichtung, Drehsinn und Radiuskorrektur für bestimmte Bahnformen.

Innengewinde	Arbeitsrichtung	Drehsinn	Radiuskorrektur

rechtsgängig

linksgängig	Z+

Z+	DR+G13

DR–G12 	RLG41

RRG42

rechtsgängig

linksgängig	Z–

Z–	DR–G12 

DR+G13	RRG42

RLG41

Außengewinde			

rechtsgängig

linksgängig	Z+

Z+	DR+G13

DR–G12 	RRG42

RLG41

rechtsgängig

linksgängig	Z–

Z–	DR–G12 

DR+G13 	RLG41

RRG42

Schraubenlinie programmieren

	Geben Sie Drehsinn und den inkrementalen Gesamtwinkel IPAG91 h mit gleichem Vorzeichen ein, sonst kann das Werkzeug in einer falschen Bahn fahren.

Für den Gesamtwinkel IPAG91 h ist ein Wert von -99 999,9999° bis +99 999,9999° eingebbar.

Polarkoordinaten-Winkel: Gesamtwinkel inkremental eingeben, den das Werkzeug auf der Schraubenlinie fährt. Nach der Eingabe des Winkels wählen Sie die Werkzeug-Achse mit einer Achswahltaste.

Koordinate für die Höhe der Schraubenlinie inkremental eingeben

Drehsinn DR 

Schraubenlinie im Uhrzeigersinn: DR–

Schraubenlinie gegen den Uhrzeigersinn: DR+

Radiuskorrektur gemäß Tabelle eingeben

NC-Beispielsätze: Gewinde M6 x 1 mm mit 5 Gängen

12 CC X+40 Y+25 

13 L Z+0 F100 M3 

14 LP PR+3 PA+270 RL F50 

15 CP IPA-1800 IZ+5 DR- 

N120 I+40 J+25 * 

N130 G01 Z+0 F100 M3 * 

N140 G11 G41 R+3 h+270 * 

N150 G12 G91 h-1800 Z+5 * 

Beispiel: Geradenbewegung polar

	

0 BEGIN PGM LINEARPO MM 	

1 BLK FORM 0.1 Z X+0 Y+0 Z-20 	Rohteil-Definition

2 BLK FORM 0.2 X+100 Y+100 Z+0 	

3 TOOL CALL 1 Z S4000 	Werkzeug-Aufruf

4 CC X+50 Y+50 	Bezugspunkt für Polarkoordinaten definieren

5 L Z+250 R0 FMAX 	Werkzeug freifahren

6 LP PR+60 PA+180 R0 FMAX 	Werkzeug vorpositionieren

7 L Z-5 R0 F1000 M3 	Auf Bearbeitungstiefe fahren

8 APPR PLCT PR+45 PA+180 R5 RL F250 	Kontur an Punkt 1 anfahren auf einem Kreis mit tangentialem Anschluss

9 LP PA+120 	Punkt 2 anfahren

10 LP PA+60 	Punkt 3 anfahren

11 LP PA+0 	Punkt 4 anfahren

12 LP PA-60 	Punkt 5 anfahren

13 LP PA-120 	Punkt 6 anfahren

14 LP PA+180 	Punkt 1 anfahren

15 DEP PLCT PR+60 PA+180 R5 F1000 	Kontur verlassen auf einem Kreis mit tangentialem Anschluss

16 L Z+250 R0 FMAX M2 	Werkzeug freifahren, Programm-Ende

17 END PGM LINEARPO MM 	

%linearpo g71 * 	

n10 g30 g17 x+0 y+0 z-20 * 	Rohteil-Definition

n20 g31 g90 x+100 y+100 z+0 * 	

n30 t1 g17 s4000 * 	Werkzeug-Aufruf

n40 g00 g40 g90 z+250 * 	Bezugspunkt für Polarkoordinaten definieren

n50 i+50 j+50 * 	Werkzeug freifahren

n60 g10 r+60 h+180 * 	Werkzeug vorpositionieren

n70 g01 z-5 f1000 m3 * 	Auf Bearbeitungstiefe fahren

n80 g11 g41 r+45 h+180 f250 * 	Kontur an Punkt 1 anfahren

n90 g26 r5 * 	Kontur an Punkt 1 anfahren

n100 h+120 * 	Punkt 2 anfahren

n110 h+60 * 	Punkt 3 anfahren

n120 h+0 * 	Punkt 4 anfahren

n130 h-60 * 	Punkt 5 anfahren

n140 h-120 * 	Punkt 6 anfahren

n150 h+180 * 	Punkt 1 anfahren

n160 g27 r5 f500 * 	Tangentiales Wegfahren

n170 g40 r+60 h+180 f1000 * 	Freifahren in der Bearbeitungsebene, Radiuskorrektur aufheben

n180 g00 z+250 m2 * 	Freifahren in der Spindelachse, Programm-Ende

n99999999 %linearpo g71 * 	

Beispiel: Helix

	

0 BEGIN PGM HELIX MM 	

1 BLK FORM 0.1 Z X+0 Y+0 Z-20 	Rohteil-Definition

2 BLK FORM 0.2 X+100 Y+100 Z+0 	

3 TOOL CALL 1 Z S1400 	Werkzeug-Aufruf

4 L Z+250 R0 FMAX 	Werkzeug freifahren

5 L X+50 Y+50 R0 FMAX 	Werkzeug vorpositionieren

6 CC 	Letzte programmierte Position als Pol übernehmen

7 L Z-12,75 R0 F1000 M3 	Auf Bearbeitungstiefe fahren

8 APPR PCT PR+32 PA-182 CCA180 R+2 RL F100 	Kontur anfahren auf einem Kreis mit tangentialem Anschluss

9 CP IPA+3240 IZ+13.5 DR+ F200 	Helix fahren

10 DEP CT CCA180 R+2 	Kontur verlassen auf einem Kreis mit tangentialem Anschluss

11 L Z+250 R0 FMAX M2 	Werkzeug freifahren, Programm-Ende

12 END PGM HELIX MM 	

%helix g71 * 	

n10 g30 g17 x+0 y+0 z-20 * 	Rohteil-Definition

n20 g31 g90 x+100 y+100 z+0 * 	

n30 t1 g17 s1400 * 	Werkzeug-Aufruf

n40 g00 g40 g90 z+250 * 	Werkzeug freifahren

n50 x+50 y+50 * 	Werkzeug vorpositionieren

n60 g29 * 	Letzte programmierte Position als Pol übernehmen

n70 g01 z-12,75 f1000 m3 * 	Auf Bearbeitungstiefe fahren

n80 g11 g41 r+32 h+180 f250 * 	Ersten Konturpunkt anfahren

n90 g26 r2 * 	Anschluss

n100 g13 g91 h+3240 z+13,5 f200 * 	Helix fahren

n110 g27 r2 f500 * 	Tangentiales Wegfahren

n120 g01 g40 g90 x+50 y+50 f1000 * 	Werkzeug freifahren, Programm-Ende

n130 g00 z+250 m2 * 	

Bahnbewegungen – Freie Kontur-Programmierung FK

Grundlagen

Werkstückzeichnungen, die nicht NC-gerecht bemaßt sind, enthalten oft Koordinaten-Angaben, die Sie nicht über die grauen Dialog-Tasten eingeben können. So können z.B.

bekannte Koordinaten auf dem Konturelement oder in der Nähe liegen,

Koordinaten-Angaben sich auf ein anderes Konturelement beziehen oder 

Richtungsangaben und Angaben zum Konturverlauf bekannt sein.

Solche Angaben programmieren Sie direkt mit der Freien Kontur-Programmierung FK. Die TNC errechnet die Kontur aus den bekannten Koordinaten-Angaben und unterstützt den Programmier-Dialog mit der interaktiven FK-Grafik. Das Bild rechts oben zeigt eine Bemaßung, die Sie am einfachsten über die FK-Programmierung eingeben.

	Beachten Sie folgende Voraussetzungen für die FK-Programmierung

Konturelemente können Sie mit der Freien Kontur-Programmierung nur in der Bearbeitungsebene programmieren. Die Bearbeitungsebene legen Sie im ersten BLK FORM-Satz des Bearbeitungs-Programms fest.

Geben Sie für jedes Konturelement alle verfügbaren Daten ein. Programmieren Sie auch Angaben in jedem Satz, die sich nicht ändern: Nicht programmierte Daten gelten als nicht bekannt!

Q-Parameter sind in allen FK-Elementen zulässig, außer in Elementen mit Relativ-Bezügen (z.B RX oder RAN), also Elementen, die sich auf andere NC-Sätze beziehen.

Wenn Sie im Programm konventionelle und Freie Kontur-Programmierung mischen, dann muss jeder FK-Abschnitt eindeutig bestimmt sein.

Die TNC benötigt einen festen Punkt, von dem aus die Berechnungen durchgeführt werden. Programmieren Sie direkt vor dem FK-Abschnitt mit den grauen Dialogtasten eine Position, die beide Koordinaten der Bearbeitungsebene enthält. In diesem Satz keine Q-Parameter programmieren.

Wenn der erste Satz im FK-Abschnitt ein FCT- oder FLT-Satz ist, müssen Sie davor mindestens zwei NC-Sätze über die grauen Dialog-Tasten programmieren, damit die Anfahrrichtung eindeutig bestimmt ist.

Ein FK-Abschnitt darf nicht direkt hinter einer Marke LBL beginnen.

Grafik der FK-Programmierung

	Um die Grafik bei der FK-Programmierung nutzen zu können, wählen Sie die Bildschirm-Aufteilung PROGRAMM + GRAFIK (siehe „Programm-Einspeichern/Editieren” auf Seite 63)

Mit unvollständigen Koordinaten-Angaben lässt sich eine Werkstück-Kontur oft nicht eindeutig festlegen. In diesem Fall zeigt die TNC die verschiedenen Lösungen in der FK-Grafik an und Sie wählen die richtige aus. Die FK-Grafik stellt die Werkstück-Kontur mit verschiedenen Farben dar:

blau	Das Konturelement ist eindeutig bestimmt

grün			Die eingegebenen Daten lassen mehrere Lösungen zu; Sie wählen die richtige aus

rot			Die eingegebenen Daten legen das Konturelement noch nicht ausreichend fest; Sie geben weitere Angaben ein

Wenn die Daten auf mehrere Lösungen führen und das Konturelement grün angezeigt wird, dann wählen Sie die richtige Kontur wie folgt:

Softkey ZEIGE LÖSUNG so oft drücken, bis das Konturelement richtig angezeigt wird. Benutzen Sie die Zoom-Funktion (2. Softkey-Leiste), wenn mögliche Lösungen in der Standard-Darstellung nicht unterscheidbar sind 

Das angezeigte Konturelement entspricht der Zeichnung: Mit Softkey LÖSUNG WÄHLEN festlegen

	Wenn Sie eine grün dargestellte Kontur noch nicht festlegen wollen, dann drücken Sie den Softkey AUSWAHL BEENDEN, um den FK-Dialog fortzuführen.

	Die grün dargestellten Konturelemente sollten Sie so früh wie möglich mit LÖSUNG WÄHLEN festlegen, um die Mehrdeutigkeit für die nachfolgenden Konturelemente einzuschränken.

Ihr Maschinenhersteller kann für die FK-Grafik andere Farben festlegen.

NC-Sätze aus einem Programm, das mit PGM CALL aufgerufen wird, zeigt die TNC mit einer weiteren Farbe.

Satznummern im Grafikfenster anzeigen

Um Satznummern im Grafikfenster anzuzeigen: 

Softkey anzeigen ausblend. satz-nr. auf anzeigen stellen (Softkey-Leiste 3)

FK-Dialog eröffnen

Wenn Sie die graue Bahnfunktionstaste FK drücken, zeigt die TNC Softkeys an, mit denen Sie den FK-Dialog eröffnen: Siehe nachfolgende Tabelle. Um die Softkeys wieder abzuwählen, drücken Sie die Taste FK erneut.

Wenn Sie den FK-Dialog mit einem dieser Softkeys eröffnen, dann zeigt die TNC weitere Softkey-Leisten, mit denen Sie bekannte Koordinaten eingeben, Richtungsangaben und Angaben zum Konturverlauf machen können.

FK-Element	Softkey

Gerade mit tangentialem Anschluss	

Gerade ohne tangentialen Anschluss	

Kreisbogen mit tangentialem Anschluss	

Kreisbogen ohne tangentialen Anschluss	

Pol für FK-Programmierung				

Pol für FK-Programmierung

Softkeys zur Freien Kontur-Programmierung anzeigen: Taste FK drücken

Dialog zur Definition des Pols eröffnen: Softkey FpoL drücken. Die TNC zeigt die Achs-Softkeys der aktiven Bearbeitungsebene

Über diese Softkeys die Pol-Koordinaten eingeben

	Der Pol für die FK-Programmierung bleibt solange aktiv, bis Sie über FPOL einen neuen definieren.

Geraden frei programmieren

Gerade ohne tangentialem Anschluss

Softkeys zur Freien Kontur-Programmierung anzeigen: Taste FK drücken

Dialog für freie Gerade eröffnen: Softkey FL drücken. Die TNC zeigt weitere Softkeys

Über diese Softkeys alle bekannten Angaben in den Satz eingeben. Die FK-Grafik zeigt die programmierte Kontur rot, bis die Angaben ausreichen. Mehrere Lösungen zeigt die Grafik grün (siehe „Grafik der FK-Programmierung”, Seite 211)

Gerade mit tangentialem Anschluss

Wenn die Gerade tangential an ein anderes Konturelement anschließt, eröffnen Sie den Dialog mit dem Softkey FLT:

Softkeys zur Freien Kontur-Programmierung anzeigen: Taste FK drücken

Dialog eröffnen: Softkey FLT drücken

Über die Softkeys alle bekannten Angaben in den Satz eingeben

Kreisbahnen frei programmieren

Kreisbahn ohne tangentialem Anschluss

Softkeys zur Freien Kontur-Programmierung anzeigen: Taste FK drücken

Dialog für freien Kreisbogen eröffnen: Softkey FC drücken; die TNC zeigt Softkeys für direkte Angaben zur Kreisbahn oder Angaben zum Kreismittelpunkt

Über diese Softkeys alle bekannten Angaben in den Satz eingeben: Die FK-Grafik zeigt die programmierte Kontur rot, bis die Angaben ausreichen. Mehrere Lösungen zeigt die Grafik grün (siehe „Grafik der FK-Programmierung”, Seite 211)

Kreisbahn mit tangentialem Anschluss

Wenn die Kreisbahn tangential an ein anderes Konturelement anschließt, eröffnen Sie den Dialog mit dem Softkey FCT:

Softkeys zur Freien Kontur-Programmierung anzeigen: Taste FK drücken

	Dialog eröffnen: Softkey FCT drücken

Über die Softkeys alle bekannten Angaben in den Satz eingeben

Eingabemöglichkeiten

Endpunkt-Koordinaten

Bekannte Angaben	Softkeys	

Rechtwinklige Koordinaten X und Y					

Polarkoordinaten bezogen auf FPOL					

NC-Beispielsätze

7 FPOL X+20 Y+30 

8 FL IX+10 Y+20 rr F100 

9 fct PR+15 IPA+30 Dr+ R15 

Richtung und Länge von Konturelementen

Bekannte Angaben	Softkeys

Länge der Geraden				

Anstiegswinkel der Geraden				

Sehnenlänge LEN des Kreisbogenabschnitts				

Anstiegswinkel AN der Eintrittstangente	

Mittelpunktswinkel des Kreisbogenabschnitts				

	Achtung Gefahr für Werkstück und Werkzeug!

Anstiegswinkel die Sie inkremental (IAN) definiert haben, bezieht die TNC auf die Richtung des letzten Verfahrsatzes. Programme die inkrementale Anstiegswinkel enthalten und auf einer iTNC 530 oder älteren TNC´s erstellt wurden, sind nicht kompatibel. 

NC-Beispielsätze

27 Flt X+25 len 12.5 an+35 rl f200 

28 Fc dr+ r6 len 10 aN-45 

29 fct dr- r15 len 15 

Kreismittelpunkt CC, Radius und Drehsinn im FC-/FCT-Satz

Für frei programmierte Kreisbahnen berechnet die TNC aus Ihren Angaben einen Kreismittelpunkt. Damit können Sie auch mit der FK-Programmierung einen Vollkreis in einem Satz programmieren.

Wenn Sie den Kreismittelpunkt in Polarkoordinaten definieren wollen, müssen Sie den Pol anstelle mit CC mit der Funktion FPOL definieren. FPOL bleibt bis zum nächsten Satz mit FPOL wirksam und wird in rechtwinkligen Koordinaten festgelegt.

	Ein konventionell programmierter oder ein errechneter Kreismittelpunkt ist in einem neuen FK-Abschnitt nicht mehr als Pol oder Kreismittelpunkt wirksam: Wenn sich konventionell programmierte Polarkoordinaten auf einen Pol beziehen, den Sie zuvor in einem CC-Satz festgelegt haben, dann legen Sie diesen Pol nach dem FK-Abschnitt erneut mit einem CC-Satz fest.

Bekannte Angaben	Softkeys	

Mittelpunkt in rechtwinkligen Koordinaten					

Mittelpunkt in Polarkoordinaten					

Drehsinn der Kreisbahn					

Radius der Kreisbahn		

NC-Beispielsätze

10 Fc ccx+20 ccy+15 dr+ r15 

11 Fpol x+20 y+15 

12 fl an+40 

13 fc dr+ r15 ccpr+35 ccpa+40 

Geschlossene Konturen

Mit dem Softkey CLSD kennzeichnen Sie Beginn und Ende einer geschlossenen Kontur. Dadurch reduziert sich für das letzte Konturelement die Anzahl der möglichen Lösungen.

CLSD geben Sie zusätzlich zu einer anderen Konturangabe im ersten und letzten Satz eines FK-Abschnitts ein.

			Konturanfang:		CLSD+

	Konturende:			CLSD–

NC-Beispielsätze

12 l x+5 y+35 rl f500 m3 

13 Fc dr- r15 clsd+ ccx+20 ccy+35 

...

17 fct dr- r+15 clsd- 

Hilfspunkte

Sowohl für freie Geraden als auch für freie Kreisbahnen können Sie Koordinaten für Hilfspunkte auf oder neben der Kontur eingeben.

Hilfspunkte auf einer Kontur

Die Hilfspunkte befinden sich direkt auf der Geraden bzw. auf der Verlängerung der Geraden oder direkt auf der Kreisbahn.

Bekannte Angaben	Softkeys		

X-Koordinate eines Hilfspunkts

P1 oder P2 einer Geraden			

Y-Koordinate eines Hilfspunkts		

P1 oder P2 einer Geraden			

X-Koordinate eines Hilfspunkts 			

P1, P2 oder P3 einer Kreisbahn			

Y-Koordinate eines Hilfspunkts 			

P1, P2 oder P3 einer Kreisbahn			

Hilfspunkte neben einer Kontur

Bekannte Angaben		Softkeys	

X- und Y- Koordinate des Hilfspunkts neben		einer Geraden		

Abstand des Hilfspunkts zur Geraden		

X- und Y-Koordinate eines Hilfspunkts neben einer Kreisbahn		

Abstand des Hilfspunkts zur Kreisbahn		

NC-Beispielsätze

13 fc dr- r10 p1x+42.929 p1y+60.071 

14 FLT An-70 PDX+50 PDY+53 D10 

Relativ-Bezüge

Relativ-Bezüge sind Angaben, die sich auf ein anderes Konturelement beziehen. Softkeys und Programm-Wörter für Relativ-Bezüge beginnen mit einem „R“. Das Bild rechts zeigt Maßangaben, die Sie als Relativ-Bezüge programmieren sollten.

	Koordinaten mit Relativbezug immer inkremental eingeben. Zusätzlich Satz-Nummer des Konturelements eingeben, auf das Sie sich beziehen.

Das Konturelement, dessen Satz-Nummer Sie angeben, darf nicht mehr als 64 Positionier-Sätze vor dem Satz stehen, in dem Sie den Bezug programmieren.

Wenn Sie einen Satz löschen, auf den Sie sich bezogen haben, dann gibt die TNC eine Fehlermeldung aus. Ändern Sie das Programm, bevor Sie diesen Satz löschen.

Relativbezug auf Satz N: Endpunkt-Koordinaten

Bekannte Angaben	Softkeys	

Rechtwinklige Koordinaten 

bezogen auf Satz N		

Polarkoordinaten bezogen auf Satz N		

NC-Beispielsätze

12 FPOL X+10 Y+10 

13 FL PR+20 PA+20 

14 FL An+45 

15 FCT IX+20 DR- R20 CCA+90 RX 13 

16 FL IPR+35 PA+0 RPR 13 

Relativbezug auf Satz N: Richtung und Abstand des Konturelements

Bekannte Angaben	Softkey

Winkel zwischen Gerade und anderem Konturelement bzw. zwischen Kreisbogen-Eintrittstangente und anderem Konturelement	

Gerade parallel zu anderem Konturelement	

Abstand der Geraden zu parallelem Konturelement	

NC-Beispielsätze

17 FL LEN 20 An+15 

18 FL AN+105 LEN 12.5 

19 FL PAR 17 DP 12.5 

20 FSELECT 2 

21 FL LEN 20 IAn+95 

22 FL IAn+220 RAN 18 

Relativbezug auf Satz N: Kreismittelpunkt CC

Bekannte Angaben	Softkey	

Rechtwinklige Koordinaten des Kreismittelpunktes bezogen auf Satz N		

Polarkoordinaten des Kreismittelpunktes bezogen auf Satz N		

NC-Beispielsätze

12 FL X+10 Y+10 RL 

13 FL ... 

14 FL X+18 Y+35 

15 FL ... 

16 FL ... 

17 FC DR- R10 CCA+0 ICCX+20 ICCY-15 RCCX12 RCCY14 

Beispiel: FK-Programmierung 1

	

0 BEGIN PGM FK1 MM 	

1 BLK FORM 0.1 Z X+0 Y+0 Z-20 	Rohteil-Definition

2 BLK FORM 0.2 X+100 Y+100 Z+0 	

3 TOOL CALL 1 Z S500 	Werkzeug-Aufruf

4 L Z+250 R0 FMAX 	Werkzeug freifahren

5 L X-20 Y+30 R0 FMAX 	Werkzeug vorpositionieren

6 L Z-10 R0 F1000 M3 	Auf Bearbeitungstiefe fahren

7 APPR CT X+2 Y+30 CCA90 R+5 RL F250 	Kontur anfahren auf einem Kreis mit tangentialem Anschluss

8 FC DR- R18 CLSD+ CCX+20 CCY+30 	FK- Abschnitt: 

9 FLT 	Zu jedem Konturelement bekannte Angaben programmieren

10 FCT DR- R15 CCX+50 CCY+75 	

11 FLT 	

12 FCT DR- R15 CCX+75 CCY+20 	

13 FLT 	

14 FCT DR- R18 CLSD- CCX+20 CCY+30 	

15 DEP CT CCA90 R+5 F1000 	Kontur verlassen auf einem Kreis mit tangentialem Anschluss

16 L X-30 Y+0 R0 FMAX 	

17 L Z+250 R0 FMAX M2 	Werkzeug freifahren, Programm-Ende

18 END PGM FK1 MM 	

Beispiel: FK-Programmierung 2

	

0 BEGIN PGM FK2 MM 	

1 BLK FORM 0.1 Z X+0 Y+0 Z-20 	Rohteil-Definition

2 BLK FORM 0.2 X+100 Y+100 Z+0 	

3 TOOL CALL 1 Z S4000 	Werkzeug-Aufruf

4 L Z+250 R0 FMAX 	Werkzeug freifahren

5 L X+30 Y+30 R0 FMAX 	Werkzeug vorpositionieren

6 L Z+5 R0 FMAX M3 	Werkzeug-Achse vorpositionieren

7 L Z-5 R0 F100 	Auf Bearbeitungstiefe fahren

8 APPR LCT X+0 Y+30 R5 RR F350 	Kontur anfahren auf einem Kreis mit tangentialem Anschluss

9 FPOL X+30 Y+30 	FK- Abschnitt: 

10 FC DR- R30 CCX+30 CCY+30 	Zu jedem Konturelement bekannte Angaben programmieren

11 FL AN+60 PDX+30 PDY+30 D10 	

12 FSELECT 3 	

13 FC DR- R20 CCPR+55 CCPA+60 	

14 FSELECT 2 	

15 FL AN-120 PDX+30 PDY+30 D10 	

16 FSELECT 3 	

17 FC X+0 DR- R30 CCX+30 CCY+30 	

18 FSELECT 2 	

19 DEP LCT X+30 Y+30 R5 	Kontur verlassen auf einem Kreis mit tangentialem Anschluss

20 L Z+250 R0 FMAX M2 	Werkzeug freifahren, Programm-Ende

21 END PGM FK2 MM 	

Beispiel: FK-Programmierung 3

	

0 BEGIN PGM FK3 MM 	

1 BLK FORM 0.1 Z X-45 Y-45 Z-20 	Rohteil-Definition

2 BLK FORM 0.2 X+120 Y+70 Z+0 	

3 TOOL CALL 1 Z S4500 	Werkzeug-Aufruf

4 L Z+250 R0 FMAX 	Werkzeug freifahren

5 L X-70 Y+0 R0 FMAX 	Werkzeug vorpositionieren

6 L Z-5 R0 F1000 M3 	Auf Bearbeitungstiefe fahren

7 APPR CT X-40 Y+0 CCA90 R+5 RL F250 	Kontur anfahren auf einem Kreis mit tangentialem Anschluss

8 FC DR- R40 CCX+0 CCY+0 	FK- Abschnitt: 

9 FLT 	Zu jedem Konturelement bekannte Angaben programmieren

10 FCT DR- R10 CCX+0 CCY+50 	

11 FLT 	

12 FCT DR+ R6 CCX+0 CCY+0 	

13 FCT DR+ R24 	

14 FCT DR+ R6 CCX+12 CCY+0 	

15 FSELECT 2 	

16 FCT DR- R1.5 	

17 FCT DR- R36 CCX+44 CCY-10 	

18 FSELECT 2 	

19 FCT dr+ R5 	

20 FLT X+110 Y+15 AN+0 	

21 FL AN-90 	

22 FL X+65 AN+180 PAR21 DP30 	

23 RND R5 	

24 FL X+65 Y-25 AN-90 	

25 FC DR+ R50 CCX+65 CCY-75 	

26 FCT DR- R65 	

27 FSELECT 1 	

28 FCT Y+0 DR- R40 CCX+0 CCY+0 	

29 FSELECT 4 	

30 DEP CT CCA90 R+5 F1000 	Kontur verlassen auf einem Kreis mit tangentialem Anschluss

31 L X-70 R0 FMAX 	

32 L Z+250 R0 FMAX M2 	Werkzeug freifahren, Programm-Ende

33 END PGM FK3 MM 	

12

Kontur anfahren und verlassen
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